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Note

In order to be printed easily, this PDF-format manual is converted from the HTML-format instruction manual included on
the "User Manuals CD-ROM" supplied with the printer. Thus, there are descriptions that are applied only in HTML format,
and functions (video display function, etc.) that cannot be used. We appreciate your understanding.
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Printing Options Using Rolls and Sheets
The printer supports both rolls and sheets.
This section introduces the main features of each, as well as the main printing methods available. Select rolls or sheets to
suit your particular printing application.

Note
• For information on the types of paper the printer supports, refer to the Paper Reference Guide.  (See "Types

of Paper.") →P.623

• A variety of other ways to print are available besides those introduced here. Choose the printing method that
suits your particular printing application, referring to "Working With Various Print Jobs" and "Enhanced
Printing Options" from the table of contents.

Roll printing
Media in spooled rolls is generally called Roll Media. Rolls are loaded on the Roll Holder, which are in turn loaded in the
printer.
Rolls can be used to print large photos or create posters or banners that cannot be printed on regular sheets.

• Large-format printing
Easily print vertical or horizontal banners from familiar applications such as Microsoft Office applications.
 (See "Printing Vertical or Horizontal Banners (Large-Format Printing).") →P.117

• Borderless printing
Print without a margin (border) around posters or photos.
 (See "Borderless Printing on Paper of Equivalent Size.") →P.101
 (See "Borderless Printing by Resizing Originals to Fit the Roll Width.") →P.108
 (See "Borderless Printing at Actual Size.") →P.92

• Banner printing
You can print multiple pages as a single continuous image, without margins between pages.
 (See "Printing Multiple Pages Continuously.") →P.140

• 90-degree rotation before printing
Originals in portrait orientation are rotated 90 degrees when possible to use paper more efficiently.
 (See "Conserving Roll Paper by Rotating Originals 90 Degrees.") →P.169

• Enlarged/reduced printing
You can freely adjust the size of originals by enlarging or reducing originals before printing.
 (See "Resizing Originals to Match the Paper Size.") →P.66
 (See "Resizing Originals to Fit the Roll Width.") →P.72
 (See "Resizing Originals by Entering a Scaling Value.") →P.78

• Free Layout (Windows) and imagePROGRAF Free Layout (Macintosh)
Print multiple documents from multiple applications (such as word-processing programs, spreadsheet programs, and so
on) next to each other.
 (See "Printing Multiple Originals Next to Each Other.") →P.135
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Note
• Loading two rolls at once (in the Roll 1 (Upper) and Roll 2 (Lower) holders) offers the following advantages.

• Save the time and effort of switching paper
Loading rolls of different types saves you the time and effort of replacing rolls. You can select the desired
roll in Paper Source in the printer driver.
 (See "Page Setup Sheet (Windows).") →P.233
 (See "Page Setup Pane (Mac OS X).") →P.453

• Automatic selection of the right paper for the print job
Selecting Roll Paper (Auto) in Paper Source in the printer driver enables automatic selection and printing
on the roll that suits the print job from the loaded rolls.
Additionally, loading two rolls of the same type enables nonstop printing of multiple jobs. After one roll is
completely used, the printer switches to the other roll automatically and continues printing.
 (See "Automatic Roll Switching.") →P.661

Sheet printing
Sheets refer to individual sheets of paper.
Insert the sheet between the Platen and the Paper Retainer.

• Enlarged/reduced printing
You can freely adjust the size of originals by enlarging or reducing originals before printing.
 (See "Resizing Originals to Match the Paper Size.") →P.66
 (See "Resizing Originals by Entering a Scaling Value.") →P.78

• Free Layout (Windows) and imagePROGRAF Free Layout (Macintosh)
Print multiple documents from multiple applications (such as word-processing programs, spreadsheet programs, and so
on) next to each other.
 (See "Printing Multiple Originals Next to Each Other.") →P.135

Loading and Printing on Rolls
These are the basic steps for loading and printing on rolls.
Follow the steps below to switch to a new roll or a roll of a different type or width before printing.

Note
• The procedure varies depending on the ManageRemainRoll setting in the printer menu and whether or not a

barcode has been printed on the loaded roll.  (See "Keeping Track of the Amount of Roll Paper Left.")
→P.651

• Steps 6 and 7 are unnecessary if ManageRemainRoll is On and a barcode has been printed on the roll.
• Step 7 is unnecessary if ManageRemainRoll is Off.

• If the Wheeled Output Stacker is installed, remove it in advance.  (See "Using the Wheeled Output Stack-
er.") →P.671

• When Width Detection in the printer menu is Off, after you have selected the type of paper in step 6, you
will need to enter the roll width.  (See "Main Menu Settings.") →P.730

• For details on supported sizes and types of rolls, see Paper Sizes or the Paper Reference Guide.  (See "Paper
Sizes.") →P.626  (See "Types of Paper.") →P.623

• If you prefer to wait for the ink to dry after printing and simply eject the document, you can deactivate auto-
matic cutting and cut the paper manually.  (See "Specifying the Cutting Method for Rolls.") →P.654
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1. Turn the printer on.  (See "Turning the Printer On and Off.") →P.702

2. Select a roll as the paper source.  (See "Selecting the Paper Source.") →P.641

3. Remove any loaded paper that will not be used.

• Rolls  (See "Removing the Roll from the Printer.") →P.644
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• Sheets  (See "Removing Sheets.") →P.669

4. Load the roll on the Roll Holder.  (See "Attaching the Roll Holder to Rolls.") →P.629
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5. Load the roll in the printer.  (See "Loading Rolls in the Printer.") →P.634

Note
• Before borderless printing, make sure the blue Switch on the platen is set toward the ● side.  (See

"Setting the Blue Switch on the Platen.") →P.867

6. Select the type of paper.  (See "Selecting the Paper Type (Roll).") →P.642
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7. Specify the paper length.  (See "Specifying the Paper Length (Roll).") →P.643

8. Complete settings in the printer driver for the type of paper and other details.

• Specifying Paper in the Printer Driver (Windows) →P.209

• Specifying Paper in the Printer Driver (Mac OS X) →P.433
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Important
• Confirm the type of paper loaded in the printer and specify the same type in the printer driver.

If the type of paper does not match, an error message is displayed and the printing quality may be
affected, or printing may not be possible.

• The paper is too small. →P.889

• Papr Type Mismatch →P.888

9. Send the print job.

• Printing in Windows →P.11

• Printing from Mac OS X →P.12

Start printing.

Loading and Printing on Sheets
These are the basic steps for loading sheets and then printing.
Follow the steps below to load and print on sheets.

Note
• For details on supported types and sizes of paper, see Paper Sizes or the Paper Reference Guide.  (See

"Paper Sizes.") →P.626  (See "Types of Paper.") →P.623
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1. Turn the printer on.  (See "Turning the Printer On and Off.") →P.702

2. Remove any loaded paper that will not be used.  (See "Removing Sheets.") →P.669

3. Complete settings in the printer driver for the type of paper and other details.

• Specifying Paper in the Printer Driver (Windows) →P.209

• Specifying Paper in the Printer Driver (Mac OS X) →P.433

Basic Printing Workflow > Printing procedure >

iPF825 Loading and Printing on Sheets

1

9



4. Send the print job.

• Printing in Windows →P.11

• Printing from Mac OS X →P.12

5. Load the sheet.  (See "Loading Sheets in the Printer.") →P.664

Note
• If you will load a sheet before sending a print job, after you load the sheet, the printer automatically

shows a menu for selection of the type of paper on the control panel Display Screen. Select the type
of paper at this point.
 (See "Selecting the Paper Type (Sheet).") →P.663

• If you select a type of paper for which Media Width Detection is deactivated ( Off is selected), you
must advance the paper manually to the position for printing.  (See "Manually Loading Paper to the
Position for Printing.") →P.667
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Start printing.

Printing in Windows
Print from the application menu.

Important
• We recommend exiting unnecessary applications before printing. Running several applications while printing

may interrupt the transfer of print data and affect printing quality.

1. In the source application, select Print from the File menu to display the dialog box for printing conditions.
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2. After confirming that the printer is selected in the dialog box, click Print or OK to start printing.

Note
• The appearance of the dialog box varies depending on the software application. In most cases, the

dialog box includes basic printing options and enables you to choose the printer, specify the range of
pages, number of copies, and so on.
Example: Print dialog box displayed by the application

• If another printer is selected, select the printer you want to use under Select Printer or in the dialog
box displayed after clicking Printer.

Settings for many printing methods (including enlarged or reduced printing, borderless printing, and so on) are displayed in
the printer driver dialog box. There are two ways to access the printer driver dialog box, as follows.

• From the application
 (See "Accessing the Printer Driver Dialog Box from Applications (Windows).") →P.216

• From the operating system menu
 (See "Accessing the Printer Driver Dialog Box from the Operating System Menu (Windows).") →P.218

Printing from Mac OS X
Print from the application menu after registering the printer.

Important
• We recommend exiting unnecessary applications before printing. Running several applications while printing

may interrupt the transfer of print data and affect printing quality.

Registering the printer
Before printing, you must register the printer in imagePROGRAF PrinterSetup.app.
For instructions on registering the printer, see "Configuring the Printer Driver Destination ." →P.789
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Important
• During this setup process, the printer will not be listed among available printers if it is off or disconnected.

Printing from the application software

1. In the application software, select Print from the File menu to display the dialog box for printing conditions.

Note
• This dialog box includes basic printing options and enables you to choose the printer, specify the

range of pages, number of copies, and so on.

2. Select the printer in the Printer list.

3. Click Print to start printing.
As shown in the following illustration, you can switch to other panes in this dialog box to complete settings for vari-
ous methods of printing, including enlarged and reduced printing, borderless printing, and so on.
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Canceling print jobs
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Canceling Print Jobs from the Control Panel
Hold down the Stop button for a second or more to cancel print jobs or ink drying in progress when the printer is online,
offline, or in Menu mode.

Printer operation varies depending on the status when you hold down the Stop button for a second or more during printing.

• If you press the Stop button before printing starts
Holding down the Stop button for a second or more before printing cancels the print job and brings the printer online.
When the roll is selected as the paper source, the printer goes online, and when sheet is selected, the printer goes off-
line.
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• If you press the Stop button during printing
Holding down the Stop button for a second or more during printing stops printing immediately.

• If you press the Stop button when printing is paused
Holding down the Stop button for a second or more when printing is paused cancels the print job.

Canceling Print Jobs from Windows
In the printer window, you can cancel jobs that are being sent to the printer.
Using imagePROGRAF Status Monitor, you can cancel print jobs that have already been received by the printer or that are
currently being printed.

1. Click the printer icon in the taskbar to display the printer window.

Note
• You can also display this window by double-clicking the printer icon in the Printers and Faxes (or

Printers ) folder, accessible through the Windows start menu.
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2. Right-click the job to cancel and select Cancel.

3. If the job to cancel is not shown in the printer window (that is, if the print data has already been received by the
printer), double-click the taskbar icon to display imagePROGRAF Status Monitor.

4. On the Printer Status sheet, click Cancel Job.

Note
• The screen may differ slightly depending on the model you are using.

Canceling Print Jobs from Mac OS X
In the printer window, you can cancel jobs that are being sent to the printer.
Otherwise, you can cancel jobs from imagePROGRAF Printmonitor if they have been received by the printer or are current-
ly being printed.
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Note
• Print jobs are shown in the printer window while they are being sent from the computer. After transmission,

jobs are not displayed even during printing.
• Print jobs are displayed in the imagePROGRAF Printmonitor window from the moment the printer starts re-

ceiving the print data until the moment printing is finished. They are not displayed before print data is sent to
the printer, even if the computer has started preparing the print data.

1. Click the printer icon in the Dock to display the printer window.

2. Click Pause Printer to stop printing.

3. If there are no jobs in the printer window that can be canceled, (that is, if the print data has already been sent to the
printer), click Utility to display imagePROGRAF Printmonitor.
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4. Select the print job to cancel and click  to delete the print job.

Note
• The screen may differ slightly depending on the model you are using.

The job sent to the printer is canceled.

5. Exit imagePROGRAF Printmonitor. In the printer window, click Start Jobs.

Important
• Always follow these steps if you cancel print jobs from imagePROGRAF Printmonitor. If you do not

restart job processing, the next job cannot be printed.
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Printing CAD Drawings
Using this printer, you can print fine lines and text clearly and sharply. It's easy to produce highly precise drawings from
CAD applications.

Note
• In Windows, you can print highly precise drawings using the provided imagePROGRAF HDI Driver for Au-

toCAD/AutoCAD LT.
For details on the HDI driver, see the HDI Driver →P.360 .

For instructions on CAD printing, refer to the following topics, as appropriate for your computer and operating system.

• Printing Line Drawings and Text (Windows) →P.21

• Printing Line Drawings and Text (Mac OS X) →P.23

Printing Line Drawings and Text
Printing is easy when you simply choose the type of original to print.

Easy Settings
Simply choose the printing application in the list for optimal printing results.

Print Target
Choose presets that match the type of document to be printed.

Print targets for line drawings and text

Print Target Description

CAD (Color Line Draw-
ing)

Settings optimized to print intricate lines in CAD draw-
ings clearly.
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Print Target Description

CAD (Monochrome Line
Drawing )

Settings optimized to print black lines in CAD drawings
clearly.

Perspective, GIS Settings optimized for printing 3D CAD drawings, per-
spective drawings, and maps, including GIS maps.

Note
• You can check the settings values for each print target by clicking View Settings.
• You can also fine-tune these values as needed. ( Advanced Settings )

For details on Advanced Settings, see "Giving Priority to Particular Graphic Elements and Colors for
Printing →P.56 "

Print Quality
Choose the print quality.
The printing mode is determined by a combination of the print quality and resolution.

Print Quality Description

Highest A setting for printing at the highest resolution when quality is most important.
Printing takes longer and consumes more ink than in other modes, but this mode
offers superior printing quality.

High Choose this setting to print at high resolution when quality is most important.
Printing takes longer and consumes more ink than in Standard or Draft modes,
but this mode offers exceptional printing quality.

Standard Choose this setting to print at standard resolution when quality and speed are both
important.
Printing takes less time than in Highest or High mode.

Draft Choose this setting to print faster.
Printing in draft mode can help you work more efficiently when checking layouts.

For instructions on printing line drawings and text, refer to the following topics, as appropriate for your computer and oper-
ating system.

• Printing Line Drawings and Text (Windows) →P.21

• Printing Line Drawings and Text (Mac OS X) →P.23

Printing Line Drawings and Text (Windows)
This topic describes how to print line drawings based on the following example.

• Document: CAD drawing
• Page size: A3 (297.0 × 420.0 mm [11.7 × 16.5 in])
• Paper: Roll paper
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• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. After confirming that D Easy Settings is selected, click CAD (Color Line Drawing) or CAD (Monochrome Line
Drawing ) in the E Print Target list.

Note
• You can check the settings values selected in the E Print Target list by clicking G View Settings.
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6. Click the Page Setup tab to display the Page Setup sheet.

7. In A Page Size, click the size of the original as specified in the application. In this case, click ISO A3.

8. Select and click a roll paper in the L Paper Source list.

9. Select the width of the loaded roll in the M Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).

10. Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings (Windows) →P.207 "

11. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "

Printing Line Drawings and Text (Mac OS X)
This topic describes how to print line drawings based on the following example.

• Document: CAD drawing
• Page size: A3 (297.0 × 420.0 mm [11.7 × 16.5 in])
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])
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1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A3.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. After confirming that D Easy Settings is selected, click CAD (Color Line Drawing) or CAD (Monochrome Line
Drawing ) in the E Print Target list.

Note
• You can check the settings values selected in the E Print Target list by clicking G View set..

8. Make your selection in the F Print Quality list.
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9. Access the Page Setup pane.

10. Select and click a roll paper in the A Paper Source list.

11. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, ISO A2/A3 (420.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.
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12. Make sure C Page Size on the Page Setup pane shows the original size as specified in C Paper Size in the Page
Attributes dialog box—in this case, ISO A3.

13. Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings (Mac OS X) →P.431 "

14. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "

Specifying Colors and Printing CAD Drawings
You can complete color settings when Color (CAD) is selected in Color Mode.
Colors can be adjusted before printing as follows when Color Compatibility is selected.

Note
• Color (CAD) is displayed when you select Advanced Settings on the Main sheet and set Print Priority to

Line Drawing/Text.

Color Compatibility
Color Setting Item

Color Setting Description

Color (CAD) 1 Print in standard colors.

Color (CAD) 2 Print in brighter colors.

Color (CAD) 3 Print emulating the Canon BJ-W3000/W3050, in colors resembling colors pro-
duced by these printers.

Color (CAD) 4 Print emulating the HP Designjet 500/800, in colors resembling colors produced by
these printers.
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Color Setting Description

Color (CAD) 5 Print emulating the HP Designjet 1000, in colors resembling colors produced by
this printer.

Color (CAD) 6 Print emulating the HP Designjet 4000/4500, in colors resembling colors produced
by these printers.

Important
• If you have selected Color (CAD) 3, Color (CAD) 4, Color (CAD) 5, or Color (CAD) 6, it is not possible

to match the colors and image quality produced by the specified printer exactly.

For instructions on configuring Color Compatibility, refer to the following topics.

• Specifying Colors and Printing CAD Drawings (Windows) →P.28

Specifying Colors and Printing CAD Drawings (Windows)
You can complete color settings when Color (CAD) is selected in Color Mode.

Note
• Color (CAD) is displayed when you select Advanced Settings on the Main sheet and set Print Priority to

Line Drawing/Text.

1. Click start > Printers and Faxes (or Printers ).

2. Select the printer, and then display the printer properties dialog box.
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3. Click the Device Settings tab to display the Device Settings sheet.

4. Click B Color Compatibility to display the Color Compatibility dialog box.

5. Select the desired color settings in the A Color Compatibility list.

Note
• For details on color settings, see "Specifying Colors and Printing CAD Drawings →P.27 "

For printing instructions, refer to the following topic.

• Choosing the Document Type and Printing Conditions (Windows) →P.59

HP-GL/2 Printing
This printer supports the original Canon GARO printer control language as well as HP-GL/2 and HP RTL(*1 →P.30 )
emulation.(*2 →P.30 ) When printing from applications that support HP-GL/2 output, specify HP-GL/2 in the applica-
tion's plotter output settings.

Note
• For instructions on configuring these settings, refer to the software documentation.
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The printer automatically switches to the corresponding processing depending on whether a GARO, HP-GL/2, or HP RTL
job is received. Configure the optional settings for HP-GL/2 emulation on the printer control panel.  (See "Main Menu Set-
tings.") →P.730
This printer can emulate the following printers using HP-GL/2 emulation.

Emulated Printers

Canon W3000 and W3050(*3 →P.30 )

Hewlett-Packard Designjet 450c, Designjet 750c Plus, and Designjet 750c

*1: HP-GL/2: Hewlett-Packard Graphics Language 2; HP RTL: Hewlett-Packard Raster Transfer Language
*2: It may not be possible to print jobs with excessively large amounts of data correctly.
*3: Layout templates are not supported.
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Printing Photos and Images
Printing is easy when you simply choose the print target.

Easy Settings
Simply choose the printing application in the list for optimal printing results.

Print Target
Choose presets that match the type of document to be printed.

Print targets for photos and images

Print Target Description

Poster The best setting for posters. Prints using vivid and high
impact colors.

Photo (Color) Suitable for printing photographic images captured with a
digital camera.

Faithful Color Reproduc-
tion

Prints by minimizing color differences. Suitable for when
the printing results are too vivid or when printing scanned
images.

Caution
• Depending on the Media Type setting, some Print Target options may not be available.

Note
• You can check the settings values for each print target by clicking View Settings.
• You can also fine-tune these values as needed. ( Advanced Settings )

For details on Advanced Settings, see "Giving Priority to Particular Graphic Elements and Colors for
Printing →P.56 "
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Print Quality
Choose the print quality.
The printing mode is determined by a combination of the print quality and resolution.

Print Quality Description

Highest A setting for printing at the highest resolution when quality is most important.
Printing takes longer and consumes more ink than in other modes, but this mode
offers superior printing quality.

High Choose this setting to print at high resolution when quality is most important.
Printing takes longer and consumes more ink than in Standard or Draft modes,
but this mode offers exceptional printing quality.

Standard Choose this setting to print at standard resolution when quality and speed are both
important.
Printing takes less time than in Highest or High mode.

Draft Choose this setting to print faster.
Printing in draft mode can help you work more efficiently when checking layouts.

For instructions on printing photos and images, refer to the following topics, as appropriate for your computer and operating
system.

• Printing Photos and Images (Windows) →P.32

• Printing Photos and Images (Mac OS X) →P.34

Printing Photos and Images (Windows)
This topic describes how to print photos based on the following example.

• Document: Photo image from a digital camera
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Premium Glossy Paper 200
• Roll paper width: 10 inches (254.0 mm)

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Premium Glossy Paper 200.
In the A Media Type, choose the type of paper used for printing, such as Glossy Paper, Coated Paper, and so on.
Make sure the paper you select is loaded in the printer.

Note
• The paper type setting in the printer driver and related software (as well as on the Control Panel ) is

updated when you install the Media Configuration Tool from the User Software CD-ROM or if you
change paper information by using the Media Configuration Tool. For details, see Media Configura-
tion Tool →P.412 .

5. After confirming that D Easy Settings is selected, click Photo (Color) in the E Print Target list.

Note
• You can check the settings values selected in the E Print Target list by clicking G View Settings.
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6. Click the Page Setup tab to display the Page Setup sheet.

7. In the A Page Size list, click the size of the original as specified in the application. In this case, click 10"x12".

8. Select and click a roll paper in the L Paper Source list.

9. Select the width of the loaded roll in the M Roll Paper Width list—in this case, 10-in. Roll (254.0mm).

10. Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings (Windows) →P.207 "

11. Confirm the print settings and print as desired.

Note
• For instructions on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "

Printing Photos and Images (Mac OS X)
This topic describes how to print photos based on the following example.

• Document: Photo image from a digital camera
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll paper
• Paper type: Premium Glossy Paper 200
• Roll paper width: 10 inches (254.0 mm)
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1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click 10"x12".

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Premium Glossy Paper 200.
Make sure the paper you select is loaded in the printer.

Note
• The types of paper indicated in the printer driver and related software (as well as on the Control Pan-

el ) are updated when you install the Media Configuration Tool from the User Software CD-ROM or
if you change paper information by using the Media Configuration Tool. For details, see Media Con-
figuration Tool →P.545 .

7. After confirming that D Easy Settings is selected, click Photo (Color) in the E Print Target list.

Note
• For information on settings optimized for printing photos and images, see "Printing Photos and Im-

ages →P.31 "

• You can check the settings values selected in the E Print Target list by clicking G View set..

8. Make your selection in the F Print Quality list.
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9. Access the Page Setup pane.

10. Select and click a roll paper in the A Paper Source list.

11. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, 10 in. (254.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.
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12. Make sure C Page Size on the Page Setup pane shows the original size as specified in C Paper Size in the Page
Attributes dialog box—in this case, 10"x12".

13. Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings (Mac OS X) →P.431 "

14. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "
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Printing Office Documents
Printing is easy when you simply choose the type of original to print.

Easy Settings
Simply choose the printing application in the list for optimal printing results.

Print Target
Choose presets that match the type of document to be printed.

Print targets for office documents

Print Target Description

Office Document Settings optimized for clear printing of office documents
such as handouts.

Note
• You can check the settings values for each print target by clicking View Settings.
• You can also fine-tune these values as needed. (Advanced Settings)

For details on Advanced Settings, see "Giving Priority to Particular Graphic Elements and Colors for
Printing →P.56 "

Print Quality
Choose the print quality.
The printing mode is determined by a combination of the print quality and resolution.

Print Quality Description

Highest A setting for printing at the highest resolution when quality is most important.
Printing takes longer and consumes more ink than in other modes, but this mode
offers superior printing quality.

High Choose this setting to print at high resolution when quality is most important.
Printing takes longer and consumes more ink than in Standard or Draft modes,
but this mode offers exceptional printing quality.

Standard Choose this setting to print at standard resolution when quality and speed are both
important.
Printing takes less time than in Highest or High mode.

Draft Choose this setting to print faster.
Printing in draft mode can help you work more efficiently when checking layouts.
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For instructions on printing office documents, refer to the following topics, as appropriate for your computer and operating
system.

• Printing Office Documents (Windows) →P.40

• Printing Office Documents (Mac OS X) →P.41

Printing Office Documents (Windows)
This topic describes how to print office documents based on the following example.

• Document: Office document created using word-processing or spreadsheet programs
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Sheets
• Paper type: Plain Paper
• Paper size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
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5. After confirming that D Easy Settings is selected, click Office Document in the E Print Target list.

Note
• You can check the settings values selected in the E Print Target list by clicking G View Settings.

6. Click the Page Setup tab to display the Page Setup sheet.

7. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4.

8. Click Cut Sheet in the L Paper Source list.

9. Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings (Windows) →P.207 "

10. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "

Printing Office Documents (Mac OS X)
This topic describes how to print office documents based on the following example.

• Document: Office document created using word-processing or spreadsheet programs
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Sheets
• Paper type: Plain Paper

Working With Various Print Jobs > Printing Office Documents >

iPF825 Printing Office Documents (Mac OS X)

2

41



• Paper size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
 

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A4 - for Paper Tray (Large Mar-
gins).

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. After confirming that D Easy Settings is selected, click Office Document in the E Print Target list.

Note
• You can check the settings values selected in the E Print Target list by clicking G View set..

8. Make your selection in the F Print Quality list.
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9. Access the Page Setup pane.

10. Click Cut Sheet in the A Paper Source list.

11. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, ISO A4 - for Paper Tray (Large Margins).

12. Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings (Mac OS X) →P.431 "
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13. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "
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Adjusting the Color in the Printer Driver
Color settings specified in the application for your documents are essentially given priority over other settings for each print
job, but further color adjustment is possible in the printer driver.

Color Mode
Choose how the printer driver processes color, as desired.
The available options vary depending on the color mode.

Color Mode Description Color Adjustment

Color Print in color. You can adjust the color balance and color-
matching method.

Monochrome Print in grayscale. You can adjust the color balance.

Color (CAD) A color mode optimized for line
drawings (2D-CAD). Lines in
red, yellow, and other colors are
printed especially clearly.

You can adjust the color balance.

Monochrome (BK ink) A color mode for printing line
drawings. Only Black ink is used.

You can adjust the color balance.

Monochrome Bitmap Print in a color mode for CAD,
using Color Ink, with all non-
white portions printed in black.

No color adjustment is supported.

No color correction (*1) Prints without performing color-
matching in the printer driver.

You can adjust the color balance.

*1: If No color correction is selected, the Matching sheet / Matching pane is not displayed.

Color Adjustment
You can adjust colors separately for images, graphics, and text documents.

Adjustment Item Description

Cyan Fine-tune color tones by adjusting the levels of Cyan, Magenta, and Yellow.

Magenta

Yellow

Gray Tone Adjust the grayscale, in a range from cool, blue tones to warm, red tones.

Brightness Adjust the brightness of printed images while keeping the darkest and lightest por-
tions intact.
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Adjustment Item Description

Contrast Adjust the contrast of the darkest and lightest portions relative to each other.
For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Saturation Adjust the level of color saturation, in a range from subdued to vivid.

Note
• Click Object Adjustment to open the Object Adjustment dialog box, which allows you to select the color

adjustment target from Image, Graphics, and Text.

Matching
You can choose the color-matching mode and method.
By adjusting the color-matching mode and method, you can make printed colors match the colors of on-screen images more
closely.

Matching Mode Description Remarks

Driver Matching Mode Enables printing of optimal color tones
using a driver specific color profile.

You should normally select this mode.

ICC Matching Mode Enables color matching using ICC pro-
files.
Select this if you want to print by speci-
fying the input profile, printer profile,
and matching method in detail.

This allows you to use ICC profiles for
digital cameras and scanners, ICC pro-
files created using the profile creation
tool, etc.

Driver ICM Mode Enables color matching by the printer
driver using the ICM function of printer
driver.
Select this if you want to print by only
specifying the matching method.

Available when using Windows.

Host ICM Mode Enables color matching by the host
computer using the ICM function of
Windows.
Select this if you want to print from an
application that supports the ICM func-
tion.

ColorSync Enables color matching by using the
ColorSync function of Mac OS.
Select this if you want to perform soft
proofing using ColorSync before print-
ing.

Available when using Mac OS.

Matching Method Description Remarks

Auto Color-matching optimized for images,
graphics, or text.

The available options and their display
order vary depending on your selected
color-matching mode, as well as the op-
erating system.Perceptual Color-matching optimized for printing

typical photos attractively. Smooth gra-
dation is a feature. This is also an easy-
to-use mode when performing color ad-
justment using application software.
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Matching Method Description Remarks

Colorimetric Color-matching optimized for printing
image data with accurate colors in input
color space. This is the easiest-to-use
mode when you want to adjust the color
and print. However, gradation may be
lost for colors of wider range than the
color reproduction range of the printer.
Generally, this is also called relative
colorimetric.

The available options and their display
order vary depending on your selected
color-matching mode, as well as the op-
erating system.

Colorimetric (No Wht-pnt
Corr)

The processing method of color-match-
ing is identical to Colorimetric. Use this
when you want to further reproduce the
target paper material color of the image
data. Generally, this also is called abso-
lute colorimetric.

Saturation Color-matching optimized for printing
posters, etc., vividly.

Note
• Be sure to calibrate your monitor colors correctly if you adjust the colors for printing. If monitor colors are

not calibrated correctly, you may not obtain the desired printing results. For instructions on monitor calibra-
tion, refer to the documentation for your monitor and operating system.

For instructions on color adjustment, refer to the following topics, as appropriate for your computer and operating system.

• Fine-Tuning Colors of Photos and Images (Windows) →P.49

• Fine-Tuning Colors of Photos and Images (Mac OS X) →P.53

Fine-Tuning Colors of Photos and Images (Windows)
You can specify your own print settings instead of using the Print Target presets. This topic describes how to fine-tune the
color tone of photos before printing.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded.

5. Click D Advanced Settings to switch the print mode.

6. Click Color in the G Color Mode list.
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7. Click H Color Settings to display the Color Settings dialog box.

8. On the Color Adjustment sheet, adjust the color tones, brightness, and so on as desired.

Adjustment Item Description

D Cyan Fine-tune color tones by adjusting the levels of Cyan, Magenta, and Yellow.

E Magenta

F Yellow

G Gray Tone Adjust the gray tone to suit the images of monochrome photos. Choose cool black
(tinged with blue), pure black (neutral), warm black (tinged with red), and so on.
Select the color tone in the color region or from the list.

H Brightness Adjust the brightness of printed images while keeping the darkest and lightest por-
tions intact.

I Contrast Adjust the contrast of the darkest and lightest portions relative to each other.
For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

J Saturation Adjust the level of color saturation, in a range from subdued to vivid.

Note
• Click Object Adjustment to open the Object Adjustment dialog box, which allows you to select the

color adjustment target from Image, Graphics, and Text.

9. Close the Color Settings dialog box.
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10. Click the Page Setup tab to display the Page Setup sheet.

11. Confirm the settings of A Page Size, L Paper Source, and so on.

12. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "
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Fine-Tuning Colors of Photos and Images (Mac OS X)
You can specify your own print settings instead of using the Print Target presets. This topic describes how to fine-tune the
color tone of photos before printing.

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. Choose the original size in the F Paper Size list.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded.

7. Click D Advanced Settings to switch the print mode.

8. Click Color in the H Color Mode list.
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9. Click I Set to display the Color Settings dialog box.

10. On the Color Adjustment pane, adjust the color tones, brightness, and so on as desired.

Adjustment Item Description

D Cyan Fine-tune color tones by adjusting the levels of Cyan, Magenta, and Yellow.

E Magenta

F Yellow

G Gray Tone Adjust the gray tone to suit the images of monochrome photos. Choose cool black
(tinged with blue), pure black (neutral), warm black (tinged with red), and so on.
Select the color tone in the color region or from the list.

H Brightness Adjust the brightness of printed images while keeping the darkest and lightest por-
tions intact.

I Contrast Adjust the contrast of the darkest and lightest portions relative to each other.
For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

J Saturation Adjust the level of color saturation, in a range from subdued to vivid.

Note
• Click Object Adjustment to open the Object Adjustment dialog box, which allows you to select the

color adjustment target from Images, Graphics, and Text.

11. Click OK to close the Color Settings dialog box.
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12. Access the Page Setup pane.

13. Confirm the settings of A Paper Source and C Page Size.

14. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "

Giving Priority to Particular Graphic Elements and Colors for Printing
You can specify detailed print settings as desired for the quality level, colors, and other criteria.

Advanced Settings
For printing results that appear just as expected for your original, you can specify which graphic elements and colors to
prioritize for printing.

Note
• Easy Settings are also available, providing convenient presets. To use the presets, simply choose the printing

application.
For details on Easy Settings, refer to the following topics.

• Printing Photos and Images →P.31

• Printing Line Drawings and Text →P.20

• Printing Office Documents →P.39

Print Priority
Choose the graphic elements that you want to emphasize for printing.
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Print Priority (*1) Description

Image A setting for posters or other documents made up mainly of photos or images, or
for emphasizing photos or images in printed documents.

Line Drawing/Text Choose this setting for CAD drawings made up mainly of intricate lines, or wall
newspapers and other notices with a large amount of text. Suitable for emphasizing
detailed text in printed documents.
However, the quality may not be sufficient when printing photos or images that re-
quire a lot of color coverage. In this case, choose Image instead.

Office Document Choose this setting for better legibility of documents combining text and graphics,
such as documents and presentation material created with typical office applica-
tions.

*1: Options suitable for the selected type of paper are listed under Print Priority.

Print Quality
Choose the print quality.
The printing mode is determined by a combination of the print quality and resolution.

Print Quality (*1) Description Print Priority

Highest A setting for printing at the highest resolution
when quality is most important. Printing takes
longer and consumes more ink than in other
modes, but this mode offers superior printing
quality.

Image

High Choose this setting to print at high resolution
when quality is most important.
Printing takes longer and consumes more ink
than in Standard or Draft modes, but this
mode offers exceptional printing quality.

Image
Line Drawing/Text

Standard Choose this setting to print at standard resolu-
tion when quality and speed are both impor-
tant.
Printing takes less time than in Highest or
High mode.

Image
Line Drawing/Text
Office Document

Draft Choose this setting to print faster.
Printing in draft mode can help you work
more efficiently when checking layouts.

Image
Line Drawing/Text

*1: Options suitable for the selected Print Priority are listed under Print Quality.

Color Settings

Setting Item Options Description

Color Mode (*1) Color
Monochrome
Color (CAD)
Monochrome (BK ink)
Monochrome Bitmap
No color correction

Choose whether to print in color or mono-
chrome.
(See "Adjusting the Color in the Printer
Driver →P.47 ")
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Setting Item Options Description

Color Adjustment Cyan
Magenta
Yellow
Gray Tone
Brightness
Contrast
Saturation

You can adjust the levels of cyan, magenta,
and yellow as well as the brightness, contrast,
saturation, and gray tones.
If you choose Monochrome or Monochrome
(BK ink) in Color Mode only Brightness
and Contrast can be adjusted.
Image, Graphics, and Text are available as
Object Adjustment options.

Color-Matching Modes Driver Matching Mode
ICC Matching Mode
Driver ICM Mode (Windows)
Host ICM Mode (Windows)
ColorSync (Mac OS X)

Choose the color-matching mode.

Color-Matching Method (*2) Auto
Perceptual
Colorimetric
Colorimetric (No Wht-pnt
Corr)
Saturation

Choose the color-matching method. The
available options vary depending on your se-
lection in Color-Matching Mode.

*1: Options suitable for the selected Print Priority are listed under Color Mode.
*2: The order of options displayed varies depending on the operating system.

Enhancing printing quality

Setting Item Description

Unidirectional Printing Choosing unidirectional printing can improve printing results if lines are printed
crooked or images are uneven. However, this takes more time than regular printing.

Thicken Fine Lines Choose this option to make fine lines clearer in CAD drawings or similar docu-
ments.

Sharpen Text Choose this option to print intricate text more distinctly.

Reduce Print Unevenness (*1) Choose this option to counteract uneven printing.

Economy Printing When this mode is selected, less ink is consumed than in regular printing, but the
quality is diminished.
Select this mode if you want to conserve ink when checking drawings, for example.
Depending on the Media Type and Print Quality settings, this mode may not be
available.

*1: Displayed in Mac OS X.

Note
• To print at a higher level of quality, in the printer driver, choose High or Highest in Print Quality, and

choose Unidirectional Printing as the direction of printing.

For instructions on specifying the print quality and color settings before printing, refer to the following topics, as appropri-
ate for your computer and operating system.

• Choosing the Document Type and Printing Conditions (Windows) →P.59

• Choosing the Document Type and Printing Conditions (Mac OS X) →P.62
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Choosing the Document Type and Printing Conditions (Windows)
You can specify your own print settings instead of using the Print Target presets. As an example, this topic describes how
to print CAD drawings as clearly as possible, with sharp lines and text.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded.
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5. Click D Advanced Settings to switch the print mode.

6. Click Line Drawing/Text in the E Print Priority list.

7. Click High (1200dpi) in the F Print Quality list.

Note
• Options displayed in the F Print Quality list vary depending on the paper type.

8. Click Color (CAD) in the G Color Mode list.

9. To adjust the color, click H Color Settings.

Note
• For instructions on adjusting color, see "Adjusting the Color in the Printer Driver →P.47 "

10. Select the K Sharpen Text check box.

Enhanced Printing Options > Adjusting Images >

Choosing the Document Type and Printing Conditions (Windows) iPF825

3

60



11. Click the Page Setup tab to display the Page Setup sheet.

12. Confirm the settings of A Page Size, L Paper Source, and so on.

13. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "

Enhanced Printing Options > Adjusting Images >

iPF825 Choosing the Document Type and Printing Conditions (Windows)

3

61



Choosing the Document Type and Printing Conditions (Mac OS X)
You can specify your own print settings instead of using the Print Target presets. As an example, this topic describes how
to print CAD drawings as clearly as possible, with sharp lines and text.

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. Choose the original size in the F Paper Size list.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded.

7. Click D Advanced Settings to switch the print mode.

8. Click Line Drawing in the E Print Priority list.
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9. Click High(1200dpi) in the F Print Quality list.

Note
• Options displayed in the F Print Quality list vary depending on the type of paper.

10. Click Color (CAD) in the H Color Mode list.

11. To adjust the color, click I Set.

Note
• For instructions on adjusting color, see "Adjusting the Color in the Printer Driver →P.47 "

12. Access the Page Setup pane.

13. Confirm the settings of A Paper Source and C Page Size.

14. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "
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Choosing Paper for Printing
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Specifying Paper in the Printer Driver ............................................................................................................... 65

Choosing a Paper for Printing
Choosing the right paper for your particular printing application will give you the best printing results.

Media Type
The printer and printer driver offer print settings optimized for various paper characteristics.

Note
• For information on the types of paper the printer supports, refer to the Paper Reference Guide.(See "Types of

Paper →P.623 ")
• The types of paper indicated in the printer driver and related software (as well as on the Control Panel ) are

updated when you install the Media Configuration Tool from the User Software CD-ROM or if you change
paper information by using the Media Configuration Tool. For information about the Media Configuration
Tool, see the Media Configuration Tool →P.412  (Windows) or Media Configuration Tool →P.545
(Macintosh).

• An error message may be displayed on the printer Control Panel if the type of paper as specified in the print-
er driver does not match the type specified on the printer. Although you can print under these conditions, the
printing results may not be suitable.

If the paper type is not listed for selection
If the type of paper loaded cannot be selected, try specifying glossy paper or proofing paper as a special paper (Special 1 to
Special 5, in this order). BK ( Black Ink ) is used as the black ink. Try specifying other types of paper as Special 6 to Spe-
cial 10. MBK ( Matte Black Ink ) is used as the black ink. Note that higher numbers in this setting enable more vivid colors
but may also cause colors to run together.

For instructions on specifying the type of paper before printing, refer to the following topics.

• Selecting the Paper Type (Roll) →P.642

• Selecting the Paper Type (Sheet) →P.663

Specifying Paper in the Printer Driver
If you replace the paper, complete the printer driver settings for the paper type and size.
For instructions on configuring paper settings in the printer driver, refer to the following topics, as appropriate for your
computer and operating system.

• Specifying Paper in the Printer Driver (Windows) →P.209

• Specifying Paper in the Printer Driver (Mac OS X) →P.433
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Printing enlargements or reductions
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Resizing Originals to Match the Paper Size
You can freely adjust the size of originals by enlarging or reducing them as desired.

Enlarged/Reduced Printing
Enlarge or reduce the original in the printer driver, as desired.

Fit Paper Size
Enlarge or reduce the original to match the size of the paper you are using.

For instructions on resizing originals to match the paper size, refer to the following topics, as appropriate for your computer
and operating system.

• Resizing Originals to Match the Paper Size (Windows) →P.66

• Resizing Originals to Match the Paper Size (Mac OS X) →P.68

Note
• For better printing results when enlarging photos from a digital camera in TIFF or JPEG format, use an im-

age-editing application software such as Adobe Photoshop to specify an image resolution of 150 dpi or more
at actual size.

Resizing Originals to Match the Paper Size (Windows)
This topic describes how to enlarge originals before printing to match the paper size, based on the following example.

• Document: Any Type
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• Page size: A4 (210.0×297.0mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then open the printer driver dialog box.(See "Accessing the Printer Driver
Dialog Box from Applications (Windows) →P.216 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Select the printing application in the E Print Target list.
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6. Click the Page Setup tab to display the Page Setup sheet.

7. Select and click a roll paper in the L Paper Source list.

8. Select the width of the loaded roll in the M Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).

9. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4.

10. Select the C Enlarged/Reduced Printing check box.

11. Select the D Fit Paper Size check box.

12. Click ISO A3 in the G Paper Size list.

13. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "

Resizing Originals to Match the Paper Size (Mac OS X)
This topic describes how to enlarge originals before printing to match the paper size, based on the following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
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• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

 

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Make your selection in the E Print Target list.

8. Make your selection in the F Print Quality list.

9. Access the Page Setup pane.

10. Select and click a roll paper in the A Paper Source list.
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11. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, ISO A2/A3 (420.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

12. Make sure C Page Size on the Page Setup pane shows the original size as specified in C Paper Size in the Page
Attributes dialog box—in this case, ISO A4.

13. Select the D Enlarged/Reduced Printing check box.

14. Make sure E Fit Paper Size is selected.
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15. Click ISO A3 in the I Paper Size list.

16. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "

Resizing Originals to Fit the Roll Width
You can freely adjust the size of originals by enlarging or reducing them as desired.

Enlarged/Reduced Printing
Enlarge or reduce the original in the printer driver, as desired.

Fit Roll Paper Width
Enlarge or reduce the original as a whole to match the roll paper width, as desired.

For instructions on resizing originals to match the roll paper width, refer to the following topics, as appropriate for your
computer and operating system.

• Resizing Originals to Fit the Roll Width (Windows) →P.72

• Resizing Originals to Fit the Roll Width (Mac OS X) →P.75

Note
• For better printing results when enlarging photos from a digital camera in TIFF or JPEG format, use an im-

age-editing application software such as Adobe Photoshop to specify an image resolution of 150 dpi or more
at actual size.

Resizing Originals to Fit the Roll Width (Windows)
This topic describes how to enlarge originals before printing to match the roll width, based on the following example.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
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• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: 16 inches (406.4 mm)

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Select the printing application in the E Print Target list.
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6. Click the Page Setup tab to display the Page Setup sheet.

7. Select and click a roll paper in the L Paper Source list.

8. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").

9. Select the C Enlarged/Reduced Printing check box.

Note
• If the C Enlarged/Reduced Printing check box is not displayed on the Page Setup sheet, clear the

B Borderless Printing check box.
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10. Click E Fit Roll Paper Width.

Note
• After you click E Fit Roll Paper Width, the Information dialog box is displayed. Select the width

of the loaded roll in the Roll Paper Width list and click OK.
• Make sure the roll paper width you specify matches the width of the loaded roll.

11. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "

Important
• When the following three settings are configured simultaneously, printing is always performed from roll 1

(the upper roll).

• Automatically switch paper sources (paper size priority) is enabled on the Device Settings sheet.
• Fit Roll Paper Width is selected in Enlarged/Reduced Printing.
• Roll Paper (Auto) is selected in Paper Source.

Resizing Originals to Fit the Roll Width (Mac OS X)
This topic describes how to enlarge originals before printing to match the roll width, based on the following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
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• Roll paper width: 16 inches (406.4 mm)

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Make your selection in the E Print Target list.

8. Make your selection in the F Print Quality list.

9. Access the Page Setup pane.

10. Select and click a roll paper in the A Paper Source list.
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11. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, 16 in. (406.4mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

12. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, ISO A4.

13. Select the D Enlarged/Reduced Printing check box.

14. Click F Fit Roll Paper Width.

15. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "

Resizing Originals by Entering a Scaling Value
You can freely adjust the size of originals by enlarging or reducing them as desired.

Enlarged/Reduced Printing
Enlarge or reduce the original in the printer driver, as desired.
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Scaling
Enlarge or reduce originals by a particular amount, as desired.

For instructions on entering a scaling value to resize originals, refer to the following topics, as appropriate for your comput-
er and operating system.

• Resizing Originals by Entering a Scaling Value (Windows) →P.79

• Resizing Originals by Entering a Scaling Value (Mac OS X) →P.81

Note
• For better printing results when enlarging photos from a digital camera in TIFF or JPEG format, use an im-

age-editing application software such as Adobe Photoshop to specify an image resolution of 150 dpi or more
at actual size.

Resizing Originals by Entering a Scaling Value (Windows)
This topic describes how to enlarge originals before printing by entering a scaling value, based on the following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

Important
• In borderless printing, you cannot resize originals by entering a scaling value.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Select the printing application in the E Print Target list.

6. Click the Page Setup tab to display the Page Setup sheet.
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7. Select and click a roll paper in the L Paper Source list.

8. Select the width of the loaded roll in the M Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).

9. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4.

10. Select the C Enlarged/Reduced Printing check box.

11. Click ISO A4 in the G Paper Size list.

12. Click F Scaling and enter 120.

Note
• You can specify enlargement that exceeds the paper size, but in this case, the portions off the bottom

and right edges of the paper will not be printed.
• If the original size after enlargement or reduction is smaller than the paper size, the original is printed

in the upper-left corner. In this case, you can center originals by selecting E Print Centered on the
Layout sheet.

13. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "

Resizing Originals by Entering a Scaling Value (Mac OS X)
This topic describes how to enlarge originals before printing by entering a scaling value, based on the following example.

• Document: Any Type
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• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

 

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Make your selection in the E Print Target list.

8. Make your selection in the F Print Quality list.

9. Access the Page Setup pane.

10. Select and click a roll paper in the A Paper Source list.
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11. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, ISO A2/A3 (420.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

12. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, ISO A4.

13. Select the D Enlarged/Reduced Printing check box.
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14. Click G Scaling and enter 120.

Note
• You can specify enlargement that exceeds the paper size, but in this case, the portion off the edge of

the paper will not be printed.
• If the original size after enlargement or reduction is smaller than the paper size, the original is printed

in the upper-left corner. In this case, you can center originals by selecting the J Print Centered
check box.

15. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "
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Printing on Oversized Paper
Except in borderless printing, the actual printing area corresponds to your selected paper size minus the space for a margin
(See "Print Area →P.764 "). To print documents or images you prepare without a margin at actual size, use an oversized
paper size.
For example, to print a A4-sized original without a margin at A4 size, print it on paper larger than A4 size and cut away the
excess margin.

Note
• If you prepare an original for printing without a margin and print it on paper of regular size, the image near

the edge will not be printed.

Oversize
The margin required by the printer is added around the outside of a regular paper size. For example, when printing a A4-
sized original (210×297 mm), you have the following options.

• (a) Regular paper size: Gray area not printed
• (b) Page Size
• (c) Oversized paper size: Print area matches the page size (b)

Important
• When printing on oversize paper, load paper larger than the page size—a size that includes the margin re-

quired by the printer.

• Sheets: Load paper that is at least 6 mm (0.24 in) wider and 26 mm (1 in) higher than the page size
• Rolls: Load paper that is at least 6 mm (0.24 in) wider and 6 mm (0.24 in) higher than the page size
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Note
• Paper larger than the maximum size supported by the printer cannot be used as paper for oversized printing.

(See "Paper Sizes →P.626 ")
• To specify a non-standard paper size in oversized printing, register the paper size as a Custom Paper Size.

Oversized printing is not available with Custom Size.(See "Printing on Non-Standard Paper
Sizes →P.126 ")

For instructions on oversized printing, refer to the following topics, as appropriate for your computer and operating system.

• Printing at Full Size (Windows) →P.87

• Printing at Full Size (Mac OS X) →P.88

Printing at Full Size (Windows)
This topic describes how to print at full size based on the following example. (Oversized Printing)

• Document: Any Type
• Page Size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")

3. Make sure the Main sheet is displayed.
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4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Click the Page Setup tab to display the Page Setup sheet.

6. Click O Size Options to display the Paper Size Options dialog box.

7. In the Paper Size Options dialog box, select the Oversize check box in Display Series.

8. Click OK to close the Paper Size Options dialog box.

9. Click Oversize - ISO A4 in the A Page Size list.

10. Select and click a roll paper in the L Paper Source list.

11. Select the width of the loaded roll in the M Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).

12. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "

Printing at Full Size (Mac OS X)
This topic describes how to print at full size based on the following example. (Oversized Printing)

• Document: Any Type
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• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

 

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In F Paper Size, click the size of the original. In this case, click ISO A4 - Oversize.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Make your selection in the E Print Target list.

8. Make your selection in the F Print Quality list.

9. Access the Page Setup pane.

10. Select and click a roll paper in the A Paper Source list.
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11. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, ISO A2/A3 (420.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

12. Make sure C Page Size shows the original size as specified in C Paper Size in the Page Attributes dialog box—in
this case, ISO A4 - Oversize.

13. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "
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Borderless Printing at Actual Size
Take advantage of borderless printing to print documents such as posters (made up mainly of photos or images) without a
surrounding margin, or border.

Borderless Printing
In regular printing, a margin required by the printer is added around the original. With borderless printing, you can print
documents without the margin, so that the printed image covers the entire surface of the paper.

Important
• Borderless printing is only available with rolls.
• Paper you can use for borderless printing is restricted to particular types of paper and rolls of particular

widths. For information on types of paper compatible with borderless printing, refer to the Paper Reference
Guide. (See "Types of Paper →P.623 ")

• Paper incompatible with the printer's auto cut function can be printed without borders on the left and right
sides only.

• These features cannot be used in combination with borderless printing: special page layouts, centering origi-
nals, and printing cut lines on rolls.

• If Fit Paper Size or Print Image with Actual Size (Windows only) is selected when performing borderless
printing, Rotate Page 90 degrees (Conserve Paper) cannot be selected.

• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be un-
even at the edges. If you require higher image quality, specify No in Auto Cut in the printer driver. In this
case, the paper can be printed without borders on the left and right sides only. After ejecting and cutting the
printed document, use scissors to cut away the top and bottom edges.

• By factory default, the ink drying time is disabled for all paper. When you are using paper that takes longer
for ink to adhere for borderless printing and the Cutter Unit touches printing surfaces that are not dry yet, it
may damage the paper or the edge of the document that is cut, depending on frequency of use. In this case,
follow these steps to change the ink drying time.

1. On the Main sheet of the printer driver, click Settings in Media Type.
2. Select the ink drying time in the Between Pages list of Drying Time.

• Before borderless printing, make sure the blue Switch on the platen is set toward the ● side.  (See "Setting
the Blue Switch on the Platen.") →P.867

Borderless Printing Method
Choose the method of borderless printing that suits the original, as desired.
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Print Image with Actual Size
Prints originals at actual size, without enlarging or reducing them. Originals must be prepared in a size that exceeds the
dimensions of the paper by 3 mm (0.12 in) on each side.

Note
• Not all page sizes are available.
• Even if you prepare originals of the same size as the paper size, the originals are automatically enlarged

when you print borderlessly in combination with resizing originals to match the paper size. This may affect
image quality. When image quality is most important, make the original 3 mm longer on each side than the
paper size so that the image can be printed at actual size in borderless printing.

For instructions on borderless printing of photos and images at actual size, refer to the following topics, as appropriate for
your computer and operating system.

• Borderless Printing at Actual Size (Windows) →P.93

• Borderless Printing at Actual Size (Mac OS X) →P.96

Borderless Printing at Actual Size (Windows)
This topic describes how to print borderlessly at actual size based on the following example.

• Document: Any type
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1. Create the original in the source application 3 mm (0.12 in) larger on each side than 254.0×304.8 mm (10 × 12 in)
—that is, 260.0×310.8 mm (10.2 × 12.2 in)

Note
• If you can specify the margin, as in Microsoft Word, set the margin at 0 mm. For instructions on

specifying the margin, refer to the software documentation.
• The extra 3 mm (0.12 in) on each side will not be printed. Create the original so that it fits inside the

paper area to be printed on.

2. Choose Print in the application menu.
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3. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")

4. Make sure the Main sheet is displayed.

5. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight Coated Paper.

6. Select the print target in the E Print Target list.

Enhanced Printing Options > Printing at full size >

Borderless Printing at Actual Size (Windows) iPF825

3

94



7. Click the Page Setup tab to display the Page Setup sheet.

8. In the A Page Size list, click the size of the original as specified in the source application. In this case, click
10"x12".

9. Select and click a roll paper in the L Paper Source list.

10. Select the B Borderless Printing check box to display the Information dialog box.
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11. Select the width of the loaded roll in the Roll Paper Width list—in this case, click 10-in. Roll (254.0mm).

12. Click OK to close the Information dialog box.

13. In C Borderless Printing Method, click F Print Image with Actual Size.

14. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "

Important
• When Automatically switch paper sources (paper size priority) is enabled on the Device Settings sheet,

Print Image with Actual Size cannot be selected in Borderless Printing Method.

Borderless Printing at Actual Size (Mac OS X)
This topic describes how to print borderlessly at actual size based on the following example.

• Document: Any Type
• Page size: 10 × 12 inches (254.0×304.8 mm)–Borderless
• Paper: Roll paper
• Paper type: Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)
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1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, choose a paper size supported for borderless printing. Here, click 10"x12" - Borderless.

Note
• Paper sizes supported for borderless printing are indicated by —Borderless.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight Coated Paper.

7. Make your selection in the E Print Target list.

8. Make your selection in the F Print Quality list.

9. Access the Page Setup pane.

10. Select and click a roll paper in the A Paper Source list.
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11. Confirm that the roll paper width matches the paper size.
Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, 10 in. (254.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

12. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, 10"x12" - Borderless.
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13. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "
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Borderless Printing on Paper of Equivalent Size
Take advantage of borderless printing to print documents such as posters (made up mainly of photos or images) without a
surrounding margin, or border.

Borderless Printing
In regular printing, a margin required by the printer is added around the original. With borderless printing, you can print
documents without the margin, so that the printed image covers the entire surface of the paper.

Important
• Borderless printing is only available with rolls.
• Paper you can use for borderless printing is restricted to particular types of paper and rolls of particular

widths. For information on types of paper compatible with borderless printing, refer to the Paper Reference
Guide. (Refer to "Types of Paper →P.623 ")

• Paper incompatible with the printer's auto cut function can be printed without borders on the left and right
sides only.

• These features cannot be used in combination with borderless printing: special page layouts, centering origi-
nals, and printing cut lines on rolls.

• If Fit Paper Size or Print Image with Actual Size (Windows only) is selected when performing borderless
printing, Rotate Page 90 degrees (Conserve Paper) cannot be selected.

• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be
slightly uneven at the edges. If you require higher image quality, specify No in Auto Cut in the printer driv-
er. In this case, the paper can be printed without borders on the left and right sides only. Cut the printed docu-
ment ejected from the printer, then use scissors to cut away the edges on the top and bottom.

• By factory default, the ink drying time is disabled for all paper. When you are using paper that takes longer
for ink to adhere for borderless printing and the Cutter Unit touches printing surfaces that are not dry yet, it
may damage the paper or the edge of the document that is cut, depending on frequency of use. In this case,
follow these steps to change the ink drying time.

1. On the Main sheet of the printer driver, click Settings in Media Type.
2. Select the ink drying time in the Between Pages list of Drying Time.

• Before borderless printing, make sure the blue Switch on the platen is set toward the ● side.  (See "Setting
the Blue Switch on the Platen.") →P.867

Borderless Printing Method
Choose the method of borderless printing that suits the original, as desired.
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Fit Paper Size
Enlarge or reduce the original to match the size of the paper you are using.

Note
• The printer driver automatically enlarges originals 3 mm (0.12 in) past the dimensions of the paper on each

side. The 3 mm portion beyond the edge on each side is not printed.

For instructions on borderless printing of photos, images, and other documents to match the paper size, refer to the follow-
ing topics, as appropriate for your computer and operating system.

• Borderless Printing by Resizing Originals to Match the Paper Size (Windows) →P.102

• Borderless Printing by Resizing Originals to Match the Paper Size (Mac OS X) →P.105

Borderless Printing by Resizing Originals to Match the Paper Size (Windows)
This topic describes how to enlarge originals before borderless printing to match the paper size, based on the following
example.

• Document: Any type
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1. In the application, create an original that takes up the entire space of the paper size.

Note
• If you can specify the margin, as in Microsoft Word, set the margin at 0 mm. For instructions on

specifying the margin, refer to the software documentation.

2. Choose Print in the application menu.

3. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")
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4. Make sure the Main sheet is displayed.

5. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight Coated Paper.

6. Select the print target in the E Print Target list.

7. Click the Page Setup tab to display the Page Setup sheet.
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8. In the A Page Size list, click the size of the original as specified in the application. In this case, click 10"x12".

9. Select and click a roll paper in the L Paper Source list.

10. Select the B Borderless Printing check box to display the Information dialog box.

11. Select the width of the loaded roll in the Roll Paper Width list—in this case, click 10-in. Roll (254.0mm).

12. Click OK to close the Information dialog box.

13. In C Borderless Printing Method, click D Fit Paper Size.

14. Click Match Page Size in the G Paper Size list.

15. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "

Important
• When Automatically switch paper sources (paper size priority) is enabled on the Device Settings sheet,

Fit Paper Size cannot be selected in Borderless Printing Method.
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Borderless Printing by Resizing Originals to Match the Paper Size (Mac OS X)
This topic describes how to enlarge originals before borderless printing to match the paper size, based on the following
example.

• Document: Any Type
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll paper
• Paper type: Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

 

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
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3. In the F Paper Size list, click the size of the original. In this case, click 10"x12".

Note
• All sizes are available in borderless printing if you resize originals to match the paper size.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.

5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight Coated Paper.

7. Make your selection in the E Print Target list.

8. Make your selection in the F Print Quality list.
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9. Access the Page Setup pane.

10. Select and click a roll paper in the A Paper Source list.

11. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, 10 in. (254.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.
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12. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, 10"x12".

13. On the Page Setup pane, select the D Enlarged/Reduced Printing check box.

14. Select the H Borderless Printing check box.

15. Click E Fit Paper Size under D Enlarged/Reduced Printing.

16. In I Paper Size, click the paper size. In this case, click 10"x12" - Borderless.

17. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "

Borderless Printing by Resizing Originals to Fit the Roll Width
Take advantage of borderless printing to print documents such as posters (made up mainly of photos or images) without a
surrounding margin, or border.

Borderless Printing
In regular printing, a margin required by the printer is added around the original. With borderless printing, you can print
documents without the margin, so that the printed image covers the entire surface of the paper.
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Important
• Borderless printing is only available with rolls.
• Paper you can use for borderless printing is restricted to particular types of paper and rolls of particular

widths. For information on types of paper compatible with borderless printing, refer to the Paper Reference
Guide. (See "Types of Paper →P.623 ")

• Paper incompatible with the printer's auto cut function can be printed without borders on the left and right
sides only.

• These features cannot be used in combination with borderless printing: special page layouts, centering origi-
nals, and printing cut lines on rolls.

• If Fit Paper Size or Print Image with Actual Size (Windows only) is selected when performing borderless
printing, Rotate Page 90 degrees (Conserve Paper) cannot be selected.

• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be un-
even at the edges. If you require higher image quality, specify No in Auto Cut in the printer driver. In this
case, the paper can be printed without borders on the left and right sides only. After ejecting and cutting the
printed document, use scissors to cut away the top and bottom edges.

• By factory default, the ink drying time is disabled for all paper. When you are using paper that takes longer
for ink to adhere for borderless printing and the Cutter Unit touches printing surfaces that are not dry yet, it
may damage the paper or the edge of the document that is cut, depending on frequency of use. In this case,
follow these steps to change the ink drying time.

1. On the Main sheet of the printer driver, click Settings in Media Type.
2. Select the ink drying time in the Between Pages list of Drying Time.

• Before borderless printing, make sure the blue Switch on the platen is set toward the ● side.  (See "Setting
the Blue Switch on the Platen.") →P.867

Borderless Printing Method
Choose the method of borderless printing that suits the original, as desired.

Scale to fit Roll Paper Width
Enlarge or reduce the original as a whole to match the roll paper width.

Note
• You can combine this function with rotating pages 90 degrees before printing so that the original width (rela-

tive to portrait orientation) matches the roll paper width in borderless printing.

For instructions on borderless printing of photos, images, and other documents to match the roll paper width, refer to the
following topics, as appropriate for your computer and operating system.
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• Borderless Printing by Resizing Originals to Fit the Roll Width (Windows) →P.110

• Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS X) →P.112

Borderless Printing by Resizing Originals to Fit the Roll Width (Windows)
This topic describes how to enlarge originals before borderless printing to match the roll width, based on the following ex-
ample.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1. In the application, create an original that takes up the entire space of the paper size.

Note
• If you can specify the margin, as in Microsoft Word, set the margin at 0 mm. For instructions on

specifying the margin, refer to the software documentation.

2. Choose Print in the application menu.

3. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")

4. Make sure the Main sheet is displayed.

5. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight Coated Paper.
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6. Select the print target in the E Print Target list.

7. Click the Page Setup tab to display the Page Setup sheet.

8. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").

9. Select and click a roll paper in the L Paper Source list.
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10. Select the B Borderless Printing check box to display the Information dialog box.

11. Select the width of the loaded roll in the Roll Paper Width list—in this case, click 10-in. Roll (254.0mm).

12. Click OK to close the Information dialog box.

13. In C Borderless Printing Method, make sure E Scale to fit Roll Paper Width is selected.

14. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "

Important
• When Automatically switch paper sources (paper size priority) is enabled on the Device Settings sheet,

only Scale to fit Roll Paper Width can be selected in Borderless Printing Method. In this case, printing is
always performed from roll 1 (the upper roll). If a paper size or media type that does not support borderless
printing is loaded in roll 1, you cannot perform borderless printing.

Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS X)
This topic describes how to enlarge originals before borderless printing to match the roll width, based on the following ex-
ample.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Heavyweight Coated Paper
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• Roll paper width: 10 inches (254.0 mm)
 

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.

Note
• All sizes are available in borderless printing if you resize originals to fit the roll width.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight Coated Paper.

7. Make your selection in the E Print Target list.

8. Make your selection in the F Print Quality list.

9. Access the Page Setup pane.

10. Select and click a roll paper in the A Paper Source list.
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11. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, 10 in. (254.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

12. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, ISO A4.

13. Select the D Enlarged/Reduced Printing check box.

14. Select the H Borderless Printing check box.
This ensures that F Fit Roll Paper Width is automatically selected in D Enlarged/Reduced Printing.
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15. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "
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Printing Vertical or Horizontal Banners (Large-Format Printing)
You can create vertical or horizontal banners by printing originals that are in banner format on rolls.
Originals created in Microsoft Word or other applications in your preferred size can be enlarged to fill the width of roll
paper by completing simple printer driver settings.

Fit Roll Paper Width
You can easily create vertical or horizontal banners by automatically enlarging or reducing originals to fit the full width of
rolls.

Note
• The maximum supported roll length is 18.0 m or 19.7 yd.

For instructions on printing vertical or horizontal banners, refer to the following topics, as appropriate for your computer
and operating system.

• Printing Vertical or Horizontal Banners (Large-Format Printing; Windows) →P.118

• Printing Vertical or Horizontal Banners (Large-Format Printing; Mac OS X) →P.122

Important
• Before printing, check how much of the roll paper is left. If you have activated automatic detection of the

remaining roll paper, a warning message is displayed when there is not enough roll paper left.
• If not much ink is left, prepare replacement ink tanks.
• To print at a higher level of quality, in the printer driver, choose High or Highest in Print Quality, and

choose Unidirectional Printing as the direction of printing.
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Printing Vertical or Horizontal Banners (Large-Format Printing; Windows)
This topic describes how to print a banner about five times as long as the roll width based on the following example.

• Document: A horizontal banner created in Microsoft Word
• Page size: Non-standard (100×500 mm [3.9×19.7 in])
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: 16 in (406.4 mm)

Follow the steps below to print a banner in either horizontal or vertical format.

1. Register a Custom Paper Size.
Banners tend to be in non-standard sizes, so register a Custom Paper Size. In this example, 100×500 mm (3.9×19.7 in)
is registered.

2. In the application, create an original in the size you registered.

3. Print the banner, using the settings that correspond to banners.

Registering a Custom Paper Size
This example describes how to register a paper size that is horizontally elongated and suitable for banners in either horizon-
tal or vertical format.

1. Display the printer driver dialog box.(See "Accessing the Printer Driver Dialog Box from the Operating System
Menu (Windows) →P.218 ")

2. Click the Page Setup tab to display the Page Setup sheet.

3. Select and click a roll paper in the L Paper Source list.
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4. Click O Size Options to display the Paper Size Options dialog box.

5. Enter a desired paper name in Custom Paper Size Name. My Horizontal Banner is used in this example.

6. In Units, click mm.

7. Under Paper Size, enter 100 in Width and 500 in Height.

8. Click Add to add the paper size of My Horizontal Banner.

9. Click OK to close the Paper Size Options dialog box.

10. Close the printer driver dialog box.

Note
• You can also specify a Custom Size as the paper size. Note that Custom Size settings are not available after

you exit the application.
For more information, see "Printing on Non-Standard Paper Sizes (Windows) →P.126 "

Creating the banner in the application
Follow the steps below to create the banner in Microsoft Word using the Custom Paper Size you registered.

1. Start Microsoft Word.

2. Choose Page Setup from the File menu to display the Page Setup dialog box.

3. Under Paper Size, click the Custom Paper Size you registered—My Horizontal Banner in this example.

Important
• If My Horizontal Banner is not listed, make sure this printer is selected as the printer to use.
• In applications such as Microsoft PowerPoint that do not enable you to choose registered paper sizes,

use the custom paper size setting in Custom and specify 100×500 mm (3.9×19.7 in)

4. Set the printing orientation to horizontal.

5. Create the banner.

Printing the banner
Follow these steps to print the banner using the corresponding banner settings.

1. Choose Print in the Microsoft Word menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. After confirming that D Easy Settings is selected, click Poster in the E Print Target list.

6. Click the Page Setup tab to display the Page Setup sheet.
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7. In the A Page Size list, click the size you registered, My Horizontal Banner.

8. Select the C Enlarged/Reduced Printing check box.

Note
• If the C Enlarged/Reduced Printing check box is not displayed on the Page Setup sheet, clear the

B Borderless Printing check box.

9. Select and click a roll paper in the L Paper Source list.

10. After you click E Fit Roll Paper Width, the Information dialog box is displayed.

11. Select the width of the loaded roll in the Roll Paper Width list. In this case, click 16-in. Roll (406.4mm), and then
click OK.

12. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "
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If printing is unsuccessful, you may be able to print after completing the following setting.

1. On the Layout sheet, click J Special Settings to display the Special Settings dialog box.

2. In the FineZoom Settings list, click Yes.

Printing Vertical or Horizontal Banners (Large-Format Printing; Mac OS X)
This topic describes how to print a banner about five times as long as the roll width based on the following example.

• Document: An original designed for a horizontal banner
• Page Size: Non-standard (100×500 mm [3.9×19.7 in])
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: 16 inches (406.4 mm)
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Follow the steps below to print a banner in either horizontal or vertical format.

1. In the application, create an original in the format of a horizontal or vertical banner.

2. Register a Custom Page Sizes (Mac OS X 10.3.9-10.5)/ Custom Paper Sizes (Mac OS X 10.6).
Banners tend to be in non-standard sizes, so register a Custom Page Sizes (Mac OS X 10.3.9-10.5)/ Custom Paper
Sizes (Mac OS X 10.6) in Page Setup. In this example, 100×500 mm (3.9×19.7 in) is registered.

3. Print the banner, using the settings that correspond to banners.

Note
• The following procedures are based on Mac OS X 10.5. The method of setting up non-standard paper sizes

varies depending on the version of Mac OS X.

Register a Custom Page Sizes
This example describes how to register and print using a page size that is horizontally elongated and suitable for banners in
either horizontal or vertical format.

1. Create the document in the application.

2. Choose Print in the application menu.

3. Select the printer in the A Printer list.

4. Click Manage Custom Sizes in the C Paper Size list to display the Custom Page Sizes dialog box.
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5. Double-click Untitled in the list at left, and then enter a name for the page size you want to register. Here, enter
100*500.
If the Untitled size is not listed at left, click + below the list.

6. Under Page Size, enter 10 in Width and 50 in Height. Here, measurements are entered in centimeters.

7. Specify the margins by entering 0.3 in Printer Margins. Here, too, measurements are entered in centimeters.

8. Click OK to close the Custom Page Sizes dialog box.

9. In the C Paper Size list, click the size of the original. In this case, click 100*500, the size you registered.

10. In D Orientation, click the icon of the document in landscape orientation.

11. Click F OK to close the dialog box.

Print the banner
Follow the steps below to print the banner using the corresponding banner settings.

1. Choose Print in the application menu.

2. Access the Main pane.

3. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

4. Make your selection in the E Print Target list.

5. Make your selection in the F Print Quality list.
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6. Access the Page Setup pane.

7. Select and click a roll paper in the A Paper Source list.

8. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, 16 in. (406.4mm).

Note
• If the width of the loaded roll is not displayed in B Roll Width, click L Printer Information on the

Main pane and update the printer information.

9. In C Page Size, make sure 100*500 is displayed, as registered in Page Setup.
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10. Select the D Enlarged/Reduced Printing check box.

11. Click F Fit Roll Paper Width.

12. Confirm the print settings, and click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "

Printing on Non-Standard Paper Sizes
By specifying the paper size, you can print on non-standard sizes of paper.
There are two ways to print on non-standard paper sizes, as follows.

Registering non-standard paper size in the printer driver
After you register non-standard paper sizes, they are listed with standard sizes so that you can choose them anytime as nee-
ded.

Note
• These non-standard paper sizes you register in the printer driver are called Custom Paper Size in Windows

and Custom Sizes in Mac OS X.

Specifying custom paper sizes for temporary use
Because these are sizes you specify temporarily in the printer driver, the sizes will not be available after you exit the appli-
cation. If you want to set up a non-standard paper size so that it will always be available, we recommend registering the
paper size in the printer driver.

Note
• These temporary paper sizes you register on the printer are called Custom Sizes in Windows.
• This can only be configured in Windows.

For instructions on specifying non-standard paper sizes for printing, refer to the following topics, as appropriate for your
computer and operating system.

• Printing on Non-Standard Paper Sizes (Windows) →P.126

• Printing on Non-Standard Paper Sizes (Mac OS X) →P.131

Printing on Non-Standard Paper Sizes (Windows)
This topic describes two ways to print on non-standard paper sizes.

• Printing by using Custom Size
• Printing by using Custom Paper Size

Printing by using Custom Size
This section describes how to print using Custom Size based on the following example.

• Document: Any Type
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• Page size: Square of non-standard dimensions (430×430 mm [16.9×16.9 in])
• Paper: Sheets
• Paper type: Any type
• Paper Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])

1. Load the square paper (430 × 430 mm [16.9 × 16.9 in]) in the printer.

2. Choose Print in the application menu.

3. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")

4. Make sure the Main sheet is displayed.

5. In the A Media Type list, select the type of paper that is loaded.

6. After confirming that D Easy Settings is selected, select from the E Print Target list.
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7. Click the Page Setup tab to display the Page Setup sheet.

8. Click Cut Sheet in the L Paper Source list.

9. Click Custom Size in the A Page Size list to display the Custom Size Settings dialog box.

10. Confirm that mm is selected in Units.

11. Enter 430 (16.9 in) in both Width and Height.

12. Click OK to close the Custom Size Settings dialog box.

13. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "

Printing by using Custom Paper Size
This section describes how to print using Custom Paper Size based on the following example. First, register a non-standard
paper size called 430 mm Square as a Custom Paper Size.

• Document: Any Type
• Page Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])
• Paper: Sheets
• Media Type: Any type
• Paper Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])
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1. Load the square paper (430 × 430 mm [16.9 × 16.9 in]) in the printer.

2. Choose Print in the application menu.

3. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")

4. Make sure the Main sheet is displayed.

5. In the A Media Type list, select the type of paper that is loaded.

6. After confirming that D Easy Settings is selected, select from the E Print Target list.
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7. Click the Page Setup tab to display the Page Setup sheet.

8. Click O Size Options to display the Paper Size Options dialog box.

9. Enter a desired paper name in Custom Paper Size Name. 430 mm Square is used in this example.

10. Select mm in Units.

11. Enter 430 (16.9 in) in both Width and Height.

Note
• If you select the Fix the Ratio of the Width to Height check box, after you enter a value in either

Width or Height, the other value will be automatically applied based on the original aspect ratio.

12. Click Add to register 430 mm Square.

13. Click OK to close the Paper Size Options dialog box.

14. Click Cut Sheet in the L Paper Source list.

15. In the A Page Size list, click the size you added,430 mm Square.

16. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "
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Printing on Non-Standard Paper Sizes (Mac OS X)
This section describes how to register and print Custom Page Sizes (Mac OS X 10.3.9-10.5)/ Custom Paper Sizes (Mac
OS X 10.6) based on the following example. Here, you will register a non-standard paper size named 430*430 in Custom
Page Sizes (Mac OS X 10.3.9-10.5)/ Custom Paper Sizes (Mac OS X 10.6).

• Document: Any Type
• Page Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])
• Paper: Sheets
• Media Type: Any type
• Paper Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])

Note
• The following procedures are based on Mac OS X 10.5. The method of setting up non-standard paper sizes

varies depending on the version of Mac OS X.

1. Create the document in the application.

2. Load the square paper (430 × 430 mm [16.9 × 16.9 in]) in the printer.

3. Choose Print in the application menu.

4. Select the printer in the A Printer list.
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5. Click Manage Custom Sizes in the C Paper Size list to display the Custom Page Sizes dialog box.

6. In Page Size, enter the height and width of the original. Here, enter 43.00 cm in Height and Width.

7. In Printer Margins, enter 0.5 for the top and side margins and 2.3 for the bottom margin. Here, measurements are
entered in centimeters.

8. Double-click Untitled in the list at left in the Custom Page Sizes dialog box and enter the paper name—in this case,
430*430.

9. Click OK to close the Custom Page Sizes dialog box.

10. In the C Paper Size list, click the size of the original. In this case, click 430*430, the size you registered.

11. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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12. Access the Main pane.

13. In the A Media Type list, select the type of paper that is loaded.

14. After confirming that D Easy Settings is selected, select from the E Print Target list.

15. Make your selection in the F Print Quality list.

16. Access the Page Setup pane.

17. Click Cut Sheet in the A Paper Source list.
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18. In C Page Size, make sure 430*430 is displayed, as registered in Page Setup.

19. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "
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Printing Multiple Originals Next to Each Other
By arranging originals from word-processing or spreadsheet programs or web browser screen shots next to each other on
single sheets, you can create highly expressive presentation materials, easy-to-understand meeting materials, and a variety
of other printed documents.

Free Layout (Windows)
Besides combining multiple pages in a single-page layout, you can combine originals from multiple files—even multiple
source applications—in a single-page layout.
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Important
• Free Layout cannot be used in 64-bit version of Windows.

imagePROGRAF Free Layout (Macintosh)
Besides combining multiple pages in a single-page layout, you can combine originals from multiple files—even multiple
source applications—in a single-page layout.

For instructions on arranging originals from multiple applications, refer to the following topics.

• Printing Multiple Originals Next to Each Other (Windows) →P.136

• Printing Multiple Originals Next to Each Other (Mac OS X) →P.138

Printing Multiple Originals Next to Each Other (Windows)
This topic describes how to arrange multiple originals using the Free Layout function.

Important
• Free Layout cannot be used in 64-bit version of Windows.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")
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3. Make sure the Main sheet is displayed.

4. Click the Layout tab to display the Layout sheet.

5. Select the A Page Layout check box.

6. Click Free Layout in the A Page Layout list.
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7. When you attempt to print, the imagePROGRAF Free Layout window is displayed. (At this point, the document will
not be printed yet.)

8. Edit and rearrange the image in the imagePROGRAF Free Layout window as desired.

Important
• Without closing the imagePROGRAF Free Layout window, repeat steps 1–7 to arrange originals

from multiple applications on the same page.

Note
• For instructions on editing and rearranging images, refer to the imagePROGRAF Free Layout help

topic.

9. Print from the imagePROGRAF Free Layout menu.

Note
• For details on imagePROGRAF Free Layout functions, refer to Free Layout →P.262 .

Printing Multiple Originals Next to Each Other (Mac OS X)
This topic describes how to use the Free Layout function to arrange multiple originals next to each other before printing.

1. Choose Print in the application menu.
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2. Access the Page Setup pane.

3. Select the N Free Layout check box.

4. Click M Print.

5. The Canon imagePROGRAF Free Layout window is displayed.
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6. Edit and rearrange the image in the Canon imagePROGRAF Free Layout window as desired.

Note
• Without closing the Canon imagePROGRAF Free Layout window, repeat steps 1 to 4 to arrange

originals from multiple applications on the same page.
• For instructions on editing and rearranging images, refer to the Canon imagePROGRAF Free Lay-

out help topic.

7. Print from the Canon imagePROGRAF Free Layout menu.

Note
• For details on Canon imagePROGRAF Free Layout functions, refer to Free Layout →P.487 .

Printing Multiple Pages Continuously
You can print multiple pages as a single continuous image, without margins between pages.

Roll paper (banner)

Important
• This feature is only available with rolls. It cannot be used when printing on sheets.
• During banner printing, settings for conserving paper, number of copies, borderless printing, enlargement or

reduction, and other layout-related settings are disregarded.

For instructions on borderless printing of photos and images at actual size, refer to the following topics, as appropriate for
your computer and operating system.

• Printing Multiple Pages Continuously (Windows) →P.141

• Printing Multiple Pages Continuously (Mac OS X) →P.143
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Printing Multiple Pages Continuously (Windows)
This topic describes how to print multiple pages as a single continuous image, without margins between pages.

Important
• This feature is only available with rolls. It cannot be used when printing on sheets.
• During banner printing, settings for conserving paper, number of copies, borderless printing, enlargement or

reduction, and other layout-related settings are disregarded.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, click the type of paper that is loaded.
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5. Click the Page Setup tab to display the Page Setup sheet.

6. Select and click a roll paper in the L Paper Source list.

7. Click N Roll Paper Options to display the Roll Paper Options dialog box.

8. Select the B Banner Printing check box.

9. Click OK.

10. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "
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Printing Multiple Pages Continuously (Mac OS X)
This topic describes how to print multiple pages as a single continuous image, without margins between pages.

Important
• This feature is only available with rolls. It cannot be used when printing on sheets.
• During banner printing, settings for conserving paper, number of copies, borderless printing, enlargement or

reduction, and other layout-related settings are disregarded.
 

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. Click the original size in the C Paper Size list.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, click the type of paper that is loaded.

7. Make your selection in the E Print Target list.

8. Make your selection in the F Print Quality list.

9. Access the Page Setup pane.

10. In the A Paper Source list, click Roll Paper 1 (Banner) or Roll Paper 2 (Banner).
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11. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "

Printing Multiple Pages Per Sheet
To conserve paper, you can print several pages of the original on a single sheet by reducing the original and dividing the
sheet into areas for each page.

Page Layout
Specify a number of pages of the original to print on a single sheet, in a layout of multiple pages per sheet.

Note
• You can print up to 16 pages of the original on a single sheet.
• You can also change the page layout order and print page boundary lines, as desired.

Important
• This function cannot be combined with the following options.

• Borderless Printing
• Scaling Originals (Windows)
• Banner Printing (Windows)

• When printing using this function, the Print Centered setting is disabled.

For instructions on printing multiple pages per sheet, refer to the following topics, as appropriate for your computer and
operating system.

• Printing Multiple Pages Per Sheet (Windows) →P.145

• Printing Multiple Pages Per Sheet (Mac OS X) →P.148

Printing Multiple Pages Per Sheet (Windows)
This topic describes how to print four pages of originals together on a single sheet based on the following example.

• Document: Any Type
• Page size: A3 (297.0×420.0 mm [11.7×16.5 in])
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• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then open the printer driver dialog box.(See "Accessing the Printer Driver
Dialog Box from Applications (Windows) →P.216 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Make your selection in the E Print Target list.

6. Make your selection in the F Print Quality list.
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7. Click the Page Setup tab to display the Page Setup sheet.

8. In A Page Size, click the size of the original as specified in the application software. In this case, click ISO A3 or
Letter (8.5"x11").

9. Select and click a roll paper in the L Paper Source list.

10. Select the width of the loaded roll in the M Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).
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11. Click the Layout tab to display the Layout sheet.

12. Select the A Page Layout check box.

13. Click 4 Pages/Sheet in the A Page Layout list.

Note
• You can select the layout order for placing four pages on a sheet and a frame border in the Page Lay-

out Printing dialog box by clicking B Set.

14. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "

Printing Multiple Pages Per Sheet (Mac OS X)
This topic describes how to print four pages of an original on a single sheet, based on the following example.

• Document: Any Type
• Page size: A3 (297.0 × 420.0 mm [11.7 × 16.5 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])
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1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A3.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Layout pane.

6. Click 4 in the A Pages per Sheet list.

Note
• You can choose the layout order and specify a boundary line for the four pages in B Layout Direc-

tion and C Border.

7. Access the Main pane.

8. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

9. Make your selection in the E Print Target list.

10. Make your selection in the F Print Quality list.
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11. Access the Page Setup pane.

12. Select and click a roll paper in the A Paper Source list.

13. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, ISO A2/A3 (420.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.
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14. Make sure C Page Size shows the original size as specified in C Paper Size in the Page Attributes dialog box—in
this case, ISO A3.

15. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "

Printing Posters in Sections
You can enlarge an original to print it in sections on several sheets. By assembling the printed sheets, you can create a post-
er larger than the maximum supported paper size of the printer.

Page Layout
Choose poster printing.

Important
• When printing using this function, the Print Centered, Watermark, No Spaces at Top or Bottom (Con-

serve Paper), and Page Options settings are disabled.

For instructions on printing large posters, refer to the following topics, as appropriate for your computer and operating sys-
tem.

• Printing Large Posters (Windows) →P.153
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Note
• This method of poster printing is supported in Windows.

Printing Large Posters (Windows)
You can enlarge an original to print it in sections on several sheets. By assembling the printed sheets, you can create a post-
er larger than the maximum supported paper size of the printer. This topic describes how to enlarge an A2 original for print-
ing it in sections on four sheets, based on the following example.

• Document: Poster
• Page size: A2 (420.0×594.0 mm [16.5 × 23.4 in])
• Paper: Sheets
• Paper Size: A2 (420.0 × 594.0 mm [16.5 × 23.4 in])

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded.

5. Click Poster in the E Print Target list.
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6. Click the Page Setup tab to display the Page Setup sheet.

7. In A Page Size, click the size of the original as specified in the application. In this case, click ISO A2.

8. Click Cut Sheet in the L Paper Source list.

9. Click the Layout tab to display the Layout sheet.
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10. Select the A Page Layout check box.

11. Click Poster (2 x 2) in the A Page Layout list.

Note
• Follow the steps below to print only a portion of the poster as divided for printing.

• Click B Set under A Page Layout to display the Pages to Print dialog box.
• On the Pages to Print dialog box, clear the check boxes of the portion you do not want to print.
• Click OK to close the Pages to Print dialog box.

12. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "
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Printing Originals Centered on Rolls
You can print originals centered on a page—for example, if the paper is larger than the original, or if you are reducing the
original.

Centering originals relative to roll paper width
If you use originals smaller than the roll paper width, you can center them relative to the width when printing.
Print Centered
Aligns the center of the original with the center of the roll, relative to the width.

For instructions on centering originals when printing on rolls, refer to the following topics, as appropriate for your computer
and operating system.

• Printing Originals Centered on Rolls (Windows) →P.156

• Printing Originals Centered on Rolls (Mac OS X) →P.158

Printing Originals Centered on Rolls (Windows)
This topic describes how to center originals before printing on rolls based on the following example.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll width: A3/A4 roll (297.0 mm [11.7 in])

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")

Enhanced Printing Options > Centering originals >

Printing Originals Centered on Rolls iPF825

3

156



3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Select the print target in the E Print Target list.

6. Click the Page Setup tab to display the Page Setup sheet.
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7. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").

8. Select and click a roll paper in the L Paper Source list.

9. Select the width of the loaded roll in the M Roll Paper Width list—in this case, ISO A3/A4 Roll (297.0mm).

10. Click the Layout tab to display the Layout sheet.

11. Select the E Print Centered check box.

12. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "

Printing Originals Centered on Rolls (Mac OS X)
This topic describes how to center originals before printing on rolls based on the following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])
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1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Make your selection in the E Print Target list.

8. Make your selection in the F Print Quality list.

9. Access the Page Setup pane.

10. Select and click a roll paper in the A Paper Source list.
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11. Make sure the width of the loaded roll is displayed in B Roll Width —in this case, ISO A3/A4 (297.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

12. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, ISO A4.

13. Select the J Print Centered check box.
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14. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "

Printing Originals Centered on Sheets
You can print originals centered on a page—for example, if the paper is larger than the original, or if you are reducing the
original.

Centering originals on sheets
If you use paper larger than the original size or print originals after reduction, the printed images may be aligned in the
upper-left corner of the paper. In this case, you can center originals on sheets when printing.
Print Centered
Aligns the center of the original with the center of the sheet.

For instructions on centering originals when printing on sheets, refer to the following topics, as appropriate for your com-
puter and operating system.

• Printing Originals Centered on Sheets (Windows) →P.162

• Printing Originals Centered on Sheets (Mac OS X) →P.165

Printing Originals Centered on Sheets (Windows)
This topic describes how to reduce an original 50% for printing centered on a sheet.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Sheets
• Paper type: Plain Paper
• Paper size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Make your selection in the E Print Target list.

6. Click the Page Setup tab to display the Page Setup sheet.
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7. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4.

8. Select the C Enlarged/Reduced Printing check box.

9. Click Match Page Size in the G Paper Size list.

10. Click F Scaling and enter 50.

11. Click Cut Sheet in the L Paper Source list.

12. Click the Layout tab to display the Layout sheet.

13. Select the E Print Centered check box.

14. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "

Important
• If you have selected Cut Sheet as the paper source, follow the instructions on the printer control pan-

el to enter the paper size.
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Printing Originals Centered on Sheets (Mac OS X)
This topic describes how to center originals for printing on sheets, based on the following example.

• Document: Any Type
• Page size: A4
• Paper: Sheets
• Paper type: Plain Paper
• Paper size: Non-standard

 

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A4 - Cut Sheet.
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4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.

5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Make your selection in the E Print Target list.

8. Make your selection in the F Print Quality list.
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9. Access the Page Setup pane.

10. Click Cut Sheet in the A Paper Source list.

11. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, ISO A4 - Cut Sheet.

12. Select the J Print Centered check box.

13. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "
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Important
• If you have selected Cut Sheet as the paper source, follow the instructions on the printer control panel to

enter the paper size.
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Conserving Roll Paper by Rotating Originals 90 Degrees
You can conserve roll paper by specifying particular settings as suitable for your original.

Rotate Page 90 degrees (Conserve Paper)
When originals are printed in portrait orientation, the original is rotated 90 degrees before printing if it fits within the roll
width. This enables you to conserve paper.

Important
• If the page would exceed the roll paper width after rotation, use this function with Scale to fit Roll Paper

Width to print rotated pages.

For tips on conserving roll paper, refer to the following topics, as appropriate for your computer and operating system.

• Conserving Roll Paper by Rotating Originals 90 Degrees (Windows) →P.169

• Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS X) →P.171

Conserving Roll Paper by Rotating Originals 90 Degrees (Windows)
This topic describes how to conserve paper by rotating originals 90 degrees before printing, based on the following exam-
ple.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3×11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])
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This example illustrates how to rotate an A4 (210.0×297.0 mm)/Letter (8.3×11.7 in) original in portrait orientation 90 de-
grees to fit within the width of A3/A4 roll paper (297.0 mm [11.7 in]), which enables you to conserve paper.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then open the printer driver dialog box.(See "Accessing the Printer Driver
Dialog Box from Applications (Windows) →P.216 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
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5. Click the Page Setup tab to display the Page Setup sheet.

6. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").

7. Select and click a roll paper in the L Paper Source list.

8. Select the width of the loaded roll in the M Roll Paper Width list—in this case, ISO A3/A4 Roll (297.0mm).

9. Select the K Rotate Page 90 degrees (Conserve Paper) check box.

10. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "

Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS X)
This topic describes how to conserve roll paper by rotating originals 90 degrees before printing, based on the following
example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])
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This example illustrates how to rotate an A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in) original in portrait orientation 90
degrees to fit within the width of A3/A4 roll (297.0 mm [11.7 in]), which enables you to conserve paper.
 

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Access the Page Setup pane.

8. Select and click a roll paper in the A Paper Source list.
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9. Make sure the width of the loaded roll is displayed in B Roll Width —in this case, ISO A3/A4 (297.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

10. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, ISO A4.

11. Select the L Rotate Page 90 degrees check box.

Enhanced Printing Options > Conserving roll paper >

Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS X) iPF825

3

174



12. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "

Conserving Roll Paper by Printing Originals Without Top and Bottom Margins
You can conserve roll paper by specifying particular settings as suitable for your original.

No Spaces at Top or Bottom (Conserve Paper)
You can print without feeding the paper for blank portions of originals if there are top and bottom margins in originals. This
enables you to conserve as much paper as the size of the margins.

Important
• Printing without the top and bottom margins is not supported in the following cases.

• Banner printing
• If you have chosen poster as the type of page layout

 

Note
• Even during borderless printing, you can print without the top and bottom margins.
• Printing without the top and bottom margins may cause inconsistency in the size of printed documents, de-

pending on the layout of images or text in your originals.

For tips on conserving roll paper, refer to the following topics, as appropriate for your computer and operating system.

• Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Windows) →P.175

• Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Mac OS X) →P.178

Conserving Roll Paper by Printing Originals Without Top and Bottom Margins
(Windows)
This topic describes how to conserve roll paper when printing originals that have a top and bottom margin, based on the
following example.

• Document: Any type
• Page size: A4 (210.0×297.0mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])
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1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
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5. Click the Page Setup tab to display the Page Setup sheet.

6. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").

7. Select and click a roll paper in the L Paper Source list.

8. Select the width of the loaded roll in the M Roll Paper Width list—in this case, ISO A3/A4 Roll (297.0mm).
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9. Click the Layout tab to display the Layout sheet.

10. Select the G No Spaces at Top or Bottom (Conserve Paper) check box.

11. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "

Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Mac OS
X)
This topic describes how to conserve roll paper when printing originals that have a top and bottom margin, based on the
following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])
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1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Access the Page Setup pane.

8. Select and click a roll paper in the A Paper Source list.
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9. Make sure the width of the loaded roll is displayed in B Roll Width —in this case, ISO A3/A4 (297.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

10. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, ISO A4.

11. Select the K No Spaces at Top or Bottom check box.
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12. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "
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Using PosterArtist to Compose Originals
Using PosterArtist to Compose Originals ........................................................................................................ 183

Using PosterArtist to Compose Originals
You can print a variety of source documents from word-processing or spreadsheet programs or screen shots from web
browsers after composing an original with them using PosterArtist.
This topic describes how to use PosterArtist to compose originals from multiple applications, creating a poster layout for
printing.

Important
• This function is only supported in Windows.
• PosterArtist (sold separately) must be installed to use this function.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then open the printer driver dialog box. (See "Accessing the Printer Driver
Dialog Box from Applications (Windows).") →P.216

3. Make sure the Main sheet is displayed.

Enhanced Printing Options > Using PosterArtist to Compose Originals >

iPF825 Using PosterArtist to Compose Originals

3

183



4. Click the Layout tab to display the Layout sheet.

5. Select the A Page Layout check box.

6. Click in the Edit Using PosterArtist in the A Page Layout list.

7. When you attempt to print, PosterArtist starts up and the PageCapture window is displayed. (At this point, the docu-
ment will not be printed yet.)

8. Choose the page to load in PosterArtist.
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9. Edit and rearrange the image in the PosterArtist window as desired.

Important
• Without closing the PosterArtist window, repeat steps 1-8 to arrange originals from multiple applica-

tions on the same page.

Note
• For instructions on editing and rearranging images, refer to the PosterArtist Manual.

10. Print from the PosterArtist menu.
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Checking Images Before Printing
Checking the Layout in a Preview Before Printing .......................................................................................... 186

Checking the Layout in a Preview Before Printing
You can check the print layout on the preview screen.

Open Preview When Print Job Starts (Windows)
While viewing the preview screen, you can also adjust orientation or other settings, and your changes will be instantly ap-
plied on the preview screen.

Note
• Under some settings and in some environments, PageComposer may be started.
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Preview (Macintosh)
While viewing the preview screen, you can also adjust layout or size settings, and your changes will be instantly applied on
the preview screen.

For instructions on how to check the layout before printing, refer to the following topics:

• Checking the Layout in a Preview Before Printing (Windows) →P.212

• Checking the Layout in a Preview Before Printing (Mac OS X) →P.437
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Printing With Watermarks
You can add watermarks (background images) to documents that require special handling.

Watermark
Watermarks are applied to all pages of your document.

Important
• Watermarks are not printed if you select poster as the type of page layout.

The following watermarks are provided:

• CONFIDENTIAL
• COPY
• DRAFT
• FILE COPY
• FINAL
• PRELIMINARY
• PROOF
• TOP SECRET

You can also create your own watermarks. Specify the following options to customize your watermark.

• Watermark string: Specify the font, size, color, and so on. Surround the watermark with a frame, if desired.
• Watermark position: Specify the position on the page, the angle, and so on.
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• Watermark printing method: Specify whether to print the watermark superimposed or under the document image. You
can also print the watermark only on the first page, if desired.

Note
• Watermarks are supported in Windows.
• In addition to the provided watermarks, you can create up to 50 original watermarks in Windows.

For detailed instructions on printing with watermarks, refer to the following topics:

• Printing with Watermarks— COPY, FILE COPY, and so on (Windows) →P.189

Printing with Watermarks— COPY, FILE COPY, and so on (Windows)
This topic describes how to print with watermarks, based on the following example of printing with a FILE COPY water-
mark.

• Document: Any type
• Page size: A2 (420.0×594.0 mm [16.5 × 23.4 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in[)

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")

3. Make sure the Main sheet is displayed.
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4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Make your selection in the E Print Target list.

Note
• You can check the settings values selected in the E Print Target list by clicking G View Settings.

6. Click the Page Setup tab to display the Page Setup sheet.

7. In A Page Size, click the size of the original as specified in the application software. In this case, click ISO A2.

8. Select and click a roll paper in the L Paper Source list.

9. Select the width of the loaded roll in the M Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).
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10. Click the Layout tab to display the Layout sheet.

11. Select the C Watermark check box.

12. Click FILE COPY in the Watermarks list.

Note
• Click D Edit Watermark to open the Edit Watermark dialog box. In the Edit Watermark dialog

box, you can create custom watermarks and change the position and angle of watermarks.

13. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "
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Making the Original Orientation Match the Paper Orientation
You can specify the original orientation to match the orientation of the paper for printing.

Orientation
Paper is usually loaded in the printer in portrait orientation. When you have an original in landscape orientation, you can
specify the printing orientation so that the original is printed in landscape orientation.

Rotate 180 degrees
The original is rotated 180 degrees to print it upside down.

Mirror
A mirror image of the original is printed.

For instructions on specifying the original orientation before printing, refer to the following topics, as appropriate for your
computer and operating system.

• Making the Original Orientation Match the Paper Orientation (Windows) →P.192

• Making the Original Orientation Match the Paper Orientation (Mac OS X) →P.194

Making the Original Orientation Match the Paper Orientation (Windows)
This topic describes how to print an original in landscape orientation after matching the paper orientation, based on the fol-
lowing example.

• Document: An original in landscape orientation
• Page size: A4 (210.0 × 297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then open the printer driver dialog box.(See "Accessing the Printer Driver
Dialog Box from Applications (Windows) →P.216 ")
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Make your selection in the E Print Target list.

6. Make your selection in the F Print Quality list.
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7. Click the Page Setup tab to display the Page Setup sheet.

8. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").

9. In H Orientation, click J Landscape.

10. Select and click a roll paper in the L Paper Source list.

11. Select the width of the loaded roll in the M Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).

12. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "

Making the Original Orientation Match the Paper Orientation (Mac OS X)
This topic describes how to print an original in landscape orientation after matching the paper orientation, based on the fol-
lowing example.

• Document: An original in landscape orientation
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])
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1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.

4. In D Orientation, click the icon of the document in landscape orientation.

5. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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6. Access the Main pane.

7. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

8. Make your selection in the E Print Target list.

9. Make your selection in the F Print Quality list.

10. Access the Page Setup pane.

11. Select and click a roll paper in the A Paper Source list.
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12. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, ISO A2/A3 (420.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

13. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, ISO A4.

14. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "
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Using Favorites
You can register print settings as Favorites to reuse settings from a particular job that met your expectations, or settings for
a particular page size that you will use repeatedly.

Favorites
Registering a favorite for later use. You can choose the settings you have registered from a list before printing, and you can
check the settings details.

Note
• You can also save the favorite settings as files. Using these files is a convenient way to print under the same

conditions on another computer. (In Windows.)

For instructions on using favorites to print, refer to the following topics, as appropriate for your computer and operating
system.

• Using Favorites (Windows) →P.214

• Using Favorites (Mac OS X) →P.438

Cutting Roll Paper After Printing
Roll paper can be automatically cut after printing.

Note
• It may not be possible to cut certain types of paper, such as adhesive paper. For details on types of paper that

cannot be used with the auto cut feature, see the Paper Reference Guide. (See "Types of Paper →P.623 ")

Automatic Cutting
Roll paper is cut automatically after printing. If you prefer, you can print continuously without cutting the roll, or you can
print a cut line.

For instructions on cutting roll paper after printing, refer to the following topics, as appropriate for your computer and oper-
ating system.

• Cutting Roll Paper After Printing (Windows) →P.198

• Cutting Roll Paper After Printing (Mac OS X) →P.200

Cutting Roll Paper After Printing (Windows)
This topic describes how to cut roll paper automatically after printing (using the auto cut function), as well as how to print a
cut line for manual cutting.

Note
• The auto cut function is activated on the printer by default and when the printer driver is installed. Follow the

steps below to reactivate the function if it is disabled, or to select the setting for printing a cut line instead.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")
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3. Click the Page Setup tab to display the Page Setup sheet.

4. Select and click a roll paper in the L Paper Source list.

5. Click N Roll Paper Options to display the Roll Paper Options dialog box.

6. To enable automatic cutting, click Yes in the A Automatic Cutting list. If you prefer to cut the paper later yourself,
click Print Cut Guideline.

7. Click OK to close the Roll Paper Options dialog box.

8. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.211 "

Roll paper will be automatically cut after printing.
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Cutting Roll Paper After Printing (Mac OS X)
This topic describes how to cut roll paper automatically after printing (using the auto cut function), as well as how to print a
cut line for manual cutting.

Note
• The auto cut function is activated on the printer by default and when the printer driver is installed. Follow the

steps below to reactivate the function if it is disabled, or to select the setting for printing a cut line instead.
 

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. Choose the original size in the C Paper Size list.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Page Setup pane.

6. Select and click a roll paper in the A Paper Source list.

7. Access the Main pane.

8. In the A Media Type list, select the type of paper that is loaded.
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9. Click C Set to display the Paper Detailed Settings dialog box.

10. To enable automatic cutting, click Printer Default in the H Automatic Cutting list. If you prefer to cut the paper
later yourself, click Print Cut Guideline.

Important
• If the automatic cut function has been deactivated on the printer, change the auto cut setting on the

printer Control Panel.

11. Click OK to close the Paper Detailed Settings dialog box.

12. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.435 "

Switching the Paper Source of Roll Paper to Match the Paper Size
You can configure the settings to print by automatically switching between roll 1 and roll 2 depending on the paper size
being printed. Because the roll paper that produces the smallest margin upon printing is automatically selected, you can
economize on paper.

Important
• This function is only supported in Windows.

1. Click start > Printers and Faxes (or Printers ).
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2. Select the printer, and then display the printer properties dialog box.

3. Click the Device Settings tab to display the Device Settings sheet.

4. Select the A Automatically switch paper sources (paper size priority) check box.

5. Click C Acquire Status.
The paper size information is acquired from the printer, and the width of the roll paper that is actually loaded in the
printer is displayed.
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6. Click OK to close the dialog box.

7. Choose Print in the application menu.

8. Select the printer in the dialog box, and then display the printer driver dialog box. (See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.216 ")

9. Click the Page Setup tab to display the Page Setup sheet.

10. Click Roll Paper (Auto) in the L Paper Source list.

11. Select the K Rotate Page 90 degrees (Conserve Paper) check box as necessary.

Note
• When Rotate Page 90 degrees (Conserve Paper) is turned on, even more paper can be conserved

depending on the paper size because pages created in portrait can be printed in landscape. (Refer to
"Conserving Roll Paper by Rotating Originals 90 Degrees (Windows) →P.169 " for details on
Rotate Page 90 degrees (Conserve Paper).)
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Important
• Always use the same media type in the upper and lower rolls of the printer. You cannot print if different

media types are loaded.
• Always click the Acquire Status button on the Device Settings sheet to acquire roll paper width informa-

tion. You might not be able to print correctly if the roll paper width is not set correctly.
• Always select Roll Paper (Auto) in Paper Source on the Page Setup sheet. You cannot use this function if

Roll Paper (Auto) is not selected.
• If Fit Roll Paper Width is selected in Enlarged/Reduced Printing and Roll Paper (Auto) is selected in

Paper Source on the Page Setup sheet while you are performing enlarged/reduced printing with Automati-
cally switch paper sources (paper size priority) enabled, printing is always performed from roll 1 (the up-
per roll).

• If you are performing borderless printing with Automatically switch paper sources (paper size priority)
enabled, only Scale to fit Roll Paper Width can be selected in Borderless Printing Method on the Page
Setup sheet. In this case, printing is always performed from roll 1 (the upper roll). If a paper size or media
type that does not support borderless printing is loaded in roll 1, you cannot perform borderless printing.
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Printer Driver Settings
For instructions on accessing the Windows printer driver, refer to the following topics.

• Accessing the Printer Driver Dialog Box from Applications →P.216

• Accessing the Printer Driver Dialog Box from the Operating System Menu →P.218
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For information on the Windows printer driver settings, refer to the following topics.

• Main Sheet →P.220
You can specify the type of paper, color processing, print quality, print preview, and other settings. Choose Easy Set-
tings to specify basic print settings based on the printing application or Advanced Settings to complete more detailed
settings as desired.

• Paper Detailed Settings Dialog Box →P.225

• View Settings Dialog Box for the Printing Application →P.226

• Color Adjustment Sheet: Color →P.226

• Matching Sheet →P.229

• Color Adjustment Sheet: Monochrome →P.231

• Page Setup Sheet →P.233
You can specify the page size of the original, borderless printing, enlargement or reduction, the orientation, the paper
size and feed source, and automatic cutting.

• Output Method dialog box →P.236

• Paper Size Options Dialog Box →P.237

• Layout Sheet →P.238
You can specify the page layout, watermarks, the orientation, the number of copies, and print processing options.

• Page Options Dialog Box →P.240

• Special Settings Dialog Box →P.241

• Favorites Sheet →P.242
Groups of print settings you select on each sheet can be saved as a favorite. Favorites you have added can be edited or
used at the time of printing as desired.

• Utility Sheet →P.244
You can specify settings related to maintenance for the Printhead and feed amount, as well as settings for Color im-
ageRUNNER Enlargement Copy.

• Support Sheet →P.245
You can view support information and the user manual.
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• Device Settings Sheet →P.247
You can display settings for optional equipment installed on the printer and see the version information for the printer
driver.

imagePROGRAF Free Layout is a feature for freely arranging originals from various source applications on a single page
as desired before printing. For details, see Free Layout →P.262 .
Color imageRUNNER Enlargement Copy is a feature for automatic enlargement and printing of scanned originals from a
Color imageRUNNER. For details, see Color imageRUNNER Enlargement Copy →P.292 .

Important
• Color imageRUNNER Enlargement Copy and imagePROGRAF Free Layout cannot be used on 64-bit

version of Windows.

Specifying Paper in the Printer Driver
If you have replaced the paper, you must complete the following settings in the printer driver.

Important
• Always specify the same type and size of paper in the printer menu and printer driver.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications →P.216 ")

Windows Software > Printer Driver >

iPF825 Specifying Paper in the Printer Driver

4

209



3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded.

Note
• Click the B Get Information button to display the Paper Information on Printer dialog box. On

the Paper Information on Printer dialog box, you can obtain information on the paper in the printer
and configure printer driver settings for the feed source and type of paper.
This function requires that the Status Monitor be installed.
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5. Click the Page Setup tab to display the Page Setup sheet.

6. In the A Page Size list, select the size of the original as specified in the application.

7. In the L Paper Source list, select how paper is supplied.

8. If you have selected roll paper in L Paper Source, select the width of the loaded roll in M Roll Paper Width.

Note
• A variety of settings are available in the printer driver to suit different printing applications.

For details on available printing conditions, see "Printer Driver Settings →P.207 "

Confirming Print Settings
There are two ways to confirm the print settings, as follows.

• Checking a preview of the settings
• Checking a print preview
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Checking a preview of the settings
A preview of the settings is displayed on the left side of the Main, Page Setup, and Layout sheets. By checking illustra-
tions and numerical values in the preview, you can confirm current settings for the page size, orientation, paper source, lay-
out, and so on.

Display Area Information Displayed

P Top illustrations Illustrations indicate the orientation, page layout, borderless printing selection, col-
or mode, and other settings information.

Q Middle, bordered area The page size, paper size, and method and percentage of enlargement or reduction
are indicated.

R Bottom illustrations Illustrations indicate the feed source, orientation, borderless printing selection, and
other settings information.

Note
• To confirm the Print Target specified in Easy Settings, click G View Settings on the Main sheet to display

the View Settings dialog box.

Checking a print preview
You can check an image of the original just as it will be printed.
When you activate this feature, imagePROGRAF Preview or PageComposer is started before printing. Confirming how
documents will be printed this way helps prevent printing errors.
For details on print previews, see "Checking the Layout in a Preview Before Printing →P.186 "

Checking the Layout in a Preview Before Printing
This topic describes how to preview images of print jobs before actually printing them.

1. Choose Print in the application menu.
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2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications →P.216 ")

3. Make sure the Main sheet is displayed.

4. Select the L Open Preview When Print Job Starts check box.

5. After you click OK, when you print a job, the imagePROGRAF Preview window will be displayed.

Note
• If PageComposer is running, access the Special Settings dialog box from the Layout sheet and clear

Enable Preview Switching.
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6. On the main window, you can check the layout and change settings as needed.

7. To print, click Print in the File menu.

Note
• For details on imagePROGRAF Preview functions, see Preview →P.249 .

Using Favorites
This topic describes how to register favorites and print using favorite settings.

Registering a favorite
This section describes the procedure for registering printing settings that have been changed in the driver as Favorites.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box. (Refer to "Accessing the Printer
Driver Dialog Box from Applications →P.216 ")

3. Perform normal printing settings.
The favorite is registered from here.

4. Click the Favorites tab to display the Favorites sheet.
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5. Click H Add to display the Add dialog box.

6. Enter a desired name in Name, such as Photos for Presentations or Monthly Report.

7. Choose a fitting icon for these print settings in the Icon list.

8. In Comment, enter a description of the favorite to be added, as desired.

9. Click OK to close the Add dialog box.
The favorite you have added is now displayed in A Favorites.

Note
• To save a favorite as a file, click J Export and specify the file to save.

Printing using the favorite
Follow the steps below to print using the favorite you have registered.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications →P.216 ")
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3. Click the Favorites tab to display the Favorites sheet.

4. In the A Favorites, choose the favorite you registered.

Note
• To import a favorite, click I Import and specify the favorite file.

5. Click D Apply Favorite to replace the favorite settings with the current print settings.

6. Confirm the print settings and print as desired.

Note
• For instructions on confirming print settings, see "Confirming Print Settings →P.211 "

Accessing the Printer Driver Dialog Box from Applications

1. Choose Print from the File menu to display the dialog box for printing conditions.

2. Select the printer, and then display the printer driver dialog box.

Note
• The dialog box for specifying printing conditions varies depending on the source application. In some

cases, when you select the printer, a sheet for configuring the printer driver is added to the dialog box.
In the following case, click Preferences.

• Example: Print dialog box displayed by the application software
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Six sheets of print settings are displayed by the printer driver: Main, Page Setup, Layout, Favorites, Utility, and
Support.

Note
• The titles of dialog boxes may vary depending on the application, and sheets other than these six

sheets may be displayed.
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Important
• If you access the printer driver dialog box from the source application, changes you make to the settings will

only apply temporarily to that application. Because these are sizes you specify temporarily in the printer driv-
er, the sizes will not be available after you exit the application.

• You can also access the printer driver dialog box from the Windows system menu.
To use the settings continuously in all applications, open the printer driver from the system menu to make the
settings.
See "Accessing the Printer Driver Dialog Box from the Operating System Menu →P.218 ".

Accessing the Printer Driver Dialog Box from the Operating System Menu

1. Click start > Printers and Faxes (or Printers ).

2. Select the printer, and then display the printer properties dialog box.
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3. Click Printing Preferences to display the Printing Preferences dialog box, titled with the name of this printer.

Note
• The Device Settings sheet is also an extension of the printer driver.(See "Device Settings Sheet

→P.247 ")

Six sheets of print settings are displayed by the printer driver: Main, Page Setup, Layout, Favorites, Utility, and
Support.
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Important
• If you access the printer driver dialog box from the operating system menu, changes you make to the settings

will apply to all applications you use for printing.
• You can also access the printer driver dialog box from applications.

See "Accessing the Printer Driver Dialog Box from Applications →P.216 ".

Main Sheet
The following settings are available on the Main sheet. For details on settings items, refer to the printer driver help file.

Note
• On the Main sheet, choose Easy Settings to specify basic print settings based on the particular printing ap-

plication, or switch to Advanced Settings to complete more detailed settings as desired.

Common Items

AMedia Type
Select the type of paper.
For information on the types of paper the printer supports, refer to the Paper Reference Guide.(See "Types of Pa-
per →P.623 ")

BGet Information
Displays Paper Information on Printer. You can update the printer driver settings for the feed source, media type, and roll
width by selecting the feed source.

• Paper Information on Printer Dialog Box →P.224
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CAdvanced Settings
Displays Paper Detailed Settings. You can configure the printing settings to match the type of media, such as the ink dry-
ing time.

• Paper Detailed Settings Dialog Box →P.225

LOpen Preview When Print Job Starts
If you turn this on, imagePROGRAF Preview starts before printing.
This allows you to check on-screen previews of documents before printing.

• Checking the Layout in a Preview Before Printing →P.186

MStatus Monitor
Starts imagePROGRAF Status Monitor.
You can check the printer status, job status, and other conditions.
You can also set up email notification if printer errors occur by completing the Email Notice settings.
For details, refer to the Status Monitor help file.

NAbout
Displays version information for the printer driver.

SDefaults
Restores all settings on the sheet to the default values.

Configuration using Easy Settings

EPrint Target
Choose presets that match the type of document to be printed.
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• Printing Photos and Images →P.31

• Printing Line Drawings and Text →P.20

• Printing Office Documents →P.39

Depending on the A Media Type setting, some E Print Target options may not be available.

FPrint Quality
Choose the level of print quality.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.56

GView Settings
Displays the Print Target setting values.
You can view and change the order of Print Target setting values.

• View Settings Dialog Box for the Printing Application →P.226

Configuration using Advanced Settings

EPrint Priority
Choose the graphic elements that you want to emphasize for printing.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.56

FPrint Quality
Choose the level of print quality.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.56
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GColor Mode
Choose the color mode.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.56

Note
• Depending on the A Media Type setting, some G Color Mode options may not be available.

HColor Settings
Click to display the Color Settings dialog box for more advanced color settings.

• Adjusting the Color in the Printer Driver →P.47

IThicken Fine Lines
Activate this option to print fine lines more distinctly.

JUnidirectional Printing
Select this checkbox to prevent problems such as misaligned lines and improve the print quality. However, the printing
speed becomes slower.

KSharpen Text
Activate this option to print text more sharply.

TEconomy Printing
Select this checkbox to reduce the amount of ink consumed during printing. However, the print quality is worse than for
normal printing.
Select this mode if you want to conserve ink when checking drawings, for example. Depending on the A Media Type and
F Print Quality settings, this mode may not be available.
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Paper Information on Printer Dialog Box
On the Paper Information on Printer dialog box, you can obtain information on the paper in the printer and configure
printer driver settings for the paper source and media type.

Note
• To display the Paper Information on Printer dialog box, on the Main sheet, click Get Information by

Media Type.(See "Main Sheet →P.220 ")

APaper Source
Shows the paper source supported by the printer, as well as information about the loaded paper. To update the paper source
and media type settings in the printer driver, select the desired Paper Source option and click OK.
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Paper Detailed Settings Dialog Box
The Paper Detailed Settings dialog box offers the following settings. For details on settings items, refer to the printer driv-
er help.

Note
• To display the Paper Detailed Settings dialog box, on the Main sheet, click Settings by Media Type.(See

"Main Sheet →P.220 ")

ADrying Time
Specify the time that the printer waits for ink to dry, as needed. The Drying Time setting is only valid for rolls.

• (See "Specifying the Ink Drying Time for Rolls →P.652 ")

BBetween Pages
Specify the time the printer waits after printing a page until ejecting the paper, as needed.

CBetween Scans
Specify the time the printer waits after printing a line on the page until printing the next line, as needed.

DRoll Paper Margin for Safety
You can specify the length of a margin on the leading edge of paper to ensure that paper susceptible to curling is held firmly
against the Platen.

ENear End Margin
Specify the length of the Near End Margin (the leading edge margin) of the roll, as needed.

FCut Speed
Select the speed of automatic cutting, as needed. You can adjust this setting if paper is not cut well when automatic cutting
is used.
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GMirror
Specify whether to print a mirror image, as needed. Select this option to print a version of the document or image with the
left and right sides inverted.

View Settings Dialog Box for the Printing Application
In the View Settings dialog box, you can check details of the selected printing application.

Note
• To display the View Settings dialog box, on the Main sheet, click View Settings by Print Target.(See

"Main Sheet →P.220 ")

APrint Target
Shows all Print Target options (settings items for the printing application).

BName
Identifies the item selected in Print Target by its name and an icon.

CDetails
Here, you can confirm detailed settings values for each listed item for the selected Print Target.

Color Adjustment Sheet: Color
If the color tone as printed is not as you expected, you can adjust it on the Color Adjustment sheet.
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Note
• To display the Color Adjustment sheet, on the Main sheet, click Color Settings by Color Mode in Ad-

vanced Settings.(See "Main Sheet →P.220 ")

ASample Type
Choose a sample image from Standard, Portrait, Landscape, or Graphics.

BView Color Pattern
Select this checkbox to display the color pattern.

CApply to Sample
Select this checkbox to apply the changed settings to the sample image.

DCyan / EMagenta / FYellow
Fine-tune color tones by adjusting the levels of each color.

GGray Tone
Adjust the color tone of grays as desired. Choose Cool Black (tinged with blue) or Warm Black (tinged with red).

HBrightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter or darker
than the original image (that is, the original photo that was scanned or the original graphic as it appears on the computer
screen).

IContrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the Contrast makes
images sharper, and reducing the Contrast softens images.
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JSaturation
Adjust the color intensity as desired. Increasing the Saturation setting makes colors more vivid, and reducing the Satura-
tion makes colors more subdued.

KObject Adjustment
Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to color adjust-
ment.

• Object Adjustment dialog box: Color →P.228

SDefaults
Click to restore all settings on the sheet to the default values.

Note
• For details on settings items, see "Adjusting the Color in the Printer Driver →P.47 "

Object Adjustment dialog box: Color
In the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. If an original
comprises images, graphics, and text, you can specify which portion to apply color adjustment to.

Note
• To display the Object Adjustment dialog box, click Object Adjustment on the Color Adjustment sheet.

A Image
Select this option to apply color adjustment to image areas, such as photos.

BGraphics
Select this option to apply color adjustment to graphics, such as lines and circles.

CText
Select this option to apply color adjustment to text.
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Matching Sheet
On the Matching sheet, you can specify color matching to compensate for differences in the appearance of colors on vari-
ous devices.

Note
• To display the Matching sheet, on the Main sheet, click Color Settings in Color Mode in Advanced Set-

tings, and then click the Matching sheet. (Refer to "Main Sheet →P.220 ")

Important
• If No color correction is selected under Color Mode, the Matching sheet is not displayed.

Driver Matching Mode
The following options are available when you select Driver Matching Mode in the A Matching Mode list.

AMatching Mode
Select the color matching mode to use, as desired.
Normally, select Driver Matching Mode. For color matching based on ICC profiles, select ICC Matching Mode, Driver
ICM Mode, or Host ICM Mode, depending on your color matching system.

BMatching Method
Select the color matching method that suits the document to be printed. Various Matching Method options are available
depending on your selection in Matching Mode.
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ICC Matching Mode, Driver ICM Mode and Host ICM Mode
The following options are available when you select ICC Matching Mode, Driver ICM Mode, or Host ICM Mode in the
A Matching Mode list.

AMatching Mode
Select the color matching mode to use, as desired.

B Input Profile Settings
You can select Image, Graphics, or Text. You can choose Matching Method and Input Profile.
Various options are available depending on your selected Matching Mode.
To apply the same input profile automatically for Graphics and Text, select Use the Same Profile for All Objects. To
apply separate input profiles to Graphics and Text, clear Use the Same Profile for All Objects and specify the individual
settings.

CPrinter Profile Settings
Specify the printer profile as desired. Normally, select Auto Settings.

Note
• For details on settings items, see "Adjusting the Color in the Printer Driver →P.47 "
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Color Adjustment Sheet: Monochrome
On the Color Adjustment sheet for monochrome printing, you can adjust the brightness and contrast.

Note
• To display the Color Adjustment sheet, on the Main sheet, click Color Settings by Color Mode in Ad-

vanced Settings.(See "Main Sheet →P.220 ")

ASample Type
Choose a sample image from Standard, Portrait, Landscape, or Graphics.

BView Color Pattern
Select this checkbox to display the color pattern.

CApply to Sample
Select this checkbox to apply the changed settings to the sample image.

DCyan / EMagenta / FYellow
Not available.

GGray Tone
Not available.

HBrightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter or darker
than the original image (that is, the original photo that was scanned or the original graphic as it appears on the computer
screen).
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IContrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the Contrast makes
images sharper, and reducing the Contrast softens images.

JSaturation
Not available.

KObject Adjustment
Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to color adjust-
ment.

• Object Adjustment dialog box: Monochrome →P.232

SDefaults
Click to restore all settings on the sheet to the default values.

Note
• For details on settings items, see "Adjusting the Color in the Printer Driver →P.47 "

Object Adjustment dialog box: Monochrome
In the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. If an original
comprises images, graphics, and text, you can specify which portion to apply color adjustment to.

Note
• To display the Object Adjustment dialog box, click Object Adjustment on the Color Adjustment sheet.

A Image
Select this option to apply color adjustment to image areas, such as photos.

BGraphics
Select this option to apply color adjustment to graphics, such as lines and circles.
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CText
Select this option to apply color adjustment to text.

Page Setup Sheet
The following settings are available on the Page Setup sheet. For details on settings items, refer to the printer driver help
file.

APage Size
Select the page size as specified in the source application.
For details on available page sizes, see "Paper Sizes →P.626 "

BBorderless Printing

Borderless printing is available if roll paper is selected in the L Paper Source list. Choose from the following options when
this setting is activated.

• Borderless Printing on Paper of Equivalent Size →P.101

• Borderless Printing by Resizing Originals to Fit the Roll Width →P.108

• Borderless Printing at Actual Size →P.92
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DFit Paper Size
Scales the document image to match the paper size.

EScale to fit Roll Paper Width
Scales the document image to match the roll width.

FPrint Image with Actual Size
Prints documents at their actual size. This function is available when you have selected the size same as the width of Roll
Paper for either the length or width of the document from the A Page Size list.

GPaper Size
Available when D Fit Paper Size is selected.
Choose the size of the paper you will print on.
For details on available paper sizes, see "Paper Sizes →P.626 "
Paper sizes compatible with borderless printing are shown in the list.

CEnlarged/Reduced Printing

Choose from the following options when this setting is activated.

• Resizing Originals to Match the Paper Size →P.66

• Resizing Originals to Fit the Roll Width →P.72

• Resizing Originals by Entering a Scaling Value →P.78

DFit Paper Size
Scales the document image to match the paper size.

EFit Roll Paper Width
Scales the document image to match the roll width.

FScaling
Resizes the document image based on a specified scaling value. Enter a value in a range of 5–600.

GPaper Size
Choose the size of the paper you will print on.
For details on available paper sizes, see "Paper Sizes →P.626 "

HOrientation
Choose the printing orientation.
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• Making the Original Orientation Match the Paper Orientation →P.192

KRotate Page 90 degrees (Conserve Paper)
Activate this setting to rotate the document image by 90 degrees before printing.

• Conserving Roll Paper by Rotating Originals 90 Degrees →P.169

LPaper Source
Choose the feed source, as desired.
Options displayed in the list vary depending on the selection in Media Type on the Main sheet.

MRoll Paper Width
Choose the roll width.
For details on available roll widths, see "Paper Sizes →P.626 "

NRoll Paper Options
Complete optional roll paper settings. Click to display the Roll Paper Options dialog box.

Under A Automatic Cutting, you can specify Yes or No and Print Cut Guideline.

• Cutting Roll Paper After Printing →P.198

Select B Banner Printing when printing multiple pages continuously.

• Printing Multiple Pages Continuously →P.140

POutput Method
Click to display the Output Method dialog box, which enables you to complete the Output Method and Name of data to
be saved settings.

• Output Method dialog box →P.236

OSize Options
Click to display the Paper Size Options dialog box, which enables you to register additional paper sizes or select the size
system for use.

• Paper Size Options Dialog Box →P.237

SDefaults
Restores all settings on the sheet to the default values.
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Output Method dialog box
The Output Method dialog box allows you to select the Output Method and set the save settings when saving to the box.

Note
• To display the Output Method dialog box, on the Page Setup sheet, click Output Method. (Refer to "Page

Setup Sheet →P.233 ")

AOutput Method
If Print is selected, the print job is saved to the printer hard disk after printing has finished.
If Print (auto delete) is selected, the data is deleted immediately after printing has finished.
If Save in mail box is selected, the print job is saved to the printer hard disk. If you choose Save in mail box, also specify
the destination personal box in the Mail box list.
If the Save data before printing check box is selected, printing starts after the print job has finished being saved in the
temporary save box.

BName of data to be saved
To use the file name, choose Use file name.
Otherwise choose Enter name and enter a name in Name.

CMail box
Displays a list of mail boxes. If you choose Save in mail box, also specify the destination personal box from the list.
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DAcquire Mail Box Name
When this is clicked, the box name acquired from the printer main unit is displayed in Mail box.

Paper Size Options Dialog Box
In the Paper Size Options dialog box, you can create and register your own Custom Paper Size. The sizes you define are
listed with standard paper sizes for selection later as needed.

Note
• To display the Paper Size Options dialog box, on the Page Setup sheet, click Paper Size Options.(See

"Page Setup Sheet →P.233 ")

APaper Size List
Shows the names and sizes of paper that can be used with the printer driver.

BDelete
Custom paper sizes created by users can be deleted from the A Paper Size List, as needed.
However, they cannot be deleted in the following situations.

• If a standard paper size of the printer driver is selected.
• If an oversized paper size is selected.
• If a paper size marked with a red circle is selected.

CCustom Paper Size Name
You can name Custom Paper Size as desired.

DUnits
Specify the desired unit of measure for the Custom Paper Size height and width.
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EPaper Size
Specify the desired Width and Height. You can make your selection from sizes that are compatible with Borderless Print-
ing by selecting Borderless Printing Size. To maintain the aspect ratio of the Width and Height as you resize the paper,
select Fix the Ratio of the Width to Height.

FAdd
Enables you to register the custom paper size you have specified or overwrite an existing custom paper size.

GDisplay Series
You can limit the number of options shown in Page Size, Paper Size, and Paper Size List.

Layout Sheet
The following settings are available on the Layout sheet. For details on settings items, refer to the printer driver help.

APage Layout
Activate this setting to select a particular page layout.

• Printing Multiple Pages Per Sheet →P.145

• Printing Posters in Sections →P.152

• Printing Multiple Originals Next to Each Other →P.135

• Using PosterArtist to Compose Originals →P.183

BSet
Click to display one of the following dialog boxes depending on the selection in A Page Layout. In these dialog boxes, you
can specify layout details and which pages to print, as well as other settings.
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• Page Layout Printing
• Pages to Print
• Free Layout Settings

CWatermark
Activating this option makes two settings available, Watermarks and D Edit Watermark.

• Printing With Watermarks →P.188

Watermarks
Lists the provided watermarks. Choose the watermark to print.

DEdit Watermark
Click to display the Edit Watermark dialog box for creating your own, original watermark.

EPrint Centered
Activate this setting to print document images in the center of the paper.

• Printing Originals Centered on Rolls →P.156

• Printing Originals Centered on Sheets →P.162

FRotate 180 degrees
Activate this option to rotate document images by 180 degrees before printing.

GNo Spaces at Top or Bottom (Conserve Paper)
Activate this setting to print the next image skipping blank areas above and below printable data in documents, which ena-
bles you to conserve the paper.

• Conserving Roll Paper by Printing Originals Without Top and Bottom Margins →P.175

HCopies
Enter the number of copies to print, in a range of 1–999.

Reverse Order
Activate this option to print pages in reverse order.

IPage Options
Click to display the Page Options dialog box, which enables you to complete settings for printing the user name, date, or
page number in the header or footer.

• Page Options Dialog Box →P.240

JSpecial Settings
If the printing results are not as you expected, click this option to change how printing is processed.

• Special Settings Dialog Box →P.241
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SDefaults
Click to restore all settings on the sheet to the default values.

Page Options Dialog Box
The Page Options dialog box offers the following settings.

Note
• To display the Page Options dialog box, on the Layout sheet, click Page Options.(See "Layout Sheet

→P.238 ")

APrint Date
Select where the date is printed, as desired. To print the time as well, select B Print Time Also.

CPrint User Name
Select where the user name is printed, as desired.

DPrint Page Number
Select where the page number is printed, as desired.

EFormat Settings
Click to display the Format Settings dialog box, which enables you to complete format-related settings.
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Note
• If you specify the same position for multiple items, the items are printed from left to right in this order: date,

user name, and page number.
• When you print multiple pages per sheet using Page Layout Printing or similar functions, these items will

be printed for each page.

Special Settings Dialog Box
If the printing results are not as you expected, you can change how printing is processed in the Special Settings dialog box.

Note
• To display the Special Settings dialog box, on the Layout sheet, click Special Settings.(See "Layout Sheet

→P.238 ")

AFineZoom Settings
This function is used in large-format printing. Normally, choose Auto. If documents are not printed correctly on large-for-
mat paper, it may help to select Yes, and if fine lines are not visible or if images are distorted when printed, it may help to
select No.

BApplication Color Matching Priority
You can give applications priority in color management.

CEnable Preview Switching
When this option is selected, PageComposer starts if you print with Open Preview When Print Job Starts selected on the
Main sheet.

DFast Graphic Process
If image colors are inconsistent in printed documents or if lines are printed in varying thicknesses, clearing this option may
help produce the expected results.

Important
• This function cannot be used on 64-bit version of Windows.
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EReduce Print Unevenness
If you are concerned about print unevenness, the printing results can be improved by selecting this option. However, print-
ing may take longer for some images.

FAdjust faint lines
If fine lines are printed in colors that do not match the colors of other shapes, clearing this option may help produce the
expected results. However, lines in some colors may appear broken.

Favorites Sheet
The following settings are available on the Favorites sheet. For details on settings items, refer to the printer driver help.

AFavorites
Printing favorites you have created are listed with Default Settings favorites.

• Using Favorites →P.198

BSettings Details
Displays details of the favorite selected in the A Favorites.

CComment
Displays notes registered in the favorite.

DApply Favorite
Click to change the current print settings to those of the favorite selected in the A Favorites.
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EApplication Settings Priority
Activate this setting to use settings values specified in the source application in preference to favorite settings selected in the
A Favorites, when clicking D Apply Favorite. For details on the settings items used in preference, refer to the printer driv-
er help.

FDelete
Click to delete the selected favorite from the A Favorites list.

GEdit
Click to display the Edit dialog box, which enables you to change the name and icon for the favorite selected in the
A Favorites list.

HAdd
Click to display the Add dialog box, which enables you to add the current print settings as a favorite.

I Import
Click to display the Open dialog box, which enables you to import favorite settings saved as a file.

JExport
Click to display the Save As dialog box, which enables you to save the favorite settings as a file.

KUp
Click to move the selected favorite up in the A Favorites list.

LDown
Click to move the selected favorite down in the A Favorites list.
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Utility Sheet
The following items can be executed on the Utility sheet. For details on the utilities, refer to the relevant utility help.

AMaintenance
Click to start the imagePROGRAF Status Monitor, which offers the following maintenance for the printer.

• Nozzle (ink ejecting outlet) check
• Nozzle (ink ejecting outlet) cleaning
• Head alignment adjustment
• Feed amount adjustment

BColor imageRUNNER Enlargement Copy
Click to launch Color imageRUNNER Enlargement Copy (iR enlargement copy), which enables you to create hot folders
used for Color imageRUNNER Enlargement Copy and assign print settings to hot folders.

• Printing Enlargements of Scanned Originals from a Color imageRUNNER →P.304

For details, see Color imageRUNNER Enlargement Copy →P.292 .
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Support Sheet
On the Support sheet, you can view support information and the user's manual.

ASupport Information
Click to access the Canon support webpage, where you can find the latest information on the printer and consumables,
check for printer driver updates, and browse other information.

BUser Manual
Click to view the printer user's manual. This function requires the user's manual to be installed on your computer.

CSettings Summaries
Click to display the View Settings dialog box, which enables you to confirm the settings for the Main, Page Setup, Lay-
out, and Favorites sheets.
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Settings Summaries Dialog Box
The Settings Summaries dialog box enables you to confirm the settings for the Main, Page Setup, Layout, and Favorites
sheets.

ACopy
Click to copy the settings information to the clipboard. You can paste the settings information into a file created with a text
editor or similar application.
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Device Settings Sheet
Many settings items on the printer properties sheets are controlled by Windows applications. However, the Device Settings
sheet is for configuring the printer, and it is an extension of the printer driver.
The following settings are available on the Device Settings sheet.

AAutomatically switch paper sources (paper size priority)
When this check box is selected, printing automatically switches between roll 1 and roll 2 depending on the paper size being
printed.
Always check the warnings described in Switching the Paper Source of Roll Paper to Match the Paper Size →P.202
before using this option.

BColor Compatibility
Click to display the Color Compatibility dialog box, which enables you to adjust colors if you have selected Color Mode
> Color (CAD).

• For details on color settings, see Specifying Colors and Printing CAD Drawings →P.27 .

CAcquire Status
The paper size information is acquired from the printer, and the width of the roll paper that is actually loaded in the printer
is displayed.
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DAbout
You can display version information for the printer driver.
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The Features of Preview
The main features of Preview are as follows.

• While viewing this screen, you can adjust layout settings of a document created with application software.
• You can not only adjust layout settings but also your changes will be instantly applied on the preview screen, and you

can print the preview screen as it is seen.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print output

to differ from the Preview settings.

Operating Environment
You can use the Preview in the following environments.

• Compatible Operating System
Windows 2000, Windows XP, Windows Server 2003, Windows Vista, Windows Server 2008, Windows 7
 

• Software that requires installation
imagePROGRAF Printer Driver

Starting Preview
Follow the procedure below to start the Preview.

1. Start the apllication software which you use.

2. From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.
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3. On the Main sheet, click on the Open Preview When Print Job Starts check box.
Click the OK button to save the settings.

Note
• Your printer is depicted in the lower-left area of this screen.

4. On the Print dialog box in the apllication software, click the Print button.

5. Preview main window is displayed.
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Preview Main Window
The Preview main window consists of the menu and tool bars, preview and dialog area and status bar.

Note
• You can use the View menu to show or hide the tool bar.

Menu Bar
This allows you to select menus required for operations.

Tool Bar
This allows you to select tool buttons required for major operations.
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Preview Area
You can check the settings you made in this area.

Dialog Area
This allows you to set the print conditions and perform a print job.
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For more information about Dialog Area, see "Dialog Area." →P.254

Status Bar
This shows the message, Pages and Output Size.
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Dialog Area
You can select the layout and print on the center.

Media Type / Paper Source /Paper Size
You can confirm the information that is set.
 

Layout Selection
You can print which conserves paper by selecting the layout.
For more information about Layout Selection, see "Printing with Selecting the Layout." →P.258
 

Center Originals Across Roll
You can print on the center of the media loaded in the printer.
For more information about Center Originals Across Roll, see "Print on the Center." →P.260

Note
• Available only if rolls are selected in Paper Source.
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No Spaces at Top or Bottom
You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the top or bottom.
For more information about No Spaces at Top or Bottom, see "Not Print Spaces at the Top/Bottom." →P.261

Note
• Available only if rolls are selected in Paper Source.

Print Button
Click the button to start printing.
 

Cancel Button
Click the button to stop printing.
 

Printer Information
You can confirm the information acquired from the printer.
 

Update Printer Information Button
Click the button to update the printer information with connecting to the printer.
 

Status Monitor Button
Click the button to start Status Monitor.
 

Enlarge/Reduce the screen display
You can enlarge or reduce the screen display when you select Zoom from the View menu.

Setting Details

Fit Screen Display all.

Fit to Width Display to the width of the paper.

Reduce Display at half of the standard size.

Standard Display at the standard size.

Enlarge Display with the double of the standard size.

Enlarge More Display with the triple of the standard size.

Note
• This item can be selected even if you have clicked the ▼ button in the toolbar Zoom.

Moving a Page
You can move a page to display when you select Go to Page from the View menu.
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Setting Details

First Page Go to the first page.

Previous Page Go to the previous page.

Next Page Go to the next page.

Last Page Go to the last page.

Go To Page Go to the specified page.

Note

• You can also move a page by clicking  on the tool bar.

Using the ruler
You can confirm the layout with using the ruler.

• Switching the ruler Show/Hide
In the View menu, select Ruler to switch the ruler Show/Hide.
 

• Changing the ruler unit
You can set the ruler unit when you select Units from the View menu.

Setting Details

mm Use mm as the ruler unit.

inch Use inches as the ruler unit.

Priority setting for rotating 90 degrees
You can select Rotate 90 Degrees If Possible or Use Driver Settings from the Options menu.

Setting Details

Rotate 90 Degrees If Possible Rotates pages in portrait orientation 90 degrees before printing. Pages are only ro-
tated if they can fit lengthwise across the roll.

Use Driver Settings Follows printer driver settings when determining whether to rotate pages.
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Selecting Rotate 90 Degrees If Possible or Placing a checkmark for Rotate Page 90 degrees (Conserve Paper) on the
printer driver

Selecting Use Driver Settings
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Printing with Selecting the Layout
You can print which conserves paper by selecting the layout.

1. In Layout Selection, click the layout button to use.

Button Details

Upper Button

Turn at the position of .

Right Button

Turn at the position of .

Left Button

Turn at the position of .
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Button Details

Lower Button

Turn at the position of .

Note
• Right Button or Left Button can be selected only when the rotated pages can fit lengthwise across

the roll.
• By clicking Right Button or Left Button, you can save paper by printing in landscape orientation on

roll paper.
• You can select only Upper Button or Lower Button if Cut Sheet is selected.

Button Details

The button is selected currently.

The button can be selected.

The button can not be selected.

2. Click the Print Button.
 

Printing on the selected layout begins.
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Print on the Center
You can print on the center of the media loaded in the printer.

1. Click the Center Originals Across Roll check box on.

2. Click the Print button
 

Printing on the center begins.

Note
• Available only if rolls are selected in Paper Source.
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Not Print Spaces at the Top/Bottom
You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the top or bottom.

1. Click the No Spaces at Top or Bottom check box on.

2. Click the Print button.
 

Printing on the settings with no spaces at top or bottom begins.
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The Features of Free Layout
The main features of Free Layout are as follows.

• Allows you to lay out at will and print a document created with application software.
• You can not only lay out multiple pages on one page but also lay out and print a multiple-file document on one page,

or lay out and print a document created with multiple application programs on one page.
• Any two pages can be arranged and printed in a layout that becomes duplex on folding.

This can be used such as for advertising posters that are suspended from the ceiling.
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Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print output

to differ from the Free Layout settings.

Operating Environment
You can use the Free Layout in the following environments.

• Compatible Operating System
Windows 2000, Windows XP, Windows Server 2003, Windows Vista, Windows Server 2008, Windows 7

• Software that requires installation
imagePROGRAF Printer Driver

Note
• This function is not available on 64-bit version of Windows.

Starting Free Layout
Follow the procedure below to start the Free Layout.

1. Start the apllication software which you use.

2. From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.

3. From the list, select the printer and select the Layout sheet.
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Note
• Your printer is depicted in the lower-left area of this screen.

4. In the Layout sheet, click on the Page Layout check box and select Free Layout from the list.
Click the OK button to save the settings.

Note
• When you select Free Layout, all other setting items will be disabled.

5. On the Print dialog box in the apllication software, click the Print button.
Free Layout main window is displayed.
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Free Layout Main Window
The Free Layout main window consists of the menu and tool bars, layout area and status bar.

Note
• You can use the View menu to show or hide the tool and status bar.

Menu Bar
This allows you to select menus required for operations.

Tool Bar
This allows you to select tool buttons required for major operations.
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Layout Area
This allows you to lay out objects and edit the object size and orientation.

Status Bar
This shows the paper size, unit of length, and number of objects.
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Detailed Settings
The printer driver opens when you select Detailed Settings from the File menu. The printer driver is used to configure basic
settings to match the type of media loaded in the printer.

Refer to Printer Driver →P.207  for details on the printer driver.

Note
• When you select the Detailed Settings, the only three sheets displayed are the Main sheet, the Page Setup

sheet, and the Layout sheet. Some of the printer driver settings may be disabled.

Windows Software > Free Layout >

iPF825 Detailed Settings

4

267



Preferences Dialog Box
This dialog box appears when you select Preferences from the File menu. This allows you to configure the preferences of
Free Layout.

Units
Set the unit for paper length, margins, and so on.

Gridlines
You can input a grid line width value in numerical characters so that they serve as a guide to laying out objects.

Note
• You can input between 10.0 and 200.0(mm) (between 0.39 and 7.88(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

Divisions
You can change the number of divisions of grid lines so that they serve as a guide to laying out objects.

Note
• You can input between 1 and 10.
• You can change the numbers by clicking either ▲ button or ▼ button.

Grid Color
Select the grid line color.

Auto Arrange Spacing
Change the object-to-object spacing to be applied in the operation of laying out objects automatically.
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Note
• You can input between 0.0 and 100.0(mm) (between 0.00 and 3.94(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

Object Frame Style
You can select the object frame style for printing.
The following settings are available for the object frame style.

Setting Details

None You can print with no frame style.

Solid Line You can print the solid line as the frame style.

Dotted Line You can print the dotted line as the frame style.

Dashed Line You can print the dashed line as the frame style.

Crop Marks You can print with the crop marks.

Page Options Dialog Box
This dialog box appears when you select Page Options from the File menu. This allows you to configure the roll paper
length, object layout order, and margins of Free Layout.

Roll Paper Length
Set the length of one page to print on roll paper.
The following settings are available for roll paper length.
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Setting Details

Auto Settings The one-page length to be printed on roll paper is automatically set so that the laid-
out objects are printed on one page.

Manual Settings You can input the length of one page to print on roll paper in numerical characters.

Note
• Available only if rolls are selected in Paper Source.
• You can input between 203.2 and 18000.0(mm) (between 8.00 and 708.66(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

Order
Set the object layout order.
The following settings are available for order.

Setting Details

Upper Left to Right The objects are laid out from upper left to right.

Upper Left to Bottom The objects are laid out from upper left to bottom.

Upper Right to Left The objects are laid out from upper right to left.

Lower Left to Top The objects are laid out from lower left to top.

Note
• When you have selected Roll Paper Length > Auto Settings and Paper Orientation > Vertical, you can

choose Upper Left to Right or Upper Right to Left.
• When you have selected Roll Paper Length > Auto Settings and Paper Orientation > Horizontal, you can

choose Upper Left to Bottom or Lower Left to Top.

Margins
You can input the paper margins in numerical characters.

Note
• You can input between 0.0 and 50.0(mm) (between 0.00 and 1.97(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

Zoom Dialog Box
This dialog box appears when you select Zoom from the View menu. You can enlarge or reduce the screen display.

Scaling
Set the magnification for enlargement or reduction of the screen display.
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Note
• You can input between 25 and 400.
• You can change the numbers by clicking ▼ button.

Format Dialog Box
This dialog box appears when you select Format from the Object menu after you select an object.

Size Sheet
You can rotate, enlarge, or reduce an object.

Note
• When the objects are not selected, you can not select Format.

Rotate
When you place a checkmark here, you can select Rotate Right or Rotate Left.

Setting Details

Rotate Right Rotates the object 90 degrees clockwise.

Rotate Left Rotates the object 90 degrees counterclockwise.

Note
• When several objects are selected, you cannot select Rotate.
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Enl./Red.
When you place a checkmark here, you can select Scaling, Fit Paper Size, or Fit Photo Size.

Setting Details

Scaling Allows you to input the value of the enlargement or reduction ratio of an object.

Fit Paper Size Prints by enlarging or reducing each object to match the paper size. If you are using
roll paper, objects are enlarged or reduced so that the width of each object matches
the width of the roll paper.

Fit Photo Size Prints all of the objects at the specified photo size.

Note
• You can input between 25 and 600.
• You can change the numbers by clicking either ▲ button or ▼ button.

Position Sheet
You can rotate, enlarge, or reduce an object.

Note
• When the objects are not selected, you can not select Format.

Object Position
You can move the object position by changing the values.

Setting Details

Vertical Pos You can input the number of the vertical position in numerical characters.

Horizontal Pos You can input the number of the horizontal position in numerical characters.
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Setting Details

Page Pos You can input the number of the page position in numerical characters.

Object Size
You can confirm the object size.

Note
• When several objects are selected, you cannot display Object Size.

Laying out a Multiple-File Document on One Page
You can lay out and print a multiple-file document on one page.

1. From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.

2. Click Properties to open the Properties dialog box.
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3. In the Page Setup sheet, select Paper Source.

Note
• Your printer is depicted in the lower-left area of this screen.

4. In the Layout sheet, click on the Page Layout check box and select Free Layout from the list.

Windows Software > Free Layout >
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Note
• Your printer is depicted in the lower-left area of this screen.
• When you select Free Layout, all other setting items will be disabled.

5. Click the OK button to save the settings.

6. In the Print dialog box, select the pages to print and the number of copies, and click the OK button.

Free Layout starts, laying out the document created with application software in the layout area as an object.
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7. Leaving Free Layout running, open other files with the application software and repeat the above steps.

Laying out a Document Created with Multiple Application Programs on One Page
You can lay out and print a document created with multiple application programs on one page.

1. From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.

2. Click Properties to open the Properties dialog box.
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3. In the Page Setup sheet, select Paper Source.

Note
• Your printer is depicted in the lower-left area of this screen.

4. In the Layout sheet, click on the Page Layout check box and select Free Layout from the list.
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Note
• Your printer is depicted in the lower-left area of this screen.
• When you select Free Layout, all other setting items will be disabled.

5. Click the OK button to save the settings.

6. In the Print dialog box, select the pages to print and the number of copies, and click the OK button.

Free Layout starts, laying out the document created with application software in the layout area as an object.
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7. Leaving Free Layout running, open other files with other application software and repeat the above steps.

Selecting an Object
When an object is selected, a select box (blue border) appears around the object.

Note
• To select an object, click that object.
• To select multiple successive objects, click them while holding down the Shift key.
• To select multiple arbitrary objects, click them while holding down the Ctrl key.
• To select all objects, select Select All from the Edit menu.
• When you specify the area with dragging the mouse, the object in the area is selected.
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Changing the Object Size
You can change the object size by means of mouse operation or by specifying a scaling value.

Note
• The vertical-to-horizontal ratio remains unchanged when the object is enlarged or reduced.

Resizing by means of mouse operation

1. Select an object.

2. Place the pointer at a corner of the selection box around the object to show the arrow handle, and drag this handle to
change the object size.

Resizing by specifying a scaling value

1. Select an object.
Click on the Enl./Red. checkbox in the Format Dialog Box →P.271  and select Scaling.

2. You either enter numbers directly.

Note
• You can input between 25 and 600.
• You can change the numbers by clicking either ▲ button or ▼ button.

3. Click the OK button.

Moving an Object
You can move the object position.

1. Select an object.
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2. Place the pointer inside the selection box of the object to show the crosshair handle, and drag it to move the object.
Alternatively, you can move the Object Position by changing the values in Vertical Pos, Horizontal Pos and Page
Pos in the Format Dialog Box →P.271 .

Rotating an Object
You can rotate the object.

1. Select an object.

2. Select Rotate Left 90 Degrees or Rotate Right 90 Degrees from the toolbar.
Alternatively, you may click on the Rotate check box in the Format Dialog Box →P.271  then select Rotate Right
or Rotate Left, and click the OK button.
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Laying out Objects Automatically
Click Auto Arrange Object in the tool bar. This automatically lays out objects. Alternatively, you may select Auto Ar-
range Object from the Object menu.

Note
• The object layout order varies depending on the Order setting in the Page Options Dialog Box →P.269

dialog box.

Aligning Objects
You can align objects systematically.

1. Select multiple objects.

2. Click the align button from the toolbar.
Alternatively, you may select the align menu from the Object menu.

Align Top
Lays out the objects, justifying them to the top.
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Center Vertically
Lays out the objects, justifying them to the vertical center.

Align Bottom
Lays out the objects, justifying them to the bottom.

Align Left
Lays out the objects, justifying them to the left.
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Center Horizontally
Lays out the objects, justifying them to the horizontal center.

Align Right
Lays out the objects, justifying them to the right.

Changing the Object Overlapping Order
You can change the object overlapping order.

1. Select an object.

2. Select the Overlapping Order menu from the Object menu.

Note
• The order of overlapping affects the order of objects automatically laid out.
• You can also select by clicking the right button of the mouse on an object.
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Bring to Front
Moves the object to the frontmost position.

Send to Back
Moves the object to the backmost position.

Bring Forward
Moves the object one position to the front.
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Send Backward
Moves the object one position to the back.

Pasting a Copied or Cut Object

1. Click Copy or Cut from the toolbar.
Alternatively, you may select Copy or Cut from the Edit menu.

2. Click Paste from the toolbar.
Alternatively, you may select Paste from the Edit menu.

Note
• The copied or cut object is laid out at the end of the page.
• You can also select by clicking the right button of the mouse on an object.
• In order to paste an object on any position that you like, you can paste the object with Pointed Paste by

clicking the right button of the mouse on any position that you want.
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Folded Duplex Window
This window is displayed if you select Folded Duplex from the Edit menu after selecting an object. Using the Folded Du-
plex function allows you to print with fold lines added.
The Folded Duplex window consists of the menu and tool bars, layout area and status bar.

Note
• The toolbar and status bar can be toggled between hidden and displayed from the View menu.

Menu Bar
This allows you to select menus required for operations.

Tool Bar
This allows you to select tool buttons required for major operations.
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Layout Area
This allows you to check the arrangement and orientation of objects.

Status Bar
This shows the paper source, roll paper width, and output size.

Finished Size Settings Dialog Box
This dialog box is displayed when you select Finished Size Settings from the Edit menu. This allows you to configure
finished size settings.

Finished Size
Selects the method for setting the finished size.
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The following settings are available for the finished size.

Setting Details

Fit Roll Paper Width Prints by automatically enlarging or reducing the entire document so that the width
of the document matches the roll paper width.

Specify Folded Size Prints by automatically enlarging or reducing the entire document to match the size
of the paper. Select the actual size of the paper you want to print on in Fit Paper
Size.

Rotate Page 90 degrees (Con-
serve Paper)

Prints by rotating pages by 90 degrees. Pages are automatically rotated if they will
fit within the roll paper width when rotated, and are not rotated if they will not fit
within the roll paper width.

Binding Settings Dialog Box
This is displayed when you select Binding Settings from the Edit menu. This allows you to configure the binding edge
settings.

Binding Edge
Configures the binding edge when folding paper.
The following settings are available for the binding edge.

Setting Details

Bottom Prints by placing the binding margin (gutter) at the bottom of the document.

Top Prints by placing the binding margin (gutter) at the top of the document.

Binding
Configures the binding margin (gutter).
Prints by creating a binding margin (gutter) of the specified size. Enter the margin size as a number.

Note
• The values that can be entered are 0 to 50 (mm).
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Print Fold Lines
Configures the color and type of fold lines.

Note
• To not print fold lines, clear the Print Fold Lines checkbox.

Fold Line Color
You can select the fold lines.

Fold Line Type
You can select the fold lines.
The following settings are available for the fold line type.

Setting Details

Solid Line You can print the solid line as the frame style.

Dotted Line You can print the dotted line as the frame style.

Dashed Line You can print the dashed line as the frame style.

Only Print Center and Edges
To print fold lines at the center and both edges, select the Only Print Center and Edges checkbox.

Prints using Folded Duplex
Allows you to produce duplex printing by combining two pages and folding them.

1. Select two objects from the layout area of Free Layout.

2. Select Folded Duplex from the Edit menu of Free Layout.
Open the Folded Duplex window and arrange the selected objects in the layout area.

3. Open the Finished Size Settings dialog box from the Edit menu.

4. Select Fit Roll Paper Width or Specify Folded Size in Finished Size.

Note
• Rotate Page 90 degrees (Conserve Paper) is also available when Specify Folded Size is selected.

5. Click OK to save the settings.

6. Open the Binding Settings dialog box from the Edit menu.

7. Select Bottom or Top in Binding Edge.

8. Specify the Binding width in Binding.
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9. Configure the Fold Line Color and Fold Line Type from Print Fold Lines.

Note
• When the Only Print Center and Edges checkbox is selected, fold lines are only printed at the three

locations of the center and both edges.

10. Click OK to save the settings.

11. Confirm the print setting and begin printing.
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The Features of Color imageRUNNER Enlargement Copy
The main features of Color imageRUNNER Enlargement Copy are as follows.

• Allows the document scanned with the Color imageRUNNER to be automatically enlarged and printed.
• You can perform basic printer settings such as printer selection, media type and output profile selection, and matching

methods, in addition to borderless printing and enlargement/reduction process without growing through the printer
driver.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print output

to differ from the Color imageRUNNER Enlargement Copy settings.

Operating Environment
You can use the Color imageRUNNER Enlargement Copy in the following environments.

• Compatible Operating System
Windows 2000, Windows XP, Windows Server 2003, Windows Vista, Windows Server 2008, Windows 7
 

• Software that requires installation
imagePROGRAF Printer Driver

Note
• This function is not available on 64-bit version of Windows.

Starting Color imageRUNNER Enlargement Copy
Follow the procedure below to start the Color imageRUNNER Enlargement Copy.

To start by selecting Printers and Faxes from the start button

1. Open the folder of the OS you are using for configuring printers.
For example, on Windows XP click the start button on the desktop, and then select Printers and Faxes.
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2. Right-click the Printers icon and select Printing Preferences to open the Printing Preferences dialog box.
In the Utility sheet, click the Color imageRUNNER Enlargement Copy button.

3. The Color imageRUNNER Enlargement Copy dialog box displays.

Note
• If you click on the Add to Startup folder check box in the Color imageRUNNER Enlargement Copy

dialog box, the icon of Color imageRUNNER Enlargement Copy utility will appear on the task bar when
starting Windows thereafter.
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To start by selecting Color imageRUNNER Enlargement Copy from the start button

1. From the Windows start button, select Color imageRUNNER Enlargement Copy.

2. The Color imageRUNNER Enlargement Copy dialog box displays.

Color imageRUNNER Enlargement Copy Dialog Box
The explanation below is on the Color imageRUNNER Enlargement Copy dialog box.

Note
• For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color image-

RUNNER Enlargement Copy." →P.292

Hot Folder
The hot folder list appears.
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Add Button
Click the button to open the Easy Setup Wizard dialog box so that you can add a hot folder.
 

Edit Button
From the Hot Folder list, select a hot folder and click the button to open the Add/Edit Hot Folder dialog box that allows
you to edit the hot folder.
 

Delete Button
From the Hot Folder list, select a hot folder and click the button to delete the hot folder.
 

Start Button
Clicking the button changes the status of the selected inactive Hot Folder to active.
 

Stop Button
Clicking the button changes the status of the selected active Hot Folder to inactive.
 

Add to Startup folder
Register the application in the Windows startup menu.

Save Printed Data
Automatically saves printed data.

About Button
Click the button to display the name and the version number of the utility.

Operation Guide Button
Click the button to display the Color imageRUNNER Enlargement Copy Setup Manual.

Hot Folder
Hot folder refers to a folder used for Color imageRUNNER Enlargement Copy.

• When transferred to the PC's hot folder, the document data scanned with the Color imageRUNNER is printed in en-
larged size from the printer according to the print conditions set in the hot folder.

• You can create a new hot folder, edit or delete an existing one, and set print conditions at will.

Note
• You can create up to 20 hot folders.
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Creating a New Hot Folder

1. Open the Color imageRUNNER Enlargement Copy dialog box, and then click the Add button.

Note
• For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color

imageRUNNER Enlargement Copy." →P.292

2. The Easy Setup Wizard dialog box displays.
Click the Next button.
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3. Select the type of printer to use.
Click the Next button.

4. Select the media type to print.

Note
• If the Borderless Printing checkbox is checked, only media types that can be used for borderless

printing are displayed in the list.

Click the Next button.
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5. Select roll paper or cut sheet to print. Also, select the media size to print.
Click the Next button.

6. Select the color matching method.
Click the Next button.

7. To receive a document scanned with the Color imageRUNNER, you need to share a folder. Enter the folder shared
name in Shared Name.
Click the Next button.

Note
• This shared name is used as the name of the hot folder.
• You cannot use the Back button, after clicking the Next button here.

Windows Software > Color imageRUNNER Enlargement Copy >

Creating a New Hot Folder iPF825

4

298



8. Click Finish button to close the Easy Setup Wizard dialog box.
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The hot folder you have created appears in the Hot Folder list in the Color imageRUNNER Enlargement Copy
dialog box.

Specifying an Existing Shared Folder as a Hot Folder

1. Share the folder you want to specify as a hot folder.

2. Open the Color imageRUNNER Enlargement Copy dialog box, and then click the Add button.

Note
• For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color

imageRUNNER Enlargement Copy." →P.292
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3. The Easy Setup Wizard dialog box displays.
Click the Manual Settings button.

4. The Add/Edit Hot Folder dialog box displays.
Enter the hot folder name in Name.
Click the Browse botton, with selecting Specify a folder, to set the existing shared folder.
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5. The location of the folders will appear.
Select the folder to specify a hot folder, and click the OK button.

6. As necessary, set the print conditions in the hot folder.  (See "Setting the Print Parameters.") →P.303
Click the OK button to close the Add/Edit Hot Folder dialog box.
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The hot folder you have created appears in the Hot Folder list in the Color imageRUNNER Enlargement Copy
dialog box.

Setting the Print Parameters
The printer driver opens when you click the Properties button in the Add/Edit Hot Folder dialog box. The printer driver is
used to configure basic settings to match the type of media loaded in the printer.

Refer to Printer Driver →P.207  for details on the printer driver.

Note
• The only three sheets displayed are the Main sheet, the Page Setup sheet, and the Layout sheet. Some of the

printer driver settings may be disabled.
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Apply Sharpness
Place a checkmark here to set the sharpness.
Drag the slider bar to the left or right to adjust. You can also adjust by directly entering a number in the numeric input field.

Note
• You can input between 0 and 500.
• You can change the numbers by clicking either ▲ button or ▼ button.
• You cannot be applied to PDF files.

Printing Enlargements of Scanned Originals from a Color imageRUNNER
Scanned originals from a Color imageRUNNER can be enlarged and printed automatically.
Originals you create by scanning with a Color imageRUNNER are transferred to a "hot folder" and printed automatically
after enlargement according to printing conditions you specify for that folder.
This processing sequence is called the Color imageRUNNER Enlargement Copy function.
To use Color imageRUNNER Enlargement Copy, first complete these settings in the following order.

1. Register a hot folder on your computer.
Register a hot folder on your computer for storing scanned originals from the Color imageRUNNER and complete the
settings for enlargement copy.

2. Complete the scanning settings on the Color imageRUNNER.
Configure the Color imageRUNNER to send scanned originals to the hot folder.

After these settings are complete, you can print enlarged copies of scanned originals from the Color imageRUNNER.

Registering a hot folder on your computer
Folders used for Color imageRUNNER Enlargement Copy (iR enlargement copy) are called hot folders. Register a hot
folder on your computer for storing scanned originals from the Color imageRUNNER. You can specify printing conditions
(such as the image quality and paper size), based on which originals transferred to the hot folder will be printed. Follow
these steps to register and modify hot folders.

1. Display the printer driver dialog box. (See "Accessing the Printer Driver Dialog Box from the Operating System
Menu .") →P.218
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2. Click the Utility tab to display the Utility sheet.

3. Click Color imageRUNNER Enlargement Copy to start the Color imageRUNNER Enlargement Copy utility.

4. Use the Color imageRUNNER Enlargement Copy utility to register or modify hot folders.
For instructions on registering and modifying hot folders, refer to the help file for the Color imageRUNNER En-
largement Copy utility.

Completing the scanning settings on the Color imageRUNNER.
Configure the Color imageRUNNER to send scanned originals to the hot folder. It is easy to send scanned originals to the
hot folder if you assign the scanning settings and destination to a Favorites button on the Color imageRUNNER.
For instructions on assigning scanning settings and destinations to a Favorites button, refer to the setting manual, displayed
by clicking Color imageRUNNER Enlargement Copy Setup Manual button of Color imageRUNNER Enlargement Copy
utility, or refer to the Color imageRUNNER manual.

Scanning the original and print an enlargement
Follow the steps below to scan an original on the Color imageRUNNER for enlarged printing on the printer. For detailed
instructions, refer to the Color imageRUNNER manual.

1. Load the original on the platen glass or document feeder of the Color imageRUNNER.

2. Press Send to display the screen for transmission.

3. Press Favorites, and then press the Favorites button assigned to the hot folder.
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4. Press Start on the control panel. If you scan originals on the platen glass, after scanning all originals, press Done on
the touch-panel display.
Scanned originals are sent to the hot folder and automatically enlarged and printed following the conditions you
specified for the folder.
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Print Plug-In for Office features
Print Plug-In for Office is a Plug-In that enables easy printing from Microsoft Office.

• It is displayed on the toolbar/ribbon, so it is easily accessible.
• It can be set by just selecting from the Wizard.
• Large-Format Printing custom media size can also be set in the Wizard from Microsoft Word or Microsoft Power-

Point.
• Custom media size can be set automatically from Microsoft Excel.
• The layout can be checked before printing by starting the preview screen.

Important
• The Print Plug-In for Office toolbar/ribbon might not be displayed in Microsoft Office after installing im-

agePROGRAF Print Plug-In for Office.
Refer to the following topic for details on how to display the imagePROGRAF Print Plug-In for Office
toolbar/ribbon.

• When Print Plug-In for Office is not displayed →P.312
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Operating Environment
Print Plug-In for Office 's operating environment is as below.

• Compatible Operating System
Windows XP, Windows Server 2003, Windows Vista, Windows Server 2008, Windows 7
 

• Software that requires installation
Microsoft Office XP/2003/2007/2010
imagePROGRAF Printer Driver Ver. 3.95 or later
 

• Hardware
CPU 2.0 GHz Pentium 4 or better
RAM 512 MB or more

Important
• If you opened the Office document from Internet Explorer, the software will not run correctly.
• If you are editing an embedded object or link object, the software will not run correctly.
• If you added the imagePROGRAF Print Plug-In ribbon to the Microsoft Office 2007/2010 Quick Access

toolbar, the software will not run correctly.

Steps to install
Below are the steps to install Print Plug-In for Office.

Note
• You must log into Windows as an Administrator before the installation.

1. Insert "User Software CD-ROM" into the CD-ROM drive and start the installer.

Note
• If the installer screen does not display, open the CD-ROM icon from My Computer, click setup.exe,

and open the icon.
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2. Click the Install Individual Software button.

3. Click Install in imagePROGRAF Print Plug-In for Office.
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4. Click the Next button.

5. Read the License Agreement, and click the Yes button.
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6. Click the Start button.

7. Click the Yes button.

8. Click the Exit button.

The installation for Print Plug-In for Office is complete.
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Important
• When you install this software, the virtual printer Canon imagePROGRAF PrintPlugIn may be installed. If

you want to use this software, do not uninstall the virtual printer Canon imagePROGRAF PrintPlugIn.
• The Print Plug-In for Office toolbar/ribbon might not be displayed in Microsoft Office after installing im-

agePROGRAF Print Plug-In for Office.
Refer to the following topic for details on how to display the imagePROGRAF Print Plug-In for Office
toolbar/ribbon.

• When Print Plug-In for Office is not displayed →P.312

Steps to uninstall
Below are the steps to uninstall Print Plug-In for Office.

1. If Microsoft Office is open, close it.

2. Select Control Panel from the start menu.

3. Open Add or Remove Programs.

4. Select imagePROGRAF Print Plug-In, and click the Remove button.

Note
• You cannot uninstall Print Plug-In for Office if an Office application is running. When a message appears,

select Cancel and close all Office applications that are running.

When Print Plug-In for Office is not displayed
Buttons such as Start imagePROGRAF Print Plug-In sometimes do not appear in the Word, PowerPoint and Excel
Office applications, and the Print Plug-In for Office functions are not available.
In this event, re-install Print Plug-In for Office.
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If you are using Microsoft Office 2003 or later, you can also enable add-ins to display Print Plug-In for Office.
See below for the procedure for re-installing the plug-in or enabling add-ins.

Re-installing Print Plug-In for Office

• If a problem occurs, such as the system or an application terminating abnormally, the Microsoft Office application
disables add-ins as a safety precaution.

In this event, you will need to re-install Print Plug-In for Office to display the imagePROGRAF Print Plug-In toolbar/
ribbon.

Note
• You cannot re-install Print Plug-In for Office once an Office application is running. When the message ap-

pears, select Cancel and close the active Office application.

Re-install Print Plug-In for Office as follows:

1. Close Microsoft Office if it is open.

2. Install Print Plug-In for Office.
For information about instsalling, see "Steps to install." →P.308

Enabling Print Plug-In for Office for items disabled in Office applications

• If a problem occurs, such as the system or an application terminating abnormally, the Microsoft Office application
disables add-ins as a safety precaution.

In this event, you will need to restore the disabled add-ins in order to display the imagePROGRAF Print Plug-In toolbar/
ribbon.
Use the procedure below to restore the add-ins disabled by Microsoft Office.
 

For Microsoft Office 2010

1. Select Options from the File menu.

2. From the list on the left side of the <application name> options dialog box, select Add-ins.
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3. Select Disabled Items in the Manage combo box and click the Go button.

4. If Addin imageprograf print plug-in (ipfaddinif.dll) is displayed in the Disabled Items dialog box, select it and
click the Enable button.

5. Close all the dialog boxes and restart the Office application.
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For Microsoft Office 2007

1. Click the Office button and then click the <application name> options button.

2. From the list on the left side of the <application name> options dialog box, select Add-ins.

3. Select Disabled Items in the Manage combo box and click the Go button.
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4. If Addin imageprograf print plug-in (ipfaddinif.dll) is displayed in the Disabled Items dialog box, select it and
click the Enable button.

5. Close all the dialog boxes and restart the Office application.

For Microsoft Office 2003

1. Click About <application name> in the Help menu of application.
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2. Click the Disabled Items button in the About <application name> dialog box.

3. If Addin imageprograf print plug-in (ipfaddinif.dll) is displayed in the Disabled Items dialog box, select it and
click the Enable button.

4. Close all the dialog boxes and restart the Office application.

To start from Microsoft Word
Below are the steps to start Print Plug-In for Office from Microsoft Word.

1. Start Microsoft Word.
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2. If Start imagePROGRAF Print Plug-In is displayed on the toolbar/ribbon, click it.

Important
• If the imagePROGRAF Print Plug-In toolbar/ribbon is not displayed, refer to the following.

• When Print Plug-In for Office is not displayed →P.312

3. Check that the imagePROGRAF Print Plug-In toolbar/ribbon is displayed.

4. Click the buttons on the toolbar/ribbon according to the items you want to set.

Icon Contents

Menu

Displays the About, Help, and Special Settings dialog boxes.
You can change the settings using the Special Settings dialog box.
Refer to Configuring Special Settings →P.358  for details.

Printer list

Select Printer.
If you select Show All Printers, the imagePROGRAF printers will be displayed
again. Select this when you want to display all printer drivers or update the display.

Print Button

The print Wizard is displayed.
The settings Print Matching Roll Width, Borderless Printing, Multi-Page
Printing, and Print Using Registered Settings can be set.

Paper Settings Button

Large-Format Wizard is displayed.
Settings for Portrait or Landscape Orientation can be set.
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Printing Wizard dialog box

Important
• If you want to change the display to another file or application while the Printing Wizard is open, close the

Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate the toolbar.

Large-Format Printing Wizard dialog box
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Important
• If you want to change the display to another file or application while the Large-Format Printing Wizard is

open, close the Large-Format Printing Wizard dialog box. Otherwise, you may not be able to change dis-
plays or operate the toolbar/ribbon.

• The layout may collapse if you create a form using existing data. If that is the case, modify the data again.

Print Matching Roll Width (Word)
Prints to the edge of the roll width. You can print large exhibits and posters, and also print Portrait and Landscape orienta-
tions made in Large-Format Printing Wizard.

1. Start Microsoft Word.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Printing Wizard is open,

close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.
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4. Click Print Matching Roll Width.

5. Select Roll Paper Width that is set in the printer.

6. Select image size.

7. Select layout.

8. Select Next.
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9. Select Media Type.

10. Select Print Range from All Pages, Current Page, and Pages.
If Pages is selected, enter the number of pages.

11. Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.
• The settings are registered when the One-Touch Registration is pressed. This is convenient if you to

need print multiple times using the same setting.
• Press the Print Preview button to display the preview screen. You can check and make changes to

the layout in the preview screen.
• When you print to the edge of the roll width, the maximum length will be the lesser of 5.587 times the

roll paper width, or 18.0m.

12. Press Print to start printing.

Borderless Printing (Word)
Prints up to the border of the media. Photos and posters can be printed without worrying about margins.

1. Start Microsoft Word.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.
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3. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Printing Wizard is open,

close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.

4. Click Borderless Printing.
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5. A confirmation dialog box is displayed. If the data fills up the page, confirm that Continue using the plug-in is
selected in Choose how to proceed and press OK.

Note
• To adjust the data, select Return to application and press OK. Exit Print Plug-In for Office and

return to the application.

6. Select Roll Paper Width that is set in the printer.

7. Select Layout.

Windows Software > Print Plug-In for Office >

Borderless Printing (Word) iPF825

4

324



8. Select Next.

9. Select Media Type.

10. Select Print Range from All Pages, Current Page, and Pages.
For Pages, insert the page number.

11. Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.
• Press the One-Touch Registration button to register the settings. This is useful for multiple printing

using the same settings.
• Press the Print Preview button to display the preview screen. You can confirm and make changes to

the layout in the preview screen.
• The maximum length for Borderless Printing is the lesser of 5.587 times the roll paper width, or

18.0m.

12. Press Print to start printing.

Multi-Page Printing (Word)
Prints multiple pages as one page. You can print handouts into a single page, or print matter with many pages.

1. Start Microsoft Word.

Windows Software > Print Plug-In for Office >

iPF825 Multi-Page Printing (Word)

4

325



2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Printing Wizard is open,

close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.
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4. Click Multi-Page Printing.

5. Select the Roll Paper Width that is set in the printer.

6. Select layout from Layout Selection.

7. Select Next.

8. Select Media Type.
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9. Select Print Range from All Pages, Current Page, and Pages.
If Pages is selected, enter the number of pages.

10. Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.
• The settings are registered when the One-Touch Registration is pressed. This is convenient if you to

need print multiple times using the same setting.
• Press the Print Preview button to display the preview screen. You can check and make changes to

the layout in the preview screen.
• The maximum length for Multi-Page Printing is the lesser of 5.587 times the roll paper width, or

18.0m.

11. Press Print to start printing.

Register the settings(Word)
If you are going to print multiple times using the same setting, you can select One-Touch Registration. Registered settings
can be recalled from Print Using Registered Settings.

1. Set up to the Print screen from Print Matching Roll Width, Borderless Printing or Multi-Page Printing of
Printing Menu.

Note
• Up to 20 items can be registered.
• The available settings are as follows.

• Print Matching Roll Width (Word) →P.320

• Borderless Printing (Word) →P.322

• Multi-Page Printing (Word) →P.325

2. Click the One-Touch Registration button.
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3. Enter name in Name.
Up to 31 characters can be entered.

4. Click . The name you entered is displayed in Registered Settings.

5. Click OK, and return to the Print screen.

6. Click Print to print, and click Cancel to cancel the print.

Note
• Clicking Cancel in the Print screen will not delete the registered settings.

Print Using Registered Settings (Word)
Prints using the registered settings.

1. Start Microsoft Word.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.
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Important
• If you want to change the display to another file or application while the Printing Wizard is open,

close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.

4. Click Print Using Registered Settings.

5. Click the Next button.

6. Select Media Type.
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7. Select Print Range from All Pages, Current Page, or Pages.
If Pages is selected, enter the number of pages.

8. Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.
• Press the Print Preview button to display the preview screen. You can check and make changes to

the layout in the preview screen.
• The maximum print length when printing with the registered settings is the lesser of 5.587 times the

roll paper width, or 18.0m.

9. Press Print to start printing.

Portrait Orientation / Landscape Orientation (Word)
Print to the edge of the roll width. You can print large exhibits and posters, or print the Landscape or Portrait Orientation
Page Sizes made in the Large-Format Printing Wizard.

Create Page Size in Portrait or Landscape Orientation.
Use the Large-Format Printing Wizard to create portrait page sizes for Potrait Orientation, and landscape page sizes for
Landscape Orientation.

1. Start Microsoft Word.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3. Click Paper Settings from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Large-Format Printing Wizard dialog box is displayed.

Note
• If you want to change the display to another file or application while the Large-Format Printing

Wizard is open, close the Large-Format Printing Wizard dialog box. Otherwise, you may not be
able to change displays or operate the toolbar/ribbon.
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4. Click Portrait Orientation or Landscape Orientation.

Note
• The steps taken to create a Portrait Page Size will be used as an example to explain the procedure.

5. Adjust Length from the list-box or slide-bar.

6. Click the Create Page button.
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7. Click OK if the message is displayed.

8. Edit and create the document.

Note
• Printing is done in Print Matching Roll Width of the Printing Wizard. For details on Print Match-

ing Roll Width, refer to see "Print Matching Roll Width (Word)." →P.320 .

Important
• The layout may collapse if you create a form using existing data. If that is the case, modify the data again.

To start from Microsoft PowerPoint
Below are the steps to start Print Plug-In for Office from Microsoft PowerPoint.

1. Start Microsoft PowerPoint.

2. If Start imagePROGRAF Print Plug-In is displayed on the toolbar/ribbon, click it.

Important
• If the imagePROGRAF Print Plug-In toolbar/ribbon is not displayed, refer to the following.

• When Print Plug-In for Office is not displayed →P.312

3. Check that the imagePROGRAF Print Plug-In toolbar/ribbon is displayed.
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4. Click the buttons on the toolbar/ribbon according to the items you want to set.

Icon Contents

Menu

Displays the About, Help, and Special Settings dialog boxes.  (See "Configuring
Special Settings.") →P.358

Printer list

Select Printer.
If you select Show All Printers, the imagePROGRAF printers will be displayed
again. Select this when you want to display all printer drivers or update the display.

Print Button

The print Wizard is displayed.
The settings Print Matching Roll Width, Borderless Printing, Multi-Page
Printing, and Print Using Registered Settings can be set.

Paper Settings Button

Large-Format Wizard is displayed.
Settings for Portrait or Landscape Orientation can be set.

Printing Wizard dialog box

Important
• If you want to change the display to another file or application while the Printing Wizard is open, close the

Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate the toolbar/rib-
bon.

Note
• If you open a password protected document as read-only, the Printing Wizard cannot be run.
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Large-Format Printing Wizard dialog box

Important
• If you want to change the display to another file or application while the Large-Format Printing Wizard is

open, close the Large-Format Printing Wizard dialog box. Otherwise, you may not be able to change dis-
plays or operate the toolbar/ribbon.

• The layout may collapse if you create a form using existing data. If that is the case, modify the data again.

Note
• If you open a password protected document as read-only, the Large-Format Printing Wizard cannot be

run. Remove the password protection.

Print Matching Roll Width (PowerPoint)
Prints to the edge of the roll width. You can print large exhibits and posters, and also print Portrait and Landscape orienta-
tions made in Large-Format Printing Wizard.

1. Start Microsoft PowerPoint.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.
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3. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Printing Wizard is open,

close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.

4. Click Print Matching Roll Width.

5. Select Roll Paper Width that is set in the printer.
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6. Select image size.

7. Select layout.

8. Select Next.

9. Select Media Type.

10. Select Print Range from All Slides, Current Slide, and Slides.
If Slides is selected, enter the slide number.

11. Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.
• The settings are registered when the One-Touch Registration is pressed. This is convenient if you to

need print multiple times using the same setting.
• Press the Print Preview button to display the preview screen. You can check and make changes to

the layout in the preview screen.
• When you print to the edge of the roll width, the maximum length will be the lesser of 14.22 times the

roll paper width, or 18.0m.

12. Press Print to start printing.

Windows Software > Print Plug-In for Office >

iPF825 Print Matching Roll Width (PowerPoint)

4

337



Borderless Printing (PowerPoint)
Prints up to the border of the media. Photos and posters can be printed without worrying about margins.

1. Start Microsoft PowerPoint.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Printing Wizard is open,

close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.
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4. Click Borderless Printing.

5. A confirmation dialog box is displayed. If the data fills up the page, confirm that Continue using the plug-in is
selected in Choose how to proceed and press OK.

Note
• To adjust the data, select Return to application and press OK. Exit Print Plug-In for Office and

return to the application.

6. Select Roll Paper Width that is set in the printer.

7. Select Layout.
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8. Select Next.

9. Select Media Type.

10. Select Print Range from All Slides, Current Slide, and Slides.
If Slides is selected, enter the slide number.

11. Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.
• Press the One-Touch Registration button to register the settings. This is useful for multiple printing

using the same settings.
• Press the Print Preview button to display the preview screen. You can confirm and make changes to

the layout in the preview screen.
• The maximum length for Borderless Printing is the lesser of 14.22 times the roll paper width, or

18.0m.

12. Press Print to start printing.

Multi-Page Printing (PowerPoint)
Prints multiple pages as one page. You can print handouts into a single page, or print matter with many pages.

1. Start Microsoft PowerPoint.
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2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Printing Wizard is open,

close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.
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4. Click Multi-Page Printing.

5. Select the Roll Paper Width that is set in the printer.

6. Select layout from Layout Selection.

7. Select Next.

8. Select Media Type.
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9. Select Print Range from All Slides, Current Slide, and Slides.
If Slides is selected, enter the slide number.

10. Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.
• The settings are registered when the One-Touch Registration is pressed. This is convenient if you to

need print multiple times using the same setting.
• Press the Print Preview button to display the preview screen. You can check and make changes to

the layout in the preview screen.
• The maximum length for Multi-Page Printing is the lesser of 14.22 times the roll paper width, or

18.0m.

11. Press Print to start printing.

Register the settings(PowerPoint)
If you are going to print multiple times using the same setting, you can select One-Touch Registration. Registered settings
can be recalled from Print Using Registered Settings.

1. Set up to the Print screen from Print Matching Roll Width, Borderless Printing or Multi-Page Printing of
Printing Menu.

Note
• Up to 20 items can be registered.
• The available settings are as follows.

• Print Matching Roll Width (PowerPoint) →P.335

• Borderless Printing (PowerPoint) →P.338

• Multi-Page Printing (PowerPoint) →P.340

2. Click the One-Touch Registration button.
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3. Enter name in Name.
Up to 31 characters can be entered.

4. Click . The name you entered is displayed in Registered Settings.

5. Click OK, and return to the Print screen.

6. Click Print to print, and click Cancel to cancel the print.

Note
• Clicking Cancel in the Print screen will not delete the registered settings.

Print Using Registered Settings (PowerPoint)
Prints using the registered settings.

1. Start Microsoft PowerPoint.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.
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Important
• If you want to change the display to another file or application while the Printing Wizard is open,

close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.

4. Click Print Using Registered Settings.

5. Click the Next button.

6. Select Media Type.
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7. Select Print Range from All Slides, Current Slide, and Slides.
If Slides is selected, enter the slide number.

8. Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.
• Press the Print Preview button to display the preview screen. You can check and make changes to

the layout in the preview screen.
• The maximum print length when printing with the registered settings is the lesser of 14.22 times the

roll paper width, or 18.0m.

9. Press Print to start printing.

Portrait Orientation / Landscape Orientation (PowerPoint)
Print to the edge of the roll width. You can print large exhibits and posters, or print the Landscape or Portrait Orientation
Page Sizes made in the Large-Format Printing Wizard.

Create Page Size in Portrait or Landscape Orientation.
Use the Large-Format Printing Wizard to create portrait page sizes for Potrait Orientation, and landscape page sizes for
Landscape Orientation.

1. Start Microsoft PowerPoint.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.
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3. Click Paper Settings from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Large-Format Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Large-Format Printing

Wizard is open, close the Large-Format Printing Wizard dialog box. Otherwise, you may not be
able to change displays or operate the toolbar/ribbon.

4. Click Portrait Orientation or Landscape Orientation.

Note
• The steps taken to create a Portrait Page Size will be used as an example to explain the procedure.
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5. Adjust Length from the list-box or slide-bar.

6. Click the Create Page button.

7. Click OK if the message is displayed.

8. Edit and create the document.

Important
• The layout may collapse if you create a form using existing data. If that is the case, modify the data

again.

Note
• Printing is done in Print Matching Roll Width of the Printing Wizard. For details on Print Match-

ing Roll Width, refer to see "Print Matching Roll Width (PowerPoint)." →P.335 .
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To start from Microsoft Excel
Below are the steps to start Print Plug-In for Office from Microsoft Excel.

1. Start Microsoft Excel.

2. If Start imagePROGRAF Print Plug-In is displayed on the toolbar/ribbon, click it.

Important
• If the imagePROGRAF Print Plug-In toolbar/ribbon is not displayed, refer to the following.

• When Print Plug-In for Office is not displayed →P.312

3. Check that the imagePROGRAF Print Plug-In toolbar/ribbon is displayed.

4. Click the buttons on the toolbar/ribbon according to the items you want to set.

Icon Contents

Menu

Displays the About, Help, and Special Settings dialog boxes.  (See "Configuring
Special Settings.") →P.358

Printer list

Select Printer.
If you select Show All Printers, the imagePROGRAF printers will be displayed
again. Select this when you want to display all printer drivers or update the display.

Print Button

The print Wizard is displayed.
The settings Print Entire Sheet and Print Selected Area can be set.
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Printing Wizard dialog box

Important
• If you want to change the display to another file or application while the Printing Wizard is open, close the

Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate the toolbar/rib-
bon.

• The Printing Wizard will not start if you click the Print button on the toolbar/ribbon while editing a cell.
• When more than one worksheet is selected, the Printing Wizard cannot be run. Select only one worksheet

and click Print again.
• When an object is selected, the Printing Wizard is not started if you click the Print button on the toolbar/

ribbon.
• If the paper size in Excel is blank, the Printing Wizard cannot be run. From the File menu in Excel, select

Page Setup and check Paper size.

Note
• If you click the Print button with a graph selected, a message dialog box will appear asking if you want to

continue printing. If you click No, you will return to the application.
• If you click the Print button with a page break set, a message dialog box will appear asking if you want to

continue printing. If you click No, you will return to the application. If you do not use the set page break,
check the page break preview and change the setting.

• If you click the Print button with a page range set, a message dialog box will appear asking if you want to
continue printing. If you click No, you will return to the application. If you do not use the set page range,
check the page break preview and change the setting.

• If you click the Print button with a worksheet or cell protected, a message dialog box will appear asking if
you want to continue printing. If you click No, you will return to the application. If you want to change the
setting, remove the protection from the worksheet or cell.
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Print Entire Sheet (Excel)
For resizing the entire sheet to fit the roll width. Choose this option to enlarge the currently displayed sheet before printing.

1. Start Microsoft Excel.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.

Important
• When more than one worksheet is selected, the Printing Wizard cannot be run. Select only one

worksheet and click Print again.

If a print area is set, a confirmation message dialog box will appear.
To print the entire sheet, cancel the setting of the print area.

The Printing Wizard dialog box is displayed.
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4. Click Print Entire Sheet.
A message will appear informing you that analysis is in progress.

The Layout menu will appear automatically.

Note
• If data analysis requires time, a message dialog will appear. If you select No, you will return to the

application.

5. Select Roll Paper Width that is set in the printer.
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6. Select image size.

7. Select layout.

8. To configure Binding, click the Binding Settings button.
Refer to Configuring Binding (Excel) →P.357  for details on the procedure for configuring Binding.

9. Select Next.

10. Select Media Type.

11. Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.
• Press the Print Preview button to display the preview screen. You can check and make changes to

the layout in the preview screen.
• When you print to the edge of the roll width, the maximum print length is 18.0m.

12. If the upper and lower margins are too wide, check No Spaces at Top or Bottom (Conserve Paper).
The upper and lower margins can be checked in Print Preview.

13. Press Print to start printing.

Important
• If divided into plural pages, try reducing the data size or the range you select.
• You cannot run Print or Print Preview if you select it for a worksheet with no data displayed.
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Print Selected Area (Excel)
For resizing the selected range of cells to fit the roll width. Choose this option to enlarge a particular part of the sheet before
printing.

1. Start Microsoft Excel.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.

Important
• When more than one worksheet is selected, the Printing Wizard cannot be run. Select only one

worksheet and click Print again.

If a print area is set, a confirmation message dialog box will appear.
To print the selected area, cancel the setting of the print area.

The Printing Wizard dialog box is displayed.
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4. Click Print Selected Area.

Important
• If only one cell is selected, Print Selected Area cannot be selected.

A message will appear informing you that analysis is in progress.

The Layout menu will appear automatically.

Important
• If the range selected in Excel 2007/2010 is too large, it will not be possible to analyze the data. Select

a smaller range and then run the analysis.
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Note
• If data analysis requires time, a message dialog will appear. If you select No, you will return to the

application.

5. Select Roll Paper Width that is set in the printer.

6. Select image size.

7. Select layout.

8. To configure Binding, click the Binding Settings button.
Refer to Configuring Binding (Excel) →P.357  for details on the procedure for configuring Binding.

9. Select Next.

10. Select Media Type.

11. Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.
• Press the Print Preview button to display the preview screen. You can check and make changes to

the layout in the preview screen.
• When you print to the edge of the roll width, the maximum print length is 18.0m.

12. If the upper and lower margins are too wide, check No Spaces at Top or Bottom (Conserve Paper).
The upper and lower margins can be checked in Print Preview.
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13. Press Print to start printing.

Important
• If divided into plural pages, try reducing the data size or the range you select.
• You cannot run Print or Print Preview if you select it for a worksheet with no data displayed.

Configuring Binding (Excel)
You can configure Binding margins for binding printouts.

1. Configure the settings up to Layout Selection in the Layout screen in Print Entire Sheet or Print Selected Area.
Refer to Print Entire Sheet (Excel) →P.351  and Print Selected Area (Excel) →P.354  for the configuration
methods.

2. Click the Binding Settings button.

Important
• You cannot click the Binding Settings button in the following situations.

• When the Image Size is set to 100%
• When a graph is selected
• When page breaks have been set
• When a sheet or cell is protected

Open the Binding Settings dialog box.

3. If the Binding checkbox is not checked, select it to turn binding on.

4. Select Binding Edge.

5. Select Binding Margin.

Windows Software > Print Plug-In for Office >

iPF825 Configuring Binding (Excel)

4

357



6. Click the OK button.
Return to the Layout screen.

Check that the Binding settings are applied in the preview screen.

7. Configure the settings in the Printing Wizard dialog box.

Configuring Special Settings
You can configure Special Settings from the imagePROGRAF Print Plug-In toolbar.

1. Click imagePROGRAF in the toolbar, and select Special Settings.

2. Turn the checkbox for the item you want to change on or off.

Item Details

Show progress indicator during plug-in
startup

When this setting is off, hides the progress indicator that appears while
the plug-in is starting up.

Center sheets and print areas When this setting is off, printing is performed without changing the
position. When this setting is on, printing is performed with the top,
bottom, left, and right margins layed out equally. When this setting is
off, printing is performed without changing the position.
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Item Details
Center sheets and print areas This function is only valid in Microsoft Excel.

Ensure image quality when creating page
sizes

When this setting is on, documents are created at the maximum size.
This reduces the enlargement ratio during actual printing, which mini-
mizes degradation of the quality of photos, etc.
This function is only valid in [ Microsoft PowerPoint.

Correct the print area when analyzing For data that cannot be processed with usual data analysis, the print
area is corrected and then the data is processed. When data analysis
fails, you may be able to print by turning on this checkbox.
This function is only valid in Microsoft Excel.

3. Click OK to close the Special Settings dialog box.
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The Features of HDI Driver
The main features of HDI Driver are as follows.

• A special HDI (Heidi Device Interface) compatible printer driver for the Autodesk, Inc. software applications for Auto-
CAD and AutoCAD LT architecture (hereafter referred to together as "AutoCAD").

• You can set up the print job with the most appropriate settings for the media and print clear, sharp printouts of plans
and diagrams created with AutoCAD.

Operating Environment
The HDI driver operating environment is as follows.

• Compatible Operating System
Windows XP, Windows Vista, Windows 7

• Compatible AutoCAD Version
AutoCAD 2005, AutoCAD LT2005, AutoCAD 2006, AutoCAD LT2006,
AutoCAD 2007, AutoCAD LT2007, DWG TrueView 2007, AutoCAD 2008, AutoCAD LT2008, DWG TrueView
2008,
AutoCAD 2009, AutoCAD LT2009, DWG TrueView 2009, AutoCAD 2010, AutoCAD LT2010, DWG TrueView
2010,
AutoCAD 2011, AutoCAD LT2011, DWG TrueView 2011,
AutoCAD 2008(x64), DWG TrueView 2008(x64), AutoCAD 2009(x64), AutoCAD LT2009(x64), DWG TrueView
2009(x64),
AutoCAD 2010(x64), AutoCAD LT2010(x64), DWG TrueView 2010(x64)
AutoCAD 2011(x64), AutoCAD LT2011(x64), DWG TrueView 2011(x64)

Note
• The supported OS version differs for each version of AutoCAD. Check with Autodesk for details.
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Installation Procedure
There are two ways to install the HDI driver.

• Installing with the Canon Installer →P.361

• Installing with the Add-A-Plotter Wizard →P.368

Installing with the Canon Installer
The Canon installer opens and displays as soon as you start the User Software CD-ROM provided with the printer. Follow
the procedure below to perform the installation from this screen.

1. Mount the User Software CD-ROM in the CD-ROM drive and start the Canon installer.

Note
• If the Canon installer screen does not appear, double-click the CD-ROM icon from the My Comput-

er to open the installer screen.

2. Select Install Individual Software in the Canon installer Setup Menu.
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The Installation List appears. Click the Install button of the imagePROGRAF HDI Driver.

The driver setup screen appears. Click the Next button.
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3. After you have read the Licensing Agreement, select I accept the terms of the license agreement and click the
Next button.

4. Confirm that the installed AutoCAD is compatible with your computer environment. Click the OK button.

Note
• Confirm that the installed AutoCAD is compatible with your computer environment.

5. The Ready to Install the Program screen opens. Click the Install button.
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6. The HDI driver files are copied to the Drv folder where the AutoCAD program files are stored.
Click the Finish button. This completes the setup of the HDI driver.

7. After AutoCAD starts, select Plotter Manager from the File menu.
The Plotters window opens. Click the Add-A-Plotter Wizard icon.
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8. The Add Plotter - Introduction Page screen opens. Check the displayed screen and then click the Nextbutton.

Note
• To open the Add-A-Plotter Wizard you can also click Start > Control Panel > Autodesk Plotter

Manager > and then double-click the Plotter Wizard icon in the Plotters window.

9. Add Plotter - Begin screen opens. Select My Computer then click the Next button.
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10. The Add Plotter - Plotter Model screen opens.
Make sure that Canon Inc. is selected in the list of Manufacturers, and for the Models select the name of the print-
er that you want to install then click the Next button.

11. The Add Plotter - Import Pcp or Pc2 screen opens. Click the Next button.

Note
• If you want the installer to read plotter information from previously stored PCP or PC2 files, click the

Import File button.
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12. The Add Plotter - Ports screen opens.
Make sure that Plot to a port is selected, select the port that you want to use for the plotter, then click the Next
button.

Note
• In the Add Plotter - Ports screen, it is recommended to select Network Port. If you select Local

Port, the AutoCAD warning message may appear when printing.

13. The Add Plotter - Plotter Name screen opens. Click the Next button.

Note
• You can change the Plotter Name setting here, but you will normally leave it as it is and go to Step

14.
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14. The Add Plotter - Finish screen opens. Click the Finish button.
This completes the installation of the HDI driver.

15. Clicking the Finish button closes the Installation List and Setup Menu and ejects the User Software CD-ROM
from the CD-ROM drive.

Installing with the Add-A-Plotter Wizard
Follow the procedure below to use the Add-A-Plotter Wizard to install the HDI driver without the Canon installer.

1. After AutoCAD starts, select Plotter Manager from the File menu.
The Plotters window opens. Click the Add-A-Plotter Wizard icon.
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2. The Add Plotter - Introduction Page screen opens. Check the displayed screen and then click the Next button.

Note
• To open the Add-A-Plotter Wizard you can also click Start > Control Panel > Autodesk Plotter

Manager > and then click the Add-A-Plotter Wizard icon in the Plotters window.

3. The Add Plotter - Begin screen opens. Select My Computer then click the Next button.

4. The Add Plotter - Plotter Model screen opens. Mount the User Software CD-ROM in the CD-ROM drive.
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5. On the Add Plotter - Plotter Model screen, click the Have Disk button.

6. The Open dialog box opens. From the Look in box, select the CD-ROM drive, and then browse to the folder that
holds the hif file.
Select the hif file then click the Open button.

Note
• The hif format file is contained in the following folder.

\HDI Driver\English\2007 (AutoCAD Version 2007)
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7. The display returns to the Add Plotter - Plotter model screen.
Select Canon Inc. from the list of Manufacturers, select the name of the printer for Models, and then click the
Next button.

8. The Add Plotter - Import Pcp or Pc2 screen opens. Click the Next button.

Note
• If you want the installer to read plotter information from previously stored PCP or PC2 files, click the

Import File button.
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9. The Add Plotter - Ports screen opens.
Make sure that Plot to a port is selected, select the port that you want to use for the plotter, then click the
Nextbutton.

Note
• In the Add Plotter - Ports screen, it is recommended to select Network Port. If you select Local

Port, the AutoCAD warning message may appear when printing.

10. The Add Plotter - Plotter Name screen opens. Click the Nextbutton.

Note
• You can change the Plotter Name setting here, but you will normally leave it as it is and go to Step

11.
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11. The Add Plotter - Finish screen opens. Click the Finish button.
This completes the installation of the HDI driver.

12. Remove the User Software CD-ROM from the CD-ROM drive.

Opening the Plotter Configuration Dialog Box
You can open the Plotter Configuration Editor dialog box by two ways.

• Opening from the AutoCAD File Menu →P.374

• Opening from the Start Menu →P.375
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Opening from the AutoCAD File Menu
Follow the procedure below to open the Plotter Configuration Editor dialog box from the AutoCAD File menu.

1. Select Plot from the AutoCAD File menu. The Plot dialog box opens.
Check the Name setting under Printer/plotter and confirm that iPFxxxx.pc3 (the name of the printer you use) is
displayed.
Click the Properties button.

Note
• If any other printer name is selected, select the name of the printer that you want to use from the

Name list.
• The names of the printers installed when the HDI driver was installed are in the Name list.
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2. The Plotter Configuration Editor dialog box opens.

Opening from the Start Menu
Follow the procedure below to open the Plotter Configuration Editor dialog box from the Start menu.

1. Click the Start button then select Control Panel.
The Control Panel window opens.
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2. Double-click the Autodesk Plotter Manager icon.
The Plotters window opens.
Double-click the iPFxxxx.pc3 icon (the icon name is the name of the printer you use) to open.

3. The Plotter Configuration Editor dialog box opens.
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Plotter Configuration Editor Dialog Box
The Plotter Configuration Editor dialog box has three sheets.
The Plotter Configuration Editor dialog box display can be manipulated by selecting the items on these sheets or in the
Explorer tree.

Note
• For more details about the General sheet and the Ports sheet, please refer to the AutoCAD manual.

Device and Document Settings Sheet
Use this sheet to perform the main printing settings. The settings for each item are shown in a tree structure on this sheet.
When you select an item the screen display changes so you make changes for the resolution and other graphic settings, the
media type, the color matching and Custom Properties settings, the drying time and the roll paper margin for safety and
other detailed media settings.

The available settings are as follows.

• Media Source and Media Size Settings →P.378

• Graphics Settings →P.379

• Custom Properties dialog box →P.384
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Media Source and Media Size Settings
Follow this procedure to select the media source and the media size.

1. Press the Source and Size below Media.
The Device and Document Settings sheet opens and switches to the display that presents the media source and size
settings.

2. From the Source list, select the media source.

3. From the Size list, select the media size.

Note
• When you change the Source setting, the Size setting returns automatically to its default settings. Ev-

ery time you adjust the Source setting, you should also re-adjust the Size setting.

4. Click the OK button.
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Graphics Settings
You can perform the graphics settings.

Vector Graphics settings
Use these settings to adjust the print mode and resolution.

1. Click the Vector Graphics below Graphics.
The Device and Document Settings sheet opens and switches to the Vector Graphics settings.

2. Select Color or Monochrome.

3. Select a setting for Color Depth from the list.
Color Depth presents the following items for selection.

Setting Details

Color 16777216（24-bit）colors

Monochrome 16777216-Level grayscale
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4. Move the Res slider to adjust the settings.
Res presents the following items for selection.

Setting Details

300 DPI Due to this low resolution, the image will print faster but its texture will appear
rough.

600 DPI This high resolution will achieve the best results.

5. Select Dithering.

Setting Details

Hardware Dithering Perform dithering on the printer.

6. Click the OK button.

Raster Graphics settings
PUse these settings to adjust the balance between the print quality, memory consumption, and the print speed of raster
graphics.

1. Click the Raster Graphics below Graphics.
The Device and Document Settings sheet opens and switches to the Raster Graphic settings.
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2. Move the slider for each item to the left or right to adjust the settings.

Setting Details

Raster and Shaded/Rendered
Viewports

Use these settings to adjust the balance between print quality, memory consump-
tion, and the print speed. If set to None, you cannot print raster images. Printing
time will take longer the higher you set the Best setting.

OLE Use these settings to adjust the balance between print quality, memory consump-
tion and the print speed when printing a OLE object. If set to None, you cannot
print OLE objects. Printing time will take longer the higher you set the Best set-
ting.

Trade-off Use these settings to lower the print quality by a certain degree if the print job can-
not be completed at the best quality.

3. Click the OK button.

Merge Control Settings
Use thse settings to merge intersecting lines.

1. Click the Merge Control below Graphics.
The Device and Document Settings sheet opens and switches to the Merge Control settings.

Setting Details

Lines Overwrite Where the lines intersect, the line that is printed last is visible, but the lines below it
are not visible.
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Setting Details

Lines Merge Where the lines intersect, the line colors merge.

2. Click the OK button.

Opening the Custom Properties Dialog Box
Follow the procedure below to open the Custom Properties dialog box.

1. In the Plotter Configuration Editor dialog box, select and open the Device and Document Settings sheet.

Note
• For more details about how to open the Plotter Configuration Editor dialog box, see "Opening the

Plotter Configuration Dialog Box." →P.373 .

2. Click Custom Properties.

3. The Device and Document Settings sheet opens and switches to the display that presents the custom properties set-
tings.
Click the Custom Properties button.
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4. The Custom Properties dialog box opens.
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Custom Properties dialog box
You can perform the settings for the media type, color matching, brightness, and other settings.

Media Type
This allows you to select the media type.

Note
• Always select media type that is actually set in the printer. When the media you chose is different from the

media set in the printer, you may not receive the desired print results.

Print Priority
Select a print quality to suit the print job.

Setting Details

Image This mode achieves the best results for printing photographic images and illustra-
tions.

Line Drawing This mode is best for printing CAD drawings with fine lines or wall newssheet or
other documents that contain large amounts of text. However, you may not achieve
the quality you expect with printing photographs or other images with many filled
areas. For these types of jobs, select Image.

Note
• The number of settings available for selection depends on the media type.

Windows Software > HDI Driver >

Custom Properties dialog box iPF825

4

384



Print Quality
Select a print quality to suit the print job.

Setting Details

Highest Gives priority to the highest possible image quality.

High Prints images of high quality.

Standard Balances quality with the need for faster printing.

Draft Gives priority to high speed printing.

Note
• The availability of settings is determined by the media type and print priority selections.

Color Mode
You can select a color mode to suit the print job.

Setting Details

Color Enables color printing.

Monochrome Disables color printing and converts image from continuous color to grayscaled
monochrome.

Color (CAD) Prints lines in the best color possible so they are easy to see.

Monochrome (BK ink) Select to print all lines with black ink.

Note
• The availability of settings depends on the print priority and media type selections.

Color Matching
You can select a color matching to suit the print job.

Setting Details

Perceptual This item does color matching with priority on color tones to reproduce the best
results in printing photographic images.

Colorimetric This item places priority on reducing the differences between the color tones you
seen on the computer screen and those you see in the printout, so the printout more
closely resemble the colors of the original.

Saturation This item does color matching with priority on saturation.

None Color matching is not performed.

Note
• Color Matching is available for selection only when Color is selected for Color Mode.

Brightness
Adjust Brightness to achieve the best level of brightness in printed line drawings.
Drag slide bar left and right to adjust the level of brightness.
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Adj. Pale Color Recognizable
When you place a checkmark here, yellow or cyan lines or other portions of images that are difficult to see when printed in
white space can become easier to see.

Economy Printing
You can reduce the amount of ink consumed for printing by placing a checkmark here.

Increase image print speed (AutoCAD2011 only)
When you print with the resolution configured to 600dpi, you can print data including raster images even faster.
However, image quality may deteriorate if high-resolution raster images are included. Remove the check in this case.

Output Method Button
Click the button to open the Output Method dialog box and you can specify the output method for HDI Driver.
For more information about the output method, see "Output Method Dialog Box." →P.388

Color Compatibility button
Click the button to open the Color Compatibility dialog box, and you can set color for when Color (CAD) is selected in
Color Mode.
For more information on setting color compatibility, see "Color Compatibility Dialog Box." →P.388

Paper Detailed Settings
To open the Paper Detailed Settings dialog box, click Settings button of the Media Type in the Custom Properties dia-
log box. You can perform the settings for ink drying time of each media and other features.
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Note
• The settings in the Paper Detailed Settings dialog box are temporary; after the print job finishes the settings

of the printer operation panel are restored.

Drying Time
Between Pages
This sets the wait time for the ink to dry between each completely printed sheet and the output of the sheet.

Setting Details

Printer Default The settings of the printer operating panel are applied.

None The paper is ejected immediately after printing.

30sec. / 1min. / 3min. / 5min. /
10min. / 30min. / 60min.

The sheet is ejected when the specified time after printing has elapsed.

Between Scans
This sets the wait time between line scans during printing.

Setting Details

Printer Default The settings of the printer operating panel are applied.

None The printing continues to the next line immediately after the last line.

1sec. / 3sec. / 5sec. / 7sec. / 9sec. The printing continues to the next line after the set time.
 

*For the media type that has problems, such as ink smears on the page or colors
that seem uneven during borderless printing etc., increase the value for this setting.

Roll Paper Margin for Safety
Near End Margin
This sets the length of the near end margin of the roll paper.

Setting Details

Printer Default The settings of the printer operating panel are applied.

3mm Print at a standard size.
 

*Select for Media Type that has no problem when printing with a standard size
margin.

20mm This setting sets the margin about 17 mm (in the feed direction) longer than the
standard margin for the media size.
 

*This is for Media Type that has a strong tendency to curl, causing the printhead to
scratch the surface.
 

Important
• If you make the margin (white space) too small, this could disturb the print image or cause the printhead to

scour the surface of some types of media. If the printhead scours the surface of the media, adjust the height of
the printhead.

Cut Speed
This selects the auto cut speed.
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Setting Details

Printer Default The settings of the printer operating panel are applied.

Fast Select this setting if cutting with the Standard setting is not clean.

Standard Select this setting when you are not experiencing problems.

Slow Select this setting if cutting with the Standard setting is not clean.

Output Method Dialog Box
Output Method dialog box appears when you click Output Method button on the Main sheet in the Custom Properties
dialog box. You can specify the output method for HDI Driver.

Setting Details

Print Normal printing. The print job data is stored temporarily in the box as the job prints

Save in mail box The print data is saved in the mail box on the HDD without printing.
Sets the number of the destination mail box for saving. The name of the data to be
saved is displayed.

Color Compatibility Dialog Box
Color Compatibility dialog box appears when you click the Color Compatibility button on the Main sheet in the Custom
Properties dialog box. You can set color for when Color (CAD) is selected in Color Mode.
You can print with color approximating the specified model by selecting Color Compatibility for printing.

Note
• Color (CAD) is displayed by selecting the Main sheet, and then Line Drawing/Text in Print Priority.
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Important
• The color and quality of the specified model cannot be perfectly matched.

Color Compatibility
Color settings and compatible models are listed below.

Color settings Compatible models

Color (CAD) 1 Standard

Color (CAD) 2 Color (CAD) Light

Color (CAD) 3 Canon BJ-W3000/W3050 （BJ-W3000/W3050 are not sold domestically in Japan.）
Color (CAD) 4 HP Designjet 500/800

Color (CAD) 5 HP Designjet 1000

Color (CAD) 6 HP Designjet 4000/4500

Printing
This section describes how to execute a print job with the HDI driver.

Note
• The description below uses printing with the AutoCAD 2007 as an example.

1. Start AutoCAD and open the image file.
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2. Select Plot from the File menu. The Plot dialog box opens.
Check the Name setting under Printer/plotter and confirm that iPFxxxx.pc3 (the name of the printer you use) is
displayed.
Click the Properties button.

Note
• If any other printer name is selected, select the name of the printer that you want to use from the

Name list.
• The names of the printers installed when the HDI driver was installed are in the Name list.
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3. The Plotter Configuration Editor dialog box opens. Perform the settings that you need for the print job.
Click the OK button to close the Plotter Configuration Editor dialog box.

Note
• For more details about how to perform the settings in the Plotter Configuration Editor dialog box,

see "Plotter Configuration Editor Dialog Box." →P.377
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4. The Plot dialog box opens.
Perform the settings that you need on the Plot dialog box, then click the OK button.

Note
• The content of the settings done in the Plotter Configuration Editor dialog box are reflected in the

Paper size settings on the Plot dialog box.
• For more details about the Plot dialog box, please refer to the AutoCAD manual.

5. The print job begins.

Note
• If the output exceeds the number of pixels prescribed for the media, in order to prevent AutoCAD

from hanging up during the print job a warning dialog box opens and asks if you want to lower the
resolution or reduce the number of colors. If this occurs, click the OK button to cancel the print job
and then lower the resolution or reduce the number of colors.

• Some media may not allow printing with certain resolution settings. If you have selected a resolution
setting that cannot be used for printing, then a dialog box will open and prompt you to change the
resolution. If this occurs, click the OK button to cancel the print job and then lower the resolution.

• A message from AutoCAD is displayed when printing starts. Press the OK button to execute the print
job. This message display can be disabled with the Options setting in the AutoCAD Tools menu. For
more details, please refer to the AutoCAD manual.
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Status Monitor
The Features of imagePROGRAF Status Monitor .......................................................................................... 393
Job Management Using imagePROGRAF Status Monitor .............................................................................. 394

The Features of imagePROGRAF Status Monitor
imagePROGRAF Status Monitor is a utility for checking the printer status and managing print jobs.
Two screens are available in imagePROGRAF Status Monitor : Printer List shows a list of printers, and Status Monitor
shows details for each printer.

• You can view a list of the printers for which printer drivers have been installed on your computer, printers connected to
your computer, and printers found on the network.
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• If a printer error occurs, you can investigate the corrective action immediately.
• Printer status can be checked in real time on a computer monitor.
• Displays the ink level of every color in the printer. An icon and warning message will notify you when ink levels are

low.
• The type of paper loaded in each media source is identified. You can also check to see if paper has run out.
• This way, the utility enables you to check printer information and take care of printer maintenance for optimal printing

results.
• You can also set up automatic email notification of any printer problems or errors to email addresses you designate in

advance.
• You can check the status of the hard disk and the documents saved on the hard disk.
• You can use the Accounting Manager to collect the print job logs for the printers and check information such as the

printing costs.
For details of the Accounting Manager, see Accounting Manager →P.396 .

Note
• For details, refer to the imagePROGRAF Status Monitor help.

Job Management Using imagePROGRAF Status Monitor
You can use the Job sheet in imagePROGRAF Status Monitor for operations such as pausing and canceling print jobs.

Preempting Other Jobs
If you select a print job and click the Preempt Other Jobs button, the selected job is printed ahead of the job that currently
precedes it in the print queue.
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Pausing/Resuming Print Jobs
Selecting a print job and clicking the Pause button pauses printing of the selected job.
To resume printing of a paused print job, select the print job and click the Resume button.

Note
• Once all the print data for a print job has been sent to the printer, the job can no longer be paused/resumed.

Canceling Print Jobs
Selecting a print job and clicking the Cancel Job button cancels printing of the selected job.

Note
• You cannot cancel other users' print jobs.
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Accounting Manager
The Accounting Manager stores the printer's print job logs so that you can use the information for checking printing costs,
etc.
The benefits of using the Accounting Manager are outlined below.

• Print Job Log Collection
This allows you to check which documents were printed from each printer, who printed them and when.

• Calculation of the Total Pages Used and the Total Cost
This allows you to use the collected print job logs to calculate totals for items such as the number of pages printed, the
amount of paper used and the printing costs incurred.

• Regular Data Acquisition for Print Jobs
This automatically logs print jobs at regular intervals.

• Exporting Print Job Data
This allows you to export collected print job data as a CSV file.

Important
• The Accounting Manager in Status Monitor displays approximate estimates of the amount of paper con-

sumed and the ink consumed per job. Canon cannot guarantee the accuracy of these estimates. These esti-
mates will also vary depending on the conditions of printer use.

• Print job log collection is not performed when Set./Adj. Menu-> Printer Info-> Show Job Log of the con-
trol panel is Off. However,

• even if Show Job Log is set to Off, regularly acquired jobs that already have been retrieved at that time are
displayed.

• When Show Job Log has been set to On again, all jobs within the printer at that time are displayed.
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Launching the Accounting Manager
The procedure for launching the Accounting Manager is shown below.

1. Open the imagePROGRAF Status Monitor window.

2. Select Accounting in the Accounting menu.
Or, open the Accounting sheet and click the Accounting button.

Accounting Manager Main Window
The Accounting Manager main window consists of a title bar, menu bar, toolbars, listed job selection area, job list area,
totals area and status bar.
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Title Bar
This displays the printer model, its serial number and the port number it is using.

Menu Bar
Allows you to select the menu options required for operation.

Toolbars
Provide tool buttons and pull-down menus for the main operations.

Note
• You can opt to either show or hide the toolbars in the View menu.

Listed Job Selection Area
You can use this area to select which job log is displayed.
If you are using regular data acquisition, this area allows you to view the collective job logs for each specified period.

For more information on how to select the job logs displayed, see Switching Between Displaying Jobs on Printer and
Regularly Acquired Jobs →P.405 .

Job List Area
This area lists the details of acquired jobs.
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It displays a list of either the print jobs on the printers or the regularly acquired print jobs. The displayed information in-
cludes the amounts of paper and ink consumed, the costs, the media type and the time taken for printing.

Note
• If the Unit Cost of Ink or Paper have not been set, **** is displayed in the Job Cost field.

Totals Area
Displays the total costs for the selected job and the amounts of paper and ink consumed.

Note
• If you are viewing regularly acquired print jobs, selecting a period on the left side of the window displays the

total costs for that period and the amounts of paper and ink consumed.
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Status Bar
Displays messages and other information.

Accounting Manager Basic Procedures
The first time you use the Accounting Manager, use the following procedures to configure the settings.

1. Configure unit costs, including the costs of ink and paper.
For details of the unit cost settings, see Configuring Unit Costs in Accounting Manager →P.400 .

2. Set options such as the units displayed.
For details of the unit settings, see Configuring Units and Display Settings in Accounting Manager →P.404 .

3. If you are using Regular Data Acquisition, configure the Regular Data Acquisition settings.
For details of the Regular Data Acquisition settings, see Automatically Acquiring Print Job Logs at Regular Inter-
vals →P.405 .

4. Specify the jobs to be listed.
For details of how to select the job logs displayed, see Switching Between Displaying Jobs on Printer and Regu-
larly Acquired Jobs →P.405 .

This displays the required print job logs and lists the details.

Configuring Unit Costs in Accounting Manager
Select Unit Costs in the Settings menu to open the Unit Costs dialog box. Configure the unit cost settings in this dialog
box.

Note
• When you select a job and then open the Unit Costs dialog box, items with unit costs that have not yet been

configured for that job are shown highlighted.

• Setting the Unit Cost for Ink →P.401

• Setting the Unit Cost for Paper →P.402

• Setting the Unit Cost for Items Other Than Ink and Paper →P.403
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Setting the Unit Cost for Ink
Open the Ink sheet. Set the unit cost for ink in this sheet.

To set the same unit cost for all the inks

1. Select the Use same price for all ink checkbox.

2. Enter the Tank Capacity and corresponding Price.

3. Click the OK button.

Important
• Your settings are not applied until you click the OK button.

To set different unit costs for each ink color

1. Select the ink color to be costed.

2. Enter the Tank Capacity and corresponding Price.
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3. Click the Overwrite button.

4. Repeat steps 1 to 3 for all the inks.

5. Click the OK button.

Important
• Your settings are not applied until you click the OK button.

Setting the Unit Cost for Paper
Open the Paper sheet. Set the unit cost for paper in this sheet.

1. Select a media type from the Media Type list.

2. Enter the Width and Length of the paper, and the Price per area for the configured width x height.

3. Click the Add button. To change the unit cost for a media type you have already set, click the Overwrite button.

4. Click the OK button.
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Important
• Your settings are not applied until you click the OK button.

Setting the Unit Cost for Items Other Than Ink and Paper
Open the Other sheet. Use this sheet to set any price for items other than inks and paper.

1. Enter any name in the Name field.

2. Enter a value in Unit Cost.

3. Use Allocated to specify whether the costs are allocated as being incurred by the print job.

4. Click the Add button. To change the unit cost for a media type you have already set, click the Overwrite button.

5. Click the OK button.

Note
• You can set unit costs for up to 5 items.
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Important
• Your settings are not applied until you click the OK button.

Configuring Units and Display Settings in Accounting Manager
Select Units and Display in the Settings menu to open the Units and Display dialog box. Use this dialog box to configure
the display settings.

Date Display Format
Use this option to select the display format for dates. "YYYY" indicates the year, "MM" the month and "DD" the day.

Currency Unit
Enter the currency unit. Enter a text string up to 3 characters long.

1000 Separator
Use this option to select the symbol used as a separator in numbers. The symbol is inserted every 3 digits.

Decimal Symbol
Use this option to select the symbol used as a decimal point.

Ink Consumed
Use this option to select the unit used for ink consumption.

Paper Width
Use this to select the unit used for paper width.
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Paper Length
Use this to select the unit used for paper length.

Area Display Format
Use this to select the unit used for paper area.

Automatically Acquiring Print Job Logs at Regular Intervals
This feature collects print job logs from the printer at regular intervals and saves the logs on your computer.

1. Select Regular Data Acquisition in the Settings menu.

2. Select Acquire print job logs regularly.

3. Click the OK button to close the dialog box.

Note
• Immediately after you configure Regular Data Acquisition, no print jobs are displayed. Wait a few moments

and then select Refresh in the View menu to display the print jobs.
• A maximum of 10,000 records are saved in a print job log. If this number is exceeded, jobs are deleted from

the log starting from the oldest record. To save old data, it is recommended that you export the data as a CSV
file.
For details of how to export print job logs as CSV files, see Exporting Print Job Data as a CSV
File →P.406 .

Important
• Print job log collection is not performed when Set./Adj. Menu-> Printer Info-> Show Job Log of the con-

trol panel is Off. However, even if Show Job Log is set to Off, regularly acquired jobs that already have
been retrieved at that time are displayed.

Canceling Regular Print Job Log Acquisition
You can use this procedure to cancel the regular acquisition of print job logs from printers.

1. Select Regular Data Acquisition in the Settings menu.

2. Uncheck the Acquire print job logs regularly option.

3. Click the OK button to close the dialog box.

Switching Between Displaying Jobs on Printer and Regularly Acquired Jobs
The print job logs displayed by the Status Monitor Accounting Manager contain two types of job: Jobs on Printer and Regu-
larly Acquired Jobs.
You can select whether to display Jobs on Printer or Regularly Acquired Jobs in the Listed Job Selection Area on the left
side of the window.
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Jobs on Printer
This shows a list of the print jobs currently held on printers.
You can change the number of jobs displayed per page using the Print Jobs Shown Per Page setting in the View menu or
the toolbar.
You can skip to a particular page using the Go to option in the View menu or the toolbar.

Note
• For printers with built-in hard disks, you can view up to 500 print jobs per printer.
• For printers without built-in hard disks, you can view up to 32 print jobs per printer. However, only 10 jobs

can be displayed if the printer is switched off.

Regularly Acquired Jobs
This shows a list of regularly acquired print jobs.
To view all the jobs in a set period, specify the period using Period and then Starting Date (or Starting Day of Week or
Starting Month) in the View menu or the toolbar.
For example, to view monthly job logs starting on the 1st of each month, set Period to Monthly and set Starting Date to 1.

Note
• Up to 10,000 regularly acquired jobs are displayed for each printer.

Exporting Print Job Data as a CSV File
You can export the collected print job data in the form of a CSV file by selecting Export Job Cost Data in the File menu.

Note
• You can also select Export Job Cost Data using the icon in the toolbar.

Selected Jobs
Exports the data for the selected print jobs in the job list as a CSV file.

Note
• You can select multiple jobs by holding down the Shift key or Ctrl key as you click the job names.

Listed Jobs
Exports the data for the print jobs currently displayed in the list as a CSV file.

Showing Job Properties
If you select a job in the job list and then select Show Job Properties in the File menu, the Job Properties dialog box
appears, allowing you to check information such as detailed cost data.
You can copy text-based information in this dialog box to the clipboard by clicking the Copy button.
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Note
• You can also open this dialog box by right-clicking the selected job and selecting Show Job Properties. Or

you can also use the toolbar icon to open the dialog box.
• If you select multiple jobs and open the Job Properties dialog box, the total costs for the selected jobs are

displayed.

Showing, Saving and Loading Selected Unit Cost Data

Show Unit Cost Data
Select Show Unit Cost Data in the File menu to open the Unit Cost Data dialog box. This lists the unit costs for items
such as the selected ink and paper.
You can copy text-based information in this dialog box to the clipboard by clicking the Copy button.

Save Unit Cost Data
Select a destination folder using Save Unit Cost Data in the File menu. The unit cost data for items such as the selected ink
and paper is saved as a file.

Load Unit Cost Data
Selecting Load Unit Cost Data in the File menu loads saved unit cost data.

Showing the Total Amount of Ink and Paper Consumed
Select Show Ink and Paper Consumed in the File menu to open the Show Ink and Paper Consumed dialog box.
This lists the total amounts of ink and paper consumed by the printer so far.
You can copy text-based information in this dialog box to the clipboard by clicking the Copy button.

Note
• Up to 7 types of media are listed in order of the amount consumed. The total consumption for other media

types is shown as Other.
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Digital Photo Front-Access
Digital Photo Front-Access .............................................................................................................................. 408

Digital Photo Front-Access
Digital Photo Front-Access is an application that links photos from Canon digital cameras and other image files on your
computer with various other applications.

• Simply select an image and click the icon of the application you want to start to launch the application.
• You can also print from Digital Photo Front-Access. In short, Digital Photo Front-Access can help you manage images

in many ways from editing to printing as an effective way to work with other applications.
• Digital Photo Front-Access also enables image retouching. For automatic retouching, select an image for retouching

and click Image Adjustment.
• Because this application automates the workflow from retouching to display for all of your images, it can save time

and work in retouching.

Note
• For details, refer to the Digital Photo Front-Access help.
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imagePROGRAF Device Setup Utility
imagePROGRAF Device Setup Utility is a utility to establish communication between the printer and your computer by
completing relevant settings. After the printer is installed, for example, you can use imagePROGRAF Device Setup Utility
to complete the network settings initially.

• Starting imagePROGRAF Device Setup Utility will show a list of printers found on the network. In this list, select the
printer (specifically, the printer's MAC address) that you want to set up, and then configure the basic settings from
your computer, such as the printer's IP address and the network frame type.

• You can see which printers are online in the network by checking the printer list. Communication between your com-
puter and these printers is possible.

Note
• We recommend that your network or printer administrator complete the setup work using imagePROGRAF

Device Setup Utility.
• For details, refer to the imagePROGRAF Device Setup Utility help.

Installing imagePROGRAF Device Setup Utility
Install imagePROGRAF Device Setup Utility from the User Software CD-ROM provided with the printer as follows:

Important
• In Windows XP/Windows Server 2003/Windows Vista/Windows Server 2008/Windows 7, you must log on

with administrative rights equivalent to the Administrator account.

1. Insert the User Software CD-ROM in the CD-ROM drive.

2. On the Setup Menu window, click Install Individual Software.

3. Click Install in imagePROGRAF Device Setup Utility.

4. Follow the instructions on the screen to proceed with the installation.
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Configuring the IP Address Using imagePROGRAF Device Setup Utility
From a computer running Windows, you can use imagePROGRAF Device Setup Utility provided with the printer to config-
ure the printer's IP address. This topic describes how to configure the IP address using imagePROGRAF Device Setup Utili-
ty.

Important
• To configure network settings, you must be logged in with administrative rights such as Administrator ac-

count. We recommend that your network administrator configure the network settings.
• For instructions on installing imagePROGRAF Device Setup Utility, see "Installing imagePROGRAF De-

vice Setup Utility." →P.409 .

1. Start imagePROGRAF Device Setup Utility from the start menu.

2. In the Device Name list displayed, select the printer to configure.
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3. Choose Protocol Settings from the Printer menu.

4. In the Setting IP Address list, choose Manual.

5. Enter the IP address assigned to the printer and click the Set button.

6. Click OK after the Confirmation message dialog box is displayed.

7. Exit imagePROGRAF Device Setup Utility.

Note
• To configure the IP address automatically, choose Auto in the Setting IP Address list and select DHCP,

BOOTP, or RARP.
• You can also specify the subnet mask and default gateway.
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The Features of Media Configuration Tool
The Media Configuration Tool offers the following features.

• Enables information about additional media (types of paper) supported by the printer to be registered on the printer
control panel and in the printer driver, through the use of relevant media information files (.amf and .med files).

• You can rearrange lists of the types of paper on the printer control panel and in printer driver dialog boxes and rename
them, in addition to other functions.

Important
• The Media Configuration Tool is normally installed when you install the printer driver from the User Soft-

ware CD-ROM by selecting Install Printer Driver and media information is registered at this time. The tool
can be used later to add or edit media information as desired.

Drivers Applicable with Media Configuration Tool

• imagePROGRAF Printer Driver
• imagePROGRAF HDI Driver

Operating Environment
You can use Media Configuration Tool in the following environments.

• Compatible Operating System
Windows 2000, Windows XP, Windows Server 2003, Windows Vista, Windows Server 2008, Windows 7

• Software that requires installation
imagePROGRAF Printer Driver
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Installation Procedures
The Media Configuration Tool installation screen appears when you start the installation of a new version of the Media
Configuration Tool. The installation procedure started from this screen is described below.

Important
• The Media Configuration Tool is normally installed when you install the printer driver from the User Soft-

ware CD-ROM by selecting Install Printer Driver and media information is registered at this time.
• You must be logged in as Administrator when installing software in Windows.

1. Start the Media Configuration Tool installer.
Click the Next button.

2. The next screen presents selections for the country or area where the printer is used.
Select a country or territory then click the Next button.
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3. The License Agreement is displayed.
Select I accept the terms of the license agreement and click the Next button.

4. The Choose Destination Location screen appears.
Select the destination folder then click the Next button.

Windows Software > Media Configuration Tool >

Installation Procedures iPF825

4

414



5. The Ready to Install the Program screen appears.
Click the Install button.

6. All the required files are copied to your computer and InstallShield Wizard Complete screen appears.
Click the Finish button.

 

This completes the installation of Media Configuration Tool.

Starting the Media Configuration Tool
Follow the procedure below to start Media Configuration Tool.
From the start menu go to Programs > iPFxxxx Media Configuration Tool > iPFxxxx Media Configuration Tool.
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Media Configuration Tool main window is displayed.

Media Configuration Tool Main Window
The explanation below is on the Media Configuration Tool main window.

Note
• For the step to open the Media Configuration Tool main window, see "Starting the Media Configuration

Tool." →P.415

Edit Media Type Information Button
Click the button to open the Edit Media Types dialog box and you can edit the media types.
For more information about Edit Media Type Information, see "Editing Media Type Information." →P.417
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Support Information Button
Click this button to access the Canon support webpage, where you can find the latest printer information, check for software
updates, and browse other information.

User Manual Button
Click this button to display the printer user manual. This function requires that the user manual be installed on your comput-
er.

Editing Media Type Information
Click the Edit Media Type Information button in the Media Configuration Tool main window to display the Edit Media
Types dialog box.

This dialog box presents functions for the following tasks.

• Adding Media Types →P.418

• Changing Media Names →P.420

• Deleting Media Types You Have Added →P.422

• Switching Media Types Display Show/Hide →P.424

• Changing the Display Order of Media Types →P.425

Note
• It may not be possible to deleting, showing/hiding, and changing the display order under some conditions.
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Adding Media Types

1. Open the Edit Media Types dialog box, and then click the Add button.

2. The Add Media Type dialog box displays.
Click the Browse button.
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3. The Browse for Folder dialog box opens.
Select the folder that contains the media information files (.amf and .med files), and then click the OK button.

4. The names of media information files in the folder you selected in the Browse for Folder dialog box are displayed
under Media Information File in the Add Media Type dialog box. Select the check boxes of paper to add and click
the OK button.

5. Click OK when the confirmation message is displayed.
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6. In the Edit Media Types dialog box, click the Update button.

The Update Media Types wizard is started at this point. For details on the procedure to update paper information
using the Update Media Types wizard, see "Updating Media Types." →P.427

Important
• Be sure to click the Update button. If you do not, your changes will not be applied to the printer and

printer driver.

Changing Media Names

1. Open the Edit Media Types dialog box.
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2. In the Media Type list, select the name to change.
Click the Rename button.

3. The Rename Media dialog box is displayed.
Edit the names in Name in Printer Driver and Name on Control Panel and click the OK button.

Note
• To restore the original names, click the Restore button.
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4. In the Edit Media Types dialog box, click the Update button.

The Update Media Types wizard is started at this point. For details on the procedure to update paper information
using the Update Media Types wizard, see "Updating Media Types." →P.427

Important
• Be sure to click the Update button. If you do not, your changes will not be applied to the printer and

printer driver.

Deleting Media Types You Have Added

1. Open the Edit Media Types dialog box.
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2. In the Media Type list, select the name of the media to delete.
Click the Delete button.

Note
• Only paper for which Status in the Media Type is Add can be deleted.

3. In the Edit Media Types dialog box, click the Update button.

The Update Media Types wizard is started at this point. For details on the procedure to update paper information
using the Update Media Types wizard, see "Updating Media Types." →P.427

Important
• Be sure to click the Update button. If you do not, your changes will not be applied to the printer and

printer driver.
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Switching Media Types Display Show/Hide

1. Open the Edit Media Types dialog box.

2. In the Media Type list, select the name of the media to switch off or on for display.
Click the Show/Hide button.
The selected paper is alternately shown or hidden.

Note
• The names of media switched for non-display appear grayed out in the Media Type list.
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3. In the Edit Media Types dialog box, click the Update button.

The Update Media Types wizard is started at this point. For details on the procedure to update paper information
using the Update Media Types wizard, see "Updating Media Types." →P.427

Important
• Be sure to click the Update button. If you do not, your changes will not be applied to the printer and

printer driver. Switching between showing and hiding the type of paper will not be applied to the
printer.

Changing the Display Order of Media Types

1. Open the Edit Media Types dialog box.
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2. Select the paper in the Media Type list for which to change the display order, and then click the buttons to move the

item (  or ).
The selected item moves one line up or down for every button click.

3. In the Edit Media Types dialog box, click the Update button.

The Update Media Types wizard is started at this point. For details on the procedure to update paper information
using the Update Media Types wizard, see "Updating Media Types." →P.427

Important
• Be sure to click the Update button. If you do not, your changes will not be applied to the printer and

printer driver.
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Updating Media Types
Clicking the Update button on the Edit Media Types dialog box opens the Update Media Types wizard. You can use this
wizard to apply new information about print media in the printer and in the printer driver.
The procedures for updating the media information with the Update Media Types wizard are as follows.

Important
• The use of this procedure is based on the assumption that Media Configuration Tool is updated or you have a

media information file for print media that is to be updated.

1. Confirm the printer, where media type information is to be updated, to be displayed in Printer in the Update Media
Types - Select Printer dialog box, and then click the Next button.

Note
• If the printer driver is not installed, the following dialog box is displayed. Select how the printer to

update is connected.

2. Communication with the printer starts and the following dialog box is displayed.
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Important
• Do not attempt to print or turn the printer off while the program is communicating with the printer.
• When the program cannot communicate with the printer, the following warning message is displayed.

3. When the program has finished communicating with the printer, the screen moves to display Update Media Types -
Confirm Update. Confirm the information received from the printer.
To update click the Execute button.

Important
• When setting a data to the printer that differs from the data to be updated, the selected media informa-

tion file is updated. When you would like to remain the data that is set to the printer, click the Cancel
button.

4. Communication with the printer starts and the following dialog box is displayed.
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Important
• Do not attempt to print or turn the printer off while the program is communicating with the printer.
• When the program cannot communicate with the printer, the following warning message is displayed.

5. After the media information file is updated successfully, the screen switches to the Update Media Types - Finish
dialog box. Click Finish to close the Update Media Types wizard.
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Printer Driver Settings
For instructions on accessing the Mac OS X printer driver, refer to the following topics.

• Accessing the Printer Driver Dialog Box from Applications →P.438

For information on the Mac OS X printer driver settings, refer to the following topics.

• Main Pane →P.439
You can specify the media type, color processing, print quality, print preview, and other settings. Choose Easy Set-
tings to specify basic print settings based on the printing application or Advanced Settings to complete more detailed
settings as desired.

• Paper Detailed Settings Dialog Box →P.444

• View settings Dialog Box for the Printing Application →P.445

• Color Settings Pane: Color →P.448
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• Color Settings Pane: Monochrome →P.450

• Page Setup Pane →P.453
You can specify the page size of the original, borderless printing, enlargement or reduction, the orientation, the paper
size and source, and automatic cutting.

• Utility Pane →P.455
You can specify settings related to maintenance for the Printhead and feed amount, as well as settings for Color im-
ageRUNNER Enlargement Copy.

• Additional Settings Pane →P.456
You can specify settings for how print jobs are sent to the printer.

• Support Pane →P.457
You can view support information and the user's manual.

With the imagePROGRAF Free Layout feature, you can arrange originals from various source applications on a single
page before printing. For details, see Free Layout →P.487 .
With the imagePROGRAF Preview feature, you can check the layout before printing and adjust layout or size settings
while viewing a preview screen. For details, see Preview →P.458 .
With the Color imageRUNNER Enlargement Copy feature, you can automatically enlarge and print scanned originals
from a Color imageRUNNER. For details, see Color imageRUNNER Enlargement Copy →P.519 .
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Specifying Paper in the Printer Driver
If you have replaced the paper, you must complete the following settings in the printer driver.

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. Choose the original size in the F Paper Size list.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded.

7. Access the Page Setup pane.

8. In the A Paper Source list, select how paper is supplied.
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9. If you have selected Cut Sheet in A Paper Source, make sure the size as selected in Page Setup is displayed in
C Page Size. If you have selected roll paper in A Paper Source, make sure the width of the loaded roll is displayed
in B Roll Width.

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

Note
• A variety of settings are available in the printer driver to suit different printing applications.

For details on available printing conditions, see "Printer Driver Settings →P.431 "

Confirming Print Settings
There are two ways to confirm what printing conditions have been specified, as follows.

• Checking a preview of the settings
• Checking a print preview
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Checking a preview of the settings
A preview of the settings is displayed on the left side of the Main, Page Setup, Utility, and Additional Settings panes.By
checking images and numerical values in the preview, you can confirm current settings for the page size, orientation, paper
source, and so on.

Display Area Information Displayed

Pane displayed when the H Im-
ages tab is clicked

On top, illustrations indicate the page size of the original, the paper size, orienta-
tion, layout, borderless printing selection, color mode, and other settings informa-
tion.
Under this, the page size, paper size, and method and percentage of enlargement or
reduction is displayed.

Pane displayed when the I Size
tab is clicked

Paper size details are indicated numerically.

Pane with printer and paper illus-
trations

Illustrations indicate the paper source, orientation, borderless printing selection,
and other settings information.

Note
• To confirm the Print Target specified in Easy Settings, click G View set. on the Main pane to display the

View settings dialog box.

Checking a print preview
You can check an image of the original just as it will be printed.
Confirming the image of print jobs beforehand helps prevent printing errors.
For details on print previews, see "Checking the Layout in a Preview Before Printing →P.186 "
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Checking the Layout in a Preview Before Printing
This topic describes how to check the layout before printing using the Canon imagePROGRAF Preview function.

1. Choose Print in the application menu.

2. Access the Main pane.

3. Select the O Print Preview check box.

4. Click M Print.
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5. The Canon imagePROGRAF Preview window is displayed.

6. Check the layout and adjust settings in the Canon imagePROGRAF Preview window as desired.

7. Print from the Canon imagePROGRAF Preview menu.

Note
• For details on imagePROGRAF Preview functions, refer to Preview →P.458 .

Using Favorites
You can use the Presets function in Mac OS X for favorite-based printing.

Note
• In the printing dialog box, click Save As in the Presets list to save the current print settings. This is a stand-

ard feature of the operating system. For details, refer to the Mac OS documentation.

Accessing the Printer Driver Dialog Box from Applications

1. In the application software, select Print from the File menu to display the dialog box for printing conditions.

Note
• This dialog box includes basic printing options and enables you to choose the printer, specify the

range of pages, number of copies, and so on.
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2. Select the printer in the Printer list.

3. Click Print to start printing.
As shown in the following illustration, you can switch to other panes in this dialog box to complete settings for vari-
ous methods of printing, including enlarged and reduced printing, borderless printing, and so on.

Main Pane
The following settings are available on the Main pane. For details on settings items, refer to the printer driver help.

Note
• On the Main pane, choose Easy Settings to specify basic print settings based on the print target, or switch to

Advanced Settings to complete more detailed settings as desired.
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Common Items

AMedia Type
Select the paper type.
For information on the types of paper the printer supports, refer to the Paper Reference Guide.(See "Types of Pa-
per →P.623 ")

BGet Information
Displays Paper Information on Printer. You can update the printer driver settings for the feed source, media type, and roll
width by selecting the feed source.

• Paper Information on Printer Dialog Box →P.443

CSet
Displays Paper Detailed Settings. You can configure the printing settings to match the type of media, such as the ink dry-
ing time.

• Paper Detailed Settings Dialog Box →P.444

OPrint Preview
If you turn this on, imagePROGRAF Preview starts before printing.
This allows you to check on-screen previews of documents before printing.

Important
• This cannot be selected if Free Layout is enabled in the Page Setup panel.

• Checking the Layout in a Preview Before Printing →P.186

LPrinter
Displays Printer. You can display printer information such as the remaining ink levels.
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Configuration using Easy Settings

EPrint Target
Choose presets that match the type of document to be printed.

• Printing Photos and Images →P.31

• Printing Line Drawings and Text →P.20

• Printing Office Documents →P.39

FPrint Quality
Choose the level of print quality.

GView set.
Click to display the View settings dialog box, which enables you to confirm the settings for the selected item from the
E Print Target list or change the order of items listed in E Print Target.

• View settings Dialog Box for the Printing Application →P.445
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Configuration using Advanced Settings

EPrint Priority
Choose the graphic elements that you want to emphasize for printing.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.56

FPrint Quality
Choose the level of print quality.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.56

HColor Mode
Choose the color mode.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.56

ISet
Click to display the Color Settings dialog box for more advanced color settings.

• Adjusting the Color in the Printer Driver →P.47

JUnidirectional Printing
Select this checkbox to prevent problems such as misaligned lines and improve the print quality. However, the printing
speed becomes slower.

QThicken Fine Lines
Activate this option to print fine lines more distinctly.
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PSharpen Text
Activate this option to print text more sharply.

KReduce Print Unevenness
Select this checkbox for two-pass printing to reduce color shading.
This option is displayed if you have selected Plain Paper in Media Type and Office Document in Print Priority.

NEconomy Printing
Select this checkbox to reduce the amount of ink consumed during printing. However, the print quality is worse than for
normal printing.
Select this mode if you want to conserve ink when checking drawings, for example. Depending on the Media Type and
Print Quality settings, this mode may not be available.

Paper Information on Printer Dialog Box
On the Paper Information on Printer dialog box, you can obtain information on the paper in the printer and configure
printer driver media type setting.

Note
• To display the Paper Information on Printer dialog box, on the Main pane, click Get Information by

Media Type.(See "Main Pane →P.439 ")

APaper Source
Shows the Paper Source supported by the printer, as well as the type of paper loaded. To update the media type setting in
the printer driver, select the desired Paper Source option and click OK.
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Paper Detailed Settings Dialog Box
The Paper Detailed Settings dialog box offers the following settings. For details on settings items, refer to the printer driv-
er help.

Note
• To display the Paper Detailed Settings dialog box, on the Main pane, click Set by Media Type.(See "Main

Pane →P.439 ")

AMedia Type
Select the paper type.
For information on the types of paper the printer supports, refer to the Paper Reference Guide.(See "Types of Pa-
per →P.623 ")

BDrying Time
Specify the time that the printer waits for ink to dry, as needed. The Drying Time setting is only valid for rolls.

• (See "Specifying the Ink Drying Time for Rolls →P.652 ")

CBetween Pages
Specify the time the printer waits after printing a page until ejecting the paper, as needed.

DBetween Scans
Specify the time the printer waits after printing a line on the page until printing the next line, as needed.

Mac OS X Software > Printer Driver >
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ERoll Paper Margin for Safety
You can specify the length of a margin on the leading edge of paper to ensure that paper susceptible to curling is held firmly
against the Platen.

FNear End Margin
Specify the length of the Near End Margin (the leading edge margin) of the roll, as needed.

GCut Speed
Select the speed of automatic cutting, as needed. You can adjust this setting if paper is not cut well when automatic cutting
is used.

HAutomatic Cutting
You can activate or deactivate automatic cutting and printing of cut lines, as desired. In this list, specify Printer Default,
None, or Print Cut Guideline.

JMirror
Specify whether to print a mirror image, as needed. Select this option to print a version of the document or image with the
left and right sides inverted.

View settings Dialog Box for the Printing Application
In the View settings dialog box, you can check details of the selected printing application.

Note
• To display the View settings dialog box, on the Main pane, click View settings by Print Target.(See "Main

Pane →P.439 ")
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iPF825 View settings Dialog Box for the Printing Application

5

445



APrint Target
Shows all Print Target options (settings items for the printing application).

BName
Identifies the item selected in Print Target by its name and an icon.

CDetails
Here, you can confirm detailed settings values for each item selected in the Print Target list.

Matching pane
On the Matching pane, you can specify color matching to compensate for differences in the appearance of colors on various
devices.

Important
• If No color correction is selected under Color Mode, the Matching pane is not displayed.

Note
• To display the Matching pane, on the Main pane click Color Settings in Color Mode in Advanced Set-

tings, and then click the Matching tab. (Refer to "Main Pane →P.439 ")

Driver Matching Mode
 

AMatching Mode
Select the color matching mode to use, as desired.

Mac OS X Software > Printer Driver >
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BMatching Method
Select the color matching method that suits the document to be printed. Various B Matching Method options are available
depending on your selection in A Matching Mode.

ICC Matching Mode
The following options are available when you select ICC Matching Mode, in the A Matching Mode list.

Note
• To display the Matching pane, on the Main pane, click Color Settings by Color Mode in Advanced Set-

tings, and then click the Matching tab.(See "Main Pane →P.439 ")

AMatching Mode
Select the color matching mode to use, as desired.

B Input Profile Settings
You can choose Input Profile.
Various options are available depending on your selected A Matching Mode.

CMatching Method
You can choose C Matching Method.
Various options are available depending on your selected A Matching Mode.

DPrinter Profile Settings
Specify the printer profile as desired.

Mac OS X Software > Printer Driver >

iPF825 Matching pane

5

447



Note
• For details on settings items, see "Adjusting the Color in the Printer Driver →P.47 "

Color Settings Pane: Color
In general, make any needed adjustments to the color of documents in the application used to create them. However, if the
color tone as printed is not as you expected, you can also adjust the color in the printer driver.

Color Adjustment pane: color
If the color tone as printed is not as you expected, you can adjust it on the Color Adjustment pane.

Note
• To display the Color Adjustment pane, on the Main pane click Color Settings by Color Mode in Ad-

vanced Settings.(See "Main Pane →P.439 ")

ASample Type
Choose a sample image from Standard, Portrait, Landscape, or Graphics.

BView Color Pattern
Select this checkbox to display the color pattern.

CApply to Sample
Select this checkbox to apply the changed settings to the sample image.

DCyan / EMagenta / FYellow
Correct color tones by adjusting the levels of each color.

Mac OS X Software > Printer Driver >
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GGray Tone
Adjust the color tone of grays as desired. Choose Cool (tinged with blue) or Warm (tinged with red).

HBrightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter or darker
than the original image (that is, the original photo that was scanned or the original graphic as it appears on the computer
screen).

IContrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the Contrast makes
images sharper, and reducing the Contrast softens images.

JSaturation
Adjust the color intensity as desired. Increasing the Saturation setting makes colors more vivid, and reducing the Satura-
tion makes colors more subdued.

Note
• For details on settings items, see "Adjusting the Color in the Printer Driver →P.47 "

KObject Adjustment
Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to color adjust-
ment.

• Object Adjustment dialog box: Color →P.449

Object Adjustment dialog box: Color
In the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. If an original
comprises images, graphics, and text, you can specify which portion to apply color adjustment to.

Note
• To display the Object Adjustment dialog box, click Object Adjustment on the Color Adjustment panel.

Mac OS X Software > Printer Driver >
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A Images
Select this option to apply color adjustment to image areas, such as photos.

BGraphics
Select this option to apply color adjustment to graphics, such as lines and circles.

CText
Select this option to apply color adjustment to text.

Color Settings Pane: Monochrome
The following settings are available on the Color Settings pane for monochrome printing.

Color Adjustment pane: Monochrome
On the Color Adjustment pane for monochrome printing, you can adjust the brightness and contrast.

Note
• To display the Color Adjustment pane, on the Main pane, click Color Settings in Advanced Settings.(See

"Main Pane →P.439 ")

ASample Type
Choose a sample image from Standard, Portrait, Landscape, or Graphics.

BView Color Pattern
Select this checkbox to display the color pattern.

Mac OS X Software > Printer Driver >
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CApply to Sample
Select this checkbox to apply the changed settings to the sample image.

DCyan / EMagenta / FYellow
Not available.

GGray Tone
Not available.

HBrightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter or darker
than the original image (that is, the original photo that was scanned or the original graphic as it appears on the computer
screen).

IContrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the I Contrast makes
images sharper, and reducing the I Contrast softens images.

JSaturation
Not available.

Note
• For details on settings items, see "Adjusting the Color in the Printer Driver →P.47 "

KObject Adjustment
Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to color adjust-
ment.
(Only supported in Mac OS X 10.3.9-10.6)

• Object Adjustment dialog box: Monochrome →P.452

Mac OS X Software > Printer Driver >
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Object Adjustment dialog box: Monochrome
In the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. If an original
comprises images, graphics, and text, you can specify which portion to apply color adjustment to.

Note
• To display the Object Adjustment dialog box, click Object Adjustment on the Color Adjustment panel.

A Images
Select this option to apply color adjustment to image areas, such as photos.

BGraphics
Select this option to apply color adjustment to graphics, such as lines and circles.

CText
Select this option to apply color adjustment to text.

Mac OS X Software > Printer Driver >
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Page Setup Pane
The following settings are available on the Page Setup pane. For details on settings items, refer to the printer driver help.

APaper Source
Choose how paper is supplied.
Options displayed in the list vary depending on the selection in A Media Type in the Main pane.

BRoll Width
Displays the paper width of the roll loaded in the printer. Unknown is displayed if the printer cannot detect the roll paper
width.

CPage Size
Displays the size of the original, as specified in the page settings of the application.
For details on page sizes available in the application. see "Paper Sizes →P.626 "

DEnlarged/Reduced Printing
Select this checkbox to choose the following options.

• Resizing Originals to Match the Paper Size →P.66

• Resizing Originals to Fit the Roll Width →P.72

• Resizing Originals by Entering a Scaling Value →P.78

EFit Paper Size
Resizes the document image to match the paper size.

FFit Roll Paper Width
Resizes the document image to match the roll width.

Mac OS X Software > Printer Driver >
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GScaling
Resizes the document image based on a specified scaling value. Enter a value in a range of 5–600.

HBorderless Printing
Borderless printing is available if roll paper is selected in the A Paper Source list.
Activate this setting for borderless printing to match the size and width of the paper.

• Borderless Printing on Paper of Equivalent Size →P.101

• Borderless Printing by Resizing Originals to Fit the Roll Width →P.108

• Borderless Printing at Actual Size →P.92

IPaper Size
Choose the size of the paper you will print on.
Click Display all selections for Paper Size to list available sizes.
For details on available paper sizes, see "Paper Sizes →P.626 "

JPrint Centered
Select this checkbox to print document images in the center of the paper.

• Printing Originals Centered on Rolls →P.156

• Printing Originals Centered on Sheets →P.162

KNo Spaces at Top or Bottom
Select this checkbox to print the next image skipping blank areas above and below printable data in documents, which ena-
bles you to conserve the paper.

• Conserving Roll Paper by Printing Originals Without Top and Bottom Margins →P.175

LRotate Page 90 degrees
Select this checkbox to rotate the document image by 90 degrees before printing.

• Conserving Roll Paper by Rotating Originals 90 Degrees →P.169

NFree Layout
Select this checkbox to start imagePROGRAF Free Layout before printing.
This allows you to print multiple documents next to each other.

Important
• This cannot be selected if Print Preview is enabled in the Main panel.

• Printing Multiple Originals Next to Each Other →P.135
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Utility Pane
The following settings are available on the Utility pane.

ASet
Click to display the Printer dialog box, which offers the following maintenance for the printer.

• Nozzle (ink ejecting outlet) cleaning
• Head alignment adjustment
• Feed amount adjustment

BView
Click to start imagePROGRAF Printmonitor, which enables you to view the status of print jobs.

CSet
Click to complete the settings for Color imageRUNNER Enlargement Copy (iR enlargement copy).
For details, see Color imageRUNNER Enlargement Copy →P.519 .

Mac OS X Software > Printer Driver >
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Additional Settings Pane
The following settings are available on the Additional Settings pane.

AData Send Method
Choose how print data is sent to the printer.

• B Send Print Data Immediately to Printer

• C Send All Print Data as Batch to Printer

DSend job to
You can configure the method for saving print jobs to the printer hard disk.

• E Print

• F Print (auto delete)

• G Save in mail box

HSave data before printing
Jobs are printed after they are saved on the hard disk.

Mac OS X Software > Printer Driver >

Additional Settings Pane iPF825

5

456



Support Pane
On the Support pane, you can view support information and the user's manual.

ASupport Information
Click to access the Canon support webpage, where you can find the latest information on the printer and consumables,
check for printer driver updates, and browse other information.

BUser Manual
Click to view the printer user's manual. This function requires the user's manual to be installed on your computer.

CSettings
The settings can be saved as a file. Click to display the Export dialog box, which enables you to specify where to save the
file.

DAbout
You can display version information for the printer driver.

Mac OS X Software > Printer Driver >
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The Features of Preview
The main features of Preview are as follows.

• While viewing this screen, you can adjust layout settings of a document created with application software.
• You can not only adjust layout settings but also your changes will be instantly applied on the preview screen, and you

can print the preview screen as it is seen.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print output

to differ from the Preview settings.

Operating Environment
You can use the Preview in the following environments.

• Compatible Operating System
Mac OS X (10.3.9 to 10.6)
 

• Software that requires installation
imagePROGRAF Printer Driver

Mac OS X Software > Preview >
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Starting Preview
Follow the procedure below to start the Preview.

1. Start the apllication software which you use.

2. From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.

3. Click Print Preview in the Main panel to attach a checkmark.

4. Click the Print button in the Print dialog box.

Note
• Your printer is depicted in the lower-left area of this screen.

Mac OS X Software > Preview >

iPF825 Starting Preview
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5. Preview main window is displayed.

Preview Main Window
The Preview main window consists of the menu and tool bars, and preview, dialog , drawer and status area.

Note
• You can use the View menu to show or hide the tool bar.

Mac OS X Software > Preview >

Preview Main Window iPF825
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Menu Bar
This allows you to select menus required for operations.

Tool Bar
This allows you to select tool buttons required for major operations.

Preview Area
You can check the settings you made in this area.

Mac OS X Software > Preview >
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Dialog Area
This allows you to set the print conditions and perform a print job.

Drawer Area
This allows you to display the thumbnails of a document.

This area appears when you click  Drawer from the tool bar.
Alternatively, you may select Drawer from the View menu.

Mac OS X Software > Preview >
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Status Area
This shows Input Size and Output Size.

Paper Settings Panel
This panel appears when you select Paper Settings in the dialog area.

Media Type
This allows you to select the media type.

Note
• Always select media type that is actually set in the printer. When the media you chose is different from the

media set in the printer, you may not receive the desired print results.

Easy Settings / Advanced Settings
Two modes are available to provide the optimum print settings for jobs.
The settings available on each mode are as follows.

• Easy Settings →P.465

• Advanced Settings →P.466

Mac OS X Software > Preview >
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Paper Source
You can select the paper source.
The following settings are available for paper source.

Setting Details

Cut Sheet Select to print on the cut sheet.

Roll Paper 1 Select to print on the roll paper of Roll Paper 1 (Upper).

Roll Paper 2 Select to print on the roll paper of Roll Paper 2 (Lower).

Roll Paper Width
This selects the width of the roll media set to the printer.

Note
• Available only if rolls are selected in Paper Source.

Copies
You can input the number of print copies in numerical characters.

Note
• The maximum value is 999.
• You can change the numbers by clicking either ▲ button or ▼ button.

Restore Defaults Button
Click the button to reset to the setting when starting Preview.

Print Button
Click the button to begin printing.

Update Printer Info. Button
Click the button to acquire printer information.

Mac OS X Software > Preview >
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Easy Settings
You can easily select the best settings for the print job by just selecting an item from the print target list that matches the
content of the document.

Print Target
You can easily select the best settings for the print job simply.
If you select each Print Target item the corresponding comment for that item is displayed below the list.

Setting Details

Default Settings Suitable for printing normal documents that contain a mixture of text, photographs,
and graphics.

Office Document Suitable for printing handouts as well as general office documents for which print
clarity is key.

Poster The best setting for posters.Prints using vivid and high impact colors.

CAD (Color Line Drawing) Prints the fine lines of CAD drawings and other such documents sharp and clear.

CAD (B/W Line Drawing) Suitable for printing CAD drawings with sharp, dark lines.

Perspective, GIS Suitable for attractive printing of 3D-CAD drawings, perspective drawings, and
GIS drawings including maps.

Photo (Color) Suitable for printing photographic images captured with a digital camera.

Faithful Color Reproduction Prints by faithfully reproducing the colors of the original image.

Custom Settings Suitable for printing documents for which Advanced Settings have been specified.

Mac OS X Software > Preview >
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Note
• The number of settings available for selection depends on the media type.

Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.

Setting Details

Print Quality Highest / High / Standard / Draft

Resolution 1200dpi / 600dpi / 300dpi

Note
• The availability of settings is determined by the media type and print priority selections.
• Printing time is longer and more ink is consumed with High than with Draft, however, print quality is high-

er.
• Printing time is shorter and less ink is consumed with Draft than with High, however, print quality is lower.

Advanced Settings
Presents detailed settings for the print quality, the color mode, and other items so you can select the values for these settings
yourself.

Mac OS X Software > Preview >
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Print Priority
Select a print quality mode that is appropriate for the print job.

Setting Details

Image This mode achieves the best results for printing photographic images and illustra-
tions.

Line Drawing This mode is best for printing CAD drawings with fine lines or wall newssheet or
other documents that contain large amounts of text. However, you may not achieve
the quality you expect with printing photographs or other images with many filled
areas. For these types of jobs, select Image.

Office Document Prints common office documents, such as proposals, memos for distribution, etc.,
so they are easy to read.

Note
• The number of settings available for selection depends on the media type.

Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.

Setting Details

Print Quality Highest / High / Standard / Draft

Resolution 1200dpi / 600dpi / 300dpi

Note
• The availability of settings is determined by the media type and print priority selections.
• Printing time is longer and more ink is consumed with High than with Draft, however, print quality is high-

er.
• Printing time is shorter and less ink is consumed with Draft than with High, however, print quality is lower.

Mac OS X Software > Preview >
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Output Settings Panel
This panel appears when you select Output Settings in the dialog area.

Enlarged/Reduced Printing
Select the method for enlarged/reduced printing.
The following settings are available for enlarged/reduced printing.

Setting Details

Fit Paper Size Enlarges/reduces the whole page automatically to fit the media size selected for
output. Select the media size to print from Paper Size.

Fit Roll Paper Width Enlarges/reduces the whole page automatically to fit the width of the roll paper
with the page width.
 

*Make sure that the width of the roll paper in the printer is set correctly for Roll
Paper Width in the Paper Settings panel.
*Displayed only if rolls are selected in Paper Source.

Scaling Enlarges/reduces the whole page by the scaling rate as specified. Input the scaling
value in numerical characters. You can specify a range between 5 and 600%.
 

*You can change the numbers by clicking either ▲ button or ▼ button.
*Although Scaling can be set to make the image larger than the media size, the part
that does not fit in the media cannot be printed.
*This is not displayed when a checkmark is placed in Borderless Printing.

Mac OS X Software > Preview >
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Borderless Printing
You can print the media without margins on all sides when the roll paper with the specific width and the specific media type
is used.
For more information about Borderless Printing, see "Print with No Borders." →P.479

Note
• Available only if rolls are selected in Paper Source.
• This is not displayed when a checkmark is placed in Print Centered.

Paper Size
You can select the size of the print media.

Note
• This is not displayed when Fit Roll Paper Width is set in Enlarged/Reduced Printing.

Print Centered
You can print on the center of the media loaded in the printer.
For more information about Print Centered, see "Print on the Center." →P.480

Note
• This is not displayed when a checkmark is placed in Borderless Printing.

No Spaces at Top or Bottom
You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the top or bottom.
For more information about No Spaces at Top or Bottom, see "Not Print Spaces at the Top/Bottom." →P.481

Note
• Available only if rolls are selected in Paper Source.

Rotate Page
Select the method for rotating page.
The following settings are available for rotating page.

Setting Details

Rotate Right 90 Degrees Rotates the portrait page right 90 degrees and print in landscape orientation. When
the rotated page can fit in the width of roll paper, the page is rotated automatically,
and when it can not fit in the width of roll paper, the page is not rotated.

Rotate Left 90 Degrees Rotates the portrait page left 90 degrees and print in landscape orientation. When
the rotated page can fit in the width of roll paper, the page is rotated automatically,
and when it can not fit in the width of roll paper, the page is not rotated.

Rotate 180 degrees Allows you to rotate the image 180 degrees from the vertical to the right.

Restore Defaults Button
Click the button to reset to the setting when starting Preview.
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Print Button
Click the button to begin printing.
 

Update Printer Info. Button
Click the button to acquire printer information.
 

Color Settings Panel
This panel appears when you select Color Settings in the dialog area.

Color Mode
You can select a color mode to suit the print job.

Setting Details

Color Enables color printing.

Monochrome Disables color printing and converts image from continuous color to grayscaled
monochrome.

Color (CAD) Prints lines in the best color possible so they are easy to see.

Monochrome Bitmap Prints all colors other than white in black.

Monochrome (BK ink) Select to print all lines with black ink.

Mac OS X Software > Preview >
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Setting Details

No color correction Prints without performing color matching in the printer driver. Select this when
color matching is performed by the application such as Adobe Photoshop or when
you want to print color charts using the profile creation tool.

Note
• The availability of settings depends on the print priority and media type selections.

Color Adjustment / Matching
You can set the color adjustment and matching.

• Color Adjustment →P.471

• Matching →P.474

Restore Defaults Button
Click the button to reset to the setting when starting Preview.

Print Button
Click the button to begin printing.

Update Printer Info. Button
Click the button to acquire printer information.

Color Adjustment
You can set the color adjustment.

Adjusting Color
Normally colors should be adjusted in the software application, but if you see colors in the printout that do not match colors
on the screen, you can perform color adjustments.

1. Select Color on Color Mode in the Color Settings panel.
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2. Select Color Adjustment.

3. Drag each slider to the left or right to adjust.

Setting Details

Cyan Adjusts the strength of colors to compensate the hues.

Magenta Adjusts the strength of colors to compensate the hues.

Yellow Adjusts the strength of colors to compensate the hues.

Brightness Adjusts the brightness of the entire image. When the results of the printout are
brighter than the original images such as the original photo before scanning and
graphics created on the display, or when you want to print in different degrees of
brightness, use this feature.

Contrast Adjusts the relative brightness between the brightest and darkest portions of the im-
age.
 

*For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Saturation Adjusts the hues for vivid color or dark color.

Gray Tone Adjusts gray from cool black (bluish tones) to warm black (reddish tones).

Note
• You can also click the up or down arrow, or enter the number directly to increase or decrease the

value.

Mac OS X Software > Preview >
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Adjusting Monochrome
Use the monochrome setting to print monochrome images of color photographs captured with a scanner or digital camera or
other color images.

1. Select Monochrome on Color Mode in the Color Settings panel.

2. Select Color Adjustment.

3. Drag each slider to the left or right to adjust.

Setting Details

Brightness Adjusts the brightness of the entire image. When the results of the printout are
brighter than the original images such as the original photo before scanning and
graphics created on the display, or when you want to print in different degrees of
brightness, use this feature.

Contrast Adjusts the relative brightness between the brightest and darkest portions of the im-
age.
 

*For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Note
• You can also click the up or down arrow, or enter the number directly to increase or decrease the

value.
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Matching
You can set the matching.

Important
• If No color correction is selected under Color Mode, the Matching is not displayed.

Matching Mode
You can select a matching mode to suit the print job.

Setting Details

Driver Matching
Mode →P.476

Enables printing of optimal color tones using a driver specific color profile. You
should normally select this mode.

ICC Matching Mode →P.477 Enables color matching using ICC profiles. Select this if you want to print by spec-
ifying the input profile, printer profile, and matching method in detail. This allows
you to use ICC profiles for digital cameras and scanners, ICC profiles created using
the profile creation tool, etc.

ColorSync →P.478 Enables color matching by using the ColorSync function of Mac OS. Select this if
you want to perform soft proofing using ColorSync before printing.

Note
• You need to set each correction on the printer driver.
• Using Mac OS X 10.5 or later, ColorSync needs to be selected in the Color Matching panel of the driver in

order to select ColorSync.

Mac OS X Software > Preview >
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Matching Method
You can select a matching method to suit the print job.
 

Input Profile
Select the input profile.

Note
• You can select only after ICC Matching Mode has been selected in Matching Mode.

Printer Profile
Select the printer profile.

Note
• (Using Mac OS X 10.3.9 - 10.4)You can select only after ICC Matching Mode or ColorSync has been se-

lected in Matching Mode.
• (Using Mac OS X 10.5 or later)You can select only after ICC Matching Mode has been selected in Match-

ing Mode.

Soft Proof
When you place a checkmark here, ColorSync applies to the preview area.

Note
• You can select only after ColorSync has been selected in Matching Mode.
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Driver Matching Mode

1. Under Matching Mode, select Driver Matching Mode.

2. Click Matching Method list, and then select a setting.

Setting Details

Auto Automatically selects the best color matching method for each Image, Graphics,
Text.

Perceptual Color-matching optimized for printing typical photos attractively. Smooth grada-
tion is a feature. This is also an easy-to-use mode when performing color adjust-
ment using application software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input col-
or space. This is the easiest-to-use mode when you want to adjust the color and
print. However, gradation may be lost for colors of wider range than the color re-
production range of the printer. Generally, this is also called relative colorimetric.
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ICC Matching Mode

1. Under Matching Mode, select ICC Matching Mode.

2. Click the Matching Method list, and then select a setting.

Setting Details

Perceptual Color-matching optimized for printing typical photos attractively. Smooth grada-
tion is a feature. This is also an easy-to-use mode when performing color adjust-
ment using application software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input col-
or space. This is the easiest-to-use mode when you want to adjust the color and
print. However, gradation may be lost for colors of wider range than the color re-
production range of the printer. Generally, this is also called relative colorimetric.

Colorimetric (No White-Point
Correction)

The processing method of color-matching is identical to Colorimetric. Use this
when you want to further reproduce the target paper material color of the image da-
ta. Generally, this also is called absolute colorimetric.

3. Click the Input Profile list and select an input profile.

4. Click the Printer Profile list and select a printer profile.
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ColorSync

1. Check that ColorSync is selected in Matching Mode.

2. To apply ColorSync to previews, check the Soft Proof check box.

Preferences Dialog Box
This dialog box appears when you select Preferences from the imagePROGRAF Advanced Preview menu. You can set
the preferences for Preview.

Units
Set the unit for paper length, margins, and so on.
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Zoom Dialog Box
This dialog box appears when you select Zoom from the View menu. You can enlarge or reduce the screen display.

Scaling
Set the magnification for enlargement or reduction of the screen display.

Note
• You can input between 10 and 400.
• You can change the numbers by clicking ▼ button.

Go to Page Dialog Box
This dialog box appears when you select Go to Page from the View menu.

Note
• You can not select Go to Page if the document is only one page.

Page
Input the page number in numerical characters to display in the preview area.

Note
• You can change the numbers in the range of the page of the documents.

Print with No Borders
You can use the borderless printing function to print without margins surrounding the image.

Note
• With some media borderless printing can be performed only between two edges.
• To use the borderless printing function, the specified media must be set to the printer.

1. On the Paper Settings Panel →P.463 , select Roll Paper in Paper Source.
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2. On the Output Settings panel, click the Enlarged/Reduced Printing check box on.

3. Select Fit Roll Paper Width.

4. Click the Borderless Printing check box on.

5. Click the Print button.
 

Borderless printing begins.

Print on the Center
You can print on the center of the media loaded in the printer.

Note
• This is not displayed when a checkmark is placed in Borderless Printing.
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1. On the Output Settings panel, click the Print Centered check box on.

2. Click the Print button.
 

Printing on the center begins.

Not Print Spaces at the Top/Bottom
You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the top or bottom.

Note
• This is not displayed when a checkmark is placed in Borderless Printing.

1. On the Paper Settings Panel →P.463 , select Roll Paper in Paper Source.
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2. On the Output Settings panel, click the No Spaces at Top or Bottom check box on.

3. Click the Print button.
 

Printing on the settings with no spaces at top or bottom begins.

Print Page Rotated 90 Degrees
You can save paper by printing in landscape orientation on roll paper.

1. On the Paper Settings Panel →P.463 , select Roll Paper in Paper Source.

2. On the Output Settings panel, click the Rotate Page check box on.
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3. Select Rotate Right 90 Degrees or Rotate Left 90 Degrees.

4. Click the Print button.
 

Printing on rotating 90 degrees begins.

Display with Fitting to the Width of the Paper
In the preview area, you can display to the width of the paper.

1. Select  Fit Roll Paper Width from the tool bar.
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2. Fitting to the width of the paper, it is displayed.

Display with All
In the preview area, you can display all.

1. Select  Fit Screen from the tool bar.

2. All is displayed.
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Display with Actual Size
In the preview area, you can display the actual size.

1. Select  Actual Size from the tool bar.

2. Actual size is displayed.

Moving a Page
You can move a page to display in the preview area.

1. Select each button in Go to Page on the tool bar.

Setting Details

Go to the first page.

Go to the previous page.

Go to the next page.

Go to the last page.
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2. The target page appears.

Note
• You can also move a page by clicking the page on the thumbnails.
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The Features of Free Layout
The main features of Free Layout are as follows.

• Allows you to lay out at will and print a document created with application software.
• You can not only lay out multiple pages on one page but also lay out and print a multiple-file document on one page,

or lay out and print a document created with multiple application programs on one page.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print output

to differ from the Free Layout settings.

Operating Environment
You can use the Free Layout in the following environments.

• Compatible Operating System
Mac OS X (10.3.9 to 10.6)

• Software that requires installation
imagePROGRAF Printer Driver

Mac OS X Software > Free Layout >
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Starting Free Layout
Follow the procedure below to start the Free Layout.

1. Start the apllication software which you use.

2. From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.

3. Click on Free Layout in the Page Setup panel to attach a checkmark.

4. Click the Print button in the Print dialog box.

Note
• Your printer is depicted in the lower-left area of this screen.

Mac OS X Software > Free Layout >
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5. Free Layout main window is displayed.

Free Layout Main Window
The Free Layout main window consists of the menu and tool bars, layout area and dialog areas.

Note
• You can use the View menu to show or hide the tool.
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Menu Bar
This allows you to select menus required for operations.

Tool Bar
This allows you to select tool buttons required for major operations.

Layout Area
This allows you to lay out objects and edit the object size and orientation.

Mac OS X Software > Free Layout >
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Dialog Area
This allows you to set the print conditions and perform a print job.

Mac OS X Software > Free Layout >
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Paper Settings Panel
This panel appears when you select Paper Settings in the dialog area.

Media Type
This allows you to select the media type.

Note
• Always select media type that is actually set in the printer. When the media you chose is different from the

media set in the printer, you may not receive the desired print results.

Easy Settings / Advanced Settings
Two modes are available to provide the optimum print settings for jobs.
The settings available on each mode are as follows.

• Easy Settings →P.494

• Advanced Settings →P.495

Paper Source
You can select the paper source.
The following settings are available for paper source.

Setting Details

Cut Sheet Select to print on the cut sheet.

Mac OS X Software > Free Layout >
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Setting Details

Roll Paper 1 Select to print on the roll paper of Roll Paper 1 (Upper).

Roll Paper 2 Select to print on the roll paper of Roll Paper 2 (Lower).

Roll Paper Width
This selects the width of the roll media set to the printer.

Note
• Available only if rolls are selected in Paper Source.

Copies
You can input the number of print copies in numerical characters.

Note
• The maximum value is 999.
• You can change the numbers by clicking either ▲ button or ▼ button.

Restore Defaults Button
Click the button to reset to the setting when starting Free Layout.

Print Button
Click the button to begin printing.

Update Printer Info. Button
Click the button to acquire printer information.
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Easy Settings
You can easily select the best settings for the print job by just selecting an item from the print target list that matches the
content of the document.

Print Target
You can easily select the best settings for the print job simply.
If you select each Print Target item the corresponding comment for that item is displayed below the list.

Setting Details

Default Settings Suitable for printing normal documents that contain a mixture of text, photographs,
and graphics.

Office Document Suitable for printing handouts as well as general office documents for which print
clarity is key.

Poster The best setting for posters.Prints using vivid and high impact colors.

CAD (Color Line Drawing) Prints the fine lines of CAD drawings and other such documents sharp and clear.

CAD (B/W Line Drawing) Suitable for printing CAD drawings with sharp, dark lines.

Perspective, GIS Suitable for attractive printing of 3D-CAD drawings, perspective drawings, and
GIS drawings including maps.

Photo (Color) Suitable for printing photographic images captured with a digital camera.

Faithful Color Reproduction Prints by faithfully reproducing the colors of the original image.

Custom Settings Suitable for printing documents for which Advanced Settings have been specified.
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Note
• The number of settings available for selection depends on the media type.

Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.

Setting Details

Print Quality Highest / High / Standard / Draft

Resolution 1200dpi / 600dpi / 300dpi

Note
• The availability of settings is determined by the media type and print priority selections.
• Printing time is longer and more ink is consumed with High than with Draft, however, print quality is high-

er.
• Printing time is shorter and less ink is consumed with Draft than with High, however, print quality is lower.

Advanced Settings
Presents detailed settings for the print priority, the print quality, and other items so you can select the values for these set-
tings yourself.
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Print Priority
Select a print quality mode that is appropriate for the print job.

Setting Details

Image This mode achieves the best results for printing photographic images and illustra-
tions.

Line Drawing This mode is best for printing CAD drawings with fine lines or wall newssheet or
other documents that contain large amounts of text. However, you may not achieve
the quality you expect with printing photographs or other images with many filled
areas. For these types of jobs, select Image.

Office Document Prints common office documents, such as proposals, memos for distribution, etc.,
so they are easy to read.

Note
• The number of settings available for selection depends on the media type.

Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.

Setting Details

Print Quality Highest / High / Standard / Draft

Resolution 1200dpi / 600dpi / 300dpi

Note
• The availability of settings is determined by the media type and print priority selections.
• Printing time is longer and more ink is consumed with High than with Draft, however, print quality is high-

er.
• Printing time is shorter and less ink is consumed with Draft than with High, however, print quality is lower.
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Color Settings Panel
This panel appears when you select Color Settings in the dialog area.

Color Mode
You can select a color mode to suit the print job.

Setting Details

Color Enables color printing.

Monochrome Disables color printing and converts image from continuous color to grayscaled
monochrome.

Color (CAD) Prints lines in the best color possible so they are easy to see.

Monochrome Bitmap Prints all colors other than white in black.

Monochrome (BK ink) Select to print all lines with black ink.

No color correction Prints without performing color matching in the printer driver. Select this when
color matching is performed by the application such as Adobe Photoshop or when
you want to print color charts using the profile creation tool.

Note
• The availability of settings depends on the print priority and media type selections.

Color Adjustment / Matching
You can set the color adjustment and matching.

Mac OS X Software > Free Layout >

iPF825 Color Settings Panel

5

497



• Color Adjustment →P.498

• Matching →P.501

Note
• Matching is not displayed if No color correction has been selected in Color Mode.

Restore Defaults Button
Click the button to reset to the setting when starting Free Layout.

Print Button
Click the button to begin printing.

Update Printer Info. Button
Click the button to acquire printer information.

Color Adjustment
You can set the color adjustment.

Adjusting Color
Normally colors should be adjusted in the software application, but if you see colors in the printout that do not match colors
on the screen, you can perform color adjustments.

1. Select Color on Color Mode in the Color Settings panel.
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2. Select Color Adjustment.

3. Drag each slider to the left or right to adjust.

Setting Details

Cyan Adjusts the strength of colors to compensate the hues.

Magenta Adjusts the strength of colors to compensate the hues.

Yellow Adjusts the strength of colors to compensate the hues.

Brightness Adjusts the brightness of the entire image. When the results of the printout are
brighter than the original images such as the original photo before scanning and
graphics created on the display, or when you want to print in different degrees of
brightness, use this feature.

Contrast Adjusts the relative brightness between the brightest and darkest portions of the im-
age.
 

*For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Saturation Adjusts the hues for vivid color or dark color.

Gray Tone Adjusts gray from cool black (bluish tones) to warm black (reddish tones).

Note
• You can also click the up or down arrow, or enter the number directly to increase or decrease the

value.
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Adjusting Monochrome
Use the monochrome setting to print monochrome images of color photographs captured with a scanner or digital camera or
other color images.

1. Select Monochrome on Color Mode in the Color Settings panel.

2. Select Color Adjustment.

3. Drag each slider to the left or right to adjust.

Setting Details

Brightness Adjusts the brightness of the entire image. When the results of the printout are
brighter than the original images such as the original photo before scanning and
graphics created on the display, or when you want to print in different degrees of
brightness, use this feature.

Contrast Adjusts the relative brightness between the brightest and darkest portions of the im-
age.
 

*For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Note
• You can also click the up or down arrow, or enter the number directly to increase or decrease the

value.
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Matching
You can set the matching.

Important
• If No color correction is selected under Color Mode, the Matching is not displayed.

Matching Mode
You can select a matching mode to suit the print job.

Setting Details

Driver Matching
Mode →P.503

Enables printing of optimal color tones using a driver specific color profile. You
should normally select this mode.

ICC Matching Mode →P.504 Enables color matching using ICC profiles. Select this if you want to print by spec-
ifying the input profile, printer profile, and matching method in detail. This allows
you to use ICC profiles for digital cameras and scanners, ICC profiles created using
the profile creation tool, etc.

ColorSync →P.505 Enables color matching by using the ColorSync function of Mac OS. Select this if
you want to perform soft proofing using ColorSync before printing.

Note
• You need to set each correction on the printer driver.
• Using Mac OS X 10.5 or later, ColorSync needs to be selected in the Color Matching panel of the driver in

order to select ColorSync.
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Matching Method
You can select a matching method to suit the print job.

Input Profile
Select the input profile.

Note
• You can select only after ICC Matching Mode has been selected in Matching Mode.

Printer Profile
Select the printer profile.

Note
• (Using Mac OS X 10.3.9 - 10.4)You can select only after ICC Matching Mode or ColorSync has been se-

lected in Matching Mode.
• (Using Mac OS X 10.5 or later)You can select only after ICC Matching Mode has been selected in Match-

ing Mode.

Soft Proof
When you place a checkmark here, ColorSync applies to the layout area.

Note
• You can select only after ColorSync has been selected in Matching Mode.
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Driver Matching Mode

1. Under Matching Mode, select Driver Matching Mode.

2. Click Matching Method list, and then select a setting.

Setting Details

Auto Automatically selects the best color matching method for each Image, Graphics,
Text.

Perceptual Color-matching optimized for printing typical photos attractively. Smooth grada-
tion is a feature. This is also an easy-to-use mode when performing color adjust-
ment using application software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input col-
or space. This is the easiest-to-use mode when you want to adjust the color and
print. However, gradation may be lost for colors of wider range than the color re-
production range of the printer. Generally, this is also called relative colorimetric.
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ICC Matching Mode

1. Under Matching Mode, select ICC Matching Mode.

2. Click the Matching Method list, and then select a setting.

Setting Details

Perceptual Color-matching optimized for printing typical photos attractively. Smooth grada-
tion is a feature. This is also an easy-to-use mode when performing color adjust-
ment using application software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input col-
or space. This is the easiest-to-use mode when you want to adjust the color and
print. However, gradation may be lost for colors of wider range than the color re-
production range of the printer. Generally, this is also called relative colorimetric.

Colorimetric (No White-Point
Correction)

The processing method of color-matching is identical to Colorimetric. Use this
when you want to further reproduce the target paper material color of the image da-
ta. Generally, this also is called absolute colorimetric.

3. Click the Input Profile list and select an input profile.

4. Click the Printer Profile list and select a printer profile.
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ColorSync

1. Check that ColorSync is selected in Matching Mode.

2. Place a checkmark on Soft Proof to simulate the output product in Layout Area.
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Preferences Dialog Box
This dialog box appears when you select Preferences from the imagePROGRAF Advanced Preview menu. You can set the
preferences for Free Layout.

Units
Set the unit for paper length, margins, and so on.

Gridlines
You can input a grid line width value in numerical characters so that they serve as a guide to laying out objects.

Note
• You can input between 10.0 and 200.0(mm) (between 0.39 and 7.87(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

Divisions
You can change the number of divisions of grid lines so that they serve as a guide to laying out objects.

Note
• You can input between 1 and 10.
• You can change the numbers by clicking either ▲ button or ▼ button.

Grid Color
Select the grid line color.

Print Object Frames
You can print the object border.
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Note
• If you do not want to print the object border, deselect the Print Object Frames check box.

Object Frame Style
You can select the object frame style for printing.
The following settings are available for the object frame style.

Setting Details

Solid Line You can print the solid line as the frame style.

Dotted Line You can print the dotted line as the frame style.

Dashed Line You can print the dashed line as the frame style.

Auto Arrange Spacing
Change the object-to-object spacing to be applied in the operation of laying out objects automatically.

Note
• You can input between 0.0 and 100.0(mm) (between 0.00 and 3.94(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

Page Setup Dialog Box
This dialog box appears when you select Page Setup from the File menu.This dialog box provides selections for setting the
media size, orientation and other important features.

Paper Orientation
This selects the paper orientation.
The following settings are available for orientation.
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Setting Details

Vertical Prints the image and text created with the application software in the orientation as
it is.

Horizontal Prints the image and text by rotating sideways 90 degrees from the orientation as
specified in the application.

Roll Paper Length
Set the length of one page to print on roll paper.
When you place a checkmark on Auto Settings, the one-page length to be printed on roll paper is automatically set so that
the laid-out objects are printed on one page.

Note
• Available only if rolls are selected in Paper Source.
• You can input between 203.2 and 18000.0(mm) (between 8.00 and 708.66(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

Order
Set the object layout order.
The following settings are available for order.

Setting Details

Upper Left to Right The objects are laid out from upper left to right.

Upper Left to Bottom The objects are laid out from upper left to bottom.

Note
• When you have selected Roll Paper Length > Auto Settings and Paper Orientation > Vertical, you can

choose only Upper Left to Right.
• When you have selected Roll Paper Length > Auto Settings and Paper Orientation > Horizontal, you can

choose only Upper Left to Bottom.

Paper Size
You can select the size of the print media.

Note
• You cannot display this if Roll Paper is selected in Paper Source.

Zoom Dialog Box
This dialog box appears when you select Zoom from the View menu. You can enlarge or reduce the screen display.
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Scaling
Set the magnification for enlargement or reduction of the screen display.

Note
• You can input between 10 and 400.
• You can change the numbers by clicking ▼ button.

Format Dialog Box
This dialog box appears when you select Format from the Object menu after you select an object. You can rotate, enlarge,
or reduce an object.

Note
• When the objects are not selected, you can not select Format.

Rotate
When you place a checkmark here, you can select Rotate Right or Rotate Left.

Setting Details

Rotate Right Rotates the object 90 degrees clockwise.

Rotate Left Rotates the object 90 degrees counterclockwise.

Note
• When several objects are selected, you cannot select Rotate.

Scaling
You can input the value for enlargement or reduction of the obeject in numerical characters.

Note
• You can input between 25 and 400.
• You can change the numbers by clicking either ▲ button or ▼ button.
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Object Size
You can confirm the object size.

Note
• When several objects are selected, you cannot display Object Size.

Laying out a Multiple-File Document on One Page
You can lay out and print a multiple-file document on one page.

1. From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.

2. Click on Free Layout in the Page Setup panel to attach a checkmark.

3. In the Print dialog box, select the pages to print and the number of copies, and click the Print button.
Free Layout starts, laying out the document created with application software in the layout area as an object.

4. Leaving Free Layout running, open other files with the application software and repeat the above steps.

Laying out a Document Created with Multiple Application Programs on One Page
You can lay out and print a document created with multiple application programs on one page.

1. From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.

2. Click on Free Layout in the Page Setup panel to attach a checkmark.

3. In the Print dialog box, select the pages to print and the number of copies, and click the Print button.
Free Layout starts, laying out the document created with application software in the layout area as an object.

4. Leaving Free Layout running, open the files with other application software and repeat the above steps.
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Selecting an Object
When an object is selected, a select box (blue border) appears around the object.

Note
• To select an object, click that object.
• To select multiple successive objects, click them while holding down the shift key.
• To select multiple arbitrary objects, click them while holding down the command key.
• To select all objects, select Select All from the Edit menu.

Changing the Object Size
You can change the object size by means of mouse operation or by specifying a scaling value.

Note
• The vertical-to-horizontal ratio remains unchanged when the object is enlarged or reduced.

Resizing by means of mouse operation

1. Select an object.
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2. Place the pointer at a corner of the selection box around the object to show the arrow handle, and drag this handle to
change the object size.

Resizing by specifying a scaling value

1. Select an object.

2. Open the Format Dialog Box →P.509 .

3. Use Scaling to set the magnification for enlargement or reduction. You either enter numbers directly.

Note
• You can input between 25 and 400.
• You can change the numbers by clicking either ▲ button or ▼ button.

4. Click the OK button.

Moving an Object
You can move the object position.

1. Select an object.
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2. Place the pointer inside the selection box of the object to show the crosshair handle, and drag it to move the object.

Rotating an Object
You can rotate the object.

1. Select an object.

2. Select Rotate Left or Rotate Right from the toolbar.
Alternatively, you may click on the Rotate check box in the Format Dialog Box →P.509  then select Rotate Right
or Rotate Left, and click the OK button.

Note
• When several objects are selected, you cannot select Rotate.
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Laying out Objects Automatically
Click Auto Arrange in the tool bar. This automatically lays out objects. Alternatively, you may select Auto Arrange Ob-
ject from the Object menu.

Note
• The object layout order varies depending on the Order setting on the Page Setup Dialog Box →P.507 .

Aligning Objects
You can align objects systematically.

1. Select multiple objects.

2. Select the align menu from the Object menu.

Align Top
Lays out the objects, justifying them to the top.
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Center Vertically
Lays out the objects, justifying them to the vertical center.

Align Bottom
Lays out the objects, justifying them to the bottom.

Align Left
Lays out the objects, justifying them to the left.
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Center Horizontally
Lays out the objects, justifying them to the horizontal center.

Align Right
Lays out the objects, justifying them to the right.

Changing the Object Overlapping Order
You can change the object overlapping order.

1. Select an object.

2. Select the overlapping order menu from the Object menu.
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Bring to Front
Moves the object to the frontmost position.

Send to Back
Moves the object to the backmost position.

Bring Forward
Moves the object one position to the front.
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Send Backward
Moves the object one position to the back.

Pasting a Copied or Cut Object

1. Click Copy or Cut from the toolbar.
Alternatively, you may select Copy or Cut from the Edit menu.

2. Click Paste from the toolbar.
Alternatively, you may select Paste from the Edit menu.

Note
• The copied or cut object is laid out at the end of the page.
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The Features of Color imageRUNNER Enlargement Copy
The main features of Color imageRUNNER Enlargement Copy are as follows.

• Allows the document scanned with the Color imageRUNNER to be automatically enlarged and printed.
• You can perform basic printer settings such as printer selection, media type and output profile selection, and matching

methods, in addition to borderless printing and enlargement/reduction process without growing through the printer
driver.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print output

to differ from the Color imageRUNNER Enlargement Copy settings.

Operating Environment
You can use the Color imageRUNNER Enlargement Copy in the following environments.

• Compatible Operating System
Mac OS X (10.3.9 to 10.6)
 

• Software that requires installation
imagePROGRAF Printer Driver
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Starting Color imageRUNNER Enlargement Copy
Follow the procedure below to start the Color imageRUNNER Enlargement Copy.

1. Open the Utility panel of the Print dialog box.

Note
• Your printer is depicted in the lower-left area of this screen.
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2. Click the Set button in Configure Color imageRUNNER Enlargement Copy. to open the Color imageRUNNER
Enlargement Copy dialog box.

Note
• You can also start the utility directly by clicking on the Color imageRUNNER Enlargement Copy.app

icon in Applications > Canon Utilities > iR Enlargement Copy.

Color imageRUNNER Enlargement Copy Dialog Box
The explanation below is on the Color imageRUNNER Enlargement Copy dialog box.

Note
• For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color image-

RUNNER Enlargement Copy." →P.520
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Delete files in the folder
From the Hot Folder list, select a hot folder and click the Delete button to delete only files in the hot folder.

Delete the entire folder, as well as items in the list above
From the Hot Folder list, select a hot folder and click the Delete button to delete the hot folder.

Delete Button
Select Delete files in the folder or Delete the entire folder, as well as items in the list above and click this button to
delete the hot folder or only files in the hot folder.

Add Button
Click the button to open the Destination Selection dialog box so that you can add a hot folder.

Edit Button
From the Hot Folder list, select a hot folder and click this button to open the Add/Edit Hot Folder dialog box that allows
you to edit the hot folder.

Monitor Hot Folder Constantly
If you click on the check box, the icon of Color imageRUNNER Enlargement Copy utility will appear on the Dock when
starting OS X thereafter.

Hot Folder
Hot folder refers to a folder used for Color imageRUNNER Enlargement Copy.

• When transferred to the PC's hot folder, the document data scanned with the Color imageRUNNER is printed in en-
larged size from the printer according to the print conditions set in the hot folder.

• You can create a new hot folder, edit or delete an existing one, and set print conditions at will.

Note
• You can create up to 10 hot folders.
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Creating a New Hot Folder

1. Open the Color imageRUNNER Enlargement Copy dialog box.

Note
• For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color

imageRUNNER Enlargement Copy." →P.520

2. Click the Add button in Enlarged Copy Settings to open the Destination Selection dialog box.

3. From the printer list in Destination, select the printer of destination.
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4. Click the OK button to open the Add/Edit Hot Folder dialog box.

5. In Name, enter the name to display in the Hot Folder list.

6. In Hot Folder, enter the Hot Folder name.

7. Click the OK button. The created Hot Folder is listed in the Color imageRUNNER Enlargement Copy dialog box.
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8. Click the Close button to close the Color imageRUNNER Enlargement Copy dialog box.

9. From the Apple Menu, open the Sharing dialog box for System Preferences.

10. Select the check box labeled File Sharing, and click the Options button.

11. Select the check box labeled Share files and folders using FTP and Share files and folders using SMB to make
shared settings.

Note
• You can create up to 10 hot folders.

Editing a Hot Folder (Setting Print Conditions)

1. Open the Color imageRUNNER Enlargement Copy dialog box.

2. Select the Hot Folder from the Hot Folder list.

3. From Enlarged Copy Settings, click Edit button to open the Add/Edit Hot Folder dialog box.
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4. Make the necessary settings in the Paper Settings Panel →P.530 .
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5. Make the necessary settings in the Output Settings Panel →P.535 .
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6. Make the necessary settings in the Color Settings Panel →P.537 .

7. Click the OK button to close the Add/Edit Hot Folder dialog box.

8. From the Apple Menu, open the Sharing dialog box for System Preferences.

9. Select the check box labeled File Sharing, and click the Options button.

10. Select the check box labeled Share files and folders using FTP and Share files and folders using SMB to make
shared settings.

Note
• If you've made shared settings when you created a new Hot Folder, you do not need to execute steps 8

to 10.
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Deleting a Hot Folder

1. Open the Color imageRUNNER Enlargement Copy dialog box.

2. Select the Hot Folder you want to delete from the Hot Folder list.

3. Select Delete the entire folder, as well as items in the list above, and then click the Delete button.

4. Read the messag,e and then click the OK button.

Note
• Select Delete files in the folder to delete only files in the hot folder.

Setting the Print Parameters
You can set the print conditions in the setting panels within the Add/Edit Hot Folder dialog box.
The settings available on each panel are as follows.

• Paper Settings Panel →P.530

• Output Settings Panel →P.535

• Color Settings Panel →P.537
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Paper Settings Panel

Easy Settings / Advanced Settings
Two modes are available to provide the optimum print settings for jobs.
The settings available on each mode are as follows.

• Easy Settings →P.532

• Advanced Settings →P.533

Media Type
This allows you to select the media type.

Note
• Always select media type that is actually set in the printer. When the media you chose is different from the

media set in the printer, you may not receive the desired print results.

Paper Source
You can select the paper source.
The following settings are available for paper source.

Setting Details

Cut Sheet Select to print on the cut sheet.

Roll Paper 1 Select to print on the roll paper of Roll Paper 1 (Upper).

Roll Paper 2 Select to print on the roll paper of Roll Paper 2 (Lower).
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Roll Paper Width
This selects the width of the roll media set to the printer.

Note
• Available only if rolls are selected in Paper Source.

Automatic Cutting
You can set the printer to cut roll paper automatically or print a guideline for cutting.
The following settings are available for automatic cutting.

Setting Details

Printer Default The value set on the printer operation panel takes priority.

None Each page is not cut after it is printed and printing continues without interruption.

Print Cut Guideline A print cut guideline is printed after each page and printing continues without inter-
ruption.

Note
• Available only if rolls are selected in Paper Source.

Copies
You can input the number of print copies in numerical characters.

Note
• The maximum value is 999.
• You can change the numbers by clicking either ▲ button or ▼ button.
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Easy Settings
You can easily select the best settings for the print job by just selecting an item from the print target list that matches the
content of the document.

Print Target
You can easily select the best settings for the print job simply.
If you select each Print Target item the corresponding comment for that item is displayed below the list.

Setting Details

Default Settings Suitable for printing normal documents that contain a mixture of text, photographs,
and graphics.

Office Document Suitable for printing handouts as well as general office documents for which print
clarity is key.

Poster The best setting for posters.Prints using vivid and high impact colors.

CAD (Color Line Drawing) Prints the fine lines of CAD drawings and other such documents sharp and clear.

CAD (B/W Line Drawing) Suitable for printing CAD drawings with sharp, dark lines.

Perspective, GIS Suitable for attractive printing of 3D-CAD drawings, perspective drawings, and
GIS drawings including maps.

Photo (Color) Suitable for printing photographic images captured with a digital camera.

Faithful Color Reproduction Prints by faithfully reproducing the colors of the original image.

Custom Settings Suitable for printing documents for which Advanced Settings have been specified.
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Note
• The number of settings available for selection depends on the media type.

Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.

Setting Details

Print Quality Highest / High / Standard / Draft

Resolution 1200dpi / 600dpi / 300dpi

Note
• The availability of settings is determined by the media type and print priority selections.
• Printing time is longer and more ink is consumed with High than with Draft, however, print quality is high-

er.
• Printing time is shorter and less ink is consumed with Draft than with High, however, print quality is lower.

Advanced Settings
Presents detailed settings for the print priority, the print quality, and other items so you can select the values for these set-
tings yourself.
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Print Priority
Select a print quality mode that is appropriate for the print job.

Setting Details

Image This mode achieves the best results for printing photographic images and illustra-
tions.

Line Drawing This mode is best for printing CAD drawings with fine lines or wall newssheet or
other documents that contain large amounts of text. However, you may not achieve
the quality you expect with printing photographs or other images with many filled
areas. For these types of jobs, select Image.

Office Document Prints common office documents, such as proposals, memos for distribution, etc.,
so they are easy to read.

Note
• The number of settings available for selection depends on the media type.

Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.

Setting Details

Print Quality Highest / High / Standard / Draft

Resolution 1200dpi / 600dpi / 300dpi

Note
• The availability of settings is determined by the media type and print priority selections.
• Printing time is longer and more ink is consumed with High than with Draft, however, print quality is high-

er.
• Printing time is shorter and less ink is consumed with Draft than with High, however, print quality is lower.
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Output Settings Panel

Enlarged/Reduced Printing
Select the method for enlarged/reduced printing.
The following settings are available for enlarged/reduced printing.

Setting Details

Fit Paper Size Enlarges/reduces the whole page automatically to fit the media size selected for
output. Select the media size to print from Paper Size.

Fit Roll Paper Width Enlarges/reduces the whole page automatically to fit the width of the roll paper
with the page width.
 

*Make sure that the width of the roll paper in the printer is set correctly for Roll
Paper Width in the Paper Settings panel.
*Displayed only if rolls are selected in Paper Source.

Scaling Enlarges/reduces the whole page by the scaling rate as specified. Input the scaling
value in numerical characters. You can specify a range between 5 and 600%.
 

*You can change the numbers by clicking either ▲ button or ▼ button.
*Although Scaling can be set to make the image larger than the media size, the part
that does not fit in the media cannot be printed.
*This is not displayed when a checkmark is placed in Borderless Printing.

Borderless Printing
You can print the media without margins on all sides when the roll paper with the specific width and the specific media type
is used.
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Note
• Available only if rolls are selected in Paper Source.

Paper Size
You can select the size of the print media.

Note
• This is not displayed when Fit Roll Paper Width is set in Enlarged/Reduced Printing.

Print Centered
Select this feature to print the image in the center of a cut sheet or to print left and right margins evenly from the edges of
roll paper.

Note
• This feature is useful when you print the document enlarged or reduced with Scaling as well. When an image

is scaled, it is always enlarged or reduced in reference to a starting point in the upper left corner of the page.
If the image is reduced, the bottom and right margins are enlarged and the top and left margins remain un-
changed. At that point, you can set all margins evenly with this feature.

No Spaces at Top or Bottom
You can set the printer to print without any empty area when the print data contains empty area at the top or bottom. Since
the printer does not feed paper over the empty area, you can save paper.

Note
• Available only if rolls are selected in Paper Source.

Rotate Page
Select the method for rotating page.
The following settings are available for rotating page.

Setting Details

Rotate Right 90 Degrees Rotates the portrait page right 90 degrees and print in landscape orientation. When
the rotated page can fit in the width of roll paper, the page is rotated automatically,
and when it can not fit in the width of roll paper, the page is not rotated.
 

*When Fit Roll Paper Width is selected under Enlarged/Reduced Printing, then
the image is enlarged or reduced after rotating to fit the width of the roll paper.

Rotate Left 90 Degrees Rotates the portrait page left 90 degrees and print in landscape orientation. When
the rotated page can fit in the width of roll paper, the page is rotated automatically,
and when it can not fit in the width of roll paper, the page is not rotated.
 

*When Fit Roll Paper Width is selected under Enlarged/Reduced Printing, then
the image is enlarged or reduced after rotating to fit the width of the roll paper.

Rotate 180 degrees Allows you to rotate the image 180 degrees from the vertical to the right.

Note
• Available only if rolls are selected in Paper Source.
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Output Method Button
Click the button to open the Output Method dialog box.
In this dialog box, you can specify the object output method.

Setting Details

Print Regular printing. Jobs are stored in the temporary storage space before printing.

Print (auto delete) After printing, jobs are immediately deleted.

Note
• To print after saving jobs in the temporary storage space, select Save data before printing.

Color Settings Panel

Color Mode
You can select a color mode to suit the print job.

Setting Details

Color Enables color printing.

Monochrome Disables color printing and converts image from continuous color to grayscaled
monochrome.

Color (CAD) Prints lines in the best color possible so they are easy to see.

Monochrome Bitmap Prints all colors other than white in black.

Mac OS X Software > Color imageRUNNER Enlargement Copy >

iPF825 Color Settings Panel

5

537



Setting Details

Monochrome (BK ink) Select to print all lines with black ink.

Note
• The availability of settings depends on the print priority and media type selections.

Matching Mode
Under Matching Mode, select the matching mode.

Setting Details

Driver Matching
Mode →P.539

Enables printing of optimal color tones using a driver specific color profile. You
should normally select this mode.

ICC Matching Mode →P.540 Enables color matching using ICC profiles. Select this if you want to print by spec-
ifying the input profile, printer profile, and matching method in detail. This allows
you to use ICC profiles for digital cameras and scanners, ICC profiles created using
the profile creation tool, etc.

ColorSync →P.541 Enables color matching by using the ColorSync function of Mac OS. Select this if
you want to perform soft proofing using ColorSync before printing.

No Correction No color matching is performed. Select this option when you want to perform color
matching in the software application.
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Driver Matching Mode

1. Under Matching Mode, select Driver Matching Mode.

2. Click Matching Method list, and then select a setting.

Setting Details

Auto Automatically selects the best color matching method for each Image, Graphics,
Text.

Perceptual Color-matching optimized for printing typical photos attractively. Smooth grada-
tion is a feature. This is also an easy-to-use mode when performing color adjust-
ment using application software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input col-
or space. This is the easiest-to-use mode when you want to adjust the color and
print. However, gradation may be lost for colors of wider range than the color re-
production range of the printer. Generally, this is also called relative colorimetric.
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ICC Matching Mode

1. Under Matching Mode, select ICC Matching Mode.

2. Click Matching Method list, and then select a setting.

Setting Details

Perceptual Color-matching optimized for printing typical photos attractively. Smooth grada-
tion is a feature. This is also an easy-to-use mode when performing color adjust-
ment using application software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input col-
or space. This is the easiest-to-use mode when you want to adjust the color and
print. However, gradation may be lost for colors of wider range than the color re-
production range of the printer. Generally, this is also called relative colorimetric.

Colorimetric (No White-Point
Correction)

The processing method of color-matching is identical to Colorimetric. Use this
when you want to further reproduce the target paper material color of the image da-
ta. Generally, this also is called absolute colorimetric.

3. Click the Input Profile list, and then select an input profile.

Note
• To match the color on the printing, select the input profile for Color imageRUNNER Enlargement

Copy of the Color imageRUNNER type in use.
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4. Click the Printer Profile list, and then select a printer profile.

ColorSync

1. Under Matching Mode, select ColorSync.

2. Click the Printer Profile list, and then select a printer profile.

Note
• Available when using Mac OS X 10.3.9-10.4.

Printing Enlargements of Scanned Originals from a Color imageRUNNER
Scanned originals from a Color imageRUNNER can be enlarged and printed automatically.
Originals you create by scanning with a Color imageRUNNER are transferred to a "hot folder" and printed automatically
after enlargement according to printing conditions you specify for that folder.
This processing sequence is called the Color imageRUNNER Enlargement Copy function.
To use Color imageRUNNER Enlargement Copy, first complete these settings in the following order.

1. Register a hot folder on your computer.
Register a hot folder on your computer for storing scanned originals from the Color imageRUNNER and complete the
settings for enlargement copy.

2. Complete the scanning settings on the Color imageRUNNER.
Configure the Color imageRUNNER to send scanned originals to the hot folder.
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After these settings are complete, you can print enlarged copies of scanned originals from the Color imageRUNNER.

Registering a hot folder on your computer
Folders used for Color imageRUNNER Enlargement Copy (iR enlargement copy) are called hot folders. Register a hot
folder on your computer for storing scanned originals from the Color imageRUNNER. You can specify printing conditions
(such as the image quality and paper size), based on which originals transferred to the hot folder will be printed. Follow
these steps to register and modify hot folders.

1. To display the Color imageRUNNER Enlargement Copy dialog box, either double-click the Color imageRUN-
NER Enlargement Copy.app icon after navigating to Canon Utilities — iR Enlargement Copy in the Applica-
tions folder or click Set in the Utility pane

Note
• Your printer is depicted in the lower-left area of this screen.

2. In Enlarged Copy Settings, click Add or Edit and either create or modify the hot folder.
For instructions on registering and modifying hot folders, refer to the help file for Color imageRUNNER Enlarge-
ment Copy.

Completing the scanning settings on the Color imageRUNNER.
Configure the Color imageRUNNER to send scanned originals to the hot folder. It is easy to send scanned originals to the
hot folder if you assign the scanning settings and destination to a Favorites button on the Color imageRUNNER.
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For instructions on assigning scanning and sending settings to the Favorites button, refer to the Color imageRUNNER man-
ual.

Scanning the original and print an enlargement
Follow the steps below to scan an original on the Color imageRUNNER for enlarged printing on the printer. For detailed
instructions, refer to the Color imageRUNNER manual.

1. Load the original on the platen glass or document feeder of the Color imageRUNNER.

2. Press Send to display the screen for transmission.

3. Press Favorites, and then press the Favorites button assigned to the hot folder.

4. Press Start on the control panel. If you scan originals on the platen glass, after scanning all originals, press Done on
the touch-panel display.
Scanned originals are sent to the hot folder and automatically enlarged and printed following the conditions you
specified for the folder.
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imagePROGRAF Printmonitor
imagePROGRAF Printmonitor is a utility for checking the printer status and managing print jobs.

• Printer status can be checked in real time on a computer monitor.
• You can check the status of print jobs, cancel jobs, and manage them as needed.
• If a printer error occurs, you can investigate the corrective action immediately.
• You can also set up automatic email notification of any printer problems or errors to email addresses you designate in

advance.

Note
• If the status of the desired printer is not shown in imagePROGRAF Printmonitor, select the printer again

as follows.

1. Make sure the printer is on and connected to the network or to a local port.
2. In the Printer menu, select the name of the desired printer.

After the printer is detected, the printer status is shown.
3. If information about the printer is not shown in step 2, choose Search Printer in the Printer menu.
4. Select the zone to search (or select *(My Zone) if no zones have been set up) and click the Search button.

Printer names listed in the Printer menu are updated with the printers that are now detected.
5. In the Printer menu, select the name of the desired printer.

After the printer is detected, the printer status is shown.
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The Features of Media Configuration Tool
The Media Configuration Tool offers the following features.

• Enables information about additional media (types of paper) supported by the printer to be registered on the printer
control panel and in the printer driver, through the use of relevant media information files (.amf and .med files).

• You can rearrange lists of the types of paper on the printer control panel and in printer driver dialog boxes and rename
them, in addition to other functions.

Important
• The Media Configuration Tool is normally installed when you install the printer driver from the User Soft-

ware CD-ROM, and media information is configured. The tool can be used later to add or edit media infor-
mation as desired.

Drivers Applicable with Media Configuration Tool

• imagePROGRAF Printer Driver

Operating Environment
You can use Media Configuration Tool in the following environments.

• Compatible Operating System
Mac OS X (10.2.8 or later)

• Software that requires installation
imagePROGRAF Printer Driver
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Procedures for Installing
Start the installer in the new version of Media Configuration Tool, and follow procedures below to install the Media Config-
uration Tool.

Important
• The Media Configuration Tool is normally installed when you install the printer driver from the User Soft-

ware CD-ROM, and media information is registered at this time.

1. Double click the MCT Installer iPFxxxx for X icon to start the Media Configuration Tool installer.

Note
• The iPFxxxx in the icon will be the printer name in use.

2. Input the administrator name and password, and click the OK button.

3. The next screen presents selections for the country or area where the printer is used.
Select a country or territory then click the OK button.
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4. The License is displayed.
After you have read Canon Software License Agreement, click the Continue button.

5. Click the Agree button.

6. Select Easy Install then click the Install button.
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7. Click the Continue button to quit another application.

8. When the following message is displayed, click the Quit button.

 

The installation of Media Configuration Tool is complete.

Note
• When the installation is completed properly, the Media Configuration Tool folder is saved in the

following folder.
Applications > Canon Utilities > iPFxxxx Media Configuration Tool

• The iPFxxxx in the folder above will be the printer name in use.

Procedures for Uninstalling

1. Double click the MCT Installer iPFxxxx for X icon to start the Media Configuration Tool installer.

Note
• The iPFxxxx in the icon will be the printer name in use.
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2. Input the administrator name and password, and click the OK button.

3. The next screen presents selections for the country or area where the printer is used.
Select a country or territory then click the OK button.
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4. The License is displayed.
After you have read Canon Software License Agreement, click the Continue button.

5. Click the Agree button.

6. Select Uninstall.
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7. Click the Uninstall button.

8. Press the Continue button when another application is running.

9. When the following message is displayed, click the Quit button.

 

Media Configuration Tool has been uninstalled.
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Starting the Media Configuration Tool
Follow the procedure below to start the Media Configuration Tool.
From the Applications menu > Canon Utilities >iPFxxxx Media Configuration Tool > MCTxxxx.app.
Media Configuration Tool main window is displayed.

Note
• If a compatible printer driver is not installed, the Media Configuration Tool will not start. If you attempt to

start the Media Configuration Tool when a printer driver is not installed, the warning message below is dis-
played.

Mac OS X Software > Media Configuration Tool >

Starting the Media Configuration Tool iPF825

5

552



Media Configuration Tool main window
The explanation below is on the Media Configuration Tool main window.

Note
• For the step to open the Media Configuration Tool main window, see "Starting the Media Configuration

Tool." →P.552

Edit Media Type Information Button
Click the button to open the Edit Media Types dialog box and you can edit the media types.
For more information about Edit Media Type Information, see "Editing Media Type Information." →P.554

Support Information Button
Click this button to access the Canon support webpage, where you can find the latest printer information, check for software
updates, and browse other information.

User Manual Button
Click this button to display the printer user manual. This function requires that the user manual be installed on your comput-
er.
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Editing Media Type Information
Click the Edit Media Type Information button in the Media Configuration Tool main window to display the Edit Media
Types dialog box.

This dialog box presents functions for the following tasks.

• Adding Media Types →P.555

• Changing Media Names →P.557

• Deleting Media Types You Have Added →P.559

• Switching Media Types Display Show/Hide →P.561

• Changing the Display Order of Media Types →P.563

Note
• It may not be possible to deleting, showing/hiding, and changing the display order under some conditions.
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Adding Media Types

1. Open the Edit Media Types dialog box, and then click the Add button.

2. The Add Media Type dialog box displays.
Click the Browse button.
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3. Select the folder that contains the media information files (.amf and .med files), and then click the Open button.

4. The names of media information files in the folder you selected in the Open dialog box are displayed under Media
Information File in the Add Media Type dialog box. Select the check boxes of paper to add and click the OK
button.

5. Click OK when the confirmation message is displayed.
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6. In the Edit Media Types dialog box, click the Update button.

The Update Media Types wizard is started at this point. For details on the procedure to update paper information
using the Update Media Types wizard, see "Updating Media Types." →P.565

Important
• Be sure to click the Update button. If you do not, your changes will not be applied to the printer and

printer driver.

Changing Media Names

1. Open the Edit Media Types dialog box.
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2. In the Media Type list, select the name to change.
Click the Rename button.

3. The Rename Media dialog box is displayed.
Edit the names in Name in Printer Driver and Name on Control Panel and click the OK button.

Note
• To restore the original names, click the Restore button.
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4. In the Edit Media Types dialog box, click the Update button.

The Update Media Types wizard is started at this point. For details on the procedure to update paper information
using the Update Media Types wizard, see "Updating Media Types." →P.565

Important
• Be sure to click the Update button. If you do not, your changes will not be applied to the printer and

printer driver.

Deleting Media Types You Have Added

1. Open the Edit Media Types dialog box.

Mac OS X Software > Media Configuration Tool >

iPF825 Deleting Media Types You Have Added

5

559



2. In the Media Type list, select the name of the media to delete.
Click the Delete button.

Note
• Only paper for which Status in the Media Type is Add can be deleted.

3. In the Edit Media Types dialog box, click the Update button.
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The Update Media Types wizard is started at this point. For details on the procedure to update paper information
using the Update Media Types wizard, see "Updating Media Types." →P.565

Important
• Be sure to click the Update button. If you do not, your changes will not be applied to the printer and

printer driver.

Switching Media Types Display Show/Hide

1. Open the Edit Media Types dialog box.
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2. In the Media Type list, select the name of the media to switch off or on for display.
Click the Show/Hide button.
The selected paper is alternately shown or hidden.

Note
• The names of media switched for non-display appear grayed out in the Media Type list.

3. In the Edit Media Types dialog box, click the Update button.
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The Update Media Types wizard is started at this point. For details on the procedure to update paper information
using the Update Media Types wizard, see "Updating Media Types." →P.565

Important
• Be sure to click the Update button. If you do not, your changes will not be applied to the printer and

printer driver. Switching between showing and hiding the type of paper will not be applied to the
printer.

Changing the Display Order of Media Types

1. Open the Edit Media Types dialog box.
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2. Select the paper in the Media Type list for which to change the display order, and then click the buttons to move the

item (  or ).
The selected item moves one line up or down for every button click.

3. In the Edit Media Types dialog box, click the Update button.

The Update Media Types wizard is started at this point. For details on the procedure to update paper information
using the Update Media Types wizard, see "Updating Media Types." →P.565

Important
• Be sure to click the Update button. If you do not, your changes will not be applied to the printer and

printer driver.
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Updating Media Types
Clicking the Update button on the Edit Media Types dialog box opens the Update Media Types wizard. You can use this
wizard to apply new information about print media in the printer and in the printer driver.
The procedures for updating the media information with the Update Media Types wizard are as follows.

Important
• The use of this procedure is based on the assumption that Media Configuration Tool is updated or you have a

media information file for print media that is to be updated.

1. Confirm the printer, where media type information is to be updated, to be displayed in Printer in the Update Media
Types - Select Printer dialog box, and then click the Next button.

2. Communication with the printer starts and the following dialog box is displayed.

Important
• Do not attempt to print or turn the printer off while the program is communicating with the printer.

Mac OS X Software > Media Configuration Tool >

iPF825 Updating Media Types

5

565



Caution
• When the program cannot communicate with the printer, the following warning message is displayed.

3. When the program has finished communicating with the printer, the screen moves to display Update Media Types -
Confirm Update. Confirm the information received from the printer.
To update click the Execute button.

Important
• When setting a data to the printer that differs from the data to be updated, the selected media informa-

tion file is updated. When you would like to remain the data that is set to the printer, click the Cancel
button.

4. Communication with the printer starts and the following dialog box is displayed.
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Important
• Do not attempt to print or turn the printer off while the program is communicating with the printer.

Caution
• When the program cannot communicate with the printer, the following warning message is displayed.

5. After the media information file is updated successfully, the screen switches to the Update Media Types - Finish
dialog box. Click Finish to close the Update Media Types wizard.
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Saved Print Jobs
Saving print jobs refers to the process of sending print jobs from a computer and storing them on the printer's hard disk. By
saving print jobs, you can print them repeatedly as needed without sending them from a computer again.

Saving print jobs offers the following benefits.

• Save the time spent using a computer
When you send a print job to the printer, you can either print it and save it on the printer at the same time or simply
save it on the printer without printing it yet. Saved print jobs can be printed in the required quantity later without the
need to use a computer again.

• Simplify reprinting, if any errors occur
If errors occur in the middle of printing (as when paper runs out), you can resume printing after clearing the error with-
out resending the print job from a computer.

• Streamline printing work
Without using a computer, you can select print jobs and print in the desired quantity. You can also select multiple print
jobs to print during the same period. This enables unattended operation at night, for example.

Output Method
To save print jobs on the printer's hard disk, choose Output Method (in Windows) or Send job to (in Mac OS X). In
Output Method (in Windows) or Send job to (in Mac OS X), choose from three options: Print, Print (auto delete), and
Save in mail box. You can also choose Save data before printing, as desired.

• Print
Save print jobs automatically at the same time they are printed. (This is the default format.)
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• Print (auto delete)
Save print jobs temporarily at the same time they are printed and delete them after printing.

• Save in mail box
Save print jobs on the printer.

• Save data before printing
This option is available in combination with Print, Print (auto delete), and Save in mail box. Print jobs are saved on
the hard disk and then printed.

Note
• The option in Output Method (in Windows) or Send job to (in Mac OS X) cannot be specified during HP-

GL/2 printing. The option in Output Method (in Windows) or Send job to (in Mac OS X) is Print.

Storage destination
The storage area on the printer's hard disk is divided into a temporary storage area and a permanent storage area. Print jobs
in the job queue or Common Box are saved in the temporary storage area. Jobs in Personal Boxes are saved in the perma-
nent storage area.

• Job queue
Print jobs in progress(*1) are temporarily saved in the job queue, a storage space where jobs are saved in the order they
will be printed.
The queue holds up to ten jobs. Subsequent jobs await the processing to add them to the queue.
*1: Jobs that are being saved, received, prepared for processing, processed, or printed, or jobs that have been interrup-
ted or are being deleted

• Common Box
Jobs sent from a computer for which you have selected Print in Output Method (in Windows) or Send job to (in Mac
OS X) are saved in the common box.
There is one Common Box, numbered 00. A password cannot be set for the Common Box.
Up to 100 print jobs can be saved here, but they will be deleted one after another starting with the oldest job in the
following situations.

• If there are more than 100 jobs in the Common Box and job queue combined
• If no more temporary storage space is available when jobs for which you have selected Print or Print (auto de-

lete) in Output Method (in Windows) or Send job to (in Mac OS X) are received
• If there is not enough space in the temporary or permanent storage area when jobs for which you have selected

Save in mail box in Output Method (in Windows) or Send job to (in Mac OS X) are received

• Personal Boxes
You can store jobs in Personal Boxes in either of the following ways.

• By moving a job stored in the Common Box into a Personal Box
• By selecting Save in mail box as the option in Output Method (in Windows) or Send job to (in Mac OS X)
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There are 29 Personal Boxes, numbered 01 to 29. You can specify a name and password for each Personal Box.
Up to 100 print jobs can be saved in all Personal Boxes combined.

Saving Print Jobs
You can save print jobs on the printer's hard disk.

Save print jobs on the printer's hard disk as follows.

• Using the printer driver (Windows) →P.572

• Using HDI Driver →P.360  (Windows)
See "Output Method Setting."

• Using Free Layout →P.262  (Windows)
See the section on the Output Method dialog box.

• Using Color imageRUNNER Enlargement Copy →P.292  (Windows)
See the section on the Output Method button on the Output Settings sheet.

• Using imagePROGRAF Preview (Windows)
Printer driver settings will be used for the format of saved print jobs.  (See "Using the printer driver (Windows).")
→P.572

 

• Using the printer driver (Mac OS) →P.573

• Using Free Layout (Mac OS)
Printer driver settings will be used for the format of saved print jobs.  (See "Using the printer driver (Mac OS).")
→P.573

• Using Color imageRUNNER Enlargement Copy →P.519  (Mac OS)
See the section on the Output Method button in the Output Settings pane.

• Using imagePROGRAF Preview (Mac OS)
Printer driver settings will be used for the format of saved print jobs.  (See "Using the printer driver (Mac OS).")
→P.573

However, the document name will be imagePROGRAF.
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Using the printer driver (Windows)

1. Access the Page Setup sheet.

2. Click Output Method to display the Output Method dialog box.
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3. Choose an Output Method.

• Print
Save print jobs automatically at the same time they are printed. (This is the default format.)

• Print (auto delete)
Save print jobs temporarily at the same time they are printed and delete them after printing.

• Save in mail box
Save print jobs on the printer.
If you choose Save in mail box, also specify the destination personal box in the Mail box list.

Note
• Click Acquire Mail Box Name to display personal box names in the Mail box list, as acquired from

the printer.
• Save data before printing

This option is available in combination with Print, Print (auto delete), and Save in mail box. Print
jobs are saved on the hard disk and then printed.

4. In Name of data to be saved, specify how to name saved print jobs.

• To use the file name, choose Use file name.
• Otherwise choose Enter name and enter a name in Name.

5. Click OK to close the Output Method dialog box.

Using the printer driver (Mac OS)

1. Access the Additional Settings pane.
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2. Choose an Send job to.

• Print
Save print jobs automatically at the same time they are printed.

• Print (auto delete)
Save print jobs temporarily at the same time they are printed and delete them after printing.

• Save in mail box
Save print jobs on the printer.
The Destination dialog box is displayed if you select Save in mail box. Here, specify the name and personal
box number for saved print jobs.

1. In Document title, enter a name to identify saved print jobs.

2. Select the personal box number in the Mail box list.

3. Click OK to close the Destination dialog box.

Note
• Save data before printing

This option is available in combination with Print, Print (auto delete), and Save in mail box. Print
jobs are saved on the hard disk and then printed.

Managing Queued Jobs (Deleting or Preempting Other Jobs)
Print jobs can be deleted or their printing order changed to print them immediately, depending on their status.
You can determine the status of print jobs in Windows by checking the Control Panel, RemoteUI, or imagePROGRAF Sta-
tus Monitor and on a Macintosh computer by checking imagePROGRAF Printmonitor.

• Deleting queued print jobs
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You cannot manually delete jobs that are already in the process of being deleted.

• Preempting other jobs
Print jobs that are being received or prepared for printing can be selected for preemptive printing.

You can manage queued print jobs as follows.

• Using the Control Panel →P.575

• Using RemoteUI →P.576

• Using imagePROGRAF Status Monitor (Windows) →P.576

• Using imagePROGRAF Printmonitor (Macintosh) →P.577

Using the Control Panel

1. Press the Menu button to display Menu Durng Prtng.
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2. You can manage queued jobs as follows.

• Deleting queued jobs

1. Press ▲ or ▼ to select Job Mgmt Menu, and then press the OK button.

2. Press ▲ or ▼ to select Print Job, and then press the ▶ button.

3. Press ▲ or ▼ to select the print job to delete, and then press the ▶ button.

4. Press ▲ or ▼ to select Delete, and then press the OK button.

• Changing the order of printing

1. Press ▲ or ▼ to select Job Mgmt Menu, and then press the OK button.

2. Press ▲ or ▼ to select Print Job, and then press the ▶ button.

3. Press ▲ or ▼ to select the job to print first, and then press the ▶ button.

4. Press ▲ or ▼ to select Preempt Jobs, and then press the OK button.

Using RemoteUI
On the Print Job page, select the job to manage and how to manage it. For details, refer to the RemoteUI help.

Using imagePROGRAF Status Monitor (Windows)
On the Job sheet, select the job and the desired function. The following functions are available.

• Preempting other jobs
• Pausing printing
• Resuming printing
• Canceling print jobs
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For details, refer to the imagePROGRAF Status Monitor help file.
 

Using imagePROGRAF Printmonitor (Macintosh)
On the Driver pane, select the job and the desired function. The following functions are available.

• Preempting other jobs
• Pausing printing
• Resuming printing
• Canceling print jobs

For details, refer to the imagePROGRAF Printmonitor help file.
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Printing Saved Jobs
You can print jobs stored on the printer's hard disk as follows.

• Using the Control Panel
• Using RemoteUI
• Using imagePROGRAF Status Monitor (Windows)
• Using imagePROGRAF Printmonitor (Mac OS)

Using the Control Panel

1. Press the Menu button to display MAIN MENU.

2. Print the saved job.

1. Press ▲ or ▼ to select Job Management, and then press the ▶ button.

2. Press ▲ or ▼ to select Stored Job, and then press the ▶ button.

3. Press ▲ or ▼ to select the box number (in the range 00–29), and then press the ▶ button.

4. Enter a password if one has been set, and then press the OK button.

5. Press ▲ or ▼ to select Job List, and then press the ▶ button.

6. Press ▲ or ▼ to select the saved job to print, and then press the ▶ button.

7. Press ▲ or ▼ to select Print, and then press the ▶ button.

8. Specify the number of copies and press the OK button.
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Using RemoteUI

1. On the Stored Job page, choose the mail box.

Note
• Enter a password if one has been set.

2. Select the print job in the list and click Print.
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3. On the Print Saved Document page, enter the quantity to print in Copies and click OK.

For details, refer to the RemoteUI help.
 

Using imagePROGRAF Status Monitor

1. On the Hard Disk sheet, select a mail box in the list and click Open.
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Note
• Enter a password if one has been set.

2. In the Documents dialog box, select the print job in the list and click Print.

3. In the Print dialog box, enter the quantity to print in Copies and click OK.
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Note
• The printing time initially indicates how long it took to finish printing one copy during the previous

print job.
If you change the value in Copies, the printing time indicates the time it took to print one copy during
the previous print job multiplied by the number of copies.

For details, refer to the imagePROGRAF Status Monitor help file.
 

Using imagePROGRAF Printmonitor

1. In the Hard Disk pane, click ▶ next to Inbox No./Name to list saved jobs.

Note
• Enter a password if one has been set.
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2. Select the saved job in the list and click Resume Printing to display the Resume Printing dialog box.

3. Specify the number of copies and click the OK button.

For details, refer to the imagePROGRAF Printmonitor help file.

Deleting Saved Jobs
You can delete saved jobs in the box shared among all users and in each personal box.
Delete stored print jobs as follows.

• Using the Control Panel
• Using RemoteUI
• Using imagePROGRAF Status Monitor (Windows)
• Using imagePROGRAF Printmonitor (Mac OS)
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Using the Control Panel

1. Press the Menu button to display MAIN MENU.

2. Delete the saved job.

1. Press ▲ or ▼ to select Job Management, and then press the ▶ button.

2. Press ▲ or ▼ to select Stored Job, and then press the ▶ button.

3. Press ▲ or ▼ to select the box number (in the range 00–29), and then press the ▶ button.

4. Enter a password if one has been set, and then press the OK button.

5. Press ▲ or ▼ to select Job List, and then press the ▶ button.

6. Press ▲ or ▼ to select the saved job to delete, and then press the ▶ button.

7. Press ▲ or ▼ to select Delete, and then press the ▶ button.

8. Confirm the print job for deletion and press the OK button.

Using RemoteUI

1. On the Stored Job page, choose the mail box.
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Note
• Enter a password if one has been set.

2. Select the saved job in the list and click Delete.

For details, refer to the RemoteUI help.
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Using imagePROGRAF Status Monitor

1. On the Hard Disk sheet, select a mail box in the list and click Open.

Note
• Enter a password if one has been set.
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2. In the Documents dialog box, select the print job in the list and click Delete.

For details, refer to the imagePROGRAF Status Monitor help file.
 
 

Using imagePROGRAF Printmonitor

1. On the Hard Disk pane, click ▶ next to Inbox No./Name to list saved jobs.
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Note
• Enter a password if one has been set.

2. Select the saved job in the list and click Delete.

For details, refer to the imagePROGRAF Printmonitor help file.

Moving Saved Jobs
Print jobs for which Print is selected as the format in Output Method (in Windows) or Send job to (in Mac OS X) are
saved in the common box, number 00. However, jobs in this mail box will be deleted one after another starting with the
oldest job in the following situations.

• If there are more than 100 saved jobs in the common box and job queue combined
• If the temporary storage area becomes full during reception of print jobs for which you have selected Print or Print

(auto delete) in Output Method (in Windows) or Send job to (in Mac OS X)
• If the temporary and permanent storage areas no longer have enough space during reception of print jobs for which you

have selected Save in mail box in Output Method (in Windows) or Send job to (in Mac OS X)

You can move jobs to personal boxes 01 to 29 to prevent them from being deleted. (Up to 100 jobs can be stored here.)
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You can also move saved jobs from one personal box to another.

Move stored print jobs as follows.

• Using RemoteUI
• Using imagePROGRAF Status Monitor (Windows)
• Using imagePROGRAF Printmonitor (Mac OS)

Note
• Jobs saved in personal boxes cannot be moved to the common box.

Using RemoteUI

1. On the Stored Job page, choose the mail box.

Note
• Enter a password if one has been set.
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2. Select the print job in the list and click Move.

3. On the Move Document page, select the name or number of the destination personal box in the Destination mail
box list and click OK.

For details, refer to the RemoteUI help file.
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Using imagePROGRAF Status Monitor (Windows)

1. On the Hard Disk sheet, select a mail box in the list and click Open.

Note
• Enter a password if one has been set.
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2. In the Documents dialog box, select the print job in the list and click Move.

3. In the Move dialog box, select the destination personal box and click OK.

For details, refer to the imagePROGRAF Status Monitor help file.
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Using imagePROGRAF Printmonitor (Mac OS)

1. In the Hard Disk pane, click ▶ next to Inbox No./Name to list saved jobs.

Note
• Enter a password if one has been set.

The password is a four-digit number.
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2. Select the print job in the list and click Move.

3. In the Move Document dialog box, select the destination personal box and click OK.

For details, refer to the imagePROGRAF Printmonitor help file.
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Saving Print Jobs Sent from Sources Other than the Printer Driver
To save print jobs sent from software or systems other than the printer driver provided with the printer, complete the Out-
put Method and Save and Print settings in the printer menu.

Important
• Contact the software or system developer for information about support for this printer function.

Specifying Output Method

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select System Setup, and then press the ▶ button.

3. Press ▲ or ▼ to select Output Method, and then press the ▶ button.

4. Press ▲ or ▼ to select the output method, and then press the OK button.

• Print
Save print jobs automatically at the same time they are printed. (This is the default format.)
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• Print (Auto Del)
Save print jobs temporarily at the same time they are printed and delete them after printing.

• Save: Box 01 (Here, the number represents a box number)
Save print jobs on the printer. If you select this option, go to step 5 and select the box for saving print jobs.

5. Press ▲ or ▼ to select the box, and then press the OK button.

Specifying Save and Print

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select System Setup, and then press the ▶ button.

3. Press ▲ or ▼ to select Save and Print, and then press the ▶ button.

4. Press ▲ or ▼ to select On, or Off, and then press the OK button.
If you select On, print jobs are saved on the hard disk and then printed.

Printing Without Saving Jobs in the Common Box
If you have selected Print in Output Method (in Windows) or Send job to (in Mac OS X) in the printer driver as the
format for print jobs sent from the computer, the jobs are saved in the common box.  (See "Saved Print Jobs.") →P.569
You can select Save: Shared Box > Off in the printer menu so that print jobs for which you have selected Output Method
> Print in the printer driver are deleted from the common box after printing.
Use this function when printing highly confidential documents.

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select System Setup, and then press the ▶ button.
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3. Press ▲ or ▼ to select Save: Shared Box, and then press the ▶ button.

Note
• If a password has been set on the printer, the Logon screen is displayed.

To change the setting, select Administrator and press the OK button. Enter the password when Ad-
min.Pswd is displayed and press the OK button before going to the next procedure.
If you select User and press the OK button, you can check settings values but cannot change them.

4. Press ▲ or ▼ to select Off, and then press the OK button.

Setting Passwords for Personal Boxes
By default, no passwords are set for personal boxes. For greater security, you can set passwords for each personal box. After
you set a password, it will be required to modify the personal box settings, as well as to display, print, delete, move, and
modify jobs saved in the personal box.

Note
• A password cannot be set for the common box.
• Enter a four-digit number as the password, in the range 0001–9999.
• Even if you have set passwords, they are not required to access personal boxes in Administrator Mode in

RemoteUI.

You can set a password for a personal box as follows.

• Using RemoteUI
• Using imagePROGRAF Status Monitor (Windows)
• Using imagePROGRAF Printmonitor (Mac OS)

Using RemoteUI

1. On the Stored Job page, select the personal box for a password.
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2. Click Edit.

3. In the Set/Register User's Inbox dialog box, specify the password and click OK.

• Set Password : Select the check box.
• Password : Enter the password. (This field is limited to four digits in the range 0001–9999.)
• Confirmation Number : Re-enter the password to confirm it.

For details, refer to the RemoteUI help.
 

Print Jobs > Advanced Print Job Operations >

Setting Passwords for Personal Boxes iPF825

6

598



Using imagePROGRAF Status Monitor (Windows)

1. On the Hard Disk sheet, select a listed personal box for a password and click Open.

Note
• Enter a password if one has been set for the personal box.
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2. In the Documents dialog box, click Settings.

3. In the Settings dialog box, specify the password and click OK.

• Set password : Select the check box.
• Password : Enter the password. (This field is limited to four digits in the range 0001–9999.)
• Re-enter to confirm : Re-enter the password to confirm it.

For details, refer to the imagePROGRAF Status Monitor help file.
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Using imagePROGRAF Printmonitor (Mac OS)

1. In the Hard Disk pane, click ▶ next to Inbox No./Name to list saved jobs. Select a saved job and click Set.

2. In the Settings dialog box, specify the password and click OK.

• Set password : Select the check box.
• Password : Enter the password. (This field is limited to four digits in the range 0001–9999.)
• Verify : Re-enter the password to confirm it.

For details, refer to the imagePROGRAF Printmonitor help file.
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Naming Personal Boxes
By default, personal boxes are unnamed. You can name them for easier management.
You can assign a name to a personal box as follows.

• Using RemoteUI
• Using imagePROGRAF Status Monitor (Windows)
• Using imagePROGRAF Printmonitor (Mac OS)

Using RemoteUI

1. On the Stored Job page, select the personal box to identify.

Note
• Enter a password if one has been set for the personal box.
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2. Click Edit.

3. In the Set/Register User's Inbox dialog box, enter the personal box name in Inbox Name and click OK.

For details, refer to the RemoteUI help.
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Using imagePROGRAF Status Monitor (Windows)

1. On the Hard Disk sheet, select a listed personal box to identify and click Open.

Note
• Enter a password if one has been set for the personal box.
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2. In the Documents dialog box, click Settings.

3. In the Settings dialog box, enter the personal box name and click OK.

For details, refer to the imagePROGRAF Status Monitor help file.
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Using imagePROGRAF Printmonitor (Mac OS)

1. On the Hard Disk pane, click ▶ next to Inbox No./Name to list saved jobs. Select a saved job and click Set.

Note
• Enter a password if one has been set.

The password is a four-digit number.
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2. In the Settings dialog box, enter the personal box name and click OK.

For details, refer to the imagePROGRAF Printmonitor help file.

Displaying a List of Saved Jobs
You can display saved print jobs in the box shared among all users and in each personal box.
View the list of stored print jobs as follows.

• Using the Control Panel
• Using RemoteUI
• Using imagePROGRAF Status Monitor (Windows)
• Using imagePROGRAF Printmonitor (Mac OS)

Using the Control Panel

1. Press the Menu button to display MAIN MENU.

2. Display a list of saved print jobs.

1. Press ▲ or ▼ to select Job Management, and then press the ▶ button.

2. Press ▲ or ▼ to select Stored Job, and then press the ▶ button.

Print Jobs > Advanced Print Job Operations >

iPF825 Displaying a List of Saved Jobs

6

607



3. Press ▲ or ▼ to select the box number (in the range 00–29), and then press the ▶ button.

4. Enter a password if one has been set, and then press the OK button.

5. Press the ▲ or ▼ button to select Job List.

Using RemoteUI
Choose a mail box on the Stored Job page to display a list of jobs saved in that mail box.

Note
• Enter a password if one has been set.

Jobs saved in the mail box are listed.

For details, refer to the RemoteUI help.
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Using imagePROGRAF Status Monitor (Windows)
On the Hard Disk sheet, select a mail box in the list and click Open.

Note
• Enter a password if one has been set.
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Jobs saved in that mail box are displayed in the Documents dialog box.

For details, refer to the imagePROGRAF Status Monitor help file.
 

Using imagePROGRAF Printmonitor (Mac OS)
On the Hard Disk pane, click ▶ next to Inbox No./Name to list saved jobs.
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Note
• Enter a password if one has been set.

The password is a four-digit number.

For details, refer to the imagePROGRAF Printmonitor help file.

Printing a List of Saved Jobs
You can print a list of saved print jobs in the common box and each personal box.
You can also print a list of print jobs by using the Control Panel.

1. Press the Menu button to display MAIN MENU.

2. Print a list of saved print jobs.

1. Press ▲ or ▼ to select Job Management, and then press the ▶ button.

2. Press ▲ or ▼ to select Stored Job, and then press the ▶ button.

3. Press ▲ or ▼ to select the box number (in the range 00–29), and then press the ▶ button.

4. Enter a password if one has been set, and then press the OK button.

5. Press ▲ or ▼ to select Print Job List, and then press the ▶ button.

6. Press ▲ or ▼ to select Yes, and then press the OK button.

Displaying Details of Saved Jobs
You can view details of stored print jobs as follows.

• Using RemoteUI
• Using imagePROGRAF Status Monitor (Windows)
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• Using imagePROGRAF Printmonitor (Mac OS)

Using RemoteUI

1. On the Stored Job page, choose the mail box.

Note
• Enter a password if one has been set.

2. Select the saved job in the list and click Details.
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The Details of the saved document page is displayed.

For details, refer to the RemoteUI help.
 

Using imagePROGRAF Status Monitor (Windows)

1. On the Hard Disk sheet, select a mail box in the list and click Open.
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Note
• Enter a password if one has been set.

2. In the Documents dialog box, select the saved job in the list and click Properties.

The Properties dialog box is displayed.

For details, refer to the imagePROGRAF Status Monitor help file.
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Using imagePROGRAF Printmonitor (Mac OS)

1. On the Hard Disk pane, click ▶ next to Inbox No./Name to list saved jobs.

Note
• Enter a password if one has been set.

The password is a four-digit number.

For details, refer to the imagePROGRAF Printmonitor help file.

Renaming Saved Jobs
You can rename stored print jobs as follows.

• Using RemoteUI
• Using imagePROGRAF Status Monitor (Windows)
• Using imagePROGRAF Printmonitor (Mac OS)
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Using RemoteUI

1. On the Stored Job page, choose the mail box.

Note
• Enter a password if one has been set.

2. Select the saved job in the list and click Details.
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3. On the Details of the saved document page, click Change Document.

4. On the Rename Saved Document page, enter the new job name in Document Name and click OK.

For details, refer to the RemoteUI help.
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Using imagePROGRAF Status Monitor (Windows)

1. On the Hard Disk sheet, select a mail box in the list and click Open.

Note
• Enter a password if one has been set.
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2. In the Documents dialog box, select the saved job in the list and click Properties.

3. In the Properties dialog box, enter the new job name and click OK.

For details, refer to the imagePROGRAF Status Monitor help file.
 

Print Jobs > Advanced Print Job Operations >

iPF825 Renaming Saved Jobs

6

619



Using imagePROGRAF Printmonitor (Mac OS)

1. On the Hard Disk pane, click ▶ next to Inbox No./Name to list saved jobs.

Note
• Enter a password if one has been set.

The password is a four-digit number.
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2. Select the saved job in the list and click Set.

3. In the Settings dialog box, enter the new job name and click OK.
Documents cannot be renamed unless a password has been set. In this case, specify a password. After renaming, you
can cancel the password as needed.

For details, refer to the imagePROGRAF Printmonitor help file.
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Paper
Types of Paper ................................................................................................................................................ 623
Paper Sizes ..................................................................................................................................................... 626

Types of Paper
For information on the types of paper the printer supports (such as plain paper, coated paper, glossy photo paper, proofing
paper, and CAD paper), refer to the Paper Reference Guide. The Paper Reference Guide identifies types of paper and gives
specifications, printer driver settings, and tips on handling paper. (See Paper Reference Guide .)
By downloading the latest version of the Media Configuration Tool from the imagePROGRAF website, you can make sure
the paper information indicated in the Paper Reference Guide, on the printer Control Panel, and in the printer driver is up to
date.

Accessing the Paper Reference Guide from imagePROGRAF Support Information
The Paper Reference Guide can also be accessed from imagePROGRAF Support Information. Follow these instructions,
as appropriate for your operating system.

• Windows

1. Double-click the iPFxxxx Support desktop icon. (iPFxxxx indicates the printer model.)

The imagePROGRAF Support Information window is displayed.

2. Click the Paper Reference Guide button.
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The Paper Reference Guide is displayed.

• Mac OS X

1. Click the iPF Support icon in the Dock.

The imagePROGRAF Support Information window is displayed.

2. Click the Paper Reference Guide button.

The Paper Reference Guide is displayed.
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Updating paper information
To update the paper information in the Paper Reference Guide and on the printer, download the latest version of the Media
Configuration Tool from the imagePROGRAF website. For information about the Media Configuration Tool, see Media
Configuration Tool →P.412  (Windows) or Media Configuration Tool →P.545  (Macintosh).
The imagePROGRAF website is accessible from imagePROGRAF Support Information.

Important
• When you use the Media Configuration Tool to update information about paper, the types of paper on the

printer Control Panel, in the printer driver, and in related software are updated.

• Windows

1. Double-click the iPFxxxx Support desktop icon. (iPFxxxx indicates the printer model.)

The imagePROGRAF Support Information window is displayed.

2. Click Visit the imagePROGRAF webpage.

The default browser on your computer is started and the imagePROGRAF webpage is displayed.

• Mac OS X

1. Click the iPF Support icon in the Dock.

The imagePROGRAF Support Information window is displayed.
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2. Click Visit the imagePROGRAF webpage.

The default browser on your computer is started and the imagePROGRAF webpage is displayed.

Paper Sizes

Rolls
Rolls that meet the following conditions are supported.

• Outer diameter: up to 150 mm (6 in.)
• Inner diameter of paper core: 2 or 3 inches
• Printing side out

Roll Width Roll Paper Width Settings in Printer Driver Borderless Printing (*1 →P.626 )

1117.6 mm (44.00 in) 44-in. Roll (1117.6mm) No

1066.8 mm (42.00 in) 42-in. Roll (1066.8mm) Yes

1030.0 mm (40.55 in) JIS B0/B1 Roll (1030.0mm) Yes

914.4 mm (36.00 in) 36-in. Roll (914.4mm) Yes

841.0 mm (33.11 in) ISO A0/A1 Roll (841.0mm) Yes

762.0 mm (30.00 in) 30-in. Roll (762.0mm) No

728.0 mm (28.66 in) JIS B1/B2 Roll (728.0mm) No

609.6 mm (24.00 in) 24-in. Roll (609.6mm) Yes

594.0 mm (23.39 in) ISO A1/A2 Roll (594.0mm) Yes

515.0 mm (20.28 in) JIS B2/B3 Roll (515.0mm) Yes

431.8 mm (17.00 in) 17-in. Roll (431.8mm) Yes

420.0 mm (16.54 in) ISO A2/A3 Roll (420.0mm) No

406.4 mm (16.00 in) 16-in. Roll (406.4mm) No

355.6 mm (14.00 in) 14-in. Roll (355.6mm) Yes

297.0 mm (11.69 in) ISO A3/A4 Roll (297.0mm) No

254.0 mm (10.00 in) 10-in. Roll (254.0mm) Yes

Custom Paper Size 　 203.2 mm (8.00 in.) – 1118.0 mm (44.02 in.)

*1: For information on types of paper compatible with borderless printing, refer to the Paper Reference Guide.  (See
"Types of Paper.") →P.623
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Sheets
Sheets of the following sizes are supported.

Paper Sizes Dimensions

ISO A0 841.0 × 1189.0 mm (33.11 × 46.81 in)

ISO A1 594.0 × 841.0 mm (23.39 × 33.11 in)

ISO A2 420.0 × 594.0 mm (16.54 × 23.39 in)

ISO A2+ 431.8 × 609.6 mm (17.00 × 24.00 in)

ISO A3 297.0 × 420.0 mm (11.69 × 16.54 in)

ISO A3+ 329.0 × 483.0 mm (12.95 × 19.02 in)

ISO A4 210.0 × 297.0 mm (8.27 × 11.69 in)

ISO B0 1000.0 × 1414.0 mm (39.37 × 55.67 in)

ISO B1 707.0 × 1000.0 mm (27.83 × 39.37 in)

ISO B2 500.0 × 707.0 mm (19.69 × 27.83 in)

ISO B3 353.0 × 500.0 mm (13.90 × 19.69 in)

ISO B4 250.0 × 353.0 mm (9.84 × 13.90 in)

JIS B0 1030.0 × 1456.0 mm (40.55 × 57.32 in)

JIS B1 728.0 × 1030.0 mm (28.66 × 40.55 in)

JIS B2 515.0 × 728.0 mm (20.28 × 28.66 in)

JIS B3 364.0 × 515.0 mm (14.33 × 20.28 in)

JIS B4 257.0 × 364.0 mm (10.12 × 14.33 in)

34"x44" (ANSI E) 863.6 × 1117.6 mm (34.00 × 44.00 in)

28"x40" (ANSI F) 711.2 × 1016.0 mm (28.00 × 40.00 in)

22"x34"(ANSI D) 558.8 × 863.6 mm (22.00 × 34.00 in)

17"x22"(ANSI C) 431.8 × 558.8 mm (17.00 × 22.00 in)

11"x17" (Ledger) 279.4 × 431.8 mm (11.00 × 17.00 in)

13"x19" (Super B) 330.2 × 482.6 mm (13.00 × 19.00 in)

Letter (8.5"x11") 215.9 × 279.4 mm (8.50 × 11.00 in)

Legal (8.5"x14") 215.9 × 355.6 mm (8.50 × 14.00 in)

36"x48" (ARCH E) 914.4 × 1219.2 mm (36.00 × 48.00 in)

30"x42" (ARCH E1) 762.0 × 1066.8 mm (30.00 × 42.00 in)

26"x38" (ARCH E2) 660.4 × 965.2 mm (26.00 × 38.00 in)

27"x39" (ARCH E3) 685.8 × 990.6 mm (27.00 × 39.00 in)

24"x36" (ARCH D) 609.6 × 914.4 mm (24.00 × 36.00 in)

18"x24" (ARCH C) 457.2 × 609.6 mm (18.00 × 24.00 in)

12"x18" (ARCH B) 304.8 × 457.2 mm (12.00 × 18.00 in)

9"x12" (ARCH A) 228.6 × 304.8 mm (9.00 × 12.00 in)

DIN C0 917.0 × 1296.0 mm (36.10 × 51.02 in)

DIN C1 648.0 × 917.0 mm (25.51 × 36.10 in)
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Paper Sizes Dimensions

DIN C2 458.0 × 648.0 mm (18.03 × 25.51 in)

DIN C3 324.0 × 458.0 mm (12.76 × 18.03 in)

DIN C4 229.0 × 324.0 mm (9.02 × 12.76 in)

20"x24" 508.0 × 609.6 mm (20.00 × 24.00 in)

18"x22" 457.2 × 558.8 mm (18.00 × 22.00 in)

14"x17" 355.6 × 431.8 mm (14.00 × 17.00 in)

12"x16" 304.8 × 406.4 mm (12.00 × 16.00 in)

10"x12" 254.0 × 304.8 mm (10.00 × 12.00 in)

10"x15" 254.0 × 381.0 mm (10.00 × 15.00 in)

8"x10" 203.2 × 254.0 mm (8.00 × 10.00 in)

US Photo 16"x20" 406.4 × 508.0 mm (16.00 × 20.00 in)

Poster 20"x30" 508.0 × 762.0 mm (20.00 × 30.00 in)

Poster 30"x40" 762.0 × 1016.0 mm (30.00 × 40.00 in)

Poster 42"x60" 1066.8 × 1524.0 mm (42.00 × 60.00 in)

Poster 44"x62" 1117.6 × 1574.8 mm (44.00 × 62.00 in)

13"x22" 329.0 × 558.0 mm (12.95 × 21.97 in)

Poster 300x900mm 300.0 × 900.0 mm (11.81 × 35.43 in)

Custom Paper Size 203.2 × 203.2 mm (8.00 × 8.00 in.) – 1118.0 × 1600.0 mm (44.02 × 62.99 in.)

Note
• In the printer driver, paper sizes are categorized into groups based on the Display Series, such as ISO A or

JIS.
In Windows, some size systems are not available by default. Follow these steps to make them available.

1. Display the printer driver dialog box.
2. Click the Page Setup tab to display the Page Setup sheet.
3. Click Size Options to display the Paper Size Options dialog box.
4. Select the Display Series check box.

• For details on non-standard paper sizes, see "Printing on Non-Standard Paper Sizes." →P.126

• Borderless printing is not supported on sheets.
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Attaching the Roll Holder to Rolls
When printing on rolls, attach the Roll Holder to the roll.
Rolls have a two- or three-inch paper core. Use the correct attachment for the paper core. The printer comes equipped with
the 2-Inch Paper Core Attachment installed.

Using the 2-Inch Paper Core Attachment Using the 3-Inch Paper Core Attachment

Roll Holder
Side

Holder Stopper Side Roll Holder Side Holder Stopper Side

No Attach-
ment Nee-
ded

2-Inch Paper Core Attachment 3-Inch Paper Core Attachment #1 3-Inch Paper Core Attachment #2

Handling Paper > Handling rolls >

iPF825 Attaching the Roll Holder to Rolls

7

629



Important
• Cut the edge of the roll paper if it is uneven, dirty, or has tape residue. Otherwise, it may cause feeding prob-

lems and affect the printing quality. Be careful not to cut through any barcodes printed on the roll.

• Align the edges of the paper on both ends of the roll. This may cause feeding problems.

Caution
• Set the roll on a table or other flat surface so that it does not roll or fall. Rolls are heavy, and dropping a roll

may cause injury.

Note
• For details on supported sizes and types of rolls, see Paper Sizes or the Paper Reference Guide.  (See "Paper

Sizes.") →P.626  (See "Types of Paper.") →P.623

• After pressing the Load/Eject button, you can refer to instructions on the Display Screen as you load the
paper.

Handling Paper > Handling rolls >

Attaching the Roll Holder to Rolls iPF825

7

630



1. Lift the Holder Stopper lever (a) from the shaft side to unlock it. Holding the Holder Stopper at the position indica-
ted (b), remove it from the Roll Holder.

2. When using a 3-inch paper core, align the tips (a) of 3-Inch Paper Core Attachment #1 with the holes (b) of the Roll
Holder and insert it firmly.
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3. With the edge of the roll paper facing forward as shown, insert the Roll Holder from the right of the roll. Insert it
firmly until the roll touches the flange (a) of the Roll Holder.

Important
• When loading a roll, be careful to avoid hitting the printer hard with the roll. This may damage the

Roll Holder.

4. Insert the attachments for the roll paper core on the Holder Stopper.
Align the tips (a) of the attachment with the holes (b) of the Holder Stopper and insert it firmly.

• 3-Inch Paper Core Attachment #2
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• 2-Inch Paper Core Attachment

5. Insert the Holder Stopper from the left in the Roll Holder as shown. Holding it at the position shown (b), push it
firmly in until the flange (a) of the Holder Stopper touches the roll. Lock the Holder Stopper lever (c) by pushing it
down toward the shaft side.
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Loading Rolls in the Printer
Follow these steps to load rolls in the printer.
You can load rolls in two positions, in the Roll 1 (Upper) and Roll 2 (Lower) holders.

Note
• Remove any loaded paper that will not be used.

• Rolls  (See "Removing the Roll from the Printer.") →P.644

• Sheets  (See "Removing Sheets.") →P.669

• If the Wheeled Output Stacker is installed, remove it in advance.  (See "Using the Wheeled Output Stack-
er.") →P.671

• If the Platen is dirty, clean inside the Top Cover.  (See "Cleaning Inside the Top Cover.") →P.833

• After pressing the Load/Eject button, you can refer to instructions on the Display Screen as you load the
paper.  (See "Checking Instructions During Printer Operations.") →P.751

Loading rolls in the Roll 1 (Upper) holder

1. Confirm that a roll is selected as the paper source.  (See "Selecting the Paper Source.") →P.641

2. Open the Top Cover and lift the Ejection Guide.
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3. Holding the Roll Holder so that the side with the white gear faces the side of the Roll Holder Slot with a white gear,
load the Roll Holder shaft (a) into the grooves (b) on both ends of the Roll Holder Slot.

Caution
• Be careful not to pinch your fingers between the Roll Holder shaft (a) and the guide grooves (b) when

loading rolls.

Note
• For instructions on attaching the Roll Holder to rolls, see "Attaching the Roll Holder to Rolls."

→P.629
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4. Using both hands, pull out the roll evenly on both ends and insert it in the Paper Feed Slot (a). Advance the roll until
the buzzer sounds.

Important
• Be careful not to soil the printing surface of roll paper as you insert it in the slot. This may affect the

printing quality. We recommend wearing clean cloth gloves when handling rolls to protect the print-
ing surface.

• If the paper is wrinkled or warped, straighten it out before loading it.
• Load the roll so that there is no gap between the right edge of the paper and the Roll Holder.
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5. Lower the Ejection Guide.

6. Close the Top Cover.

7. Press the OK button.
The paper is now advanced.

After you load a roll, the printer automatically shows a menu for selection of the type of paper on the Display Screen.
At this point, specify the type of paper.  (See "Selecting the Paper Type (Roll).") →P.642
 

Loading rolls in the Roll 2 (Lower) holder

Caution
• Do not detach the Roll Unit in the following cases.

• During printing
Vibration from removing the Roll Unit may affect the printing quality.

• If a sheet is loaded in the printer
The sheet may be ejected, and (rarely) it may be bent.
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1. Confirm that a roll is selected as the paper source.  (See "Selecting the Paper Source.") →P.641

2. Holding the Roll Unit Lever (a), pull out the Roll Unit.
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3. Holding the Roll Holder so that the side with the white gear faces the side of the Roll Holder Slot with a white gear,
load the Roll Holder shaft (a) into the grooves (b) on both ends of the Roll Holder Slot.

Caution
• Be careful not to pinch your fingers between the Roll Holder shaft (a) and the guide grooves (b) when

loading rolls.

Note
• For instructions on attaching the Roll Holder to rolls, see "Attaching the Roll Holder to Rolls."

→P.629
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4. Pull out the roll evenly on both ends and insert it in the Paper Feed Slot (a). Advance the roll until the buzzer sounds.

Important
• Be careful not to soil the printing surface of roll paper as you insert it in the slot. This may affect the

printing quality. We recommend wearing clean cloth gloves when handling rolls to protect the print-
ing surface.

• If the paper is wrinkled or warped, straighten it out before loading it.
• Load the roll so that there is no gap between the right edge of the paper and the Roll Holder.
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5. In a crouching position, push the Roll Unit into the printer.

6. Position the Wheeled Output Stacker by the printer.  (See "Using the Wheeled Output Stacker.") →P.671

7. Press the OK button.
The paper is now advanced.

After you load a roll, the printer automatically shows a menu for selection of the type of paper on the Display Screen.
At this point, specify the type of paper.  (See "Selecting the Paper Type (Roll).") →P.642

Selecting the Paper Source
When advancing paper, press the Feeder Selection button and select the source.
You can determine the selected source by checking which lamp is lit—either the Roll Media lamp (a) or the Cut Sheet
lamp (b).

• Roll Media lamp : Selected when printing on Roll Media.
• Cut Sheet lamp : Selected when printing on Sheets.
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Note
• If a sheet is loaded when you change the paper source to a roll, "Eject sheet?" is displayed. Press the OK

button and remove the sheet.
• You cannot switch the paper source in the following situations:

• When the Message lamp is flashing
Check the message on the Display Screen and take action as necessary. (See "Error Messag-
es →P.886 .")

• When the Data lamp is flashing
Select the paper source after printing is finished.

• When a printer menu operation is in progress
Wait until the operation is finished before selecting the paper source.

• When in the process of loading paper
Finish loading the paper before selecting the paper source.

• When in the process of replacing Ink Tank
Finish replacing the Ink Tank before selecting the paper source.

• When the Top Cover is open
Close the Top Cover before selecting the paper source.

Selecting the Paper Type (Roll)
When changing the type of paper after the paper has been advanced, specify the type of paper as follows.

Important
• For best printing results, the printer fine-tunes the feed amount for each type of paper. Be sure to select the

type of paper to use correctly before printing.
• Because the printer fine-tunes the feed amount for each type of paper, the margins and the size of printed

images may vary depending on the type of paper used. If margins and the size of images are not as you ex-
pected, adjust the paper feed amount and Printhead height.
 (See "Adjusting the Feed Amount.") →P.684
 (See "Troubleshooting Paper Abrasion and Blurry Images (Head Height).") →P.683

Note
• After you load the roll, the printer automatically shows a menu for selection of the paper type on the Display

Screen, unless a barcode has been printed on the roll or you have activated automatic monitoring of the re-
maining roll paper. Select the type of paper, and then press the OK button.
If no barcode has been printed on the roll and you have activated automatic monitoring of the remaining roll
paper, specify the roll length after the paper type.  (See "Specifying the Paper Length (Roll).") →P.643

1. Press the Menu button to display MAIN MENU.
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2. Press ▲ or ▼ to select Media Menu, and then press the ▶ button.

3. Press ▲ or ▼ to select Roll1(Uppr) Type or Roll2 (Lwr) Type, and then press the ▶ button.

4. Press ▲ or ▼ to select the type of paper loaded in the printer, and then press the OK button.

Note
• For details on types of paper, see the Paper Reference Guide.  (See "Types of Paper.") →P.623  By

default, Plain Paper is selected.
• If you move the Release Lever, the setting automatically reverts to the previously selected paper.
• Be sure to select the correct paper type. If this setting does not match the loaded paper, it may cause

feed errors and affect printing quality.
• If automatic monitoring of the remaining roll is deactivated ( Off is selected) and you have selected a

type of paper for which width detection is deactivated ( Off is selected), you must advance the paper
manually to the position for printing.  (See "Manually Loading Paper to the Position for Printing.")
→P.667

5. Press the Online button to bring the printer online.

Specifying the Paper Length (Roll)
When changing the length of paper after the paper has been advanced, specify the length as follows.

Note
• When you specify the roll length in the printer menu, ManageRemainRoll must be set to On.
• After you select the type of roll, the printer automatically shows a menu for selection of the roll length on the

Display Screen if no barcode has been printed on the roll and you have set ManageRemainRoll to On. Se-
lect the roll length, and then press the OK button. The printer will automatically go online.

1. Press the Menu button to display MAIN MENU.
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2. Press ▲ or ▼ to select Media Menu, and then press the ▶ button.

3. Press ▲ or ▼ to select Roll1(Uppr)Lngth or Roll2(Lwr) Lngth, and then press the ▶ button.

4. Press ▲ or ▼ to select the length of paper loaded in the printer, and then press the OK button.
Specify the roll length as follows.

1. Press ◀ or ▶ to move the cursor (_) to each field for entering numbers.

2. Press the ▲ or ▼ button to enter the value.

3. Repeat steps 1 and 2 to finish entering the value, and then press the OK button.

5. Press the Online button to bring the printer online.

Removing the Roll from the Printer
Remove rolls from the printer as follows.

Note
• If the Wheeled Output Stacker is installed, remove it in advance.  (See "Using the Wheeled Output Stack-

er.") →P.671

• If you need to cut a printed roll, select Paper Cutting in the printer menu and cut the roll at the desired
position.  (See "Specifying the Cutting Method for Rolls.") →P.654

• If you have selected Media Menu >ManageRemainRoll >On in the printer menu, a barcode indicating the
amount of paper left is printed on the leading edge of the roll. However, barcodes are not printed on some
types of paper, and only a text message indicating paper information is printed.

Caution
• If you have activated automatic monitoring of the remaining roll paper, do not remove the roll before the

barcode is printed. You will be unable to keep track of the amount of roll paper left.
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Removing rolls from the Roll 1 (Upper) position

1. Press the Load/Eject button.

2. Press ▲ or ▼ to select Remove Roll, and then press the OK button.

3. Press ▲ or ▼ to select "Roll 1 (Upper)", and then press the OK button.
The roll can now be removed.

4. Open the Top Cover and lift the Ejection Guide.

5. Using both hands, rotate the Roll Holder in the direction of the arrow to rewind the roll.
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6. Remove the Roll Holder from the Roll Holder Slot.

Note
• For instructions on removing the Roll Holder from rolls, see "Removing the Roll Holder from

Rolls." →P.649

7. Lower the Ejection Guide and close the Top Cover.

Note
• To load new paper in the printer at this point, see "Loading Rolls in the Printer." →P.634

Removing rolls from the Roll 2 (Lower) position

1. Press the Load/Eject button.
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2. Press ▲ or ▼ to select Remove Roll, and then press the OK button.

3. Press ▲ or ▼ to select "Roll 2 (Lower)", and then press the OK button.
The roll can now be removed.

4. After confirming that the Online lamp is off, hold the Roll Unit Lever (a) and pull out the Roll Unit.

5. Using both hands, rotate the Roll Holder in the direction of the arrow to rewind the roll.
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6. Remove the Roll Holder from the Roll Holder Slot.

Note
• For instructions on removing the Roll Holder from rolls, see "Removing the Roll Holder from

Rolls." →P.649

• To load new paper in the printer at this point, see "Loading Rolls in the Printer." →P.634

7. In a crouching position, push the Roll Unit in with both hands.
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Removing the Roll Holder from Rolls

1. Lift the Holder Stopper lever (a) from the shaft side to unlock it. Holding the Holder Stopper at the position indica-
ted (b), remove it from the Roll Holder.

2. Remove the Roll Holder from the roll.

3. When removing attachments, push the tips (a) in as you remove the attachment.

• 3-Inch Paper Core Attachment #1 ( Roll Holder side)
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• 3-Inch Paper Core Attachment #2 ( Holder Stopper side)

• 2-Inch Paper Core Attachment

Important
• Store the roll in the original bag or box, away from high temperature, humidity, and direct sunlight. If paper

is not stored properly, the printing surface may become scratched, which may affect the printing quality
when you use it again.

Feeding Roll Paper Manually
When the printer is offline, you can advance or retract the roll on the Platen by pressing ▲ or ▼.

1. Press the Online button to bring the printer offline.

2. Confirm that a roll is selected as the paper source.  (See "Selecting the Paper Source.") →P.641
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3. Press the ▲ or ▼ button to advance or retract the roll.
Press ▲ to retract the roll manually.
Press ▼ to advance the roll manually.

Note
• Holding down ▲ or ▼ for less than a second moves the roll about 1 mm (0.04 in).

Holding down ▲ or ▼ for more than a second moves the roll until you release the button. Release the button
when the Display Screen indicates "End of paper feed. Cannot feed paper more.".

Keeping Track of the Amount of Roll Paper Left
If you have activated automatic monitoring of the remaining roll paper, when the roll is ejected, a barcode with text is prin-
ted on the roll paper that identifies the type of paper and amount left. When this function is activated and barcodes are prin-
ted on the roll paper, the type of paper and amount left are automatically detected after rolls are loaded. The barcode will be
cut off after it has been read.

Note
• If the document is not cut but kept in the printer, only the text message is printed.

Important
• Because this function is not compatible with clear film, an error message may be displayed ( "The roll is

empty." ) after you load clear film. For this reason, deactivate the function before loading clear film.
• If the barcode on the roll is not detected, enter the type and length of paper on the Control Panel.

Follow these steps to activate monitoring of the remaining roll paper.

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select Media Menu, and then press the ▶ button.

3. Press ▲ or ▼ to select ManageRemainRoll, and then press the ▶ button.

4. Press ▲ or ▼ to select the setting, and then press the OK button.
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Specifying the Ink Drying Time for Rolls
When you are using paper that takes longer for ink to adhere, if the Cutter touches printed surfaces that are still wet, it may
damage the paper or cause rough cut edges. Also, ink may be transferred onto the paper surface during ejection, soiling it.
You can prevent problems by adjusting the drying time after printing before the paper is cut.

Windows

1. Display the printer driver dialog box.
 (See "Accessing the Printer Driver Dialog Box from the Operating System Menu (Windows).") →P.218

2. Select the Main sheet and click C Advanced Settings in A Media Type.
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3. In the Paper Detailed Settings dialog box displayed next, select the desired settings values in B Between Pages
and C Between Scans in A Drying Time, and then click OK.
 (See "Paper Detailed Settings Dialog Box (Windows).") →P.225

Mac OS X

1. Choose Print in the application menu.

2. Select the Main pane and click C Settings in A Media Type.
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3. In the Paper Detailed Settings dialog box displayed next, select the desired settings values in C Between Pages
and D Between Scans in B Drying Time, and then click OK.
 (See "Paper Detailed Settings Dialog Box (Mac OS X).") →P.444

Note
• By factory default, Drying Time is deactivated ( Off ) for all paper types.
• To have the printer wait for ink to dry immediately after printing without releasing paper, set Cutting Mode

to Eject in the printer menu.
 (See "Specifying the Cutting Method for Rolls.") →P.654

Specifying the Cutting Method for Rolls
How a roll is cut after ejection varies depending on the printer settings.

Cutting Method Menu Settings Driver Setting

Automatic The roll is automatically cut by the Cutter Unit
following printer driver settings.

Cutting
Mode

Automat-
ic

Auto Cut Yes

Eject
→P.655

Choose this setting if you prefer not to have
documents dropped immediately after printing,
as when waiting for ink to dry.
To cut the roll using the Cutter Unit, hold down
the Stop button for a second or more.

Eject Yes

Man-
ual
→P.656

Choose this setting when using media that can-
not be cut using the Cutter Unit.
Cut each page from the roll using scissors. For
continuous printing (if you will cut each page
later), in Auto Cut, select Yes, or select Print
Cut Guideline.

Manual No Yes
Print Cut
Guideline
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Cutting Method Menu Settings Driver Setting
Man-
ual
→P.656

 (See "Cutting Roll Paper After Printing.")
→P.198

Cutting
Mode

Auto CutManual No Yes
Print Cut
Guideline

Paper
Cut-
ting
→P.658

Choose this option if you want to cut pages by
pressing Cutter Unit buttons for manual cutting
after printing when the printer driver is config-
ured to Auto Cut > No or Print Cut Guideline.
Otherwise choose this option if you want to cut
the roll edge after loading a roll.

Paper
Cutting

Yes No Print
Cut
Guideline

Note
• Automatic and Eject are valid only when you have specified Auto Cut > Yes in the printer driver.
• With Eject, printing does not resume after a series of jobs have been printed continuously until the roll is cut.

Cut rolls manually in the following cases:

Eject (waiting for ink to dry after printing)

Important
• When cutting wide printed documents after ejection, have two people support the documents. If the paper

drops, printed documents may be damaged.
• Do not lift the paper when holding printed documents before cutting. If the paper rises, it may affect the

printing quality.

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select Paper Details, and then press the ▶ button.
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3. Press ▲ or ▼ to select the type of paper, and then press the ▶ button.

4. Press ▲ or ▼ to select Cutting Mode, and then press the ▶ button.

5. Press ▲ or ▼ to select Eject, and then press the OK button.

6. Start printing.
Roll paper is fed to the specified cut position and then automatically stopped.

7. As you support the printed document to prevent it from dropping, hold down the Stop button for at least a second to
cut the roll.

Manual (when using media that cannot be cut using the Cutter Unit )

1. Press the Menu button to display MAIN MENU.
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2. Press ▲ or ▼ to select Paper Details, and then press the ▶ button.

3. Press ▲ or ▼ to select the type of paper, and then press the ▶ button.

4. Press ▲ or ▼ to select Cutting Mode, and then press the ▶ button.

5. Press ▲ or ▼ to select Manual, and then press the OK button.

6. Start printing.
The printer stops advancing the paper after printing.

7. Press the Online button.

Roll paper is fed to the specified cut position and then automatically stopped.

8. Cut the roll paper manually with scissors or the like.

9. Press the Online button.

The roll is rewound, and rewinding stops automatically.
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Paper Cutting (to have the roll cut at your specified position)

1. After pressing the Online button to bring the printer offline, press ▲ or ▼ to advance the roll paper to the position
for cutting.

2. Press the Menu button to display MAIN MENU.

3. Press ▲ or ▼ to select Paper Cutting, and then press the ▶ button.

4. Press ▲ or ▼ to select Yes, and then press the OK button.
After the roll paper is cut, it is rewound automatically.

Caution
• If paper would be short when cut at a particular position, the roll may automatically be advanced in

some cases before cutting.
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Cutting the Leading Edge of Roll Paper Automatically
If the leading edge of a roll is crooked or warped, it may cause an error message or printing problems. In this case, set Trim
Edge First to Automatic or On on the Control Panel to have the printer cut the leading edge to make the edge straight after
you load a roll.
Trim Edge First offers the following options.

• Automatic
If the left and right side of the leading edge of the roll ((a) and (b)) are uneven by 40 mm (1.6 in) or more when you
load the roll, the edge is cut an amount relative to the slant to ensure a straight edge, and scraps are removed. The edge
is not cut if the unevenness is less than 40 mm. However, paper may sometimes be cut, depending on the state of the
leading edge.

• Off
The edge is not cut and scraps are not removed. This setting is Off for most types of paper, by default. For more infor-
mation, see the Paper Reference Guide.  (See "Types of Paper.") →P.623

• On
The leading edge is cut off when you load a roll, and scraps are removed. The amount of paper cut off from the leading
edge varies depending on the paper type. For more information, see the Paper Reference Guide.  (See "Types of Pa-
per.") →P.623

Note
• If you print on paper that has an irregular width, set Skew Check Lv. to Loose for a higher skew detection

threshold or to Off to disable skew detection. However, if paper is loaded askew when detection is Off, note
that paper jams or Platen soiling may occur.

Follow these steps to change the Trim Edge First setting.

1. Press the Menu button to display MAIN MENU.
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2. Press ▲ or ▼ to select Paper Details, and then press the ▶ button.

3. Press ▲ or ▼ to select the type of paper, and then press the ▶ button.

4. Press ▲ or ▼ to select Trim Edge First, and then press the ▶ button.

5. Press ▲ or ▼ to select the desired setting option, and then press the OK button.
This setting takes effect the next time you load a roll.

Reducing Dust from Cutting Rolls
The printer is equipped with a function to reduce cutting dust for media such as Backlit Film that are more likely to generate
debris when cut. This may improve printing quality and help prevent Printhead damage. You can set up this function to be
activated for some types of paper.
When this function is activated, black lines are printed at the leading and trailing edges of documents.

Important
• Do not activate the function to reduce cutting dust for paper that wrinkles easily, such as Plain Paper or light-

weight paper. This may impair cutting and cause paper jams.
• Borderless printing is not available when this function is activated. Deactivate this function before borderless

printing.

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select Paper Details, and then press the ▶ button.

3. Press ▲ or ▼ to select the type of paper loaded in the printer, and then press the ▶ button.

4. Press ▲ or ▼ to select CutDustReduct., and then press the ▶ button.
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5. Press ▲ or ▼ to select On, and then press the OK button.
The function to reduce cutting dust is now activated.

Roll Holder Set
Load a roll on the roll holder and then load the holder in the printer. The Roll Holder in the Roll Holder Set RH2-44 is for
use with both 2-inch and 3-inch paper cores. Use the correct attachment for the particular paper core.  (See "Attaching the
Roll Holder to Rolls.") →P.629

• Roll Holder Set RH2-44

• Roll Holder (for 2- and 3-inch paper cores)

• Attachments

Using the 2-Inch Paper Core Attachment Using the 3-Inch Paper Core Attachment

2-Inch Paper Core Attachment 3-Inch Paper Core Attachment #1 3-Inch Paper Core Attachment #2

Automatic Roll Switching
Two rolls can be loaded on the printer, in the Roll 1 (Upper) position and in the Roll 2 (Lower) position. Selecting Roll
Paper (Auto) in Paper Source in the printer driver enables automatic selection and printing on the roll that suits the print
job from the loaded rolls.
The printer determines which roll to use based on these conditions, in the following order.

Note
• If an error message is displayed, neither paper feed slot is loaded with paper suitable for the print job. Check

the print job and replace the paper.  (See "Removing the Roll from the Printer.") →P.644
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1. When ManageRemainRoll in the printer menu is set to On, the roll longer than the length of a single page of the
print job is used.
When ManageRemainRoll is set to Off and both rolls are longer than the print job, the second condition determines
which roll is used.

Note
• When the roll currently advanced is a type of paper that cannot be cut and the printed pages have not

been cut, the currently advanced roll is used.
• If both rolls are too short, an error message is displayed.

2. Use a type of paper that matches the print job.
When both or neither loaded roll matches the type of paper in the print job, the third condition determines which roll
is used.

Note
• When Detect Mismatch in the printer menu is set to Warning or None, the roll is determined by the

following conditions.
• When neither loaded roll matches the type of paper in the print job and Detect Mismatch in the print-

er menu is set to Pause, an error message is displayed.

3. If Roll Switching in the printer menu is set to No RollSwitching, the currently advanced roll is used.
If Roll Switching in the printer menu is set to Use Optimal Size, the fourth condition determines which roll is used.

4. When the print job calls for borderless printing, the roll compatible with borderless printing is used.
When the print job does not specify borderless printing, or if both rolls are compatible with borderless printing, the
fifth condition determines which roll is used.

Note
• If neither roll is compatible with borderless printing, an error message is displayed.

5. Use a size of paper that matches the width specified in the print job.
When both loaded rolls match the width of paper in the print job or the width is not specified in the job, the sixth
condition determines which roll is used.
When Width Detection is set to Off, the seventh condition determines which roll is used.

Note
• When neither loaded roll matches the width specified in the print job, an error message is displayed.

6. Use a size of paper that accommodates the width specified in the print job.
When both loaded rolls can accommodate the width specified in the print job, the seventh condition determines
which roll is used.

Note
• When Detect Mismatch in the printer menu is set to Warning or None, the roll is determined by the

following conditions.
• When neither loaded roll is wide enough for the print job and Detect Mismatch in the printer menu is

set to Pause, an error message is displayed.

7. The roll closest to the roll width specified in the print job is used.
If both rolls are equally close to the specified width, the currently advanced roll is used.
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Handling sheets
Selecting the Paper Type (Sheet) ................................................................................................................... 663

 

Loading Sheets in the Printer .......................................................................................................................... 664
 

Manually Loading Paper to the Position for Printing ....................................................................................... 667
 

Removing Sheets ............................................................................................................................................ 669
 

Selecting the Paper Type (Sheet)
When changing the type of paper after the paper has been advanced, specify the type of paper as follows.

Note
• After you load the sheet, the printer automatically shows a menu for selection of the paper type on the Dis-

play Screen. In this case, select the paper type, and then press the OK button. The printer will automatically
go online.

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select Media Menu, and then press the ▶ button.

3. Press ▲ or ▼ to select Cut Sheet Type, and then press the ▶ button.

4. Press ▲ or ▼ to select the type of paper loaded in the printer, and then press the OK button.

Note
• For details on paper types, see the Paper Reference Guide.  (See "Types of Paper.") →P.623 Plain

Paper is selected by factory default.
If you move the Release Lever, the setting automatically reverts to Plain Paper.

• Be sure to select the correct paper type. If this setting does not match the loaded paper, it may cause
feed errors and affect the printing quality.

• If you select a type of paper for which Media Width Detection is deactivated ( Off is selected), you
must advance the paper manually to the position for printing.  (See "Manually Loading Paper to the
Position for Printing.") →P.667
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5. Press the Online button to bring the printer online.

Loading Sheets in the Printer

Note
• For details on supported types and sizes of paper, see Paper Sizes or the Paper Reference Guide.  (See

"Paper Sizes.") →P.626  (See "Types of Paper.") →P.623

• If the Platen is dirty, clean inside the Top Cover before loading paper.  (See "Cleaning Inside the Top Cov-
er.") →P.833

• After pressing the Load/Eject button, you can refer to instructions on the Display Screen as you load the
paper.  (See "Checking Instructions During Printer Operations.") →P.751

1. If you send a print job from a computer beforehand, the type and size of paper are shown on the Display Screen. Lift
the Release Lever and open the Top Cover.
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Important
• Do not touch the Linear Scale (a), Carriage Shaft (b), or Ink Tube Stabilizer (c). Touching these parts

may damage them.

2. With a sheet lengthwise and printing-side up, insert it between the Platen (a) and the Paper Retainer (b). Align the
edges of the sheet as follows.

1. Align the sheet with the Paper Alignment Line (c) at right.

2. Align the inserted edge of the sheet with the leading edge of the Paper Alignment Line (d), as shown.
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When inserted, sheets are automatically held by suction against the Platen.

Important
• Load a sheet so that it is parallel to the Paper Alignment Line at right (c). Loading paper askew will

cause an error.
• Warped paper may rub against the Printhead. Straighten paper if it is warped before loading it.

Note
• You can adjust the strength of suction holding paper against the Platen when the Release Lever is up.

If it is difficult to load paper, press the ▲ or ▼ button on the Control Panel to adjust the strength. Set
suction stronger by pressing the ▲ button or weaker with the ▼ button. Three settings are available.
However, even if you increase the suction, it may not be sufficient to hold some types of paper
against the Platen well. In this case, use your hand to load the paper.

• Sheets are held in place by suction through holes on the Platen. Although the suction may produce a
noise when paper is loaded in some positions, it does not indicate a problem. If the noise is distract-
ing, try moving the paper over slightly to the left or right (up to 1 mm [0.039 in]) while keeping it
parallel to the Paper Alignment Line.

• The suction remains on for about 30 seconds during loading. If you cannot finish loading a sheet dur-
ing this time, pull the sheet away and reinsert it to start the suction again.

3. Lower the Release Lever and close the Top Cover.

The printer now starts feeding the paper.
After the paper is advanced, the printer automatically goes online and starts printing.
If no print job has been received from the computer beforehand, the printer automatically shows a menu for selection
of the type of paper on the Display Screen.
In this case, select the type of paper.  (See "Selecting the Paper Type (Sheet).") →P.663
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Manually Loading Paper to the Position for Printing
When printing on non-standard sizes of paper or to specify a particular position to start printing, in the printer menu set
Width Detection to Off for the paper used.
Setting Width Detection to Off will prevent paper from being automatically advanced to the position for printing. In this
case, manually load paper at the position for printing.
Instructions for manually loading paper at the position for printing when Width Detection is set to Off are as follows.

1. If you send a print job from a computer beforehand, the type and size of paper are shown on the Display Screen. Lift
the Release Lever and open the Top Cover.

Important
• Do not touch the Linear Scale (a), Carriage Shaft (b), or Ink Tube Stabilizer (c). Touching these parts

may damage them.

Handling Paper > Handling sheets >

iPF825 Manually Loading Paper to the Position for Printing

7

667



2. Keeping the right edge of the paper aligned with the extended line of the Paper Alignment Line (a) on the right side
of the printer, load the paper so that the near edge is aligned with the groove (b) at the far end of the Platen.
In this case, advance the paper as far into the paper feed slot as possible because it will be printed starting at that
position.

3. Lower the Release Lever and close the Top Cover.

4. If no print job has been received from the computer, press ▲ or ▼ to select of the type of paper loaded, and then
press the OK button.

5. When "Width Detection OFF. OK to continue?" is shown on the Display Screen, press ▲ or ▼ to select "Leave
OFF" and then press the OK button.

6. Check the position of the loaded paper and press the OK button.

7. Press ▲ or ▼ to select the paper size, and then press the OK button.
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Note
• If a print job received requires paper larger than the selected paper, it may soil the Platen.

Removing Sheets
Remove sheets from the printer as follows.

1. Press the Load/Eject button.

Note
• Paper cannot be ejected by using the Load/Eject button when print jobs are in progress or during the

ink drying period. Before ejecting paper, press the Stop button to cancel printing, print job process-
ing, or ink drying.

2. Press the OK button to eject the paper.

The paper is ejected from the front of the printer.
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3. As you hold the sheet, lift the Release Lever and remove the sheet.

4. Lower the Release Lever.
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Output Stacker
Wheeled Output Stacker ................................................................................................................................. 671

Using the Wheeled Output Stacker ............................................................................................................. 671

Wheeled Output Stacker
An output stacker with casters, positioned in front of the printer.

a. Output Stacker
A cloth tray that catches ejected documents.
The Output Stacker can be opened and closed using the rod in front.

b. Output Stacker Ejection Guides
Prevent printed documents from winding around the Roll Holder or being drawn into the Paper Feed Slot.
Hold the Wheeled Output Stacker by these guides when moving it.

c. Output Stacker Foot Stand
Equipped with casters to facilitate moving it.

d. Stopper
Locks the Stand casters.
Always release the Stopper before moving the printer. Moving the printer while the Stopper is locked may scratch the
casters or the floor.

Note
• For instructions on assembling the Wheeled Output Stacker, see the setup guide provided with the Wheeled

Output Stacker.

Using the Wheeled Output Stacker
Positioning the Wheeled Output Stacker by the printer will prevent rolls from dropping on the floor after printing.
The stacker is equipped with casters to facilitate moving it.

Important
• The Output Stacker can accommodate one sheet. When printing multiple pages, remove each sheet after it is

printed.
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Positioning the Wheeled Output Stacker by the printer

1. Holding the Output Stacker Ejection Guides (a), move the stacker between the printer Stand.

2. Lock the casters.
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Removing the Wheeled Output Stacker from the printer

Note
• If there is not enough space to move the Wheeled Output Stacker, remove any printed documents inside the

Output Stacker and fold the Output Stacker up.

1. Release the caster lock.

Handling Paper > Output Stacker >

iPF825 Using the Wheeled Output Stacker

7

673



2. Holding the Output Stacker Ejection Guides (a), move the stacker away from the printer.
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Adjustments for Better Print Quality

Adjusting the Printhead 676

Adjusting the feed amount 684

Adjustments for Better Print Quality >
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Adjusting the Printhead
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Automatic Straightening of Lines and Colors (Auto Head Adj.) .................................................................. 676
Manual Straightening of Lines and Colors (Manual Head Adj) ................................................................... 678

 

Adjusting Line Misalignment (Head Inc. Adj.) .................................................................................................. 680
 

Troubleshooting Paper Abrasion and Blurry Images (Head Height) ............................................................... 683

Adjusting the Printhead
If printed documents are affected by the following problems, try adjusting the printhead.

• Printing is faint or affected by banding in different colors
Execute Nozzle Check to check for printhead nozzle clogging.
For instructions, see "Checking for Nozzle Clogging." →P.813

• Printed vertical lines are warped or colors are out of alignment
Use Auto Head Adj. or Manual Head Adj to adjust the printhead position.
Normally, use Auto Head Adj.. However, when using special paper or if printing is not improved after executing
Advanced Adj. in Auto Head Adj., try Manual Head Adj.
For adjustment instructions, Automatic Straightening of Lines and Colors (Auto Head Adj.) →P.676  or see
"Manual Straightening of Lines and Colors (Manual Head Adj)." →P.678

• Printed lines are misaligned
Execute Head Inc. Adj. to adjust the angle of inclination of the printhead.
Even slight misalignment can be corrected.
For adjustment instructions, see "Adjusting Line Misalignment (Head Inc. Adj.)." →P.680

• Paper rubs against the printhead, or image edges are blurred
Executing Head Height to adjust the printhead height may improve printing results.
For adjustment instructions, see "Troubleshooting Paper Abrasion and Blurry Images (Head Height)." →P.683

Automatic Straightening of Lines and Colors (Auto Head Adj.)
If printed vertical lines are warped or colors are out of alignment, adjust the Printhead alignment.
Use Auto Head Adj. to have the printer print and read a test pattern for automatic adjustment of the printhead.
Auto Head Adj. offers two modes, Standard Adj. and Advanced Adj..
Standard Adj. will fix most slight image distortion or color misalignment, but if not, try Advanced Adj..
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Note
• If advanced adjustment does not improve printing results, or if you are using special paper, try manual ad-

justment.
For instructions on manual adjustment, see "Manual Straightening of Lines and Colors (Manual Head
Adj)." →P.678

• Use Standard Adj. if you have switched to another type of paper or if you want the boundaries between
colors to appear as attractive as possible.

• Use Advanced Adj. to fine-tune the space between nozzles or colors if you have switched the printhead or if
you want printed documents to appear as vivid as possible. We recommend using Advanced Adj. for print-
ing at a higher level of image quality.

• Always make sure the loaded paper matches the type of paper specified on the printer. Adjustment cannot be
completed correctly unless the loaded paper matches the settings.

• We recommend using the type of paper you use most often for adjustment.
• This function is not available with CAD Tracing Paper, CAD Translucent Matte Film, or CAD Clear Film. If

adjustment is not possible as expected using highly transparent film or similar media, try another type of pa-
per, or try adjust the Printhead alignment manually.  (See "Manual Straightening of Lines and Colors
(Manual Head Adj).") →P.678

Paper to Prepare
Rolls An unused roll at least 10 inches wide

Sheets Standard Adj. : One sheet of unused paper of at least A4/Letter size
Advanced Adj. : Five sheets of unused paper of at least A4/Letter size (or one sheet when using A2 or larger,
or two sheets when using A3 loaded lengthwise)

Execute Auto Head Adj. as follows.

1. Load paper.

• Attaching the Roll Holder to Rolls →P.629

• Loading Rolls in the Printer →P.634

• Loading Sheets in the Printer →P.664

2. Press the Menu button to display MAIN MENU.

3. Press ▲ or ▼ to select Adjust Printer, and then press the ▶ button.

4. Press ▲ or ▼ to select Auto Head Adj., and then press the ▶ button.

5. Press ▲ or ▼ to select Standard Adj. or Advanced Adj., and then press the ▶ button.
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6. Press ▲ or ▼ to select Yes, and then press the OK button.
A test pattern is printed for printhead adjustment.
Adjustment is now finished if you have printed on a roll or a sheet of A2 size or larger.

7. If you are printing on sheets smaller than A2 size for Advanced Adj., a confirmation message is displayed asking
you whether to continue printing. Press the OK button and follow the instructions displayed.

Manual Straightening of Lines and Colors (Manual Head Adj)
If printed vertical lines are warped or colors are out of alignment, adjust the Printhead alignment.
With Manual Head Adj, you can manually adjust the Printhead alignment by printing and reading a test pattern.
You can adjust the Printhead alignment automatically or manually. Normally, choose automatic adjustment. If advanced
adjustment does not improve printing results, or if you are using special paper, try manual adjustment. For instructions on
straightening lines and colors automatically, see "Automatic Straightening of Lines and Colors (Auto Head Adj.)."
→P.676

Note
• If Manual Head Adj is not available although displayed in the menu, choose Advanced Adj. in Auto Head

Adj.. Manual Head Adj is available in the menu after you try Advanced Adj. once.
• Always make sure the loaded paper matches the type of paper specified on the printer. Adjustment cannot be

completed correctly unless the loaded paper matches the settings.
• We recommend using the type of paper you use most often for adjustment.

Paper to Prepare
Rolls An unused roll at least 10 inches wide

Sheets One sheet of unused paper of at least A4/Letter size

Execute Manual Head Adj as follows.

1. Load paper.

• Attaching the Roll Holder to Rolls →P.629

• Loading Rolls in the Printer →P.634

• Loading Sheets in the Printer →P.664
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2. Press the Menu button to display MAIN MENU.

3. Press ▲ or ▼ to select Adjust Printer, and then press the ▶ button.

4. Press ▲ or ▼ to select Manual Head Adj, and then press the ▶ button.

5. Press ▲ or ▼ to select Yes, and then press the OK button.
A test pattern is printed for printhead adjustment.

6. Press ▲ or ▼ to select D, and then press the ▶ button.

7. Press ▲ or ▼ to select D-1, and then press the ▶ button.

8. Examine test pattern D-1 for printhead adjustment and determine the number of the pattern with straight lines.

Note
• If lines seem straightest in two patterns but you cannot decide which one is better, choose an inter-

mediate value. For example, choose 11 if you cannot decide whether pattern 10 or 12 is better.

9. Press ▲ or ▼ to select the pattern number, and then press the OK button.

10. Repeat steps 7 and 9 to specify the adjustment value for D-2 to D-5 and D-7 to D-11.

11. Press the ◀ button.

12. Press ▲ or ▼ to select Register Setting, and then press the ▶ button.
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13. Press ▲ or ▼ to select Yes, and then press the OK button.
The adjustment value is now registered, and adjustment is complete.

Adjusting Line Misalignment (Head Inc. Adj.)
If printed lines are misaligned, try adjusting the angle of the Printhead. Even slight misalignment can be corrected. Adjust
the Printhead orientation by printing and reading a test pattern.

Paper to Prepare
Rolls An unused roll at least 10 inches wide

Sheets One sheet of unused paper of at least A4/Letter size

Execute Head Inc. Adj. as follows.

1. Load the paper.

• Attaching the Roll Holder to Rolls →P.629

• Loading Rolls in the Printer →P.634

• Loading Sheets in the Printer →P.664

Note
• When loading paper, specify the type of paper correctly. Using paper that you have not specified on

the printer may cause feeding problems and affect the printing quality.
• We recommend loading a type of paper that you use often.

2. Press the Menu button to display MAIN MENU.

3. Press ▲ or ▼ to select Adjust Printer, and then press the ▶ button.

4. Press ▲ or ▼ to select Head Inc. Adj., and then press the ▶ button.

5. Press ▲ or ▼ to select Yes, and then press the OK button.
After the Printhead is moved, a message is displayed requesting you to open the Top Cover.
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6. Open the Top Cover.

7. Align the Angle Adjustment Lever with the red square and close the Top Cover.

Adjustments for Better Print Quality > Adjusting the Printhead >

iPF825 Adjusting Line Misalignment (Head Inc. Adj.)

8

681



A test pattern is printed for adjustment.

Important
• Do not touch the Linear Scale (a), Carriage Shaft (b), or Ink Tube Stabilizer (c). Touching these parts

may damage them.

8. Examine the test pattern for adjustment. Determine the straightest set of lines.

9. Open the Top Cover and move the Angle Adjustment Lever to match the number (or the square) of the straightest
set of lines.
If no single set of lines is perfectly straight, move the Angle Adjustment Lever to a position between the numbers (or
between the number and the square) of the two sets of lines that are least misaligned.
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10. Close the Top Cover.
The Printhead is now straight, and adjustment is complete.

Troubleshooting Paper Abrasion and Blurry Images (Head Height)
If paper rubs against the printer or the edge is wrinkled from rubbing, adjusting the Printhead height may improve results.
If image edges are blurred, it may help to lower the Printhead.

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select Paper Details, and then press the ▶ button.

3. Press ▲ or ▼ to select the type of paper, and then press the ▶ button.

4. Press ▲ or ▼ to select Head Height, and then press the ▶ button.

5. Press ▲ or ▼ to select the Printhead height, and then press the OK button.

Adjustments for Better Print Quality > Adjusting the Printhead >

iPF825 Troubleshooting Paper Abrasion and Blurry Images (Head Height)

8

683



Adjusting the feed amount
Adjusting the Feed Amount ............................................................................................................................. 684

Selecting a Feed Amount Adjustment Method (Feed Priority) .................................................................... 684
Auto Band Adjustment (Auto Band Adj.) ..................................................................................................... 685
Manual Band Adjustment (Manual Band Adj) ............................................................................................. 686
Banding Adjustment During Printing (Fine Band Adj.) ................................................................................ 688
Adjusting Line Length (Adjust Length) ........................................................................................................ 689

 

Adjusting the Vacuum Strength (VacuumStrngth) ........................................................................................... 691

Adjusting the Feed Amount
If printed documents are affected by the following problems, try adjusting the feed amount.

• Banding in different colors
• Line length is not accurate in the direction paper is fed

To adjust the feed amount, do the following, in this order.

1. Depending on the issue, change the Feed Priority setting for the particular type of paper.  (See "Selecting a Feed
Amount Adjustment Method (Feed Priority).") →P.684

2. Based on the Feed Priority setting, use Auto Band Adj., Manual Band Adj, or Adjust Length.  (See "Auto Band
Adjustment (Auto Band Adj.).") →P.685  (See "Manual Band Adjustment (Manual Band Adj).")
→P.686  (See "Adjusting Line Length (Adjust Length).") →P.689

3. If additional fine-tuning is necessary after Auto Band Adj. or Manual Band Adj, use Fine Band Adj. in the Menu
Durng Prtng.  (See "Banding Adjustment During Printing (Fine Band Adj.).") →P.688

Selecting a Feed Amount Adjustment Method (Feed Priority)
Methods of adjusting the amount paper is fed are set for each type of paper, in the Feed Priority setting.
Adjust the Feed Priority setting to suit your particular printing application.

• Band Joint : Adjusts the feed amount to reduce banding across the sheet in printed documents.
The settings of Auto Band Adj. or Manual Band Adj are applied. If you have executed Fine Band Adj., in addition
to the settings of Auto Band Adj. or Manual Band Adj, the settings of Fine Band Adj. are also applied.

• Print Length : Adjusts the feed amount for better accuracy of lines in printed documents.
The settings of A:High or B:Standard/Draft in the Adjust Length menu are applied.

• Automatic : Band Joint or Print Length is selected, depending on Print Priority as selected in the printer driver at
the time of printing.
Image or Office Document : Band Joint is selected.
Line Drawing/Text : Print Length is selected.
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Note
• Use Manual Band Adj for transparent media or other paper for which adjustment with Auto Band Adj. is

not possible.
• Either B:Standard/Draft or A:High in the Adjust Length menu is applied, depending on printer driver set-

tings at the time of printing.
• If you have selected Easy Settings in the printer driver, follow these steps to confirm the Print Priority

setting.

• Windows: Click View Settings on the Main tab to display the View Settings dialog box.
• Mac OS X: Click View set. on the Main pane to display the View settings dialog box.

Follow these steps to change the Feed Priority setting.

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select Paper Details, and then press the ▶ button.

3. Press ▲ or ▼ to select the type of paper, and then press the ▶ button.

4. Press ▲ or ▼ to select Feed Priority, and then press the ▶ button.

5. Press ▲ or ▼ to select Automatic, Band Joint or Print Length and then press the OK button.

Auto Band Adjustment (Auto Band Adj.)
If printed images are affected by banding in different colors, adjust the amount that paper is fed.
Auto Band Adj. offers two modes, Standard Adj. and Advanced Adj.. Use Advanced Adj. if Standard Adj. does not
eliminate banding, or when using paper other than genuine Canon paper or paper for purposes other than checking output.
Always check the Feed Priority setting before using Auto Band Adj..  (See "Selecting a Feed Amount Adjustment
Method (Feed Priority).") →P.684

Note
• When using highly transparent media not compatible with Auto Band Adj., you must adjust the feed amount

manually.  (See "Manual Band Adjustment (Manual Band Adj).") →P.686

• If additional fine-tuning is necessary after Auto Band Adj., use Fine Band Adj..  (See "Banding Adjust-
ment During Printing (Fine Band Adj.).") →P.688

• To adjust the measurement scale and ensure accuracy (so that lines in CAD drawings are printed at exactly
the right length, for example), specify the amount of paper stretching or shrinkage when adjusting the feed
amount.  (See "Adjusting Line Length (Adjust Length).") →P.689

• This may take some time, depending on the type of paper.
• Use paper of the same type and size for adjustment as you will use for printing.
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Paper to Prepare
Rolls An unused roll at least 10 inches wide

Sheets Standard Adj. : One sheet of unused paper of at least A4/Letter size
Advanced Adj. : Two sheets of unused paper of at least A4/Letter size (or one sheet when using A2 or larger)

Execute Auto Band Adj. as follows.

1. Load paper.

• Attaching the Roll Holder to Rolls →P.629

• Loading Rolls in the Printer →P.634

• Loading Sheets in the Printer →P.664

Note
• Always make sure the loaded paper matches the type of paper specified. Adjustment cannot be com-

pleted correctly unless the setting value matches the loaded paper.

2. Press the Menu button to display MAIN MENU.

3. Press ▲ or ▼ to select Adjust Printer, and then press the ▶ button.

4. Press ▲ or ▼ to select Auto Band Adj., and then press the ▶ button.

5. Press ▲ or ▼ to select Standard Adj. or Advanced Adj., and then press the ▶ button.

6. Press ▲ or ▼ to select Yes, and then press the OK button.
A test pattern is printed for band adjustment.
Adjustment is now finished if you have printed on a roll or on sheets of A2 size or larger.

7. If you are printing on sheets smaller than A2 size for Standard Adj., a confirmation message is shown on the Dis-
play Screen, requesting you to continue printing. Press the OK button and follow the instructions on the Display
Screen.

Manual Band Adjustment (Manual Band Adj)
If printed images are affected by banding in different colors, adjust the amount that paper is fed.
Use Manual Band Adj for transparent media or other paper for which adjustment with Auto Band Adj. is not possible.
We recommend automatic adjustment for other types of paper.  (See "Auto Band Adjustment (Auto Band Adj.).") →P.685
Always check the Feed Priority setting before using Manual Band Adj.  (See "Selecting a Feed Amount Adjustment
Method (Feed Priority).") →P.684
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Note
• If additional fine-tuning is necessary after Manual Band Adj, use Fine Band Adj..  (See "Banding Adjust-

ment During Printing (Fine Band Adj.).") →P.688

• Use paper of the same type and size for adjustment as you will use for printing.

Paper to Prepare
Rolls An unused roll at least 10 inches wide

Sheets Two sheets of unused paper of at least A4/Letter size

Execute Manual Band Adj as follows.

1. Load paper.

• Attaching the Roll Holder to Rolls →P.629

• Loading Rolls in the Printer →P.634

• Loading Sheets in the Printer →P.664

Note
• Always make sure the loaded paper matches the type of paper specified. Adjustment cannot be com-

pleted correctly unless the setting value matches the loaded paper.

2. Press the Menu button to display MAIN MENU.

3. Press ▲ or ▼ to select Adjust Printer, and then press the ▶ button.

4. Press ▲ or ▼ to select Manual Band Adj, and then press the ▶ button.

5. Press ▲ or ▼ to select Yes, and then press the OK button.
Test pattern A is printed for band adjustment.

6. Examine test pattern A for band adjustment. Determine the pattern in which streaks are least noticeable.
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Note
• If streaks seem least noticeable in two patterns but you cannot decide which one is better, choose an

intermediate value. For example, choose 11 if you cannot decide whether pattern 10 or 12 is better.

7. Press ▲ or ▼ to display the number selected in step 6, and then press the OK button.
Test pattern B is printed for band adjustment.

8. Examine test pattern B for band adjustment. Determine the pattern in which streaks are least noticeable.

9. Press ▲ or ▼ to display the number selected in step 8, and then press the OK button.
The adjustment value is now registered, and adjustment is complete.

Banding Adjustment During Printing (Fine Band Adj.)
If, during printing, the contrast is uneven sideways across the paper or banding in different colors appears at 50 mm (2 in.)
intervals, try adjusting the feed amount as follows. The results of adjustment are applied to printing in progress, enabling
you to check the results immediately. However, note that because printing is paused, colors may be slightly different.
Use Fine Band Adj. after Auto Band Adj. or Manual Band Adj if finer adjustment is required.  (See "Auto Band Adjust-
ment (Auto Band Adj.).") →P.685  (See "Manual Band Adjustment (Manual Band Adj).") →P.686

Note
• The Fine Band Adj. value is reset to 0 if you use Auto Band Adj. or Manual Band Adj.

Execute Fine Band Adj. during printing as follows.

1. Press the Online button to pause printing.

2. Press the Menu button to display the menu during printing.  (See "Main Menu Settings (During Printing).")
→P.742

3. Press ▲ or ▼ to select Menu Durng Prtng, and then press the OK button.

Adjustments for Better Print Quality > Adjusting the feed amount >

Banding Adjustment During Printing (Fine Band Adj.) iPF825

8

688



4. Press ▲ or ▼ to select Fine Band Adj., and then press the ▶ button.

5. Press ▲ or ▼ to change the value, and then press the OK button.

Note
• The supported range is –5 to +5.

6. Press the Online button to resume printing.

Adjusting Line Length (Adjust Length)
Use Adjust Length to ensure that lines in CAD drawings are printed at exactly the right length.
In the Adjust Length menu, choose the mode of length adjustment ( A:High or B:Standard/Draft ) that suits your particu-
lar printing application.

• A:High : This setting is applied when Highest or High is selected in Print Quality in the printer driver.
• B:Standard/Draft : This setting is applied when Standard or Draft is selected in Print Quality in the printer driver.

Check the Feed Priority setting before using Adjust Length.  (See "Selecting a Feed Amount Adjustment Method
(Feed Priority).") →P.684

Note
• Use paper of the same type and size for adjustment as you will use for printing.
• If you have selected Easy Settings on the printer, follow these steps to confirm the Print Quality setting.

• Windows: Click View Settings on the Main tab to display the View Settings dialog box.
• Mac OS X: Click View set. on the Main pane to display the View settings dialog box.

Paper to Prepare
Rolls An unused roll at least 10 inches wide

Sheets One sheet of unused paper of at least A4/Letter size

Follow these steps to change the Adjust Length setting.

1. Load paper.

• Attaching the Roll Holder to Rolls →P.629

• Loading Rolls in the Printer →P.634

• Loading Sheets in the Printer →P.664
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Note
• Always make sure the loaded paper matches the type of paper specified in the settings. Adjustment

cannot be completed correctly unless the loaded paper matches the settings.

2. Press the Menu button to display MAIN MENU.

3. Press ▲ or ▼ to select Adjust Printer, and then press the ▶ button.

4. Press ▲ or ▼ to select Adjust Length, and then press the ▶ button.

5. Press ▲ or ▼ to select A:High or B:Standard/Draft, and then press the ▶ button.

6. Press ▲ or ▼ to select Yes, and then press the OK button.
A test pattern is printed for adjustment based on the amount of paper stretching or shrinkage. The scale bar shows
Millimeter in 50 mm units and Inch in 1 inch units.

Note
• A test pattern is printed in black when you choose A:High or in magenta if you choose B:Standard/

Draft.
• To cancel printing the test pattern for adjustment, hold down the Stop button for a second or more,

and then go to step 7.

7. Measure the length of the adjustment pattern. Calculate the difference between the measured length and actual
length. Enter it as a percentage and press the OK button.
You can adjust the value in 0.02% increments. Press ▲ to increase the value or ▼ to decrease it.
If the scale is printed shorter than actual size, set the value toward the positive side; if it is printed longer, set the
value toward the negative side.

Note
• You can also specify the adjustment value in Adjust Length in the Paper Details menu. In this case,

no test pattern for adjustment is printed.
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Adjusting the Vacuum Strength (VacuumStrngth)
When printing on heavyweight paper or paper that curls or wrinkles easily, if paper rubs against the printer or the edge is
wrinkled from rubbing, adjusting the level of suction against paper on the Platen may improve results.

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select Paper Details, and then press the ▶ button.

3. Press ▲ or ▼ to select the type of paper, and then press the ▶ button.

4. Press ▲ or ▼ to select VacuumStrngth, and then press the ▶ button.

5. Press ▲ or ▼ to select the level of suction against paper on the Platen, and then press the OK button.

Adjustments for Better Print Quality > Adjusting the feed amount >
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Printer Parts

Printer parts 693

Control Panel 700

Hard Disk 754
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Printer Specifications 761
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Front

a. Top Cover
Open this cover to install the Printhead, load paper, and remove any jammed paper from inside the printer as needed.
 (See "Top Cover (Inside).") →P.696

b. Ejection Guide
Guides printed documents as they are ejected. Open this guide when loading a roll.

c. Roll Holder Slot
Slide the Roll Holder into this slot.
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d. Roll Holder
Load the roll on this holder.

e. Protective Cloth for Sheets
A cloth tray that catches ejected sheets.

f. Paper Feed Slot
When loading a roll, insert the edge of the roll paper here. You can load rolls in two positions, on the printer side in the
Roll 1 (Upper) position and on the roll unit side in the Roll 2 (Lower) position.

g. Holder Stopper
Secure rolls on the Roll Holder with this part.

h. Ink Tank Cover
Open this cover to replace an Ink Tank.  (See "Ink Tank Cover (Inside).") →P.698

i. Control Panel
Use this panel to operate the printer and check the printer status.  (See "Control Panel.") →P.700

j. Release Lever
Releases the Paper Retainer. Lift this lever toward the front of the printer when loading paper.

k. Maintenance Cartridge
Ink used for maintenance purposes such as head cleaning is absorbed. (Replace the cartridge when it is full.)

l. Carrying Handles
When carrying the printer, have six people hold it by these handles under both sides.

m. Maintenance Cartridge Cover
Open this cover to replace the Maintenance Cartridge.

n. Stand
A stand that holds the printer. Equipped with casters to facilitate moving it.

o. Stand L
The left leg of the Stand.

p. Stand R
The right leg of the Stand.

q. Leg Covers
Covers for Stand L and Stand R.

r. Stopper
Locks the Stand casters.
Always release the Stopper before moving the printer. Moving the printer while the Stopper is locked may scratch the
casters or the floor.

s. Roll Unit
A unit for loading two rolls.

t. Roll Unit Lever
Hold this lever to pull out the Roll Unit.

Printer Parts > Printer parts >
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Back

a. Carrying Handles
When carrying the printer, have six people hold it by these handles under both sides.

b. Ethernet Port
Connect an Ethernet cable to this port. The lamp is lit if the Ethernet cable is connected correctly and communication is
possible between the computer and printer.

c. USB Port
Connect a USB cable to this port. The printer is compatible with Hi-Speed USB connections.

d. Manual Pocket
Store printer manuals in this pocket.

e. Power Supply Connector
Connect the power cord to this connector.

f. Accessory Pocket
Store assembly tools, Roll Holder attachments, and other items in this pocket.

g. Roll Unit Power Supply Inlet
Connect the Roll Unit power cord to this inlet.
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Top Cover (Inside)

a. Top Cover Roller
Prevents paper from rising when ejected.

b. Paper Alignment Line
Align paper with this line when loading it.

c. Carriage
Moves the Printhead. The carriage serves a key role in printing.  (See "Carriage.") →P.697

d. Carriage Shaft
The Carriage slides along this shaft.

e. Paper Retainer
Important in supplying the paper. This retainer holds paper as it is fed.

f. Platen
The Printhead moves across the platen to print. Vacuum holes on the platen hold paper in place.

g. Borderless Printing Ink Grooves
For catching ink outside the edges of paper during borderless printing.
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h. Cleaning Brush
When cleaning inside the printer under the Top Cover, use this brush to sweep away paper dust on the Platen.
Also use the brush to move the blue Switch on the Platen.

i. Cutter Rail
The Cutter Unit passes over this rail to cut paper.

j. Cutter Unit
A round-bladed cutter for automatic paper cutting.

k. Linear Scale
The linear scale serves a key role in detecting the Carriage position. Be careful not to touch this part when cleaning
inside the Top Cover or clearing paper jams.

l. Switch
Set the switch to the side opposite ● if the edges of printed images are blurred. Set the switch to the ● side before
borderless printing.  (See "Setting the Blue Switch on the Platen.") →P.867

Carriage

a. Printhead Fixer Cover
Holds the Printhead in place.

b. Printhead
The printhead is equipped with ink nozzles. The carriage serves a key role in printing.

c. Printhead Fixer Lever
Locks the Printhead Fixer Cover.

d. Shaft Cleaner
Prevents the Carriage Shaft from becoming dirty.

e. Angle Adjustment Lever
Use this lever to fine-tune the printer to correct misalignment of printed lines.
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Ink Tank Cover (Inside)

Note: The figure shows the printer as loaded with 700 ml (23.7 fl oz) Ink Tank.

a. Ink Tanks
Cartridges of ink in various colors.

b. Ink Tank Lock Lever
A lever that locks the Ink Tank in place and protects it. Lift and lower the lever when replacing an Ink Tank. To open
it, lift the stopper of the lever until it stops, and then push it down toward the front. To close it, push it down until it
clicks into place.

c. Ink Lamp (Red)
Indicates the state of the Ink Tank as follows when the Ink Tank Cover is opened.

• On
The Ink Tank is installed correctly.

• Off
No Ink Tank is installed, or the ink level detection function is disabled.

• Flashing Slowly
Not much ink is left.

• Flashing Rapidly
Ink tank is empty.

d. Ink Color Label
Load an Ink Tank that matches the color and name on this label.

e. Ink Set
An Ink Tank that can be used in the printer is labeled with a white letter A in a black circle on the side. When purchas-
ing an Ink Tank, make sure an A is printed on the label.  (See "Ink Tanks.") →P.799
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Ink Tank Cover (Inside) iPF825

9

698



Printer Parts > Printer parts >

iPF825 Ink Tank Cover (Inside)

9

699



Control Panel
Control Panel ................................................................................................................................................... 700
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Checking Instructions During Printer Operations ............................................................................................ 751

Control Panel

a. Online Button (Green)
Switches the printer online and offline. (See "Switching Modes.") →P.710

• On
The printer is online.

• Flashing
The printer is switching modes.

• Off
The printer is offline.

b. Menu Button
Displays the main menu of the printer. (See "Main Menu Settings.") →P.730

Printer Parts > Control Panel >

Control Panel iPF825

9

700



c. Data lamp (Green)

• Flashing
During printing, the Data lamp flashes when the printer is receiving or processing print jobs. Otherwise, this lamp
flashes when the print job is paused or the printer is updating the firmware.

• Off
There are no active print jobs when the Data lamp is off.

d. Message lamp (Orange)

• On
A warning message is displayed.

• Flashing
An error message is displayed.

• Off
The printer is off or is operating normally.

e. Paper Source Section
After you press the Feeder Selection button, the lamp for your chosen paper source is lit.

1. Roll Media lamp (Green)

• On
Indicates that a roll is selected as the paper source.

• Off
Indicates that a sheet is selected as the paper source.

2. Cut Sheet lamp (Green)

• On
Indicates that a sheet is selected as the paper source.

• Off
Indicates that a roll is selected as the paper source.

f. Feeder Selection Button
Switches the paper source. Each time you press this button, the paper source switches between the roll and the sheet,
and the corresponding lamp on the Paper Source Section is lit.

g. Display Screen
Shows the printer menu, as well as the printer status and messages.

h. Color Label
This label indicates the Ink Tank color. The label corresponds to the ink level on the Display Screen.

i. HDD lamp (Green)

• On
Indicates the printer is accessing the hard disk.

• Off
Indicates the printer is not accessing the hard disk.

j. ◀ Button
Menu mode: Press this button to display the menu one level higher.

Printer Parts > Control Panel >
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k. ▲ Button
Offline: Press this button to rewind rolls manually. (See "Feeding Roll Paper Manually.") →P.650

Menu mode: Press this button to display the previous menu item or setting value.

l. ▼ Button
Offline mode: Press this button to feed the roll manually in the direction of ejection, as needed. (See "Feeding Roll
Paper Manually.") →P.650

Menu mode: Press this button to display the next menu item or setting value.

m. ▶ Button
Menu mode: Press this button to display the menu one level lower.

n. OK Button
In Menu mode, press this button to confirm or execute the selected item or setting. Also press this button if the Display
Screen indicates to press the OK button.

o. Information Button
Displays printer submenus. Press this button to display information about ink, paper, and so on. (See "Submenu Dis-
play.") →P.743

You can also hold down this button for three seconds to clean the Printhead ( Head Cleaning A ).

p. Power Button
Turns the printer on and off. (See "Turning the Printer On and Off.") →P.702

q. Load/Eject Button
By pressing this button, you can check instructions on loading and removing paper. Instructions for loading paper are
shown on the Display Screen if pressed when no paper is loaded, and instructions for removing paper are shown if
paper is loaded.

r. Stop Button
Hold down for at least a second to cancel print jobs in progress or end the ink drying period.

Note
• In Sleep mode, you can press any button except the Power button to bring the printer online again.

Turning the Printer On and Off

Turning the printer on

1. Press the Power button to turn on the printer.
The printer will now start up.
After the Display Screen shows the Canon logo, "Starting up... Please wait." is displayed.

Printer Parts > Control Panel >
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2. The printer goes online in preparation for printing after startup, and the Online lamp and paper source section lamp
remain lit.

The printer will not go online in the following situations. Take action as needed.

• The Top Cover is open
Close the Top Cover.

• The Ink Tank Cover is open
Close the Ink Tank Cover.

• The Printhead is not installed
Please see "Replacing the Printhead." →P.816

• Ink Tank is not installed
Please see "Replacing Ink Tanks." →P.799

• ERROR is shown on the Display Screen
Turn off the printer and contact your Canon dealer.

• The Online lamp and Message lamp are not lit (even once), and nothing appears on the Display
Screen
Make sure the printer is plugged in correctly. Check the connection at the plug and electrical outlet.

• No paper is loaded
Load paper.  (See "Loading and Printing on Rolls.") →P.3  (See "Loading and Printing on Sheets.") →P.8

Important
• Starting the printer when it is connected via the USB cable to a Macintosh computer that is off may cause the

computer to start up at the same time. To prevent this, disconnect the USB cable before starting the printer.
Connecting the printer to the computer via a USB hub may solve this issue.

Turning the printer off

Important
• Never disconnect the printer's power supply or unplug it during a print job. This could damage the printer.

Printer Parts > Control Panel >
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1. Make sure no print jobs are in progress.
If the Message lamp is flashing, check the message on the Display Screen and take action as necessary.(See "Error
Messages →P.886 .")

If the Data lamp is flashing, the printer is receiving a print job. Turn off the printer only after printing is finished.

2. Hold down the Power button for more than a second.

After "Shut Down.. Please Wait.." is shown on the Display Screen, the printer shuts off.

Printer Modes
Printer modes are classified as follows and described in this topic.

• Modes →P.704

• Mode transition →P.706

• Online, and state of the Control Panel →P.707

• Offline, and state of the Control Panel →P.707

• Menu mode, and state of the Control Panel →P.709

• Submenu mode, and state of the Control Panel →P.709

Modes
The printer has five modes as follows:
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• Online
The printer is ready to receive jobs sent from the computer. Jobs sent from the computer are processed immediately. If
jobs are received in other modes, they are printed the next time the printer goes online.

• Offline
Any jobs sent from the computer are held without being printed.
While the printer is offline, you can feed or cut roll paper manually.
The printer goes offline automatically if jobs cannot be processed, such as if errors occur.

• Menu mode
Menus are displayed on the printer, and you can select, set, or execute menu items. Any jobs sent from the computer
are held without being printed.

• Submenu mode
Submenus are displayed regarding ink and paper information. Jobs can be received and printing is possible while sub-
menus are displayed and the printer is online. In other modes, any jobs sent from the computer are held without being
printed while submenus are displayed.

• Sleep mode
The printer is in power-saving mode. The printer automatically enters Sleep mode to conserve power if it is idle for a
specific period (by factory default, five minutes), that is, if no print jobs are received or buttons are pressed while all
covers are closed.
You can specify the period before the printer enters Sleep mode in the Sleep Timer menu.  (See "Main Menu Set-
tings.") →P.730

If any print jobs are received when the printer is in Sleep mode (after it was originally online), the printer goes online
and prints the jobs.

Printer Parts > Control Panel >
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Mode transition
The printer mode transitions are as follows:
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*1: When submenus are displayed, you can press any button other than the Information button to return to the previous
mode.

*2: The printer automatically enters Sleep mode if it is idle for a specific period (by factory default, five minutes), that is, if
no print jobs are received or buttons are pressed while all covers are closed. However, it does not enter Sleep mode
while error messages are displayed.

*3: In Sleep mode, the printer can be restored to the previous state by pressing any button. Sleep mode is also terminated if
a print job is received or a command is issued from RemoteUI.

Online, and state of the Control Panel

Not printing Printing in progress (receiving or processing print jobs)

Display Screen

• Top Line of the Display Screen
The printer status is displayed here. The selected paper source is indicated by an icon to the left of the type of paper.

• Middle Level of the Display Screen
The first and second lines display the paper type and size.
Any warning messages are displayed here on lines 2–4. Take the appropriate action. (See "Error Messag-
es →P.886 .")

• Bottom Line of the Display Screen
Here, the remaining ink level is indicated.  (See "Checking Ink Tank Levels.") →P.811

Control Panel

• Online lamp
Lit when the printer is online.

• Data lamp
Flashes when print jobs are being received or processed.

• Message lamp
Lit when warning messages are displayed.

Offline, and state of the Control Panel
Offline

Printer Parts > Control Panel >
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Not printing Printing is paused

Display Screen

• Display Screen
The printer status is displayed here. The selected paper source is indicated by an icon to the left of the type of paper.

• Middle Level of the Display Screen
The first and second lines display the paper type and size.
Any warning messages are displayed here on lines 2–4. Take the appropriate action. (See "Error Messag-
es →P.886 .")

• Bottom Line of the Display Screen
Here, the remaining ink level is indicated.  (See "Checking Ink Tank Levels.") →P.811

Control Panel

• Message lamp
Lit when warning messages are displayed.

Error Messages

If action can be taken If no action can be taken

• Top Line of the
Display Screen
Error messages are dis-
played.

• Bottom Line of the
Display Screen
Here, the remaining ink
level is indicated.  (See
"Checking Ink Tank
Levels.") →P.811

• Top Line of the
Display Screen
Error messages are dis-
played.

• Bottom Line of the
Display Screen
The corrective actions
are displayed here.

• Top Line of the
Display Screen
The error message is
displayed with the fol-
lowing instructions:
"Turn off printer,
wait, then turn on
again.".

• Display Screen
ERROR is displayed,
followed by the error
code and "Call for
service.".

• Data lamp
Flashes when print jobs are being received.

• Message lamp
Flashes when error messages are displayed.

• Data lamp
Flashes when print jobs are being received.

• Message lamp
Flashes when error messages are displayed.
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If action can be taken If no action can be taken

Take the appropriate action. (See "Error Messag-
es →P.886 .")

Turn off the printer and wait at least three seconds before
restoring the power.
If the message is still displayed after this, write down the
error code and message, turn off the printer, and contact
the Canon dealer for assistance.

Menu mode, and state of the Control Panel

Main menu Menu items and settings Main menu (during printing)

• Display Screen
Pressing the Menu button when
printing is not in progress displays
the main menu.
The title of the selected menu is
displayed on the first line, and
menus immediately under the cur-
rent menu are displayed on the
second and subsequent lines.
Lower level menus are available if
▶ is displayed at right.  (See
"Main Menu Operations.")
→P.713

• Display Screen
The title of the selected menu is
displayed on the first line, and
menu items or settings are dis-
played on the second and subse-
quent lines.  (See "Main Menu
Operations.") →P.713
The menu of options available
during printing (top figure) can
be displayed by pressing the ▶
button when the main menu is
displayed (left figure).

• Display Screen
Menus available during printing are
displayed if you press the Menu
button during printing.
If you select a menu, the title of the
selected menu is displayed on the
first line, and menus immediately
under the current menu are dis-
played on the second and subse-
quent lines. Lower level menus are
available if ▶ is displayed at right.
 (See "Main Menu Operations.")
→P.713

Submenu mode, and state of the Control Panel

Remaining Maintenance
Cartridge capacity and ink

levels

Information on the loaded
paper Printer information HP-GL/2 setting informa-

tion

Press the Information button to display this information, one after another: the Maintenance Cartridge capacity and
remaining ink levels, paper information, printer information, and GL2 settings information.  (See "Submenu Display.")
→P.743
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Switching Modes

Switching the Printer Online/Offline
Press the Online button to switch the printer online or offline.

The Online lamp is lit in Online mode. Printing is possible in this mode.

The Online lamp is off in Offline mode.

Depending on the status, the printer switches online and offline as follows.

Printer Status When Online is Pressed

Online The printer switches offline and the Online lamp goes off.

Online, printing Switches offline and printing is paused.
When printing is paused, the Printing menu is available.

Offline If paper has been advanced, the printer goes online and the Online lamp is lit.

Offline, when an error
message is displayed

In the case of error messages other than those shown below or if paper is not loaded, the
printer remains offline until you solve the problem. The Online lamp remains off.

If the following error messages are displayed, the printer goes online and printing is re-
sumed.

• "Insufficient paper for job"

• "PHead needs cleaning."

Printer Parts > Control Panel >
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Printer Status When Online is Pressed
Offline, when an error
message is displayed

• "Papr Size Mismatch"

• "Papr Type Mismatch"

Menu mode If paper has been advanced, the printer goes online and the Online lamp is lit.

Menu mode, printing Switches online and the Online lamp is lit.
Print is resumed.

Switching to Menu Mode
Press the Menu button to display the main menu.

Depending on the status, the printer switches to Menu mode as follows.

Printer Status When Menu is Pressed

Online Switches to Menu mode.

Online, printing Either menus available during printing or a screen to manage print jobs is dis-
played. If you select a menu, the printer switches to that menu mode.

Offline Switches to Menu mode.

Offline, printing Menus available during printing are displayed.

Offline, when an error message is
displayed

You cannot access Menu mode until the problem is solved.

Press the Information button to display the submenus.

Press the Information button to display the Maintenance Cartridge capacity and remaining ink levels, as well as informa-
tion on the loaded paper and the printer. Press the Information button repeatedly to change the information displayed.  (See
"Submenu Display.") →P.743
Press any button other than the Information button to restore the previous mode.
After you display a submenu, the printer will revert to the previous mode in about ten seconds if no print job is received or
if you do not operate the printer.
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Note
• You can start Head Cleaning A by holding down the Information button for three seconds or more.  (See

"Cleaning the Printhead.") →P.815

Printer Menu Operations
The printer menu includes a main menu and submenus.

• Main menu operations when no print job is in progress →P.712

• Main menu operations during printing →P.712

• Submenu operations →P.713

Main menu operations when no print job is in progress
Access the main menu by pressing the Menu button on the Control Panel.

Note
• The main menu will not be displayed in the following case even if you press the Menu button.

• An error message is displayed:
Switches to Menu mode after the problem is solved.

The following operations are available from the main menu.

• Paper settings
• Print settings
• Printer settings
• HP-GL/2 settings
• Job management menu operations

For a description of specific items available in the main menu, see "Main Menu Settings." →P.730
For instructions on selecting and setting main menu items, see "Main Menu Operations." →P.713

Note
• By default, main menu settings apply to all print jobs. However, for settings that are also available in the

printer driver, the values specified in the printer driver take priority.

Main menu operations during printing
The Menu Durng Prtng and Job Mgmt Menu can be accessed from the Menu Selection screen by pressing the Menu
button on the control panel during printing. Other menus are available after printing is finished.

Note
• The Menu Selection screen will not be displayed in the following case even if you press the Menu button.

• An error message is displayed:
Switches to Menu mode after the problem is solved.

The following operations are available from the main menu during printing.
 
 

Menu Durng Prtng

• Printhead cleaning
• Manual adjustment of the paper feed amount
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• Display of printer-related information

Job Mgmt Menu

• Job management menu operations

For a description of specific items available in the main menu during printing, see "Main Menu Settings (During Print-
ing)." →P.742
For instructions on selecting and setting main menu items during printing, see "Main Menu Operations." →P.713

Submenu operations
Access submenus by pressing the Information button on the Control Panel. You can check the following information in
submenus.

• Remaining Maintenance Cartridge capacity
• Ink levels
• Information on the loaded paper
• Printer information
• HP-GL/2 setting information

For a description of specific items displayed in submenus, see "Submenu Display." →P.743

Main Menu Operations
Press the Menu button to display the main menu. For details, see "Main Menu Settings." →P.730

• Main menu (displayed if you press the Menu button when printing is not in progress)

• Menu selection (if you press the Menu button when printing is in progress)

Note
• The main menu will not be displayed in the following case even if you press the Menu button.

• When an error message is displayed
You can switch to Menu mode after the problem is solved.

Printer Parts > Control Panel >

iPF825 Main Menu Operations

9

713



Simply press buttons on the Control Panel to access various function menus from the main menu and set or execute menu
items.
The following section describes menu operations and how they are presented in this User Manual.

• Accessing menus →P.714

• Specifying menu items →P.715

• Specifying numerical values →P.715

• Executing menu commands →P.716

Accessing menus
Printer menus are grouped by function.
Menus are displayed with the upper line selected. Use the buttons on the Control Panel to access each menu.

• Press ▲ to access a higher level menu on the same screen, and press ▼ to access a lower one. If not all menus can be
displayed on the screen at once, press ▲ and ▼ to scroll the menu. Items you select are highlighted.

The scroll bar at right indicates the current position in the overall menu.
• Lower level menus are available if ▶ is displayed at right. To access these lower level menus, select a menu and press
▶.

Printer Parts > Control Panel >

Main Menu Operations iPF825

9

714



• Upper level menus are available if ◀ is displayed at left in the top line. To access these upper level menus, press ◀.

Specifying menu items
Follow these steps to specify menu items.

1. Press ▲ or ▼ to select a menu, and then press the ▶ button.
Repeat these steps until the desired menu options are displayed.

2. Press ▲ or ▼ to select a setting item to complete, and then press the OK button.
The check box at left is selected, and the setting is confirmed.

After two seconds, the display reverts to the upper level menu.

3. Press the Online button to bring the printer online.

Note
• If a confirmation message is displayed regarding the setting you entered, press the OK button. The

setting is applied, and the printer goes online.

Specifying numerical values
Follow these steps to enter numbers. In this example, network settings items are entered.

1. Press ▲ or ▼ to select Interface Setup, and then press the ▶ button.
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2. Press ▲ or ▼ to select TCP/IP, and then press the ▶ button.

3. Press ▲ or ▼ to select IP Setting, and then press the ▶ button.

4. Press ▲ or ▼ to select IP Address, and then press the ▶ button.

5. Press ◀ or ▶ to move the cursor (_) to each field for entering numbers.

6. Press ▲ or ▼ to enter the number, and then press the OK button.

Note
• Hold down ▲ or ▼ to increase or decrease the value continuously.
• Make sure the IP address you enter for the printer is not the same as any computer IP address in your

network.

7. Repeat steps 5 and 6 to continue entering numbers.

8. Press the Online button to bring the printer online.

Note
• If a confirmation message is displayed regarding the setting you entered, press the OK button. The

setting is applied, and the printer goes online.

Executing menu commands
Follow these steps to execute menu commands.

1. Press ▲ or ▼ to select a menu, and then press the ▶ button.
Repeat these steps until the desired menu options are displayed.
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2. Press ▲ or ▼ to select a setting item to execute, and then press the OK button.

After two seconds, the menu command is executed. After commands are executed, in most cases the printer reverts
to the state before the menu operation, either online or offline.

Menu Structure

Main Menu
The structure of the main menu is as follows. Values at right indicated by an asterisk * are the defaults.
For instructions on menu operations, see "Main Menu Operations." →P.713
For details on menu items, see "Main Menu Settings." →P.730 .

First Level Second
Level

Third Lev-
el

Fourth
Level Fifth Level Sixth Level Seventh

Level Eighth Level

Paper
Cutting
(*1
→P.728

)

No *

Yes

Rep. Ink
Tank

No *

Yes

Head
Cleaning

Head Cleaning A *

Head Cleaning B

Paper
Menu

Cut Sheet
Type

(The paper type is displayed here.) (*5 →P.729 )
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First Level Second
Level

Third Lev-
el

Fourth
Level Fifth Level Sixth Level Seventh

Level Eighth Level

Paper
Menu

Roll1(Upp
r) Type
(*1
→P.728

)

(The paper type is displayed here.) (*5 →P.729 )

Roll1(Upp
r)Lngth
(*1
→P.728

),
(*2
→P.728

)

##.# m

### feet (*11 →P.729 )

Roll2
(Lwr)
Type
(*1
→P.728

)

(The paper type is displayed here.) (*5 →P.729 )

Roll2(Lwr
) Lngth
(*1
→P.728

),
(*2
→P.728

)

##.# m

### feet (*11 →P.729 )

ManageR-
emainRoll

Off *

On

Paper De-
tails

(The paper
type is dis-
played
here.)
(*5
→P.729

)

Roll Dry-
ingTime

Off

30 sec.

1 min.

3 min.

5 min.

10 min.

30 min.

60 min.

Scan Wait
Time

Dry time Off *

1 sec.

3 sec.

5 sec.

7 sec.

9 sec.
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First Level Second
Level

Third Lev-
el

Fourth
Level Fifth Level Sixth Level Seventh

Level Eighth Level

Paper De-
tails

(The paper
type is dis-
played
here.)
(*5
→P.729

)

Scan Wait
Time

Area
(*12
→P.729

)

Entire area *

Leading edge

Feed Pri-
ority

Automatic *

Band Joint

Print Length

Adjust
Length A

From –0.70% to 0.70%

Adjust
Length B

From –0.70% to 0.70%

Head
Height

Automatic *

Highest

High

Standard

Low

Lowest

Skew
Check Lv.

Standard *

Loose

Off

Vac-
uumStrng
th

Automatic *

Strongest

Strong

Standard

Weak

Weakest

Width De-
tection

Off

On *

NearEnd
RollMrgn

3mm

20mm

Cut Speed Fast

Standard

Slow

Trim Edge
First

Automatic

Off

On

Cutting
Mode

Automatic

Eject

Manual
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First Level Second
Level

Third Lev-
el

Fourth
Level Fifth Level Sixth Level Seventh

Level Eighth Level

Paper De-
tails

(The paper
type is dis-
played
here.)
(*5
→P.729

)

Bordless
Margin

Automatic

Fixed

CutDus-
tReduct.

Off

On

NearEnd
Sht Mrgn

3mm

20mm

Return
Defaults

No

Yes

Job Man-
agement

Print Job Job List (Choose a
print job.)

Delete

Preempt Jobs

Stored Job Mailbox
List

(Enter a
password if
one has
been set.)

Job List Print

Delete

Print Job
List

No

Yes

Job Log (Choose
from infor-
mation
about the
latest three
print jobs.)

Document Name

User Name

Page Count

Job Status OK

CANCELED

Print Start
Time

yyyy/mm/dd hh:mm

Print End
Time

yyyy/mm/dd hh:mm

Print
Time

xxxsec.

Print Size xxxxxxxxsq.mm

Media Type

Interface USB

Network

Ink Con-
sumed

(The total
amount of
ink con-
sumed and
ink colors
are dis-
played
here.)

xxx.xxx ml

HDD In-
formation

HDDSpace :xx.x GB

GL2 Set-
tings

Quality
Manager

Color
Mode

Monochrome

Color (CAD) 1 *
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First Level Second
Level

Third Lev-
el

Fourth
Level Fifth Level Sixth Level Seventh

Level Eighth Level

GL2 Set-
tings

Quality
Manager

Color
Mode

Color (CAD) 2

Color (CAD) 3

Color (CAD) 4

Color (CAD) 5

Color (CAD) 6

Print
Quality

Fast

Standard *

High

Input Res-
olution

600dpi *

300dpi

Print
(Econo-
my)

Off *

On

Paper
Manager

Paper
Source

Automatic *

Roll 1 (Upper)

Roll 2 (Lower)

Cut Sheet

Margin 3mm(Standard) *

5mm

Conserve
Paper

Off *

On

Auto Ro-
tate

Off *

On

Nesting Use Nest-
ing

Off *

On

Nesting
WaitTime

xx min.

Cut Lines Off *

On

Line &
Pen Man-
ager

Enable
merge

Off *

On

Pen Setup Select Pa-
lette

Software *

Palette A

Palette B

Factory

Define Pa-
lette

Palette A (Select the
pen num-
ber)

Width (Indicates the
value of Width
)

Color 0-255
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First Level Second
Level

Third Lev-
el

Fourth
Level Fifth Level Sixth Level Seventh

Level Eighth Level

GL2 Set-
tings

Line &
Pen Man-
ager

Pen Setup Define Pa-
lette

Palette A (Select the
pen num-
ber)

Line At-
tributes

No Setting

Circle Setting

Palette B (Select the
pen num-
ber)

(Indicates
Width,
Color, and
Line At-
tributes )

(Specify the
values of
Width, Color,
and Line At-
tributes )

Factory (Select the
pen num-
ber)

(Indicates Width, Color, and
Line Attributes )

Reset Pa-
lette

All Palette

Palette A

Palette B

Smoothing Software *

Smooth

Thicken-
FineLines

Off *

On

Adjust-
FaintLines

Off

On *

Processin-
gOption

Warning Off *

On

On-the-
Fly

Off *

On

PageSize-
Process1

Off *

On

PageSize-
Process2

Off *

On

Adjust
Printer

Auto Head
Adj.

Standard
Adj.

No

Yes

Advanced
Adj.

No

Yes

Auto Print Off

On *

Manual
Head Adj
(*9
→P.729

)

No

Yes

Auto Band
Adj.

Standard
Adj.

No

Yes
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First Level Second
Level

Third Lev-
el

Fourth
Level Fifth Level Sixth Level Seventh

Level Eighth Level

Adjust
Printer

Auto Band
Adj.

Advanced
Adj.

No

Yes

Manual
Band Adj

No

Yes

Adjust
Length
(*3
→P.728

)

A:High No

Yes

B:Stand-
ard/Draft

No

Yes

Head Inc.
Adj.

No

Yes

Interface
Setup
(*13
→P.729

)

EOP Tim-
er
(*13
→P.729

)

10 sec.

30 sec.

1 min.

2 min.

5 min.

10 min. *

30 min.

60 min.

TCP/IP
(*13
→P.729

)

IP Mode
(*13
→P.729

)

Automatic

Manual *

Protocol
(*4
→P.729

)
(*13
→P.729

)

DHCP
(*13
→P.729

)

On

Off *

BOOTP
(*13
→P.729

)

On

Off *

RARP
(*13
→P.729

)

On

Off *

IP Setting
(*10
→P.729

)
(*14
→P.729

)

IP Ad-
dress

0.0.0.0–255.255.255.255

Subnet
Mask

0.0.0.0–255.255.255.255

Default G/
W

0.0.0.0–255.255.255.255
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First Level Second
Level

Third Lev-
el

Fourth
Level Fifth Level Sixth Level Seventh

Level Eighth Level

Interface
Setup
(*13
→P.729

)

NetWare
(*13
→P.729

)

NetWare
(*13
→P.729

)

On

Off *

Frame
Type
(*6
→P.729

)
(*13
→P.729

)

Auto Detect

Ethernet 2

Ethernet 802.2 *

Ethernet 802.3

Ethernet SNAP

Print
Service
(*6
→P.729

)
(*13
→P.729

)

BinderyPServer

RPrinter

NDSPServer *

NPrinter

AppleTalk
(*13
→P.729

)

On

Off *

Ethernet
Driver
(*13
→P.729

)

Auto De-
tect
(*13
→P.729

)

On *

Off

Comm.Mo
de
(*7
→P.729

)
(*13
→P.729

)

Half Duplex *

Full Duplex

Ethernet
Type
(*7
→P.729

)
(*13
→P.729

)

10 Base-T *

100 Base-TX

Spanning
Tree
(*13
→P.729

)

Not Use *

Use
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First Level Second
Level

Third Lev-
el

Fourth
Level Fifth Level Sixth Level Seventh

Level Eighth Level

Interface
Setup
(*13
→P.729

)

Ethernet
Driver
(*13
→P.729

)

MAC Ad-
dress
(*13
→P.729

)

000085XXXXXX

Return
Defaults
(*14
→P.729

)

No *

Yes

Mainte-
nance

Repl.
maint cart

No

Yes

Replace
P.head

No

Yes

Repl. S.
Cleaner

No

Yes

Move
Printer

Level 1 *

Level 2

Level 3

System
Setup

Warning Buzzer Off

On *

Detect
Mismatch

Pause

Warning

None *

Skip
Take-Up
Err
(*9
→P.729

)

Off *

On

Keep Pa-
per Size

Off *

On

Paper Size
Basis

Sht Selec-
tion 1

ISO A3+ *

13"x19"(Super B)

Sht Selec-
tion 2

ISO B1

28"x40" (ANSI F)

Roll
Switching

Use Optimal Size *

No RollSwitching

TrimEdge
Reload

Automatic

Off *

On
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First Level Second
Level

Third Lev-
el

Fourth
Level Fifth Level Sixth Level Seventh

Level Eighth Level

System
Setup

Noz.
Check
Freq.

Off

1 page

10 pages

Automatic *

Carria-
geS-
canWdth

Automatic *

Fixed

Sleep Tim-
er
(*15
→P.729

)

5 min. *

10 min.

15 min.

20 min.

30 min.

40 min.

50 min.

60 min.

240 min.

Length
Unit

meter *

feet/inch

Time Zone
(*13
→P.729

)

0:London (GMT)

+1:Paris,Rome

+2:Athens,Cairo

+3:Moscow

+4:Eerevan,Baku

+5:Islamabad

+6:Dacca

+7:Bangkok

+8:Hong Kong

+9:Tokyo,Seoul

+10:Canberra

+11NewCaledonia

+12:Wellington

-12:Eniwetok

-11:Midway is.

-10Hawaii(AHST)

-9:Alaska(AKST)

-8:Oregon (PST)

-7:Arizona(MST)

-6:Texas (CST)

Printer Parts > Control Panel >

Menu Structure iPF825

9

726



First Level Second
Level

Third Lev-
el

Fourth
Level Fifth Level Sixth Level Seventh

Level Eighth Level

System
Setup

Time Zone
(*13
→P.729

)

-5:NewYork(EST)

-4:Santiago

-3:Buenos Aires

-2:

-1:Cape Verde

Date For-
mat
(*13
→P.729

)

yyyy/mm/dd *

dd/mm/yyyy

mm/dd/yyyy

Date &
Time
(*13
→P.729

)

Date yyyy/mm/dd (*8 →P.729 )

Time hh:mm

Language

*

Contrast
Adj.

–4,–3,–2,–1,0*,+1,+2,+3,+4

Reset
Papr-
Setngs
(*13
→P.729

)

No

Yes

Erase
HDD Data

High
Speed
(*13
→P.729

)

No

Yes

Secure
High Spd.
(*13
→P.729

)

No

Yes
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First Level Second
Level

Third Lev-
el

Fourth
Level Fifth Level Sixth Level Seventh

Level Eighth Level

System
Setup

Erase
HDD Data

Secure
(*13
→P.729

)

No

Yes

Output
Method

Print *

Print (Auto Del)

Save: Box XX

Save and
Print

Off *

On

Save:
Shared
Box
(*13
→P.729

)

Off

On *

Show Job
Log
(*13
→P.729

)

Off

On *

Admin.
Menu
(*13
→P.729

)

Change Password (*14 →P.729 )
Init.Admin.Pswd (*14 →P.729 )

Test Print Status
Print

No

Yes

Paper De-
tails

No

Yes

Print Job
Log

No

Yes

Menu
Map

No

Yes

Nozzle
Check

No

Yes

Color Pa-
lette

No

Yes

Informa-
tion

System Info

Error Log 1:xxxxxxxx-xxxx

2:xxxxxxxx-xxxx

*1:  Available only if a roll is loaded.
*2:  Available only if ManageRemainRoll is On.
*3:  Available if Feed Priority is Automatic or Print Length.
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*4:  Not displayed if IP Mode is Manual.
*5:  For information on the types of paper the printer supports, refer to the Paper Reference Guide.  (See "Types of

Paper.") →P.623  The paper type setting in the printer driver and related software (as well as on the Control
Panel ) is updated when you install the printer driver from the User Software CD-ROM or if you change paper
information by using the Media Configuration Tool.See the Media Configuration Tool →P.412  or Media
Configuration Tool →P.545 .

*6:  Not displayed if NetWare is Off.
*7:  Not displayed if Auto Detect is On.
*8:  Follows the setting in Date Format.
*9:  Available after you have used Advanced Adj. in Auto Head Adj. once.
*10:  Not displayed if IP Mode is Automatic.
*11:  Follows the setting in Length Unit.
*12:  Leading edge is not available as a setting option in the Paper Detailed Settings dialog box of the printer driv-

er.
*13:  Viewing and configuration is possible for administrators, and only viewing for other users.
*14:  Viewing and configuration is possible for administrators only.
*15:  Default setting for the time to enter the power save mode/Sleep mode is recommended.

Caution
• Only the following menus are displayed during printing.

Choose this menu to display Head Cleaning, Fine Band Adj., and Information.
Choose this menu to display Job Management.

Submenus
Each time you press the Information button on the Control Panel, printer information is displayed in the following order.

• The remaining Maintenance Cartridge capacity and ink levels

• Information on the loaded paper

Printer Parts > Control Panel >
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• Printer information

• HP-GL/2 settings information

For details on submenu screens, see "Submenu Display." →P.743

Main menu during printing
The structure of the main menu during printing is as follows.
For instructions on menu operations, see "Main Menu Operations." →P.713
For details on menu items available during printing, see "Main Menu Settings (During Printing)." →P.742

First Level Second Level Third Level Fourth Level

Menu Durng Prtng Head Cleaning * Head Cleaning A *

Head Cleaning B

Fine Band Adj. From –5 to 5

Information System Info

Error Log 1:xxxxxxxx-xxxx

2:xxxxxxxx-xxxx

Main Menu Settings
Main menu items are described in the following tables.
For instructions on selecting or setting menu items, see "Main Menu Operations." →P.713 .
For details on menu levels and values, see "Menu Structure." →P.717

Setting Item Description, Instructions

Paper Cutting This command is available only if a roll is loaded.
Choose Yes to cut the roll at the current position. However, if paper cannot be advanced
to the cut position, it will not be cut. In this case, manually advance the roll before cutting
it.  (See "Feeding Roll Paper Manually.") →P.650

Rep. Ink Tank When replacing ink tanks, choose Yes and follow the instructions on the screen.  (See
"Replacing Ink Tanks.") →P.799
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Setting Item Description, Instructions

Head Cleaning Clean the Printhead.  (See "Cleaning the Printhead.") →P.815
Choose Head Cleaning A if printing is faint, oddly colored, or contains foreign substan-
ces.
Choose Head Cleaning B if no ink is printed at all, or if printing is not improved by
Head Cleaning A.

Paper Menu Specify the type and size of paper.  (See " Paper Menu .") →P.732

Paper Details Specify detailed paper-related settings, including the ink drying time and borderless print-
ing options.  (See " Paper Details .") →P.732

Job Management Manage print jobs on the printer's hard disk.  (See " Job Management .") →P.734

GL2 Settings Specify settings for HP-GL/2 printing.  (See " GL2 Settings .") →P.735

Adjust Printer Adjust the Printhead alignment or amount of feed by printing a test pattern.  (See " Adjust
Printer .") →P.738

Interface Setup Configure the EOP timer and network settings.  (See " Interface Setup .") →P.738

Maintenance Access maintenance settings when replacing the Printhead or preparing to move the print-
er.  (See " Maintenance .") →P.739

System Setup Specify the printer system settings, including the date format and display language.  (See
" System Setup .") →P.740

Admin. Menu Change Password By setting a password, you can restrict menu display and
configuration as follows. You can input between 0 and
9999999.

• Viewing and configuration by administrators
only
IP Setting
Return Defaults
Change Password
Init.Admin.Pswd

• Viewing and configuration by administrators,
and only viewing by other users
Interface Setup settings (except IP Setting, Return
Defaults )
Time Zone
Date Format
Date & Time
Reset PaprSetngs
High Speed
Secure High Spd.
Secure
Save: Shared Box
Show Job Log
Admin. Menu

Init.Admin.Pswd Choose OK to restore the Admin. Menu password to the
default values.

Test Print Choose Status Print to print information about the printer.
Choose Paper Details to print the paper settings as specified in Paper Details.
Choose Print Job Log to print a record of print jobs, including the paper type and size,
amount of ink used, and so on. (Information on ink consumption is general, not specific
in nature.)
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Setting Item Description, Instructions
Test Print Choose Menu Map to print a list of the main menu options.

Choose Nozzle Check to print a test pattern for checking the nozzles.
Select Color Palette to print the GL2 color palette.

Information Displays printer information and an error log.  (See " Information .") →P.742

Paper Menu

Setting Item Description, Instructions

Cut Sheet Type (*1 →P.732 ) Choose the type of sheets.
 (See "Selecting the Paper Type (Sheet).") →P.663

Roll1(Uppr) Type (*1 →P.732 )
Roll2 (Lwr) Type (*1 →P.732 )

Choose the type of roll.
 (See "Selecting the Paper Type (Roll).") →P.642

Roll1(Uppr)Lngth
Roll2(Lwr) Lngth

Displayed if ManageRemainRoll is On.
If a barcode is not printed on rolls, specify the roll length.
The roll length is displayed in meters or feet, depending
on the setting in Length Unit.

Roll2 (Lwr) Type (*1 →P.732 ) Choose the type of roll.
 (See "Selecting the Paper Type (Roll).") →P.642

Roll2(Lwr) Lngth (*1 →P.732 ) Displayed if ManageRemainRoll is On.
If a barcode is not printed on rolls, specify the roll length.
The roll length is displayed in meters or feet, depending
on the setting in Length Unit.

ManageRemainRoll Choose On to print a barcode at the end of a roll before
you remove it. The printed barcode can be used in manag-
ing the amount of roll paper left. Choose Off if you prefer
not to print the barcode.
 (See "Keeping Track of the Amount of Roll Paper
Left.") →P.651

*1:  For information on the types of paper the printer supports, refer to the Paper Reference Guide.  (See "Types of
Paper.") →P.623  The types of paper indicated in the printer driver and related software (as well as on the
Control Panel ) are updated when you install the printer driver from the User Software CD-ROM or if you up-
date paper information by using the Media Configuration Tool. See Media Configuration Tool →P.412  or
Media Configuration Tool →P.545 .

Paper Details

Setting Item Description, Instructions

(The type of paper is dis-
played here.)
(*1 →P.734 )

Roll DryingTime Specify the time to wait for the ink to dry for each sheet.
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Setting Item Description, Instructions
(The type of paper is dis-
played here.)
(*1 →P.734 )

Scan Wait Time Specify the time to wait for the ink to dry between each
scan (after the printhead finishes moving in one direction),
in consideration of how quickly the ink dries. Also specify
the applicable area for the ink drying time. Select Entire
area to apply the ink drying time after each scan until the
document is fully printed. Select Leading edge to apply
the ink drying time after each scan only in the area 110–
160 mm from the leading edge. (The applicable length
varies depending on the Print Quality setting.) Note that
printing will take longer if you specify the Scan Wait
Time setting. In particular, when Leading edge is selec-
ted, colors may be uneven in the boundary between the
areas with and without a drying time.

Feed Priority Specify exact paper feeding, if desired. Normally, select
Automatic. Choose Print Length if you prefer to feed the
paper an exact amount. However, note that choosing Print
Length may result in slight banding in the direction of
Carriage scanning.

Adjust Length Displayed if Feed Priority is Print Length.
Adjustment relative to the amount of stretching or shrink-
age of the current paper.
Enter either the adjustment results from Print Pattern or
the discrepancy that you measured (as a percentage).
For paper that tends to stretch, increase the feed amount
by choosing a higher adjustment value. For paper that
tends to shrink, decrease the feed amount by choosing a
lower adjustment value.

Head Height Adjust the Printhead height.  (See "Troubleshooting Pa-
per Abrasion and Blurry Images (Head Height).")
→P.683

Skew Check Lv. If you print on Japanese paper (washi) or other handmade
paper that has an irregular width, choose Loose for a high-
er skew detection threshold, or choose Off to disable skew
detection. However, if paper is loaded askew when detec-
tion is Off, note that paper jams or Platen soiling may oc-
cur.

VacuumStrngth Specify the level of suction that holds paper against the
Platen.  (See "Adjusting the Vacuum Strength (Vac-
uumStrngth).") →P.691

Width Detection Specify this option to print inside boundaries or in other
cases when specifying a particular starting position for
printing. Paper width and skew are not detected if you se-
lect Off. If paper is loaded askew, note that paper jams or
Platen soiling may occur.

NearEnd RollMrgn Specify the minimum margin at the leading edge of roll
paper to ensure better printing quality at the leading edge.
Note that if you choose 3mm, it may lower the printing
quality at the leading edge and affect feeding accuracy.
The printed surface may be scratched, and ink may adhere
to the leading edge. It may also cause the Platen to be-
come soiled.
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Setting Item Description, Instructions
(The type of paper is dis-
played here.)
(*1 →P.734 )

Cut Speed Choose the cutting speed. If you use adhesive paper,
choosing Slow helps prevent adhesive from sticking to the
cutter and keeps the cutter sharp.

Trim Edge First If a roll is loaded, the end of the paper will be cut.

Cutting Mode Specify whether or not to cut with the standard round-bla-
ded cutter.
Choose Automatic to have the roll cut automatically after
printing. If you choose Manual, the paper will not be cut
after printing. Instead, a line will be printed at the cut po-
sition.
Choose Eject if you prefer not to have documents dropped
immediately after printing, as when waiting for ink to dry.

Bordless Margin Adjust the margin during borderless printing.
Choose Automatic to have the printer automatically de-
tect the paper width and configure the margin settings for
borderless printing. If margins are mistakenly created
when Automatic is selected, choose Fixed. In this case,
the paper width is not detected automatically, and the
document is printed without borders, using the margin set-
tings required by the printer.

CutDustReduct. If you choose On, a line will be printed at the cut position
when paper cutting is selected. This option reduces the
amount of debris given off after cutting. It also helps pre-
vent adhesive from sticking to the cutter and keeps the
cutter sharp if you use adhesive paper.  (See "Reducing
Dust from Cutting Rolls.") →P.660

NearEnd Sht Mrgn Specify a margin at the leading edge of sheets to ensure
better printing quality at the leading edge.
Note that if you choose 3mm, it may lower the printing
quality at the leading edge and affect feeding accuracy.
The printed surface may be scratched, and ink may adhere
to the leading edge.

Return Defaults Choose Yes to restore Paper Details to the default values.

*1:  For information on the types of paper the printer supports, refer to the Paper Reference Guide.  (See "Types of
Paper.") →P.623  The types of paper indicated in the printer driver and related software (as well as on the
Control Panel ) are updated when you install the printer driver from the User Software CD-ROM or if you up-
date paper information by using the Media Configuration Tool.

Job Management

Setting Item Description, Instructions

Print
Job

Job
List

(Choo
se a
print
job)

Delete Delete the current job or queued jobs.  (See "Managing
Queued Jobs (Deleting or Preempting Other Jobs).")
→P.574

Preempt Jobs Print the job first after the current print job is finished.  (See
"Managing Queued Jobs (Deleting or Preempting Other
Jobs).") →P.574
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Setting Item Description, Instructions

Stor-
ed
Job

Mail-
box
List

(Enter
a
pass-
word
if one
has
been
set.)

Job
List

(Choo
se a
print
job)

Print Print the saved job.

De-
lete

Delete the saved job.

Print Job List Print a list of saved print jobs.

Job
Log

(Choo
se
from
infor-
ma-
tion
about
the
latest
three
print
jobs.)

Document Name Displays the document name in the last print job.

User Name Displays the name of the user who sent the print job.

Page Count Displays the number of pages in the print job.

Job Status Displays the results of the print job processed.

Print Start Time Displays the time when the print job was started.

Print End Time Displays the time when the print job was finished.

Print Time Displays the time required to print the job.

Print Size Displays the paper size in the print job.

Media Type Displays the type of paper in the print job.

Interface Displays the interface used for the print job.

Ink Consumed Indicates a rough estimate of how much ink was consumed
per job.(*1 →P.735 )

HDD
Infor-
ma-
tion

HDDSpace Displays the space available on the printer's hard disk.

*1:   Indicates a rough estimate of how much ink was consumed per page. Actual ink consumption may be different.
The average margin of error for estimates calculated according to Canon measurement conditions for ink costs
is ±15%. Canon does not guarantee the accuracy of these estimates. Estimates may vary depending on condi-
tions of use. Calculation of these estimates does not include ink consumed when cleaning printheads by forceful
ejection of ink.

GL2 Settings

Setting Item Description, Instructions

Quality Man-
ager

Color Mode Monochrome Print in monochrome.

Color (CAD) 1 Print in standard colors.

Color (CAD) 2 Print in brighter colors.

Color (CAD) 3 Print emulating the following printers, in colors resembling
colors produced by these printers: Canon BJ-W3000/W3050.
(*1 →P.737 )

Color (CAD) 4 Print emulating the HP Designjet 500/800, in colors resem-
bling colors produced by these printers.(*1 →P.737 )

Color (CAD) 5 Print emulating the HP Designjet 1000, in colors resembling
colors produced by this printer.(*1 →P.737 )

Color (CAD) 6 Print emulating the HP Designjet 4000/4500, in colors re-
sembling colors produced by these printers.(*1 →P.737 )
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Setting Item Description, Instructions
Quality Man-
ager

Print Quality Choose the print quality.

Input Resolution Choose the printer input resolution, 600dpi or 300dpi.

Print (Economy) Although printing quality is diminished, less ink is con-
sumed than in regular printing. Select On to conserve ink.

Paper Manag-
er

Paper Source Choose the source of paper for HP-GL/2 printing.

Margin Specify the margin around paper. The margin for the trailing
edge of sheets is 23 mm (0.9 in).
However, if you have specified the leading margin in Paper
Details, the value in Paper Details has priority.

Conserve Paper Conserves paper when printing.

Auto Rotate If the long side of an original is shorter than the roll width,
the original is automatically rotated 90 degrees to conserve
paper. Similarly, if the long side of an original in landscape
orientation is longer than the roll width and the short side is
shorter than the roll width, the original is repositioned to fit
on the paper.
HP RTL print jobs are not rotated. Because HP RTL images
are not rotated even if the paper is rotated 90 degrees, images
may be cut off or the blank paper may be ejected. In this
case, set Auto Rotate to Off.

Nesting Use Nesting Selecting On will store print jobs until multiple documents
can be arranged to fill up the roll width, instead of printing
each print job as it is received.

Nesting Wait-
Time

Specify a time to wait until printing, as desired.

Cut Lines Select On to print cut lines between each document on the
roll.

Line & Pen
Manager

Enable merge Specify whether to merge or print over colors where lines
overlap.
Choose Off to print the second line over the first. Choose On
to merge all overlapping colors.

Pen Setup Select Palette As pen values, choose Software, Palette A, Palette B, or
Factory.
Choose Software to print according to software settings.
Choose Palette A or Palette B to print using the value speci-
fied in Define Palette.

Define Palette Specify the Width, Color, and Line Attributes in the pa-
lette Pen no.. Choose Factory to confirm the values when
Factory is selected in Select Palette.
In Line Attributes, choose No Setting or Circle Setting as
the processing for the ends and junctions of lines.

• If you choose No Setting
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Setting Item Description, Instructions
Line & Pen
Manager

Pen Setup Define Palette • If you choose Circle Setting

Reset Palette Restore Define Palette to the default palette settings.

Smoothing Choose whether to print arcs as smooth curved lines or as
multiple connected line segments.

• If you choose Software
Operation is determined by the application. If nothing is
specified by the application, the result is as shown in the
figure.

Note: By default, this is a 72-sided figure

• If you choose Smooth

ThickenFineLines Select On to print fine lines more distinctly.

AdjustFaintLines If fine lines are printed in colors that do not match the colors
of other shapes, selecting Off may help produce the expected
results. However, lines in some colors may appear broken.

ProcessingOp-
tion

Warning Select On to have any GL2-related warnings displayed.

On-the-Fly Selecting On will start printing jobs sooner if you are print-
ing only HP RTL print jobs and printing would not start until
later. However, images may be incomplete in some cases, so
be sure to check the printing results.

PageSizeProcess1 Normally, the area available for printing excludes a margin
required by the printer, and images are positioned according-
ly. Selecting On in this setting eliminates any misalignment
of the printing position if the image itself includes a border.

PageSizeProcess2 Selecting On will determine the paper size based on the im-
age rendering area.

*1:   It is not possible to match the colors and image quality produced by the specified printer exactly.
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Adjust Printer

Setting Item Description, Instructions

Auto Head Adj. Standard Adj. Choose Yes to have the printer print and read a test pattern
for the automatic adjustment of Printhead alignment rela-
tive to the printing direction.  (See "Automatic Straight-
ening of Lines and Colors (Auto Head Adj.).") →P.676

Advanced Adj. Choose Yes to have the printer print and read a test pattern
for the automatic adjustment of Printhead alignment rela-
tive to the nozzle, ink tank, and printing direction.  (See
"Automatic Straightening of Lines and Colors (Auto
Head Adj.).") →P.676

Auto Print Choose On to have the printer automatically execute the
Advanced Adj. operations after you replace the Print-
head.  (See "Automatic Straightening of Lines and Col-
ors (Auto Head Adj.).") →P.676

Manual Head Adj Choose Yes to print a test pattern for adjustment of Print-
head alignment relative to the printing direction. Enter the
adjustment value manually based on the resulting pattern.
 (See "Manual Straightening of Lines and Colors (Man-
ual Head Adj).") →P.678

Auto Band Adj. Standard Adj. Choose Yes to have the printer print and read a band ad-
justment test pattern for automatic adjustment of the feed
amount.  (See "Auto Band Adjustment (Auto Band
Adj.).") →P.685

Advanced Adj. Choose this option when using paper other than genuine
Canon paper or paper for which printing has been verified
by Canon.
Choose Yes to have the printer print and read a band ad-
justment test pattern for automatic adjustment of the feed
amount. Note that this function takes more time and re-
quires more ink than Standard Adj.  (See "Auto Band
Adjustment (Auto Band Adj.).") →P.685

Manual Band Adj Choose Yes to print a test pattern for adjusting the feed
amount based on the type of paper.
 (See "Manual Band Adjustment (Manual Band Adj).")
→P.686

Adjust Length A:High ( Adjust Length
A )
B:Standard/Draft ( Ad-
just Length B )

Prints a test pattern for particular types of paper to com-
pensate for paper stretching or shrinkage, after which you
can enter the amount of adjustment.  (See "Adjusting Line
Length (Adjust Length).") →P.689

Head Inc. Adj. Choose Yes to print a test pattern for adjusting the orienta-
tion of the Printhead.  (See "Adjusting Line Misalignment
(Head Inc. Adj.).") →P.680

Interface Setup

Setting Item Description, Instructions

EOP Timer Specify the timeout period before cancellation of print jobs
that cannot be received by the printer.
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Setting Item Description, Instructions

TCP/IP IP Mode Choose whether the printer IP address is configured automat-
ically or a static IP address is entered manually.

Protocol DHCP Specify the protocol used to configure the IP address auto-
matically.BOOTP

RARP

IP Setting IP Address Specify the printer network information when using a static
IP address.
Enter the IP address assigned to the printer, as well as the
network subnet mask and default gateway.

Subnet Mask

Default G/W

NetWare NetWare Specify the NetWare protocol. To apply your changes,
choose Register Setting.

Frame Type Specify the frame type to use.

Print Service Choose the print service.

AppleTalk Specify whether to use the AppleTalk protocol. To apply
your changes, choose Register Setting.

Ethernet Driv-
er

Auto Detect Specify the communication method. To apply your changes,
choose Register Setting.
Choose On for automatic configuration of the LAN commu-
nication protocol. Choose Off to use settings values of
Comm.Mode and Ethernet Type.

Comm.Mode Choose the LAN communication method.

Ethernet Type Choose the LAN transfer rate.

Spanning Tree Choose whether spanning-tree packets are supported over
the LAN.

MAC Address Displays the MAC address.

Return Defaults Return Defaults/Execute? is displayed if you press the ▼
button. Choose OK to restore the network settings to the de-
fault values.

Maintenance

Setting Item Description, Instructions

Repl. maint cart When replacing the Maintenance Cartridge, choose Yes
and follow the instructions on the screen.  (See "Replac-
ing the Maintenance Cartridge.") →P.823

Replace P.head Not displayed during a warning message that the remain-
ing Maintenance Cartridge capacity is low.
When replacing the Printhead, choose Yes and follow the
instructions on the screen.  (See "Replacing the Print-
head.") →P.816

Repl. S. Cleaner When replacing the Shaft Cleaner, choose Yes and follow
the instructions on the screen.  (See "Replacing the Main-
tenance Cartridge.") →P.823

Move Printer Not displayed during a warning message that the remain-
ing Maintenance Cartridge capacity is low.
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Setting Item Description, Instructions
Move Printer When transferring the printer to another location, choose

Yes and follow the instructions on the screen.  (See "Pre-
paring to Transfer the Printer.") →P.837

System Setup

Setting Item Description, Instructions

Warning Buzzer Set the buzzer. Choose On for the buzzer to sound once
for warnings and three times for errors.

Detect Mismatch Choose Warning for notification (display of a warning
message) during printing if the paper type specified in the
printer menu does not match the paper type in the printer
driver. Choose None to continue to print without notifica-
tion. Choose Pause to have printing paused under these
circumstances. In this case, you can continue printing by
pressing the Online button.

Keep Paper Size Choose On to use the paper size setting as the basis for
printing instead of other settings. The margin setting of the
printer menu will be used instead of the margin setting of
the printer driver if the latter is smaller, which may pre-
vent text or images in the margin from being printed.

Choose Off to use the printer driver settings instead. Even
if the margin setting of the printer driver is smaller than
that of the printer menu, text or images will not be cut off.
However, this requires longer paper because the actual
margin will be equal to the margin setting of the printer
driver plus the margin setting of the printer menu.

Paper Size Basis Sht Selection 1 If sheet size detection is activated, choose whether ISO
A3+ or 13"x19"(Super B) is applied when an intermedi-
ate size is detected.

Sht Selection 2 If sheet size detection is activated, choose whether ISO
B1 or 28"x40" (ANSI F) is applied when an intermediate
size is detected.

Roll Switching Use Optimal Size Selects the optimal paper size to minimize the amount of
paper wasted.
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Setting Item Description, Instructions
Roll Switching No RollSwitching Prints using the roll currently advanced on the Platen.

TrimEdge Reload Specify whether to trim the leading edge of the currently
retracted roll when the roll is advanced. Cut the edge if
you are concerned about any marks left on the roll when
the roll is left in the retracted position. Selecting On will
always trim the edge when the roll is advanced from the
retracted position. Selecting Automatic will trim the edge
when the roll has been in the retracted position for two
days or more.

Noz. Check Freq. Specify the timing for automatic checks of nozzle clog-
ging. Choose 1 page to check once per printed page.
Choose 10 pages to check once per ten printed pages.
Choose Automatic to have the printer automatically ad-
just the timing for checks based on the frequency of noz-
zle use.

CarriageScanWdth For specifying the carriage scan width during printing. Se-
lect Automatic for movement equivalent to the width of
paper loaded. Selecting Fixed will reduce any soiling on
the back of the paper, although printing may take a little
longer.

Sleep Timer Specify the period before the printer enters sleep mode.

Length Unit Choose the unit of measurement when roll length is dis-
played. You can switch the unit for the value in Roll
Length Set and the amount of paper left as indicated in
the submenu.

Time Zone Specify the time zone. Time zone options indicate a main
city in this time zone and the difference from Greenwich
Mean Time.

Date Format Specify the date format.

Date & Time Date Set the current date.

Time Set the current time. Available only if the Date setting is
specified.

Language Specify the language used on the Display Screen.

Contrast Adj. Adjust the Display Screen contrast level.

Reset PaprSetngs Restores settings that you have changed with Media Con-
figuration Tool to the default values.

Erase HDD Data High Speed Erases file management data for print job data stored on
the printer's hard disk.  (See "Erasing Data on the Print-
er's Hard Disk.") →P.758

Secure High Spd. Overwrites the entire hard disk with random data.  (See
"Erasing Data on the Printer's Hard Disk.") →P.758

Secure Overwrites the entire hard disk with 00, FF, and random
data (one time each). Verification is performed to check if
the data was correctly written.  (See "Erasing Data on the
Printer's Hard Disk.") →P.758

Output Method Print Select the output method.

Print (Auto Del)
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Setting Item Description, Instructions
Output Method Save: Box 01 To print as usual, select Print. Selecting Print (Auto Del)

will print the job and then delete the data from the printer's
hard disk. Selecting Save: Box 01 will only save the print
job in the box, without printing it.

Save and Print Select On to print the job after it has been saved.

Save: Shared Box Select Off to print without saving jobs in the box shared
among multiple users.

Show Job Log Selecting Off prevents display of the log in Job Menu >
Job Log. Additionally, the log is not printed if you choose
Job Menu > Print Job Log. Note that because job logs
are not collected, the Status Monitor accounting functions
will not work correctly.

Information

Setting Item Description, Instructions

System Info Firmware Displays the printer firmware version.

Boot Displays the version of the boot ROM.

MIT Displays the version of the MIT database format.

s/n Displays the printer's serial number.

MAC Displays the MAC address of the printer.

IP Displays the printer's IP address.

Error Log 1: xxxxxxxx-xxxx
2: xxxxxxxx-xxxx

Displays the most recent error messages (up to two).

Main Menu Settings (During Printing)
Main menu items during printing are described in the following tables.
For instructions on selecting or setting menu items, see "Main Menu Operations." →P.713 .
For details on menu levels and values, see "Menu Structure." →P.717

Setting Item Description, Instructions

Menu Durng Prtng Head Cleaning Printhead cleaning options.  (See "Cleaning the Print-
head.") →P.815
Choose Head Cleaning A if printing is faint, oddly col-
ored, or contains foreign substances.
Choose Head Cleaning B if no ink is printed at all, or if
printing is not improved by Head Cleaning A.

Fine Band Adj. Fine-tune the feed amount manually.

Information Displays the information about the printer and history of
print jobs.  (See "Information.") →P.743
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Information

Setting Item Description, Instructions

System Info Firmware Displays the version of the printer and firmware.

Boot Displays the version of the boot ROM.

MIT Displays the version of the MIT database format.

s/n Displays the printer's serial number.

MAC Displays the MAC address.

IP Displays the IP address.

HDDSpace Displays the space available on the printer's hard disk.

Error Log 1: xxxxxxxx-xxxx Displays the two most recent error message numbers,
most recent first.2: xxxxxxxx-xxxx

Submenu Display
Press the Information button to display this information, one after another: the Maintenance Cartridge capacity and remain-
ing ink levels, paper information, printer information, and HP-GL/2 settings information.
Each time you press the Information button, the following submenus are displayed.

Note
• Press any button other than the Information button to restore the previous mode.
• After you display a submenu, the printer will revert to the previous mode in about ten seconds if no print job

is received or if you do not operate the printer.

Remaining Maintenance Cartridge capacity and ink levels

The remaining Maintenance Cartridge capacity is shown on the top level of the Display Screen.
The remaining level of each ink is shown on the bottom level of the Display Screen. Ink levels shown on the Display Screen
correspond to the inks identified by the color labels on the bottom of the Display Screen.
These symbols may be displayed above the ink level: ! if ink is low, × if no ink is left, and ? if ink level detection is not on.
Remaining ink is indicated as follows.
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Information on the loaded paper
Here, the paper size, type, and related printer settings are displayed.

Printer information
Displays the firmware version, serial number, free hard disk space, IP address, and interface information.

HP-GL/2 setting information
HP-GL/2 settings information is displayed on three screens.

Status Print
You can print a Status Print report indicating the current status of the printer.
With Status Print, information is printed regarding the printer firmware version, various settings, and the utilization level
of consumables.

Printing Status Print Reports

1. Load paper.
If using sheets, load paper A4/Letter-sized. You will need at least four sheets.
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2. Press the Menu button to display MAIN MENU.

3. Press ▲ or ▼ to select Test Print, and then press the ▶ button.

4. Press ▲ or ▼ to select Status Print, and then press the ▶ button.

5. Press ▲ or ▼ to select Yes, and then press the OK button.

Checking the information in the Status Print report
The following information is included in the Status Print report.

Canon imagePROGRAF iPFxxxx Status Print Printer model

Firm Firmware version

Boot Boot ROM version

MIT(DBF) MIT database format version

MIT(DB) MIT database version

S/N Printer serial number

MAC Printer MAC address

IP Printer IP address

Ink Info MC Maintenance Cartridge capacity (%)

C, M, Y, MBK, BK Ink levels.
The remaining ink is displayed in a five-level scale.

Media Menu Information on the loaded paper.

Cut Sheet Type

Roll1(Uppr) Type

Roll2 (Lwr) Type

ManageRemainRoll

Job Management Job-related information.

HDD Information The free space on the printer's hard disk drive.

HDD Space
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Adjust Printer Current printer settings.

Auto Head Adj. Printhead adjustment value.

Auto Print

Interface Setup Current network settings.

EOP Timer Sets the elapsed time between receiving last data and cancel-
ing printing.

TCP/IP Settings related to TCP/IP.

IP Mode

Protocol

DHCP

BOOTP

RARP

IP Setting IP Setting values.

IP Address

Subnet
Mask

Default G/
W

NetWare NetWare settings.

NetWare

Frame
Type(*1 →P.746 )

Print Serv-
ice(*1 →P.746 )

AppleTalk Values that specify whether AppleTalk is active or not.

Ethernet Driver Ethernet Driver settings.

Auto Detect

Comm.Mode(*2
→P.746 )

Ethernet
Type(*2 →P.746 )

Spanning Tree

MAC Address

*1: Display when NetWare is set to On.
*2: Display when Auto Detect is set to On.

System Setup System settings.

Warning Current warning and error settings.

Buzzer

Detect Mismatch

Keep Media Size Current paper-related settings.
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Paper Size Basis Current paper-related settings.

Sheet Selection 1

Sheet Selection 2

Roll Switching

TrimEdge Reload

Noz. Check Freq. Nozzle-check settings.

CarriageScanWdth Carriage scan width setting.

Sleep Timer Printer system settings.

Length Unit

Time Zone

Date Format

Language

Contrast Adj.

Output Method Current output method setting.

Save and Print

Save:Shared Box

GL2 Settings HP-GL/2 setting values.

Quality Manager

Color Mode

Print Quality

Input Resolution

Print (Economy)

Paper Manager Paper Source

Margin

Conserve Paper

Auto Rotate

Nesting

Use Nesting

Nesting Wait-
Time

Cut Lines

ProcessingOption Warning

On-the-Fly

PageSizePro-
cess1

PageSizePro-
cess2

Printer Parts > Control Panel >

iPF825 Status Print

9

747



GL2 Settings HP-GL/2 setting values.

Line&Pen Manager

Enable merge

Pen Setup

Select Palette

Define Palette (Factory)

Pen 0 -- Width

Pen 1 -- Width

Pen 2 -- Width

Pen 3 -- Width

Pen 4 -- Width

Pen 5 -- Width

Pen 6 -- Width

Pen 7 -- Width

Pen 8 -- Width

Pen 9 -- Width

Pen 10 -- Width

Pen 11 -- Width

Pen 12 -- Width

Pen 13 -- Width

Pen 14 -- Width

Pen 15 -- Width

Define Palette (Palette A)

Pen 0 -- Width

Pen 1 -- Width

Pen 2 -- Width

Pen 3 -- Width

Pen 4 -- Width

Pen 5 -- Width

Pen 6 -- Width

Pen 7 -- Width

Pen 8 -- Width

Pen 9 -- Width

Pen 10 -- Width

Pen 11 -- Width

Pen 12 -- Width

Pen 13 -- Width

Pen 14 -- Width

Pen 15 -- Width
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Define Palette (Palette B) HP-GL/2 setting values.

Pen 0 -- Width

Pen 1 -- Width

Pen 2 -- Width

Pen 3 -- Width

Pen 4 -- Width

Pen 5 -- Width

Pen 6 -- Width

Pen 7 -- Width

Pen 8 -- Width

Pen 9 -- Width

Pen 10 -- Width

Pen 11 -- Width

Pen 12 -- Width

Pen 13 -- Width

Pen 14 -- Width

Pen 15 -- Width

Smoothing

ThickenFineLines

AdjustFaintLines

Network (RemoteUI) Current network settings used by RemoteUI.

TCP/IP

Frame Type

Use DHCP

Use BOOTP

Use RARP

Enable DNS Dynamic
Update

Use Zeroconf Function

IP Address

Subnet Mask

Gateway Address

LPD Printing

IPP Printing

IPP Printer URI

RAW Printing

Raw Port Number

Raw Mode Bi-direction
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FTP Printing Current network settings used by RemoteUI.

Primary DNS Server Ad-
dress

Secondary DNS Server
Address

DNS Host Name

DNS Domain Name

Multicast DNS Service
Name

NetWare NetWare settings.

Frame Type

IPX External Network
Number

Node Number

Print Service

Tree Name

Context
Name

Print Serv-
er Name

Print Serv-
er Pass-
word

Polling In-
terval

Current AppleTalk settings.Phase Type

Name

Network
Number

Zone

HEAD LOT NUMBER Printhead lot number.

LOT

PARTS STATUS Utilization status of replacement parts that require servic-
ing.COUNTER A–Y

COUNTER Utilization status of the cutter, media, and other items (in-
dicating how much they have been used).CUTTER

MEDIA

LIFE TTL

LIFE ROLL
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LIFE ROLL2 Utilization status of the cutter, media, and other items (in-
dicating how much they have been used).

LIFE CUT-
SHEET

MEDIA1-7

NAME

TTL

ROLL

ROLL2

CUTSHEET

AFTER INSTALLATION

Checking Instructions During Printer Operations
You can refer to instructions on the printer control panel when loading paper, replacing ink tanks, or performing other oper-
ations.

How to view instructions
Once you complete an action described in the instructions, the printer detects the action and switches to the next instruction
screen.
 

In the case of actions the printer cannot detect, instruction screens are switched every four seconds, and the sequence of
operations is shown repeatedly.
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When all actions in the sequence are finished, the instruction screen for the next step is displayed.
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Note
• During a continuous display of instructions, you can press the ◀ button to pause the instructions on the cur-

rent screen.
Press the ◀ or ▶ button to display the previous or next screens. If you do not press the ◀ or ▶ button
within 30 seconds, continuous display is resumed.
Press the OK button to display the instruction screen for the next step.

Viewing instructions for loading or removing rolls

1. Press the Load/Eject button.

2. Press ▲ or ▼ to select Load Roll or Remove Roll, and then press the OK button.

3. Press ▲ or ▼ to select Roll1(Uppr)Lngth or Roll2 (Lwr) Type, and then press the OK button.

Instructions are now displayed.

Viewing instructions for loading or removing sheets

1. Press the Load/Eject button.

Instructions are now displayed.
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Hard Disk
Printer Hard Disk Operations .......................................................................................................................... 754

 

Checking the Free Hard Disk Space ............................................................................................................... 755
Erasing Data on the Printer's Hard Disk .......................................................................................................... 758

Printer Hard Disk Operations
Printer hard disk operations are available from the following programs and interfaces.

• Printer driver
• imagePROGRAF HDI Driver
• imagePROGRAF Free Layout
• Color imageRUNNER Enlargement Copy
• imagePROGRAF Status Monitor
• imagePROGRAF Printmonitor
• RemoteUI
• Control Panel

The hard disk operations available through each interface are as follows.

Windows

Printer
driver

image-
PROGRAF
Free Layout image-

PROGRAF
Status
Monitor

Remo-
teUI

Control
Panel

image-
PROG-

RAF HDI
Driver

Color im-
ageRUN-
NER En-
largement

Copy

Mac OS Printer
driver

Color im-
ageRUN-
NER En-
largement

Copy

image-
PROGRAF
Printmoni-

tor

Operation Availability Availability Availability Availabil-
ity

Availabili-
ty

Saving print jobs Print Yes Yes No No No

Print (auto delete) Yes Yes No No No

Save in mail box Yes No No No No

Save data before
printing(*1)

Yes Yes No No No

Do not save print jobs
in the common box

No No No No Yes

Save print jobs sent
from sources other
than the printer driver

No No No No Yes

Operations with
saved jobs

Print saved jobs No No Yes Yes Yes
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Windows

Printer
driver

image-
PROGRAF
Free Layout image-

PROGRAF
Status
Monitor

Remo-
teUI

Control
Panel

image-
PROG-

RAF HDI
Driver

Color im-
ageRUN-
NER En-
largement

Copy

Mac OS Printer
driver

Color im-
ageRUN-
NER En-
largement

Copy

image-
PROGRAF
Printmoni-

tor

Operation Availability Availability Availability Availabil-
ity

Availabili-
ty

Operations with
saved jobs

Delete saved jobs No No Yes Yes Yes

Job queue manage-
ment

Display job queue No No Yes Yes Yes

Delete No No Yes Yes Yes

Preempt Jobs No No Yes Yes Yes

Mail box manage-
ment

Move saved jobs No No Yes Yes No

Modify saved jobs No No Yes Yes No

Modify mail boxes No No Yes Yes No

Print a list of saved
jobs

No No No No Yes

Display a list of saved
jobs

No No Yes Yes Yes

Other operations Display free hard disk
space

No No Yes Yes Yes

Initialize hard disk No No No No Yes

Display the time of
printing

No No Yes No No

Display error messages No No Yes Yes Yes

*1:This option is available in combination with Print, Print (auto delete), and Save in mail box. Print jobs are
saved and then printed.

Checking the Free Hard Disk Space
You can check the space available on the printer's hard disk as follows.

• Using the Control Panel
• Using RemoteUI
• Using imagePROGRAF Status Monitor (Windows)
• Using imagePROGRAF Printmonitor (Macintosh)
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Using the Control Panel

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select Job Management, and then press the ▶ button.

3. Press ▲ or ▼ to select HDD Information, and then press the ▶ button.

Note
• You can also check the available hard disk space in the submenu indicating printer information. Press the

Information button to display the submenus.  (See "Submenu Display.") →P.743

 
 

Using RemoteUI
To view the box list, select Stored Job in Job Management. On the Stored Job page, the free hard disk space is shown in
the upper-right corner when boxes are listed.

For details, refer to the RemoteUI help.
 
 

Printer Parts > Hard Disk >

Checking the Free Hard Disk Space iPF825

9

756



Using imagePROGRAF Status Monitor
The Hard Disk sheet shows the free hard disk space.
･ Hard Disk Sheet in imagePROGRAF Status Monitor

For details, refer to the imagePROGRAF Status Monitor help file.
 
 

Using imagePROGRAF Printmonitor
The Hard Disk pane shows the free hard disk space.
･ Hard Disk Pane in imagePROGRAF Printmonitor
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For details, refer to the imagePROGRAF Printmonitor help file.

Erasing Data on the Printer's Hard Disk
You can erase data on the printer's hard disk from the Control Panel.
There are three ways to erase the data, as follows.

Erasure
Method Details

High
Speed

Erases file management data for print job data stored on the printer's hard disk. Choose this method for
relatively fast erasure. Because only the file management data is erased, the print job data itself is not
erased. Note that it may be possible to read this data using commercial data recovery software.

Secure
High Spd.

Overwrites the entire hard disk with random data. No verification is performed to check if the data was
correctly written. Choose this method to erase highly confidential data. Note that it may be possible to
read the overwritten data using specialized data recovery tools.

Secure Overwrites the entire hard disk with 00, FF, and random data (one time each). Verification is performed
to check if the data was correctly written. Choose this method to erase especially confidential data. It is
virtually impossible to recover the overwritten data. Conforms to the DoD5220.22-M standard of the U.S.
Department of Defense.

Note
• For a more secure method of preventing data recovery, we recommend physically or magnetically destroying

the hard disk. In this case, the hard disk can no longer be used.
• Erase HDD Data is not available if there is a job queue.

Also note that during execution of Erase HDD Data, print jobs cannot be processed.

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select System Setup, and then press the ▶ button.

3. Press ▲ or ▼ to select Erase HDD Data, and then press the ▶ button.

4. Press ▲ or ▼ to select the method of erasure, and then press the ▶ button.

Note
• If a password has been set on the printer, the Admin.Pswd screen is displayed. In this case, enter the

password and press the OK button to go to the next step.

Printer Parts > Hard Disk >
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5. Press ▲ or ▼ to select Yes, and then press the OK button to display the confirmation screen.

Note
• As for the time required for deletion, confirm it on the Control Panel. However, when High Speed is

selected, this finishes in several seconds.

6. Press ▲ or ▼ to select Yes, and then press the OK button to start erasure.

Printer Parts > Hard Disk >
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Optional accessories

Printer Parts > Optional accessories >

iPF825
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Printer Specifications
Specifications .................................................................................................................................................. 761
Print Area ........................................................................................................................................................ 764

Specifications

Important
• The following values may vary depending on the operating environment.

Printer

Power supply 100–120 V AC (50/60 Hz), 220–240 V
AC (50/60 Hz)

Power consumption During operation 190 W max.

Sleep mode 100–120 V: 5 W max.
220–240 V: 6 W max.

Off 1 W max. (*1 →P.761 )

Operating noise (*2 →P.761 ) During operation Approx. 52 dB (A) max. (6.8 bels or
less)

Standby Approx. 35 dB (A) max.

Operating environment Temperature 15–30°C (59–86°F)

Humidity 10–80%, non-condensing

Dimensions (W × D × H) Printer only 1,893 × 766 × 1,144 mm (74.5 × 30.2 ×
45.0 in)

Printer and Stand (including Roll
Holder and Wheeled Output Stack-
er )

1,893 × 1,291 × 1,144 mm (74.5 × 50.8
× 45.0 in)

Weight Printer and Stand (not including the
Printhead and Ink Tank )

Approx. 189 kg (416.7 lb)

Space for installation (W × D × H) Printer and Wheeled Output Stacker 2,293 × 1,837 × 1,500 mm (90.3 × 72.3
× 59.1 in)

*1: The printer uses a trace amount of power even when turned off. To stop all power consumption, turn off the
printer and unplug the power cord.

*2: Calculation based on ISO 7779. Operating conditions: On the Main sheet of the printer driver, Media Type >
Plain Paper, Advanced Settings > Print Priority > Line Drawing/Text, and Print Quality > Standard.

Printing performance

Print method Bubblejet

Maximum resolution 2400 dpi horizontally (*1 →P.761 ) × 1200 dpi vertically

Printhead PF-03

Number of nozzles MBK: 5,120; Others: 2,560 each color

*1: Prints with a minimum 1/2400 inch dot pitch between ink droplets.

Printer Parts > Printer Specifications >
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Interface

USB
2.0(*1 →P.762 )

Format Internal port

Mode Full-speed (12 Mbps), high-speed (480 Mbps), bulk transfer

Connector Series B (4-pin)

Ethernet Format Internal port

Specification IEEE 802.3 10BASE-T, IEEE 802.3u 100BASE-TX/Auto-Negotia-
tion, IEEE 802.3x Full Duplex

Protocols IPX/SPX (Netware 4.2, 5.1, 6.0), SNMP, TCP/IP, AppleTalk, HTTP

*1: Use in USB 2.0 High Speed mode requires the following environment:

• Computer: USB 2.0 High-Speed–compatible
• Operating system: Windows 2000/Windows XP/Windows Server 2003/WindowsVista /Windows Server 2008/

Windows 7 or Mac OS X ver. 10.3.9 or later
• USB 2.0 driver: Microsoft USB 2.0 driver (available from Windows Update or the Service Pack.)
• USB cable: Certified USB 2.0 cable

Ink

Ink Tank MBK Ink Tank ( Matte Black
Ink, or black ink for matte paper)

Pigment ink PFI-303MBK (330 ml [11.2 fl
oz]) or PFI-703MBK (700 ml
[23.7 fl oz])

BK Ink Tank ( Black Ink ) Dye ink PFI-303BK (330 ml [11.2 fl oz])
or PFI-703BK (700 ml [23.7 fl
oz])

C Ink Tank ( Cyan Ink ) Dye ink PFI-303C (330 ml [11.2 fl oz]) or
PFI-703C (700 ml [23.7 fl oz])

M Ink Tank ( Magenta Ink ) Dye ink PFI-303M (330 ml [11.2 fl oz])
or PFI-703M (700 ml [23.7 fl
oz])

Y Ink Tank ( Yellow Ink ) Dye ink PFI-303Y (330 ml [11.2 fl oz]) or
PFI-703Y (700 ml [23.7 fl oz])

Capacity 330 or 700 ml (11.2 or 23.7 fl oz)
per color (*1 →P.762 )

*1: The provided Starter Ink Tanks contain 330 ml (11.2 fl oz) each.

Paper
For information on the types of paper the printer supports, refer to the Paper Reference Guide.  (See "Types of Paper.")
→P.623

Paper width Rolls 254–1,117.6 mm (10–44 in)

Sheets 203–1,117.6 mm (8–44 in)

Length of one page Rolls 203 (*1 →P.763 )–18,000 mm (8–708.7 in)

Sheets 203–1,600 mm (8–63 in)

Thickness Rolls 0.07–0.8 mm (0.0028–0.031 in)

Sheets 0.07–0.8 mm (0.0028–0.031 in)

Printer Parts > Printer Specifications >
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Paper Size Roll width 44-in. Roll (1117.6mm), 42-in. Roll (1066.8mm), JIS B0/B1 Roll
(1030.0mm), 36-in. Roll (914.4mm), ISO A0/A1 Roll (841.0mm),
30-in. Roll (762.0mm), JIS B1/B2 Roll (728.0mm), 24-in. Roll
(609.6mm), ISO A1/A2 Roll (594.0mm), JIS B2/B3 Roll
(515.0mm), 17-in. Roll (431.8mm), ISO A2/A3 Roll (420.0mm), 16-
in. Roll (406.4mm), 14-in. Roll (355.6mm), ISO A3/A4 Roll
(297.0mm), 10-in. Roll (254.0mm)

Sheets ISO A0, ISO A1, ISO A2, ISO A2+, ISO A3, ISO A3+, ISO A4,
ISO B0, ISO B1, ISO B2, ISO B3, ISO B4, JIS B0, JIS B1, JIS B2,
JIS B3, JIS B4, 34"x44" (ANSI E), 28"x40" (ANSI F),
22"x34"(ANSI D), 17"x22"(ANSI C), 13"x19" (Super B), 11"x17"
(Ledger), Legal (8.5"x14"), Letter (8.5"x11"), 36"x48" (ARCH E),
30"x42" (ARCH E1), 26"x38" (ARCH E2), 27"x39" (ARCH E3),
24"x36" (ARCH D), 18"x24" (ARCH C), 12"x18" (ARCH B),
9"x12" (ARCH A), DIN C0, DIN C1, DIN C2, DIN C3, DIN C4,
20"x24", 18"x22", 14"x17", 12"x16", 10"x12", 10"x15", 8"x10",
US Photo 16"x20", Poster 20"x30", Poster 30"x40", Poster
42"x60", Poster 44"x62", 13"x22", Poster 300x900mm

Print area Normal size Printable area

• Rolls
3 mm (0.12 in) from each side

• Sheets
3 mm (0.12 in) from the top, 23 mm (0.91 in) from the bottom, and
3mm (0.12 in) from the left and right sides

For information on the recommended print area, see "Print Area."
→P.764

Borderless printing
(*2 →P.763 )

Printable area (rolls)
0 mm from the top, 0 from the bottom, and 0 mm from the left and
right sides

Supported width for borderless printing 42-in. Roll (1066.8mm), JIS B0/B1 Roll (1030.0mm), 36-in. Roll
(914.4mm), ISO A0/A1 Roll (841.0mm), 24-in. Roll (609.6mm),
ISO A1/A2 Roll (594.0mm), JIS B2/B3 Roll (515.0mm), 17-in. Roll
(431.8mm), 14-in. Roll (355.6mm), 10-in. Roll (254.0mm)

*1: When supplying paper, use a roll approximately 1,000 mm (1,093.6 yd) or longer.
*2: Printing may not be possible in some cases, depending on the type and size of paper.

Hard Disk

Hard disk capacity 160 GB (print job storage capacity: 92
GB)

Print job storage capacity Common Box 100 jobs

Personal Boxes 100 jobs

Options

Roll Holder Set RH2-44
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Print Area
A margin required by the printer is added with respect to the size of paper loaded in the printer. Except in borderless print-
ing, the actual printing area corresponds to the paper size minus the space for this margin.

Note
• Printable Area: The area that can be printed.
• There is no margin (that is, a margin of 0 mm) during borderless printing on rolls.
• Recommended Print Area: We recommend printing within this area.
• To print so that your original matches the print area exactly, use an oversized paper size that includes the

required margin.  (See "Printing on Oversized Paper.") →P.86

 
Margins of Printable Area Margins of Recommended Print Area

Top Edge Bottom Edge Sides Top Edge Bottom Edge Sides

Sheets 3 mm (0.12 in) 23 mm (0.91
in)

3 mm (0.12 in) 20 mm (0.79
in)

23 mm (0.91
in)

5 mm (0.20 in)

Rolls 0/3 mm (0/0.12
in)

0/3 mm (0/0.12
in)

0/3 mm
(0/0.12 in)

20 mm (0.79
in)

5 mm (0.20 in) 5 mm (0.20 in)

Sheets

• Printable Area
a margin of 3 mm (0.12 in) on top, 23 mm (0.91 in) on bottom, and 3 mm (0.12 in) on left and right sides is required.

• Recommended Print Area
A margin of 20 mm (0.79 in) on top, 23 mm (0.91 in) on bottom, and 5 mm (0.20 in) on left and right sides is required.

Rolls
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• Printable Area
A margin of 3 mm (0.12 in) on all sides is required. During borderless printing, the margin on all sides is 0 mm. For
information on paper compatible with borderless printing, see the Paper Reference Guide.  (See "Types of Paper.")
→P.623

• Recommended Print Area
A margin of 20 mm (0.79 in) on top, 5 mm (0.20 in) on bottom, and 5 mm (0.20 in) on left and right sides is required.
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Network Setting

Network Setting 767

Network Setting (Windows) 779

Network Setting (Mac OS X) 789
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Network Environment

System requirements
The system requirements, which vary depending on your network, are as follows.

• Printing over a TCP/IP network

• Compatible operating systems

• Windows 2000 (Professional or Server)
• Windows XP (Home Edition or Professional)
• Windows Server 2003 (Standard Edition)
• Windows Vista (Home Basic/Business/Ultimate)
• Windows Server 2008 (Standard Edition or Enterprise Edition)
• Windows 7
• Windows XP Professional x64 Edition
• Windows Server 2003 x64 Edition
• Windows Vista x64
• Windows Server 2008 x64
• Windows 7 x64
• Mac OS X 10.2.8 or later
• Unix (Solaris 9)
• Unix (Red Hat 9)

• Compatible computer

• A computer that runs one of the above operating systems

Note
• The imagePROGRAF printer driver is supported in Mac OS X 10.3.9 or later.
• The imagePROGRAF printer driver is not compatible with Unix.

• Printing over an AppleTalk network

• Compatible operating systems
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iPF825 Network Environment

10

767



• Mac OS X 10.2.8–10.4
• Compatible computer

• A computer that runs one of the above operating systems

Note
• The printer cannot be used over a LocalTalk network.
• Compatible with EtherTalk Phase 2.
• The imagePROGRAF printer driver is not compatible with AppleTalk.

• Printing over a NetWare network

• Compatible servers

• Novell NetWare 4.2/5.1/6.0
• Compatible clients

• Windows 2000 (Professional or Server)
• Windows XP (Professional)

• Compatible computer

• A computer that runs one of the above operating systems

Note
• In NetWare 6.0, iPrint is not supported.

Network Environment
After confirming what type of network environment you will connect the printer to, set up the printer and computers as
needed.

• Example of a Windows network
In Windows networks, print over TCP/IP.

Note
• NetBIOS is not supported.
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• Example of a Macintosh network
In Macintosh networks, print over AppleTalk (EtherTalk) or TCP/IP, using Bonjour (Zeroconf) functions.

Note
• The imagePROGRAF printer driver is not compatible with AppleTalk.

• Example of a NetWare network

Note
• Even if there is a NetWare server in your network environment, you can use it in conjunction with TCP/

IP or AppleTalk. In this case, complete the settings for each protocol you will use.

Configuring the IP Address on the Printer
You must configure the printer's IP address before using the printer in a TCP/IP network.
The printer's IP address is configured automatically when you install the printer driver following the instructions in the Set-
up Guide.
Configure the IP address by using imagePROGRAF Device Setup Utility, the printer Control Panel, or ARP or PING com-
mands, if the IP address is changed, or if you change the printer connection mode to a network connection. For details on
configuring the IP address, refer to the following topics.

• Configuring the IP Address Using imagePROGRAF Device Setup Utility →P.410  (Windows)
• Configuring the IP Address Using the Printer Control Panel →P.770

• Configuring the IP Address Using ARP and PING Commands →P.771
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Important
• If you use a DHCP server for automatic assignment of the printer's IP address, printing may no longer be

possible after the printer is turned off and on. This is because an IP address different from before has been
assigned. Thus, when using DHCP server functions, consult your network administrator and configure the
settings in one of the following ways.

• Configure the setting for dynamic DNS updating
In RemoteUI, activate the setting Enable DNS Dynamic Update.  (See "Configuring the Printer's TCP/
IP Network Settings.") →P.773

• Configure the setting for assignment of the same IP address each time the printer starts up

Note
• We recommend configuring the printer's IP address even if you will use the printer in networks other than

TCP/IP networks. Configuring the printer's IP address enables you to use RemoteUI to configure the network
settings and manage the printer with a web browser.
For details on RemoteUI, see "Using RemoteUI." →P.772

Configuring the IP Address Using the Printer Control Panel
This topic describes how to configure the printer's IP address on the Control Panel.

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select Interface Setup, and then press the ▶ button.

3. Press ▲ or ▼ to select TCP/IP, and then press the ▶ button.

4. Press ▲ or ▼ to select IP Setting, and then press the ▶ button.

5. Press ▲ or ▼ to select IP Address, and then press the ▶ button.

6. After you press ◀ or ▶ to select the input field, numerical input is possible.
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7. Press the ▲ or ▼ button to enter the value.

Note
• Pressing the ▲ button increases the number by 1. The maximum value is 255, after which 0 is dis-

played.
• Pressing the ▼ button decreases the number by 1. The minimum value is 0, after which 255 is dis-

played.
• Hold down ▲ or ▼ to increase or decrease the value continuously.

8. Repeat steps 6–7 to enter the IP address assigned to the printer.

9. Press the Online button to bring the printer online.
If any settings are changed, a confirmation message is displayed. In this case, press the OK button.

Important
• Be sure to complete step 9. This will activate the values you have entered.
• You can also specify the subnet mask and default gateway on the Control Panel.

Note
• If an error message is displayed, check the settings and correct any invalid values.
• To cancel the setup process, hold down the Stop button for a second or more.

Configuring the IP Address Using ARP and PING Commands
This topic describes how to configure the IP address using ARP and PING commands.
To use the ARP and PING commands, you will need to know the printer's MAC address. You can confirm the MAC ad-
dress on the Control Panel.

1. Check the printer's MAC address.
You can confirm the MAC address on the Control Panel as follows:

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select Interface Setup, and then press the ▶ button.

3. Press ▲ or ▼ to select Ethernet Driver, and then press the ▶ button.

4. Press ▲ or ▼ to select MAC Address, and then press the ▶ button.

Note
• You can investigate the MAC address by printing a Status Print report.

 (See "Status Print.") →P.744
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2. In Windows, open a command prompt, or in Mac OS X, start Terminal.

3. Execute the following command to add entries to the ARP table for managing IP addresses and corresponding MAC
addresses.
arp -s [IP address] [the printer's MAC address you have verified]
Example: arp -s xxx.xxx.xxx.xxx 00-00-85-xx-xx-xx

Note
• In Mac OS X when using Terminal, enter the arp command in the format arp -s xxx.xxx.xxx.xxx

00:00:85:xx:xx:xx. For details, refer to the help file for the command line.

4. Execute the following command to send the IP address to the printer and configure it.
ping [IP address as specified in the ARP command] -l 479
Example: ping xxx.xxx.xxx.xxx -l 479

Note
• In -l, the l is the letter l.
• In Mac OS X when using Terminal, enter the ping command in the format ping -s 479

xxx.xxx.xxx.xxx. For details, refer to the help file for the command line.

Note
• The subnet mask and default gateway will be set to 0.0.0.0. Use RemoteUI to change the subnet mask and

default gateway to match your network settings.
For details on RemoteUI, see "Using RemoteUI." →P.772

Using RemoteUI
Enter the printer's IP address in a web browser to display the RemoteUI page. After you log on to RemoteUI from the page,
you can check and change the status of the printer and print jobs, and configure network settings.
To access RemoteUI, start the web browser and enter the following URL in the Location (or Address ) box to display the
RemoteUI page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/
 

For details on configuring printer settings for networks, refer to the following topics.

• Configuring the Printer's TCP/IP Network Settings →P.773

• Configuring the Printer's AppleTalk Network Settings →P.789

• Configuring the Printer's NetWare Network Settings →P.780

• Specifying Printer-Related Information →P.774

Note
• RemoteUI also offers many other features. You can display the ink levels, check error messages and other

status information, and cancel print jobs.
• By factory default, the English screen is displayed. To change the display language, select the desired lan-

guage under Language before logging on in administrator mode.
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Important
• Use Netscape Navigator 6.0 or later, Internet Explorer 5.01 or later, or Firefox 1.5 or later as a web browser.

In Mac OS X, you can also use Safari 1.32 or later or Safari 2.03 or later.
• Access is not possible via a proxy server. In environments where a proxy server is used, add the printer's IP

address to Exceptions (addresses accessed without a proxy server) in the web browser proxy server settings.
(Settings may vary depending on the network environment.)

• Enable JavaScript and cookies in the web browser.
• If you access RemoteUI with the printer name instead of its IP address, make sure the DNS settings are cor-

rectly configured.

Configuring the Printer's TCP/IP Network Settings
Follow the steps below to configure the TCP/IP network settings.

1. Start the web browser and enter the following URL in the Location (or Address ) box to display the RemoteUI
page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.

3. If a password has been set on the printer, enter the password.

4. Click Network in the Device Manager menu at left to display the Network page.

5. Click Edit in the upper-right corner of the TCP/IP group to display the Edit TCP/IP Protocol Settings page.

6. Refer to the TCP/IP Settings Items table to complete the settings.

TCP/IP Settings Items
Item Details Default Setting

Use DHCP Activate this setting to use DHCP for configuring the IP address. Off

Use BOOTP Activate this setting to use BOOTP for configuring the IP address. Off

Use RARP Activate this setting to use RARP for configuring the IP address. Off

Enable DNS Dy-
namic Update

Activate this setting to perform DNS server registration automati-
cally.

Off

Use Zeroconf
Function

Activate this setting to use Bonjour. On

IP Address Specify the printer's IP address. 0.0.0.0

Subnet Mask Specify the printer's subnet mask. 0.0.0.0

Gateway Address Specify the printer's default gateway. 0.0.0.0

LPD Printing Activate this setting to use LDP Printing. On

IPP Printing Activate this setting to use IPP Printing. On

IPP Printer URI Specify the URI of the printer used for IPP printing using up to
252 characters.

printer
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Item Details Default Setting
IPP Printer URI When using a standard Windows port for IPP printing, enter an

URL less than 255 bytes for all characters for http://"IP ad-
dress"/IPP-URI.

printer

RAW Printing Activate this setting to use Raw Printing. On

RAW Mode Bi-di-
rection

Activate this setting to use Raw mode bidirectional communica-
tion.

Off

FTP Printing Activate this setting to use FTP Printing. On

SMTP Server Ad-
dress

Specify the SMTP server's IP address. 0.0.0.0

Primary DNS Serv-
er Address

Specify the IP address of the primary DNS server. 0.0.0.0

Secondary DNS
Server Address

Specify the IP address of the secondary DNS server. 0.0.0.0

DNS Host Name Specify the printer host name, up to 63 characters (1–63 charac-
ters). Use single-byte letters, numbers, and - (hyphens). Do not use
numbers or - for the first character or - for the last character.

NB-17FBxxxxxxxxxxxx

DNS Domain Name Specify the printer domain name, up to 63 characters. Use single-
byte letters, numbers, - (hyphens), and . (periods). Do not use
numbers, -, or . for the first character, or - or . for the last charac-
ter.

blank

Multicast DNS
Service Name

Specify the printer's Multicast DNS service name. (1–63 charac-
ters)
This name will be displayed when Bonjour functions are used.

Canon iPFxxxx (xxxxxx)

7. Click OK to display the Network page.

Note
• If you specify to configure the IP address using DHCP, BOOTP, or RARP, there must be a server that sup-

ports such protocol running in the network.
• If you specify to configure the IP address using DHCP, BOOTP, or RARP, the IP address obtained by this

method is used first. If you cannot obtain the IP address, the address specified in IP Address is used.
• It takes a minute or two to determine whether DHCP, BOOTP, or RARP are available. We recommend clear-

ing check boxes of options you will not use.
• If you are using a DNS server, select Enable DNS Dynamic Update and enter the IP Address for DNS serv-

ers, DNS host name, and DNS domain name in Primary DNS Server Address, Secondary DNS Server
Address, DNS Host Name, and DNS Domain Name, respectively.

Specifying Printer-Related Information
Follow the steps below to specify device information and security settings.

1. Start the web browser and enter the following URL in the Location (or Address ) box to display the RemoteUI
page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.
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3. If a password has been set on the printer, enter the password.

4. Click Information in the Device Manager menu at left to display the Information page.

5. To display the relevant settings page, click Edit in the upper-right corner of Device Information or Security, de-
pending on what information you want to specify.

6. Refer to the table of settings for device information and security as you complete these settings.

Device Information Settings
Item Details Default Setting

Device Name Enter a device name.
(0–32 characters)

blank

Location Enter the location where the device is installed.
(0–32 characters)

blank

Administrator Enter the administrator's name.
(0–32 characters)

blank

Phone Enter the administrator's contact information.
(0–32 characters)

blank

Comments(E-mail) Enter any comments regarding the administrator.
(0–32 characters)

blank

Security Settings
Item Details Default Setting

Old Password Enter the current device password.
(0–14 characters)

blank

New Password Enter the new password.
(0–14 characters)

blank

Confirm Enter the new password again to confirm it.
(0–14 characters)

blank

Besides entering a password, you can specify other security-related information, such as IP address-based SNMP or
TCP usage restrictions, MAC address-based access restrictions, or IPP and FTP authentication settings.

7. Click OK to activate the settings.
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Configuring the Communication Mode Manually
This topic gives instructions for configuring the communication mode manually.

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select Interface Setup, and then press the ▶ button.

3. Press ▲ or ▼ to select Ethernet Driver, and then press the ▶ button.

4. Press ▲ or ▼ to select Auto Detect, and then press the ▶ button.

5. Press ▲ or ▼ to select Off, and then press the OK button.
Return to the Ethernet Driver menu.

6. Press ▲ or ▼ to select Comm.Mode, and then press the ▶ button.

7. Press ▲ or ▼ to select the communication mode, and then press the OK button.
Return to the Ethernet Driver menu.

8. Press ▲ or ▼ to select Ethernet Type, and then press the ▶ button.

9. Press ▲ or ▼ to select the Ethernet type, and then press the OK button.
Return to the Ethernet Driver menu.

10. Press ▲ or ▼ to select Spanning Tree, and then press the ▶ button.

11. Press ▲ or ▼ to enable or disable spanning tree support, and then press the OK button.
Return to the Ethernet Driver menu.
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12. Press the Online button.
After the confirmation message is displayed, press OK.
The new settings will take effect after the printer restarts.

Email Notification When Printing is Finished or Errors Occur
The printer can notify you of the printer status by email. Even when you are away from the printer, you can know when
printing is finished or if errors occur. Receive notification via email on your mobile phone or at your computer.

Use the imagePROGRAF Status Monitor (Windows) function to set up email recipients and message timing. Besides being
informed of finished print jobs or errors, you can also complete settings for email notification when service is needed or it's
time to replace consumables. For detailed instructions,see "Specifying Printer-Related Information." →P.774

Note
• For details on email notification using imagePROGRAF Status Monitor (in Windows), refer to the image-

PROGRAF Status Monitor help.
• Mail server authentication is only supported with imagePROGRAF Status Monitor.

Initializing the Network Settings
Use RemoteUI to restore the network settings to the default values as follows.

Important
• Initializing the network settings will also restore the default value of the printer's IP address. As a result, the

RemoteUI page cannot be displayed in the web browser after this procedure.
• For instructions on reconfiguring the IP address, see "Configuring the IP Address on the Printer." →P.769

• For details on RemoteUI, see "Using RemoteUI." →P.772
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1. Start the web browser and enter the following URL in the Location (or Address ) box to display the RemoteUI
page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.

3. If a password has been set on the printer, enter the password.

4. Click Network in the Device Manager menu at left to display the Network page.

5. Click Reset to Default settings in the lower-right corner of the Network Interface group.

6. After confirming the message, click OK to restore the network settings to the default values.

Note
• You can also use imagePROGRAF Device Setup Utility or the Control Panel to restore the default network

settings.
• If you use the Control Panel to initialize the network settings, press the Menu button to display MAIN

MENU, and then press ▲, ▼, and ▶ to select Interface Setup → Ethernet Driver → Init. Settings →
Yes (in this order), and finally press the OK button.
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Configuring the Printer Driver Destination
This topic describes how to specify the printer driver destination if the printer's IP address is changed, or if you will use the
printer over a network connection instead of via USB connection.
The procedure described below is the configuration based on the LPR or Raw protocol using the standard TCP/IP port in
Windows ( Standard TCP/IP Port ).

Important
• If you will use the printer in a TCP/IP network, make sure the printer's IP address is configured correctly.

• Configuring the IP Address on the Printer →P.769

1. Open the Printers and Faxes (or Printers ) window.

2. Right-click the icon of this printer and choose Properties to open the printer properties window.

3. Click the Port tab to display the Port sheet.

4. Click Add Port to display the Printer Ports dialog box.

5. In the Available Port list, select Standard TCP/IP Port.

6. Click New Port.
After the wizard starts, a window is displayed for the Welcome to the Add Standard TCP/IP Printer Port Wiz-
ard.

7. Click Next.

8. In Printer Name or IP Address, enter the printer's IP address. If the DNS is configured, you can also enter the DNS
Domain Name.

9. Follow the instructions on the screen to add a printer port.

10. Click Close to close the Printer Ports dialog box.

11. Make sure the printer port you added is displayed under Ports, and that the port is selected.

12. Click Close to close the printer properties window.
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Configuring the Printer's NetWare Network Settings
Follow the steps below to configure the NetWare network settings.

1. Start the web browser and enter the following URL in the Location (or Address ) box to display the RemoteUI
page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.

3. If a password has been set on the printer, enter the password.

4. Click Network in the Device Manager menu at left to display the Network page.

5. Click Edit in the upper-right corner of the NetWare group to display the Edit NetWare Protocol Settings page.

6. Refer to the NetWare Settings Items table to complete the settings.

NetWare Settings Items

Item Details Default
Setting

Frame Type Specify the type of frame to use in NetWare. Disabled

NCP Burst Mode Activate this setting to use NCP Burst Mode.
This mode supports fast data transfer when printing in queue server
mode. Normally, leave the setting On.

On

Print Application Choose the print service.

• Bindery PServer

• RPrinter

• NDS PServer

• NPrinter

NDS PSer-
ver

Packet Signature Select If Requested by Server to use packet signature. If Reques-
ted by
Server

Bindery
PServer

File Server Name Specify the name of a file server that has a NetWare print server.
(0–47 characters)

—

Print Server
Name

Specify the name of a NetWare print server.
(0–47 characters)

—

Print Server
Password

Set a password for the print server.
(0–20 characters)

—

Polling Interval Specify the interval to confirm jobs.
(1–15 seconds)

5

RPrinter Print Server
Name

Specify the name of a NetWare print server.
(0–47 characters)

—

Printer Number Specify the number of the printer connected to the NetWare print
server.
(0–15)

0
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Item Details Default
Setting

NDS PSer-
ver

Tree Name Specify the name of an NDS tree that has a NetWare print server.
(0–32 characters)

—

Context Name Specify the name of a context that has a NetWare print server.
(0–255 characters)

—

Print Server
Name

Specify the name of a NetWare print server.
(0–64 characters)

—

Print Server
Password

Set a password for the print server.
(0–20 characters)

—

Polling Interval Specify the interval to confirm jobs.
(1–255 seconds)

5

NPrinter Print Server
Name

Specify the name of a NetWare print server.
(0–47 characters)

—

Printer Number Specify the number of the printer connected to the NetWare print
server.
(0–254)

0

7. Click OK to display the Network page.

Specifying the Printer's Frame Type
To enable communication between the printer and computers on your network, specify the Ethernet frame type in your Net-
Ware environment.
Follow the steps below to specify the frame type by using imagePROGRAF Device Setup Utility or the printer Control
Panel.

Note
• You can specify the frame type by using RemoteUI if the printer's IP address is configured.

Important
• Before specifying the frame type, make sure the printer is on and connected to the network.
• For instructions on installing imagePROGRAF Device Setup Utility, see "Installing imagePROGRAF De-

vice Setup Utility." →P.409 .

Specifying the Frame Type Using imagePROGRAF Device Setup Utility

1. Start imagePROGRAF Device Setup Utility.

2. In the list of printers, select the printer to configure.

3. Choose Protocol Settings from the Printer menu.

4. In the NetWare Frame Type list, select the frame type.

5. Click ETHERNET II under Frame Type in TCP/IP.
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6. In IP Address, enter the IP address assigned to the printer, and then enter the subnet mask in Subnet Mask and the
default gateway in Gateway Address.

Important
• You must specify the IP address here to be able to configure NetWare protocol settings using Remo-

teUI.

7. Click Set.

8. Click OK after the Confirmation message dialog box is displayed.

9. Exit imagePROGRAF Device Setup Utility.

Specifying the Frame Type Using the Printer Control Panel

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select Interface Setup, and then press the ▶ button.

3. Press ▲ or ▼ to select NetWare, and then press the ▶ button.

4. Press ▲ or ▼ to select NetWare, and then press the ▶ button.

5. Press ▲ or ▼ to select On, and then press the OK button.
Return to the NetWare menu.

6. Press ▲ or ▼ to select Frame Type, and then press the ▶ button.

7. Press ▲ or ▼ to select the frame type to use, and then press the OK button.
Return to the NetWare menu.

8. Press ▲ or ▼ to select Print Service, and then press the ▶ button.

9. Press ▲ or ▼ to select the desired print service, and then press the OK button.
Return to the NetWare menu.
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10. Press the Online button to bring the printer online.
If any of the settings is changed, a message for confirmation is displayed. In this case, press the OK button.

Important
• Be sure to complete step 10. This will activate the values you have entered.

Note
• If an error message is displayed, check the settings and correct any invalid values.
• To cancel the setup process, hold down the Stop button for a second or more.

Specifying NetWare Print Services
Before printing in a NetWare network, you must configure print services such as print servers, print queues, and so on. You
can configure the print service settings from a computer using any of the following software.

• NWADMIN
• PCONSOLE

(from Novell, provided with NetWare)

Important
• If you use NWADMIN to configure the print service settings, Novell Client (the Novell NetWare client soft-

ware) must be installed as the client software application.
• NetWare networking is unsupported in Windows Vista.

This topic gives instructions for configuring NetWare print services. The order of this procedure may vary depending on the
environment.

Choosing the type of print services
Before completing print service settings, choose the type of print service. Refer to the following descriptions as needed.

Note
• In NetWare 5.1 or 6.0, NDPS may also be used as the print service. If you use NDPS, use the Novell printer

gateway included with NetWare. For details on configuring NDPS, refer to the NetWare documentation.

• NDS (Novell Directory Service) and bindery
NDS and bindery are both supported. Use the mode that is compatible with your network environment.

• Queue server mode and remote printer mode
Queue server mode and remote printer mode are both supported.

• Queue server mode
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When using queue server mode, all print server functions are supported, so there is no need for other print server
software or hardware. In NDS queue server mode (NDS PServer), the NDS print server is used for printing. In
bindery queue server mode (Bindery PServer), the bindery print server is used for printing. Note that if you use
queue server mode, a NetWare user license is required for each network interface.

• Remote printer mode
In remote printer mode, the printer is controlled by the NetWare print server. Thus, a NetWare print server is re-
quired. In NDS remote printer mode (NPrinter), the NDS print server is used for printing, and in bindery remote
printer mode (RPrinter), the bindery print server is used for printing.

Using NWADMIN or PCONSOLE to set up the print server
Use NWADMIN to set up the print server if NDS queue server mode or remote printer mode is used.

1. Log into NetWare as Administrator or with equivalent rights, and then start NWADMIN.

2. Run Quick Setup.

1. Choose Print Services Quick Setup in the Tools menu.

2. Enter a desired name in Print Server Name. To use an existing print server, click the button at right and
choose the name from the list.

3. Enter a desired printer name in Name.

4. To use the printer in queue server mode, choose Other/Unknown in Type. To use the printer in remote printer
mode, choose Parallel in Type, click Communications, and set Ports to LPT1 and Connection Type to
Manual Load.

5. Enter a desired queue name in Name.

6. In Volume, enter the volume object (that is, the object representing the physical volume on the network) where
the print queue will be created. Click the button at right to choose from a list.

7. Complete other settings as needed and click OK.

Note
• The print server name will be required when configuring the printer's protocol settings. Write down

the print server name for future reference.
• When running Quick Setup, the printer is assigned printer number 0. When using the printer in queue

server mode, do not change the printer number from 0.

3. Set a password.

1. Right-click the print server created in step 2 and choose Details.

2. Click Change Password to open the password input dialog box. Enter the password.

3. Click OK to close the password input dialog box.

4. Click OK or Cancel to close the details dialog box.
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4. To use the printer in remote printer mode, start the print server.
To use the NetWare file server as the print server, enter LOAD PSERVER.NLM at the file server and press the
Enter key.

Note
• This procedure is not required when using queue server mode.

Use PCONSOLE to set up the print server if bindery queue server mode or remote printer mode is used.

1. Log into NetWare as Supervisor and start PCONSOLE.

2. Switch to bindery mode.

3. If the print server has not been created, create it.

1. In Available Options, select Quick Setup and press the Enter key.

2. Enter the name of the new print server, the new printer, and the queue.

Note
• The print server name will be required when configuring the printer's protocol settings. Write down

the print server name for future reference.

4. Specify the printer type.

1. To use the printer in queue server mode, choose Other/Unknown in Type. To use remote printer mode, set
Printer Type to Parallel and Position to Manual Load.

2. Press the Esc key.

3. After the confirmation message is displayed, choose Yes and press the Enter key.

5. Set a password.

1. In Available Options, select Print Servers and press the Enter key.

2. Select the print server created in step 2 and press the Enter key.

3. Select Password, and press the Enter key to display the password input dialog box.

4. Enter the password and press the Enter key.

6. Press the Esc key several times to display the dialog box for confirming that PCONSOLE is finished.

7. Click Yes to exit PCONSOLE.

Specifying NetWare Protocols
Follow the steps below to configure NetWare protocol settings other than the frame type by using RemoteUI.

Note
• For details on RemoteUI, see "Using RemoteUI." →P.772

Network Setting > Network Setting (Windows) >

iPF825 Specifying NetWare Protocols

10

785



1. Start the web browser and enter the following URL in the Location (or Address ) box to display the RemoteUI
page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.

3. If a password has been set on the printer, enter the password.

4. Click Network in the Device Manager menu at left to display the Network page.

5. Click Edit in the upper-right corner of the NetWare group to display the Edit NetWare Protocol Settings page.

6. Make sure the Frame Type indicates the frame type used on the NetWare network.

7. To use burst mode, choose On for NCP Burst Mode.

Note
• Burst mode supports fast data transfer when printing in queue server mode. Normally, choose On.

8. In Print Application, click the print service to be used.

Note
• Only one print service selected here will be enabled. Multiple print services are not available at the

same time.

9. For packet signature, click If Requested by Server in Packet Signature.

10. Complete the following settings based on the selected service.

• If you have selected Bindery PServer: Queue Server Mode (Using a Bindery Print Server)

1. In File Server Name, enter the file server name.

2. In Print Server Name, enter the name of the print server created in "Specifying NetWare Print Serv-
ices →P.783 ."

3. In Print Server Password, enter the password of the print server created in "Specifying NetWare Print
Services →P.783 ."

4. In Polling Interval, specify the interval at which the printer checks the NetWare print queue.

• If you have selected RPrinter: Remote Printer Mode (Using a Bindery Print Server)

1. In Print Server Name, enter the advertising name of the print server created in "Specifying NetWare
Print Services →P.783 ."

2. In Printer Number, enter the same printer number specified in "Specifying NetWare Print Serv-
ices →P.783 ."

• If you have selected NDS PServer: Queue Server Mode (Using an NDS Print Server)

1. In Tree Name and Context Name, enter the tree and context name of the print server.
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2. In Print Server Name, enter the name of the print server created in "Specifying NetWare Print Serv-
ices →P.783 ."

3. In Print Server Password, enter the password of the print server created in "Specifying NetWare Print
Services →P.783 ."

4. In Polling Interval, specify the interval at which the printer checks the NetWare print queue.

• If you have selected NPrinter: Remote Printer Mode (Using a NDS Print Server)

1. In Print Server Name, enter the advertising name of the print server created in "Specifying NetWare
Print Services →P.783 ." Usually, the advertising name is the same as the name of the print server.

2. In Printer Number, enter the same printer number specified in "Specifying NetWare Print Serv-
ices →P.783 ."

11. Click OK to display the Network page.

For a list of NetWare protocol settings items, see "Configuring the Printer's NetWare Network Settings." →P.780

Configuring NetWare Network Settings
To print over a NetWare network, configure the network environment as follows.

Important
• To configure network settings, you must be logged in with administrative rights such as Administrator ac-

count. We recommend that your network administrator configure the network settings.

1. Specify the Ethernet frame type for communication between the printer and computers.
For instructions, see "Specifying the Printer's Frame Type." →P.781

2. Specify the NetWare print services, including the print server and queue.
For instructions, see "Specifying NetWare Print Services." →P.783

3. Specify NetWare protocol details besides the frame type.
For instructions, see "Specifying NetWare Protocols." →P.785
After you have completed the steps above, configure each computer for printing over the NetWare network.

4. Connect to the NetWare network.
Install NetWare client software on each computer to be used for printing over the network, and log in to the Net-
Ware server or tree. For instructions on connection, refer to the NetWare and operating system documentation.

5. Install the printer driver.
Follow the instructions of your network administrator to install the printer driver on each computer to be used for
printing. When installing the printer driver, choose Network Printer as the printer destination, and then choose the
print queue created from the NetWare print service settings.

6. Follow these steps to configure the printer port. This step is not necessary if you specified the printer destination
during installation of the printer driver.

1. Open the Printers and Faxes (or Printers ) window.

2. Right-click the printer icon and choose Properties.

3. Click the Port (or Advanced ) tab to display the Port (or Advanced ) sheet.
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4. As the destination port, specify the print queue created by configuring the NetWare print service settings.

Network Setting > Network Setting (Windows) >

Configuring NetWare Network Settings iPF825

10

788



Network Setting (Mac OS X)
Configuring the Printer Driver Destination ...................................................................................................... 789

 

Configuring the Printer's AppleTalk Network Settings ..................................................................................... 789
Configuring the Destination for AppleTalk Networks ...................................................................................... 790
Configuring the Destination for TCP/IP Network ............................................................................................ 793
Configuring the Destination for Bonjour Network ........................................................................................... 796

Configuring the Printer Driver Destination
Specify the printer driver destination as follows if the printer's IP address is changed, or if you will use the printer over a
network connection instead of via USB connection.

• If you switch to printing in an AppleTalk network, see "Configuring the Destination for AppleTalk Networks ."
→P.790

• If you switch to printing in a TCP/IP network, or if the printer's IP address is changed, see "Configuring the Destina-
tion for TCP/IP Network ." →P.793

• If you switch to printing in a Bonjour network, see "Configuring the Destination for Bonjour Network ." →P.796

Configuring the Printer's AppleTalk Network Settings
Follow the steps below to configure the AppleTalk network settings.

1. Start the web browser and enter the following URL in the Location (or Address ) box to display the RemoteUI
page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.

3. If a password has been set on the printer, enter the password.

4. Click Network in the Device Manager menu at left to display the Network page.

5. Click Edit in the upper-right corner of the AppleTalk group to display the Edit AppleTalk Protocol Settings page.

6. Refer to the AppleTalk Settings Items table to complete the settings.

AppleTalk Settings Items
Item Details Default Setting

Phase
Type

Specify whether to use AppleTalk.
If you will use AppleTalk, choose Phase 2.
If you will not use AppleTalk, choose Disabled.

Disabled

Name
(*1)

Specify the object name used by AppleTalk (in up to 31 single-byte or 15 double-byte
characters).
However, do not use the following single-byte characters: @, *, :, and =.

Canon
NB-17FB
(xxxxxx)

Zone (*2) Specify the printer zone name, up to 31 single-byte characters. *

Network Setting > Network Setting (Mac OS X) >

iPF825 Configuring the Printer Driver Destination

10

789



Item Details Default Setting
Zone (*2) However, do not use the following single-byte characters: @, :, and =. Also avoid us-

ing * (which represents the default zone) in the middle of a string.
*

*1:The object name you have specified in Name is displayed in Printer Setup Utility (or Print Center ) in Mac OS
X 10.2.8–10.4. If you use multiple printers in the same zone, assign a unique name to each printer. By default,
the network interface name is Canon NB-17FB (xxxxxx). (Here, xxxxxx is the last six digits of the printer's
MAC address.)

*2: If zones have been created on the network, enter the name of the printer's zone. If there are no zones, leave the
asterisk * entry (for the default zone) as it is. If you enter a network zone name that does not match created
zones, the printer will not be detected by Macintosh computers. Consult your network administrator for informa-
tion on zone names.

7. Click OK to display the Network page.

Configuring the Destination for AppleTalk Networks
To print over an AppleTalk network, activate the AppleTalk protocol and configure the destination as follows.

Activating AppleTalk on the printer

Important
• By factory default, the AppleTalk protocol is disabled on the printer.

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select Interface Setup, and then press the ▶ button.

3. Press ▲ or ▼ to select AppleTalk, and then press the ▶ button.

4. Press ▲ or ▼ to select On, and then press the OK button.
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5. Press the Online button to bring the printer online.
If any of the settings is changed, a confirmation message is displayed. In this case, press the OK button.

Important
• Be sure to complete step 5. This will activate the values you have entered.

Note
• By using RemoteUI, you can also specify the object name used by AppleTalk, as well as the printer zone

name.
For details on RemoteUI, see "Using RemoteUI." →P.772

Configuring the destination (Mac OS X)

Important
• AppleTalk is supported in Mac OS X 10.2.8–10.4.

Note
• The following procedures are based on Mac OS X 10.4. The method of configuring the destination varies

depending on the version of Mac OS X.

1. In System Preferences, click Network to display the Network window.
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2. In Show, choose Built-in Ethernet. Next, click AppleTalk, select Make AppleTalk Active, and click Apply now.

3. Close the Network window and save the settings.

4. Choose Utilities (or Applications ) in the Go menu of Finder.

5. Click Printer Setup Utility (or Print Center ) in the Utilities folder.

6. If the printer name is not displayed in Printer List, click Add.
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7. Select the printer from the list in the Printer Browser window and click Add.

Configuring the Destination for TCP/IP Network
Follow the steps below to configure the destination if you will use the printer in a TCP/IP network.

Important
• If you will use the printer in a TCP/IP network, make sure the printer's IP address is configured correctly.

• Configuring the IP Address Using the Printer Control Panel →P.770

Configuring the Destination (Mac OS X)

Note
• The following procedures are based on Mac OS X 10.4. The method of configuring the destination varies

depending on the version of Mac OS X. If you use other versions, refer to the help for the Printer Setup
Utility (or the Print Center ).

1. Choose Utilities (or Applications ) in the Go menu of Finder.

2. Click Printer Setup Utility (or Print Center ) in the Utilities folder.
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3. Click Add to display the Printer Browser window.

4. Click More Printers.
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5. In the list of connection methods, click Canon IP(iPF).

6. Enter the printer's IP address in Printer's Address and click Add.
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7. Make sure the printer has been added, and then close the Printer List window.

Important
• If imagePROGRAF Generic is indicated in Kind, the printer information is not properly acquired. Make

sure the printer is on and connected to the network.  (See "Cannot connect the printer to the network.")
→P.873

Configuring the Destination for Bonjour Network
In Mac OS X 10.2.8 and later, use Bonjour functions to easily connect the printer to the network. Follow the steps below to
configure the destination if you use the printer on TCP/IP network.

Important
• Bonjour and IP Print (Auto) do not support printing to a printer on other network groups that require a rout-

er for connection. Make sure the computer and printer are on the same network. For information about net-
work settings, ask your network administrator.

• By default, Bonjour is activated on the printer. The printer name as displayed in Printer Setup Utility (or
Print Center ) in Mac OS X is predefined as the Multicast DNS Service Name. You can activate or deacti-
vate the Bonjour function or change the printer name by using RemoteUI. For instructions on changing it, see
"Using RemoteUI." →P.772

1. Choose Utilities (or Applications ) in the Go menu of Finder.

2. Click Printer Setup Utility (or Print Center ) in the Utilities folder.

3. If the printer name is not displayed in Printer List, click Add.
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4. Select the printer from the list in the Printer Browser window and click Add.
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Ink Tanks
When purchasing ink tanks, make sure an A is printed on the label, along with the following Ink Tank serial numbers.

• 330 ml (11.2 fl oz)

• MBK Ink Tank PFI-303MBK
• BK Ink Tank PFI-303BK
• C Ink Tank PFI-303C
• M Ink Tank PFI-303M
• Y Ink Tank PFI-303Y

• 700 ml (23.7 fl oz)

• MBK Ink Tank PFI-703MBK
• BK Ink Tank PFI-703BK
• C Ink Tank PFI-703C
• M Ink Tank PFI-703M
• Y Ink Tank PFI-703Y

Note
• For instructions on ink tank replacement, see "Replacing Ink Tanks." →P.799

Replacing Ink Tanks

Compatible ink tanks
Replacement ink tanks in 330 ml (11.2 fl oz) and 700 ml (23.7 fl oz) capacities are supported.
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These ink tanks are labeled with a white letter A in a black circle on the side. Request ink tanks with the same label when
you purchase new ones. For details, see "Ink Tanks." →P.799

Precautions when handling ink tanks
Take the following precautions when handling ink tanks.

Caution
• For safety, keep ink tanks out of the reach of children.
• If ink is accidentally ingested, contact a physician immediately.

Important
• When it is time to install ink tanks, before opening the pouch tilt the tank to the left and right gently seven or

eight times. If you do not agitate the Ink Tank, the ink may sediment, which may affect printing quality.
• Do not remove and agitate ink tanks that have already been installed in the printer. Ink may leak out.
• Avoid dropping the Ink Tank after removing it from the pouch. Otherwise, ink may leak and cause stains.
• There may be ink around the ink supply section of ink tanks you remove. Handle ink tanks carefully during

replacement. The ink may stain clothing.
• We recommend using up an Ink Tank in the course of printing within six months after breaking the seal.

Printing quality may be affected if you use older ink tanks.
• Do not leave the printer without ink tanks installed for extended periods (a month or more). Residual ink may

become clogged inside the printer and affect printing quality.

How to replace an Ink Tank

1. Make sure the printer is ready for Ink Tank replacement. →P.800

2. Access the menu for Ink Tank replacement. →P.801  (Otherwise, open the Ink Tank Cover.)

3. Remove the Ink Tank.

• 330 ml ink tanks →P.802

• 700 ml ink tanks →P.804

4. Load the new Ink Tank.

• 330 ml ink tanks →P.806

• 700 ml ink tanks →P.808

Make sure the printer is ready for Ink Tank replacement
You can replace ink tanks if the Display Screen indicates the printer is Online or Offline, or if messages advise you to
check the amount of ink left or replace ink tanks.
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If a message requests you to replace ink tanks, press the OK button.

Do not remove an Ink Tank during initialization immediately after turning on the printer, or during printhead cleaning.

Note
• Ink Tank replacement is possible even when print jobs are being canceled or if paper is being advanced.

Access the menu for Ink Tank replacement

Note
• This step is not necessary if a message requests you to replace ink tanks. Check the message on the Display

Screen and press the OK button. Remove the Ink Tank at this point.

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select Rep. Ink Tank, and then press the ▶ button.

3. Press ▲ or ▼ to select Yes, and then press the OK button.
A message on the Display Screen requests you to open the Ink Tank Cover. Remove the Ink Tank at this point.
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Remove the Ink Tank (330 ml)

1. Open the Ink Tank Cover of the tank for replacement and check the Ink Lamp.
The Ink Lamp flashes quickly if there is no ink left.

2. Lift the stopper (a) of the Ink Tank Lock Lever for the color to replace. Lift the Ink Tank Lock Lever until it stops,
and then push it down to the front.

Note
• Push the Ink Tank Lock Lever down until it locks.
• Make sure the Ink Tank Lock Lever does not return to the original position.
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3. Hold the Ink Tank by the grips (a) and remove it. Press the OK button.

Caution
• If there is still ink in the Ink Tank you removed, store it with the ink holes (a) facing up. Otherwise,

ink may leak and cause stains. Put the Ink Tank in a plastic bag and seal it.

Note
• Dispose of used ink tanks according to local regulations.
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Remove the Ink Tank (700 ml)

1. Open the Ink Tank Cover of the tank for replacement and check the Ink Lamp.
The Ink Lamp flashes quickly if there is no ink left.

2. Lift the stopper (a) of the Ink Tank Lock Lever for the color to replace. Lift the Ink Tank Lock Lever until it stops,
and then push it down to the front.

Note
• Push the Ink Tank Lock Lever down until it locks.
• Make sure the Ink Tank Lock Lever does not return to the original position.
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3. Hold the Ink Tank by the handle (a) and remove it. Press the OK button.

Caution
• If there is still ink in the Ink Tank you removed, store it in the box with the ink holes (a) facing up.

Otherwise, ink may leak and cause stains.

Note
• Dispose of used ink tanks according to local regulations.

Maintenance > Ink Tanks >

iPF825 Replacing Ink Tanks

11

805



Load the ink tank (330 ml)

1. Before opening the pouch, tilt the Ink Tank to the left and right gently seven or eight times.

Important
• If you do not agitate the Ink Tank, the ink may sediment, which may affect printing quality.

2. Open the pouch and remove the Ink Tank.

Important
• Never touch the ink holes or electrical contacts. This may cause stains, damage the Ink Tank, and

affect printing quality.
• Do not remove and agitate ink tanks that have already been installed in the printer. Ink may leak out.
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3. Press the OK button and insert the Ink Tank into the holder with the ink holes facing down, as shown.

Note
• Ink tanks cannot be loaded in the holder if the color or orientation is incorrect.

If the Ink Tank does not fit in the holder, do not force it into the holder. Make sure the color of the
Ink Tank Lock Lever matches the color of the Ink Tank, and check the orientation of the Ink Tank
before reloading it.

4. Lift the Ink Tank Lock Lever until it stops, and then push it down until it clicks into place.

5. Make sure the Ink Lamp is lit in red.
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Note
• If the Ink Lamp is not lit in red, reload the tank.

6. Close the Ink Tank Cover.

The printer will go online or offline.

Load the ink tank (700 ml)

1. Before opening the pouch, hold the new Ink Tank with both hands and tilt it to the left and right as shown, shaking
gently it seven or eight times.

Important
• If you do not agitate the Ink Tank, the ink may sediment, which may affect printing quality.
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2. Open the pouch and remove the Ink Tank.

Important
• Never touch the ink holes or electrical contacts. This may cause stains, damage the Ink Tank, and

affect printing quality.
• Do not remove and agitate ink tanks that have already been installed in the printer. Ink may leak out.

3. Press the OK button and insert the Ink Tank into the holder with the ink holes facing down, as shown.

Note
• Ink tanks cannot be loaded in the holder if the color or orientation is incorrect.

If the Ink Tank does not fit in the holder, do not force it into the holder. Make sure the color of the
Ink Tank Lock Lever matches the color of the Ink Tank, and check the orientation of the Ink Tank
before reloading it.
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4. Lift the Ink Tank Lock Lever until it stops, and then push it down until it clicks into place.

5. Make sure the Ink Lamp is lit in red.

Note
• If the Ink Lamp is not lit in red, reload the tank.

6. Close the Ink Tank Cover.

The printer will go online or offline.
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Checking Ink Tank Levels
On the Display Screen, you can check how much ink is left in the Ink Tank.
The Display Screen indicates the remaining ink levels, unless an error message is displayed.

During error messages, press the Information button to view the ink levels on the Display Screen.

These levels shown on the Display Screen correspond to the inks identified by the Color Label on the bottom of the Display
Screen.
These symbols may be displayed above the ink level: ! if ink is low, × if no ink is left, and ? if you have deactivated ink
level detection.
The remaining ink level is indicated as shown below.

If the Display Screen indicates to replace the Ink Tank, replace the Ink Tank. If a message is displayed indicating to check
the remaining ink levels, or after tasks that consume a lot of ink such as large-format printing or head cleaning, check the
remaining levels and replace Ink Tank as needed. (See "Replacing Ink Tanks.") →P.799

When to Replace Ink Tanks
Replace or prepare to replace Ink Tank in the following situations.
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If a message for checking the ink is shown on the Display Screen
When there is little ink left, the Message lamp is lit and "Ink Level: Check" is shown on the Display Screen. You can
continue to print, but prepare to replace the Ink Tank. (See "Checking Ink Tank Levels.") →P.811

Before print jobs and maintenance that consume a lot of ink
If little ink is left, there may not be enough for large-format printing, head cleaning, and maintenance, which require a lot of
ink. In this case, replace or prepare to replace the Ink Tank before maintenance.

If a message for ink replacement is shown on the Display Screen
When ink runs out, the Message lamp flashes, a message regarding Ink Tank replacement is shown on the Display Screen,
and printing is disabled. Replace the Ink Tank at this point.
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Replacing the Printhead .................................................................................................................................. 816

Printhead
This is a replacement Printhead for the printer.

• Printhead PF-03

Note
• For instructions on replacing the Printhead, see "Replacing the Printhead." →P.816

Checking for Nozzle Clogging
If printing is faint or streaked in different colors, make sure the Printhead nozzles are clear by printing a test pattern to check
the nozzles.

Note
• You can specify a number of pages in the printer's Noz. Check Freq. menu for automatic nozzle checking

every time you finish printing that quantity.  (See "Main Menu Settings.") →P.730

1. Load unused paper.

• Attaching the Roll Holder to Rolls →P.629

• Loading Rolls in the Printer →P.634

• Loading Sheets in the Printer →P.664
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2. Press the Menu button to display MAIN MENU.

3. Press ▲ or ▼ to select Test Print, and then press the ▶ button.

4. Press ▲ or ▼ to select Nozzle Check, and then press the ▶ button.

5. Press ▲ or ▼ to select Yes, and then press the OK button.
The printer goes online and prints a test pattern.

6. Check the printing results.
The Printhead L prints the test pattern for nozzle checking on the top line in each color, and the Printhead R prints
the test pattern on the bottom line.
If the horizontal lines are not faint or incomplete, the nozzles are clear.

If some sections of the horizontal lines are faint or incomplete, the nozzles for those colors are clogged.

If horizontal lines are faint or incomplete, follow the steps below and check again for nozzle clogging.

1. Clean the Printhead.  (See "Cleaning the Printhead.") →P.815

2. Print a test pattern to check the nozzles.

Note
• If you repeat these steps several times but the horizontal lines are still faint or incomplete, contact

your Canon dealer.
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Cleaning the Printhead
Cleaning the Printhead may help clear nozzles that are clogged.
Choose one of two Printhead cleaning modes ( Head Cleaning A or Head Cleaning B ), depending on the problem to
resolve.

Note
• You can specify a number of pages in the printer's Noz. Check Freq. menu for automatic nozzle checking

and cleaning every time you finish printing that quantity.  (See "Main Menu Settings.") →P.730

• You can start Head Cleaning A by holding down the Information button for three seconds or more.

Cleaning the Printhead

Note
• If printing does not improve after Head Cleaning A, try Head Cleaning B. If this does not solve the prob-

lem, repeat Head Cleaning B one or two times. If this still does not improve printing, the Printhead may
have reached the end of its useful life. Contact your Canon dealer.

Caution
• Do not remove the Maintenance Cartridge or Ink Tank during cleaning.

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select Head Cleaning, and then press the ▶ button.

3. Press ▲ or ▼ to select the type of cleaning, and then press the OK button.

• Head Cleaning A
Use Head Cleaning A if printing is faint or contains foreign substances. This method of cleaning consumes the
least amount of ink. It takes about three minutes to complete.

• Head Cleaning B
Use Head Cleaning B if no ink comes out of the printhead, or if Head Cleaning A does not solve the problem.
It takes about four minutes to complete.

The printhead is cleaned, and the printer goes online.

4. Print a test pattern to check the nozzles, and determine whether cleaning has cleared the nozzles.  (See "Checking
for Nozzle Clogging.") →P.813
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Replacing the Printhead

When to replace the Printhead
Replace the Printhead in the following situations.

• If the printing quality does not improve even after one or two cycles of Head Cleaning B from the printer
menu

• If the Display Screen indicates "Open top cover and replace the printhead."

• If your Canon dealer has advised you to replace the Printhead

Compatible printheads
For information on compatible printheads, see "Printhead." →P.813

Precautions when handling the Printhead
Take the following precautions when handling the Printhead.

Caution
• For safety, keep the Printhead out of the reach of children.
• If ink is accidentally ingested, contact a physician immediately.
• Do not touch the Printhead immediately after printing. The Printhead becomes extremely hot, and there is a

risk of burns.

Important
• There may be ink around the nozzles of the Printhead you remove. Handle the Printhead carefully during

replacement. The ink may stain clothing.
• Do not open the Printhead pouch until immediately before installation. After removing the Printhead from

the pouch, install it right away. If the Printhead is left after the pouch is opened, the nozzles may dry out,
which may affect printing quality.

• If you need to put a Printhead somewhere temporarily before installation, do not keep the nozzles and metal
contacts →P.820  facing down. If the nozzles or metal contacts are damaged, it may affect the printing
quality.

Replacing the Printhead

Caution
• When replacing the Printhead immediately after printing, wait a few minutes before replacing it. The metal

parts of the Printhead become hot during printing, and there is a risk of burns from touching these parts.

Note
• Prepare a new Ink Tank when ink levels are low.
• Your hands may become dirty during Printhead replacement. Use the gloves provided with the new Printhead

for replacement.
• Choose On in Auto Print to have the printer automatically adjust the Printhead alignment after replacement

of the Printhead.  (See "Main Menu Settings.") →P.730

1. If the roll is not ejected because of the cutting method selected, cut it manually and remove it.  (See "Cutting Roll
Paper After Printing.") →P.198
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2. Clean inside the Top Cover.  (See "Cleaning Inside the Top Cover.") →P.833

3. Press the Menu button to display MAIN MENU.

4. Press ▲ or ▼ to select Maintenance, and then press the ▶ button.

5. Press ▲ or ▼ to select Replace P.head, and then press the ▶ button.

6. Press ▲ or ▼ to select Yes, and then press the OK button.
Ink is now filled.
After about two minutes, a message is shown on the Display Screen instructing you to open the Top Cover.

7. Open the Top Cover.

Instructions are now shown on the Display Screen regarding Printhead replacement.
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8. If the Printhead Fixer Cover or Printhead Fixer Lever is dirty, use a damp cloth that you have wrung out completely
to wipe it clean.

Important
• Do not touch the Linear Scale (a), Carriage Shaft (b), or Ink Tube Stabilizer (c). Touching these parts

may damage them.

• Never touch the metal contacts of the Carriage. This may damage the printer.
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9. If the ventilation duct (a) is dirty, use a damp cloth that you have wrung out completely to wipe it clean. Move the
Carriage out of the way manually if the Carriage is concealing the ventilation duct, and then clean the duct.

10. Pull the Printhead Fixer Lever forward all the way to open it completely.

11. Pull up the Printhead Fixer Cover to open it completely.

12. Remove the used Printhead.
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Note
• Dispose of the used Printhead in accordance with local regulations.

13. Holding the new Printhead by the grips (a), remove it from the case.

Important
• When handling the Printhead, always hold it by the grips (a). Never touch the nozzles (b) or metal

contacts (c). This may damage the Printhead and affect printing quality.

14. While firmly holding the Printhead you have removed, use your other hand to remove the orange Safety Cap 1 (a).
Squeeze the grips (c) of Safety Cap 2 (b) and pull it down to remove it.
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Important
• The inside surfaces of Safety Cap 1 (a) and Safety Cap 2 (b) are coated with ink to protect the noz-

zles. Be careful not to touch these surfaces when removing the caps.
• Never touch the ink supply section (d). This may cause printing problems.
• The Printhead contains ink to protect the nozzles. We recommend removing Safety Cap 2 (b) as you

hold it over the Printhead package or safely out of the way to avoid spilling ink and staining your
clothes or the surrounding area. If ink accidentally spills, wipe off the ink with a dry cloth.

• Do not reattach the Safety Cap or protective material. Dispose of these materials in accordance with
local regulations.

15. With the nozzles facing down and the metal contacts toward the back, insert the Printhead into the Carriage. Careful-
ly push the printhead firmly into the Carriage, ensuring that the nozzles and metal contacts do not touch the carriage.

16. Pull the Printhead Fixer Cover down toward the front to lock the Printhead in place.

17. Push the Printhead Fixer Lever toward the back of the printer until it clicks.
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18. Close the Top Cover.

Ink now fills the system.
After about six minutes, the Printhead will be automatically aligned, and the printer will go online.
If no paper has been loaded, a message is displayed requesting you to load paper.

Important
• Never remove an Ink Tank while the system is filling with ink.
• If Auto Print is Off in the printer menu, the Printhead alignment will not be adjusted. In this case,

adjust the alignment after Printhead replacement by accessing Advanced Adj. in Auto Head Adj..
 (See "Automatic Straightening of Lines and Colors (Auto Head Adj.).") →P.676
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Maintenance Cartridge
A replacement Maintenance Cartridge. The Maintenance Cartridge is provided with a Shaft Cleaner.

• Maintenance Cartridge MC-09

Note
• For instructions on replacing the Maintenance Cartridge, see "Replacing the Maintenance Cartridge."

→P.823

Replacing the Maintenance Cartridge

Compatible maintenance cartridges
For information on compatible maintenance cartridges, see "Maintenance Cartridge." →P.823

Precautions when handling the Maintenance Cartridge
Take the following precautions when handling the Maintenance Cartridge.

Caution
• For safety, keep the Maintenance Cartridge out of the reach of children.
• If ink is accidentally ingested, contact a physician immediately.

Important
• Do not remove the Maintenance Cartridge except to replace it.
• To prevent ink from leaking from a used Maintenance Cartridge, avoid dropping the cartridge or storing it at

an angle. Otherwise, ink may leak and cause stains.
• Ink adheres to the top of the Maintenance Cartridge after it has been used. Handle the Maintenance Cartridge

carefully during replacement. The ink may stain clothing.
• Do not install a used Maintenance Cartridge in another printer.
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Replacing the Maintenance Cartridge

1. Make sure no print jobs are in progress.
You can replace the Maintenance Cartridge if the Display Screen indicates the printer is Offline or if messages ad-
vise you to replace the Maintenance Cartridge.

If a message prompts you to replace the Maintenance Cartridge, press the OK button. Steps 2–5 are unnecessary in
this case. Go to step 6 and remove the Maintenance Cartridge.

Do not replace the Maintenance Cartridge during initialization immediately after turning on the printer, during Print-
head cleaning, or while ink is being drawn out.
If you pause printing to replace the Maintenance Cartridge, it may cause the printed images to be blurry.

2. Press the Menu button to display MAIN MENU.

3. Press ▲ or ▼ to select Maintenance, and then press the ▶ button.

4. Press ▲ or ▼ to select Repl. maint cart, and then press the ▶ button.

5. Press ▲ or ▼ to select Yes, and then press the OK button.
A message on the Display Screen advises you to open the Maintenance Cartridge Cover.
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6. At this point, open the Maintenance Cartridge Cover.

7. Hold the used Maintenance Cartridge by the grip (a) with one hand and put your other hand under the Maintenance
Cartridge to hold it firmly on the bottom, keeping it level as you pull it out.

Important
• Used maintenance cartridges are heavy. Always grasp the cartridge firmly and keep the cartridge lev-

el during removal and storage. If you drop a used Maintenance Cartridge or store it at an angle, ink
may leak and cause stains.

• The remaining Maintenance Cartridge capacity is recorded on each printer. Do not install a used
Maintenance Cartridge in another printer.
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8. Open the box, remove the plastic bag, packaging material, and Shaft Cleaner (a), and then take out the Maintenance
Cartridge (b).

Important
• Never touch the metal contacts (a). This may damage the Maintenance Cartridge.

9. Keep the used Maintenance Cartridge level as you put it in the plastic bag. Expel excess air from the plastic bag and
seal the zipper.
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10. Confirm the Maintenance Cartridge is right-side up, put it in the box with the packaging material attached, and store
it so that it stays level.

Important
• Always put the used Maintenance Cartridge back in the box and store the box on a flat surface. Other-

wise, ink may leak and cause stains.
• In accordance with corporate environmental protection policies, Canon collects used maintenance

cartridges. Follow the instructions provided with the new Maintenance Cartridge that describe how to
process the used Maintenance Cartridge.

11. Wipe away any soiling on the Maintenance Cartridge Cover.

Important
• Support the Maintenance Cartridge Cover from underneath as you wipe it.
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12. Keeping the new Maintenance Cartridge level, insert it all the way in.

13. Close the Maintenance Cartridge Cover.

14. Press the OK button.

The printer now initializes the Maintenance Cartridge.
Next, replace the Shaft Cleaner.

Replacing the Shaft Cleaner
Replace the Shaft Cleaner when you replace the Maintenance Cartridge. New Shaft Cleaner is included with replacement
Maintenance Cartridge.
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After you execute Repl. maint cart and replace the Maintenance Cartridge, a message will appear on the Display Screen
requesting you to replace the Shaft Cleaner. Select Yes and press the OK button. Next, go to step 4.

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select Maintenance, and then press the ▶ button.

3. Press ▲ or ▼ to select Repl. S. Cleaner, and then press the ▶ button.

4. Press ▲ or ▼ to select Yes, and then press the OK button.
After the Carriage is moved, the Display Screen indicates "Open Upper Cover".

Note
• If you do not respond within two minutes, shaft cleaner replacement is canceled and the printer goes

online automatically. In this case, repeat the procedure.

5. Open the Top Cover.

Note
• Do not open the Printhead Fixer Lever toward the front.

Accidentally opening the Printhead Fixer Lever toward the front will draw out ink, which consumes
ink.
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6. Hold the Shaft Cleaner on the right side of the Carriage by the grips (a) and pull it toward you to remove it.

Important
• Do not touch the Linear Scale (a), Carriage Shaft (b), or Ink Tube Stabilizer (c). Touching these parts

may damage them.

7. After removing the cap of the new Shaft Cleaner, hold it by the grips (a) and attach it to the Carriage.
Push the Shaft Cleaner until it clicks into place.
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Note
• Attach the cap from the new Shaft Cleaner on the used one. Be sure to put the used Shaft Cleaner in

the small box before putting it in the larger box with the used Maintenance Cartridge for disposal.

8. Close the Top Cover.

The Carriage is moved, and the printer goes online.

Checking the Remaining Maintenance Cartridge Capacity
The Maintenance Cartridge absorbs excess ink from borderless printing, printhead cleaning, and other processes. You can
confirm the remaining capacity of the Maintenance Cartridge by checking the Maintenance Cartridge capacity shown on the
Display Screen.
Press the Information button to display the remaining capacity of the Maintenance Cartridge on the Display Screen.

If the Display Screen indicates to replace the Maintenance Cartridge, replace the Maintenance Cartridge. If a message is
displayed indicating to check the remaining capacity of the Maintenance Cartridge, or before tasks that deplete much of the
capacity such as head cleaning or preparations to move the printer, check the remaining Maintenance Cartridge capacity and
replace the Maintenance Cartridge as needed. (See "Replacing the Maintenance Cartridge.") →P.823

When to Replace the Maintenance Cartridge
Replace or prepare to replace the Maintenance Cartridge in the following situations.
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If a message for checking the Maintenance Cartridge is shown on the Display Screen
When the Maintenance Cartridge capacity is low, the Message lamp is lit and "Prepare for maint cart replacement." is
displayed. You can continue to print, but check the remaining Maintenance Cartridge capacity and prepare to replace the
Maintenance Cartridge with a new one. (See "Checking the Remaining Maintenance Cartridge Capacity.") →P.831

When much of the Maintenance Cartridge capacity is depleted
Printhead cleaning, Printhead replacement, and preparations to transfer the printer deplete much of the Maintenance Car-
tridge capacity. (In particular, preparing to move the printer depletes a lot of the capacity.)
To check the remaining Maintenance Cartridge capacity, press the Information button. Replace the Maintenance Cartridge
and perform related maintenance as needed.

If a message for the Maintenance Cartridge replacement is shown on the Display Screen
When the Maintenance Cartridge is full, the Message lamp flashes and a message to replace the Maintenance Cartridge is
shown on the Display Screen. Printing is disabled, and you cannot replace the Printhead or transfer the printer. Replace the
Maintenance Cartridge with a new one.
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Cleaning the Printer Exterior
Clean the printer regularly to maintain better printing quality and help prevent problems.
About once a month, clean the printer exterior.

1. Turn the printer off.  (See "Turning the Printer On and Off.") →P.702

2. Unplug the power cord from the outlet.

Caution
• Always turn off the printer and unplug the power cord before cleaning or maintenance. Accidentally

leaving the printer on poses a risk of injury if you touch moving parts inside the printer.

3. Using a damp cloth that you have wrung out completely, wipe away any dirt or paper dust from the Paper Feed Slot
(a), power cord plug, and so on. Dry these parts with a dry cloth.

Caution
• Never use flammable solvents such as alcohol, benzene, or thinner. If these substances come into con-

tact with electrical components inside the printer, there is a risk of fire or electrical shock.

Important
• If the Ejection Guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend

cleaning the Ejection Guide even if it does not appear dirty, because it may actually be covered with
paper dust.
 (See "Cleaning Inside the Top Cover.") →P.833

4. Plug the power cord into the outlet.

Cleaning Inside the Top Cover
Clean inside the Top Cover to maintain better printing quality and help prevent problems.
Also clean inside the Top Cover in the following situations to ensure optimal operation.

• If the printed surface or the underside of paper is dirty after printing

• After you have used up a roll
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• After borderless printing

• After printing on small paper

• After printing on paper that generates a lot of cutting debris

• If you have replaced the roll

• After printing on paper that generates a lot of paper dust

• If the message "Blue platen switch is dirty." is displayed

Important
• If the Platen inside the Top Cover becomes dirty, it may soil the underside of paper. We recommend cleaning

the Platen after borderless printing or printing on small paper.
• If the Ejection Guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend clean-

ing the Ejection Guide even if it does not appear dirty, because it may actually be covered with paper dust.

1. Open the Top Cover.

2. If paper dust has accumulated in the Vacuum holes (a) on the Platen or in the Borderless Printing Ink Grooves (b),
use the Cleaning Brush (c) provided with the printer to wipe it away.
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Important
• Do not touch the Linear Scale (a), Carriage Shaft (b), or Ink Tube Stabilizer (c). Touching these parts

may damage them.
Avoid cleaning where the Carriage is retracted, in position (d) or (e).

Note
• If the Cleaning Brush is dirty, rinse it in water.
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3. Using a damp cloth that you have wrung out completely, wipe away dirt or paper dust (debris from cutting) inside
the Top Cover.
Wipe away any ink residue and paper dust (debris from cutting) on the Top Cover Roller (a), all over the Platen (b),
the Paper Retainer (c), the Borderless Printing Ink Grooves (d), the Ejection Guide (e), the blue Switch (f), the sec-
tion around the right-side Borderless Printing Ink Grooves (g), and so on.

Important
• Do not use a dry cloth to wipe inside the Top Cover. This may create a static charge, which may at-

tract dust and affect the printing quality.
• Never use flammable solvents such as alcohol, benzene, or thinner. If these substances come into con-

tact with electrical components inside the printer, there is a risk of fire or electrical shock.
• Do not touch the clear sheet on the side of the Top Cover Roller. This may damage the roller.

4. Close the Top Cover.
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Other Maintenance
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Updating the Firmware .................................................................................................................................... 843

Preparing to Transfer the Printer
To protect the internal parts in transit, always follow the steps below before transferring the printer to a new location. Refer
to the Setup Guide for details on packing the printer and installing it after transfer.

Important
• Be sure to contact your Canon dealer before transferring the printer to a new location. Ink may leak and dam-

age the printer if you do not prepare the printer correctly and it is tipped or stood on end in transit.

Note
• It is not possible to prepare the printer for transfer if the Display Screen requests Maintenance Cartridge re-

placement or checking of the remaining capacity. Replace the Maintenance Cartridge before transfer prepara-
tions.  (See "Replacing the Maintenance Cartridge.") →P.823

• Depending on the state of the printer, part replacement may be necessary when preparing to transfer the
printer (that is, when you execute the printer menu item to prepare for transfer).

• Ink must be drained before Level 2 or Level 3 printer transfer, as described in the following table. Prepare a
Maintenance Cartridge in advance.

• Always follow the instructions of the service representative when transferring the printer under Level 3 con-
ditions.

Level Shipping Meth-
od (Example) Permitted Angle of Inclination

Amount of
Ink to Dis-

pose of

Required
Mainte-

nance Car-
tridges(*1)

1 By truck Lengthwise: 0°–30°

Rotation: 0°–10°

0 0 or 1

2 By plane All directions: 0°–30° Approx. 200
ml

1 or 2
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Level Shipping Meth-
od (Example) Permitted Angle of Inclination

Amount of
Ink to Dis-

pose of

Required
Mainte-

nance Car-
tridges(*1)

3 Tipping the
printer or hold-
ing it upright for
elevators or
stairs

Lengthwise: 0°–90°
Rotation: 0°–30°

Approx. 700
ml

2 or 3

*1: The quantity of cartridges required depends on the capacity of the Maintenance Cartridge in use.

1. Remove the Wheeled Output Stacker from the printer.
 (See "Using the Wheeled Output Stacker.") →P.671

2. Remove the paper.

• Rolls  (See "Removing the Roll from the Printer.") →P.644

• Sheets  (See "Removing Sheets.") →P.669

3. Press the Menu button to display MAIN MENU.

4. Press ▲ or ▼ to select Maintenance, and then press the ▶ button.

5. Press ▲ or ▼ to select Move Printer, and then press the ▶ button.

6. Press ▲ or ▼ to select the level of transfer, and then press the OK button.

7. After the message "Always contact service before preparing to move the printer." is shown on the Display
Screen, press the OK button.
The Display Screen indicates "Please Wait..".

• If you have selected Level 1 in step 6, after processing in preparation to move the printer is finished, the mes-
sage "Finished preparing to move printer. Turn off printer." is shown on the Display Screen. Go to step 15.

• When you are finished preparing to transfer the printer after selecting Level 2 or Level 3 conditions, the Dis-
play Screen requests you to open the Ink Tank Cover. Follow the procedure starting with step 8.

Important
• If consumables must be replaced, the message "Consumables must be replaced. Call for service."

is shown on the Display Screen and preparation is not possible. If this message is displayed, press the
OK button and contact your Canon dealer for assistance.
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8. Open the Ink Tank Cover.

9. Lift the stopper (a) of the Ink Tank Lock Lever (a). Lift the Ink Tank Lock Lever until it stops, and then push it
down to the front.

10. Remove the Ink Tank.
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Note
• Store the Ink Tank you removed in the box with the ink holes (a) facing up. Otherwise, ink may leak

and cause stains.

11. Repeat steps 9 and 10 to remove all ink tanks.

12. Push down the release lever (a) as shown as you gently return all ink tank lock levers to the original position.

13. Close the Ink Tank Cover.
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At this point, ink is drawn out from inside the tubes.

Important
• Do not remove the Maintenance Cartridge during this process.

When the process is finished, "Finished preparing to move printer. Turn off printer." is displayed.

14. Press the Power button and turn off the printer.

Important
• Turn off the printer before you unplug it. It may damage the printer if you unplug it before it is off

and transfer it in that state. If you accidentally unplug the printer, plug it in again, reinstall the Ink
Tank, wait until the printer comes online, and follow this procedure again.

15. Disconnect the printer power cord and interface cable, as well as the Roll Unit power cord.

16. Open the Top Cover, grasp the Belt, insert it between the Belt Stopper, and affix the Belt Stopper with a hex screw
at the position indicated.
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Important
• Here, the Belt Stopper is the one that was removed and stored after initial installation. Neglecting to

attach the Belt Stopper may damage the printer.
• Do not touch the Linear Scale (a), Carriage Shaft (b), or Ink Tube Stabilizer (c). Touching these parts

may damage them.

17. Close the Top Cover.

18. Tape down printer covers to secure them, in the reverse order of tape removal during installation.

19. Remove the Stand by reversing the installation procedure, when it was attached to the printer.

20. Disassemble and repackage the Stand by following the installation procedure in reverse.

21. Repack the Roll Holder, Holder Stopper, and printer in shipping materials, and then package them in a shipping box.
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Updating the Firmware
Update the printer firmware to take advantage of new and improved printer functions.

Confirming the firmware version

1. Press the Menu button to display MAIN MENU.

2. Press ▲ or ▼ to select Information, and then press ▶.

3. Press ▲ or ▼ to select System Info, and then press the OK button.
The firmware version is displayed.

Updating the Firmware
To obtain the latest firmware, visit the Canon website. If the firmware available online is newer than the installed firmware,
update the printer firmware. For details on downloading and updating the firmware, visit the Canon website.
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Frequently Asked Questions
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Frequently Asked Questions
This section presents frequently asked questions and answers. To view more detailed explanations, click the hyperlinks in
the answer column.

Question Answer

How do I print on a
roll?

When printing on rolls, after loading the roll, specify the paper type and length, both on the
Control Panel and in the printer driver.
⇒"Loading and Printing on Rolls →P.3 "

How do I print on a
sheet?

When printing on sheets, specify the paper type and size in the printer driver before loading
the paper.
⇒"Loading and Printing on Sheets →P.8 "

How do I switch be-
tween printing on rolls
and sheets?

Press the Feeder Selection button to switch the paper source between the roll and a sheet.
⇒"Selecting the Paper Source →P.641 "

How do I change the
paper type or size?

Specify the type and size of paper, both on the Control Panel and in the printer driver.

• Specifying it in the printer driver
⇒"Specifying Paper in the Printer Driver →P.65 "

• Specifying it on the Control Panel
Selecting the paper type
⇒"Selecting the Paper Type (Roll) →P.642 "
⇒"Selecting the Paper Type (Sheet) →P.663 "
Selecting the paper size
⇒"Specifying the Paper Length (Roll) →P.643 "

How do I cut the roll
paper after printing?

You can wait until ink dries before cutting the roll, and you can cut rolls at a desired posi-
tion.
⇒"Specifying the Cutting Method for Rolls →P.654 "

How do I print without
borders?

Borderless printing is possible on rolls. You can also specify borderless printing in the print-
er driver by adjusting the original size to match the paper size.
Before borderless printing, set the blue Switch on the platen to the ● side.
Borderless printing is not supported on sheets.
⇒"Borderless Printing on Paper of Equivalent Size →P.101 "
⇒"Borderless Printing by Resizing Originals to Fit the Roll Width →P.108 "
⇒"Borderless Printing at Actual Size →P.92 "
⇒"Setting the Blue Switch on the Platen →P.867 "

How do I print an A4
original enlarged on A2
paper?

In the printer driver, you can adjust the original image to match the paper size or width, or
you can specify enlargement or reduction before printing as desired.
⇒"Resizing Originals to Match the Paper Size →P.66 "
⇒"Resizing Originals to Fit the Roll Width →P.72 "
⇒"Resizing Originals by Entering a Scaling Value →P.78 "

How do I print without
wasting paper?

To conserve paper, you can specify in the printer driver to rotate originals 90 degrees or to
print without top and bottom margins.
⇒"Conserving Roll Paper by Rotating Originals 90 Degrees →P.169 "
⇒"Conserving Roll Paper by Printing Originals Without Top and Bottom Mar-
gins →P.175 "
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Question Answer

How do I print without
wasting all the blank
space on the right side
when printing an A4-
sized original at A3
size?

By specifying to rotate originals 90 degrees in the printer driver, you can print at A4 size to
fill the width of A3 paper.
⇒"Conserving Roll Paper by Rotating Originals 90 Degrees →P.169 "

How do I print in land-
scape (or portrait) ori-
entation?

You can print originals that are in landscape (or portrait) orientation automatically enlarged
to fit the roll width. This is an easy way to create vertical or horizontal banners.
⇒"Printing Vertical or Horizontal Banners (Large-Format Printing) →P.117 "

How do I print on a
custom paper size?

You can specify custom sizes temporarily in the printer driver.
⇒"Printing on Non-Standard Paper Sizes →P.126 "

How do I register cus-
tom paper sizes?

You can add desired sizes (Custom Paper Sizes) in the Size Options dialog box of the print-
er driver.
⇒"Printing on Non-Standard Paper Sizes →P.126 "

How do I print lines
thicker?

By specifying Thicken Fine Lines in the printer driver, you can print fine lines thicker to
make them easier to see.
⇒"Giving Priority to Particular Graphic Elements and Colors for Printing →P.56 "

How do I modify how
colors are printed?

You can adjust colors as desired in the printer driver before printing.
⇒"Adjusting the Color in the Printer Driver →P.47 "

How do I use printer
driver settings again in
subsequent jobs?

By saving settings information in a favorite, you can apply the settings again before printing
anytime as needed.
⇒"Using Favorites →P.198 "

Can I use the printer in
combination with a
Color imageRUNNER
?

The printer can be used for automatic enlargement and printing of scanned originals from a
Color imageRUNNER.
⇒"Printing Enlargements of Scanned Originals from a Color imageRUN-
NER →P.304 "
⇒"Printing Enlargements of Scanned Originals from a Color imageRUN-
NER →P.541 "

How do I print enlarge-
ments of scanned origi-
nals from a Color im-
ageRUNNER ?

By using Color imageRUNNER Enlargement Copy (iR enlargement copy), you can auto-
matically print enlargements of scanned originals from a Color imageRUNNER.
⇒"Printing Enlargements of Scanned Originals from a Color imageRUN-
NER →P.304 "
⇒"Printing Enlargements of Scanned Originals from a Color imageRUN-
NER →P.541 "
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Problems Regarding Paper
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Troubleshooting When Paper Jams are not Found ......................................................................................... 853
 

Roll Paper Cannot be Inserted into the Paper Feed Slot ................................................................................ 856
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Paper is not cut straight ................................................................................................................................... 857
Paper is not cut ............................................................................................................................................... 857

 

The size of clear film cannot be detected ........................................................................................................ 857

Clearing Jammed Roll Paper
If roll paper jams, follow the steps below to remove jams.

Note
• If you do not find any scraps or jams, see "Troubleshooting When Paper Jams are not Found." →P.853

1. Turn the printer off.  (See "Turning the Printer On and Off.") →P.702

2. Open the Top Cover.

3. If the Carriage is out, move the Carriage out of the way, away from the paper.
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Important
• Do not touch the Linear Scale (a), Carriage Shaft (b), or Ink Tube Stabilizer (c). Touching these parts

may damage them.

4. If the Cutter is out, move the Cutter to the right side, away from the paper.

Important
• If the Cutter is on the left side, be sure to move it to the right. If the Cutter is on the left side when

you turn the printer on, the printer may rip the paper.
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5. Lift the Release Lever.

6. Holding the paper on both sides, pull the jammed portion out toward the front. Use a scissors or cutting tool to cut
away the printed or wrinkled portion.

Caution
• When cutting paper, be careful to avoid injury and damaging the printer.
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7. If the Carriage is on the left, move the Carriage to the right until it stops.

Important
• Always move the Carriage to the right side. If the Carriage is on the left, a Carriage error may occur

when you turn on the printer.

8. Hold the edge of the roll paper in the middle as you gently pull it evenly to the position of the Ejection Guide (a).
Align the right side of the roll paper with the Paper Alignment Line (b), keeping this side parallel to the line, and
then lower the Release Lever.

Important
• Do not force the roll paper into alignment with the Paper Alignment Line (b). This may prevent the

paper from being advanced straight.
• If you pull out too much of the roll, an excessive amount will be cut away.
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9. Close the Top Cover.

10. Turn the printer on.  (See "Turning the Printer On and Off.") →P.702
The roll is now advanced. After it is finished being advanced, you can resume printing.

Note
• You can ensure that the edge is cut neatly by selecting Paper Cutting in the printer menu.

 (See "Specifying the Cutting Method for Rolls.") →P.654

Clearing a Jammed Sheet
If a sheet jams, follow the steps below to remove it.

1. Turn the printer off.  (See "Turning the Printer On and Off.") →P.702

2. Open the Top Cover.

3. If the Carriage is out, move the Carriage out of the way, away from the paper.
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Important
• Do not touch the Linear Scale (a), Carriage Shaft (b), or Ink Tube Stabilizer (c). Touching these parts

may damage them.

4. Lift the Release Lever.

5. Hold the paper and pull it out, toward the front.
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Note
• If you do not find any scraps or jams, see "Troubleshooting When Paper Jams are not Found."

→P.853

6. If the Carriage is on the left, move the Carriage to the right until it stops.

Important
• Always move the Carriage to the right side. If the Carriage is on the left, a Carriage error may occur

when you turn on the printer.

7. Lower the Release Lever and close the Top Cover.

8. Turn the printer on.  (See "Turning the Printer On and Off.") →P.702

Troubleshooting When Paper Jams are not Found
If you cannot find a paper jam, search for the paper as follows.

1. Turn the printer off.  (See "Turning the Printer On and Off.") →P.702

2. Remove the Wheeled Output Stacker from the printer.  (See "Using the Wheeled Output Stacker.") →P.671
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3. Holding the Roll Unit Lever (a), pull out the Roll Unit.

4. Check for paper in the lower part of the printer. Remove any jammed paper here by pushing it to the floor with your
fingers.

5. Lift the Release Lever.

Troubleshooting > Problems Regarding Paper >

Troubleshooting When Paper Jams are not Found iPF825

12

854



6. Open the Top Cover, and if there is a paper jam at the position shown, push it inside with your fingers.

The paper will drop to the floor or to the lower part of the printer.

Note
• If paper remains in the lower part of the printer, push it to the floor with your fingers.
• If the paper does not drop to the floor or to the lower part of the printer, fold an A4 sheet three times,

insert it through the gap of the Platen (a) and the Paper Retainer (b), and push the jammed paper out.
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7. Lower the Release Lever and close the Top Cover.

8. In a crouching position, push the Roll Unit in.

9. Position the Wheeled Output Stacker by the printer.  (See "Using the Wheeled Output Stacker.") →P.671

10. Turn the printer on.  (See "Turning the Printer On and Off.") →P.702

Roll Paper Cannot be Inserted into the Paper Feed Slot

Cause Corrective Action

The roll paper is warped. Straighten out curls and reload the roll.

If paper cannot be advanced from Roll 2 (Lower),
the Roll Unit Cable is disconnected.

Connect the Roll Unit Cable firmly to the Roll Unit Power Sup-
ply Inlet and the inlet on the roll unit.
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Cannot Load Sheets

Cause Corrective Action

The paper source selection is incorrect. Press the Feeder Selection button to activate the Cut Sheet lamp.

Paper is not cut straight

Cause Corrective Action

The paper is bent or curled at the cut position. Straighten out any curling by the edges of the paper.

Paper rises by the ends of the cut position before it is cut. Reload the paper correctly.

Paper is not cut

Cause Corrective Action

In the printer driver, No or Print Cut Guideline is specified
in Auto Cut.

Specify Yes in Auto Cut in the printer driver.

In MAIN MENU, Eject or Manual is specified in Cutting
Mode.

Specify Automatic in Cutting Mode in MAIN
MENU.

The size of clear film cannot be detected

Cause Corrective Action

The Platen is soiled with ink or other substances. Open the Top Cover and clean the entire Platen.
 (See "Cleaning Inside the Top Cover.") →P.833
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Printing does not start
The Data lamp on the Control Panel does not light up .................................................................................... 858
The printer does not respond even if print jobs are sent ................................................................................. 858

 

Ink Filling.. is displayed ................................................................................................................................... 858
The display screen indicates Agitating ............................................................................................................ 859

The Data lamp on the Control Panel does not light up

Cause Corrective Action

The printer is not on. Make sure the power cord is securely plugged in, all the way. Press the Power but-
ton to turn on the printer.

The target printer was not selec-
ted when printing. (The printer is
in Sleep mode.)

In Windows, select the printer by clicking Select Printer or Printer in the printing
dialog box and try printing again.

In Mac OS X, open the dialog box of the printer driver, select the printer from the
list of Printer, and try printing again.

The print job is paused. (The
printer is in Sleep mode.)

In Windows, restart the print job as follows.

1. Select the printer icon in the Printers and Faxes (or Printers ) window.

2. Clear Pause Printing in the File menu to restart the print job.

In Mac OS X, restart the print job as follows.

1. Click Print & Fax. (This is identified as Printer Setup Utility or Print Center
in other versions of Mac OS X.)

2. Select the printer, and then Resume Printer (or Start Jobs ) in the Printers
menu to restart the print job.

The printer does not respond even if print jobs are sent

Cause Corrective Action

The printer is offline. Press the Online button on the Control Panel to bring the printer on-
line.

You have printed when select Save in mail
box is selected in Output Method.

Print the job saved on the printer's hard disk.
 (See "Printing Saved Jobs.") →P.578

Ink Filling.. is displayed

Cause Corrective Action

The printer was forced off during oper-
ation.

Wait until the system has been filled with ink. This process may take about
ten minutes.
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The display screen indicates Agitating

Cause Corrective Action

Ink agitation is in
progress.

The time for agitation varies depending on how long the printer has been turned off. (Between
about a minute and a half to twenty minutes.) During agitation, you can print or do other opera-
tions after the printer goes Online.
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The printer stops during a print job
An error message is shown on the Display Screen ......................................................................................... 860
The printer ejects blank, unprinted paper ........................................................................................................ 860

 

An error message is shown on the Display Screen

Status Corrective Action

An error message is displayed during printing. Check the error message and take action as necessary.
(See "Error Messages →P.886 .")

The last portion of roll paper was used during a print job,
and paper could not be advanced because the trailing edge
is taped to the roll.

Remove the used roll and insert a new roll.
 (See "Removing the Roll from the Printer.") →P.644
 (See "Removing the Roll Holder from Rolls.") →P.649
 (See "Loading and Printing on Rolls.") →P.3

The printer ejects blank, unprinted paper

Status Corrective Action

The leading edge of the roll paper
was cut to straighten it.

This operation is normal.
The printer cuts the leading edge of the roll to straighten it and ejects the scraps
when Trim Edge First in the printer menu is On or when Trim Edge First is
Automatic and the leading edge is slanted. The printer is ready to print after this
initial preparation.
When Off is selected under Trim Edge First, the edge is not cut and scraps are
not removed.

The Printhead nozzles are clog-
ged.

Print a test pattern to check the nozzles and make sure the Printhead is in good
condition for printing.
 (See "Checking for Nozzle Clogging.") →P.813
Clean the Printhead if the nozzles are clogged.
 (See "Cleaning the Printhead.") →P.815

A print job was received from an
incompatible printer driver.

Use the correct imagePROGRAF printer driver for the printer and try printing
again.

The printer has received print data
that includes HP RTL commands
when Auto Rotate is On.

Set Auto Rotate to Off before attempting to print again.
 (See "Main Menu Settings.") →P.730

The printer is damaged. Contact your Canon dealer for assistance.
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Problems with the printing quality
Printing is faint ................................................................................................................................................. 861
Paper rubs against the printhead .................................................................................................................... 862
The edges of the paper are dirty ..................................................................................................................... 863
The surface of the paper is dirty ...................................................................................................................... 863
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Printed colors are inaccurate ........................................................................................................................... 864
Banding in different colors occurs ................................................................................................................... 865
Colors in printed images are uneven ............................................................................................................... 865
Image Edges are Blurred or White Banding Occurs ....................................................................................... 866

Setting the Blue Switch on the Platen ......................................................................................................... 867
The contrast becomes uneven during printing ................................................................................................ 870

 

The length of printed images is inaccurate ...................................................................................................... 870
Documents are printed crooked ...................................................................................................................... 870
Documents are printed in monochrome .......................................................................................................... 870
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Problems with the printing quality caused by the type of paper ...................................................................... 872

Printing is faint

Cause Corrective Action

You may be printing on the wrong
side of the paper.

Print on the printing surface.

The Printhead nozzles are clogged. Print a test pattern to check the nozzles and see if they are clogged.
 (See "Checking for Nozzle Clogging.") →P.813

Because the printer was left without
ink tanks installed for some time,
ink has become clogged in the ink
supply system.

After the ink tanks have been installed for 24 hours, run Head Cleaning B.
 (See "Cleaning the Printhead.") →P.815

Paper is jammed inside the Top
Cover.

Follow the steps below to remove the jammed piece of paper inside the Top
Cover.

1. Press the Online button to bring the printer offline.

2. Open the Top Cover and make sure the Carriage is not over the Platen.

3. Remove any scraps of paper inside the Top Cover.
 (See "Clearing Jammed Roll Paper.") →P.847
 (See "Clearing a Jammed Sheet.") →P.851

4. Close the Top Cover.

During borderless printing, the ink
was not dry enough before cutting.

Specify a longer drying period in the printer menu, in Roll DryingTime in Pa-
per Details.
 (See "Main Menu Settings.") →P.730

Printing may be faint if Print Qual-
ity in Advanced Settings in the
printer driver is set to Standard or
Draft.

In Advanced Settings of the printer driver, choose Highest or High in Print
Quality.
Printing in Draft or Standard mode is faster and consumes less ink than in
Highest or High modes, but the printing quality is lower.
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Cause Corrective Action
Printing may be faint if Print Qual-
ity in Advanced Settings in the
printer driver is set to Standard or
Draft.

 (See "Giving Priority to Particular Graphic Elements and Colors for Print-
ing.") →P.56

Paper rubs against the printhead

Cause Corrective Action

The type of paper specified in the
printer driver does not match the
type loaded in the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.634
 (See "Loading Sheets in the Printer.") →P.664

Make sure the same type of paper is specified in the printer driver as you have
loaded in the printer.

1. Hold down the Stop button for a second or more to cancel printing.

2. Change the type of paper in the printer driver and try printing again.

Paper has been loaded incorrectly,
causing it to wrinkle.

Reload the paper.
 (See "Loading Rolls in the Printer.") →P.634
 (See "Loading Sheets in the Printer.") →P.664

The Printhead is set too low. In Head Height, choose Automatic.
 (See "Troubleshooting Paper Abrasion and Blurry Images (Head Height).")
→P.683

You are printing on heavyweight
paper or paper that curls or wrin-
kles easily after absorbing ink.

When printing on Heavyweight Coated Paper or other paper-based media, choose
a VacuumStrngth setting of Strong or Strongest. If paper still rubs against the
printhead, try raising the Printhead by setting Head Height to Highest.
 (See "Adjusting the Vacuum Strength (VacuumStrngth).") →P.691
 (See "Troubleshooting Paper Abrasion and Blurry Images (Head Height).")
→P.683

When printing on CAD Tracing Paper or other film-based media, choose a Vac-
uumStrngth setting of Standard, Strong, or Strongest. If paper still rubs
against the printhead, try raising the Printhead by setting Head Height to High-
est.
 (See "Adjusting the Vacuum Strength (VacuumStrngth).") →P.691
 (See "Troubleshooting Paper Abrasion and Blurry Images (Head Height).")
→P.683

When printing on paper 0.1 mm (0.004 in) thin or thinner, choose a Vac-
uumStrngth setting of Weakest. If paper still rubs against the printhead, try rais-
ing the Printhead by setting Head Height to Highest.
 (See "Adjusting the Vacuum Strength (VacuumStrngth).") →P.691
 (See "Troubleshooting Paper Abrasion and Blurry Images (Head Height).")
→P.683

When you have loaded paper, the
paper you have loaded does not
match the type selected on the
Display Screen.

Be sure to select the correct type of paper in the printer menu when loading paper.
 (See "Loading Rolls in the Printer.") →P.634
 (See "Loading Sheets in the Printer.") →P.664
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The edges of the paper are dirty

Cause Corrective Action

The Platen has become dirty after
borderless printing or printing on
small paper.

Open the Top Cover and clean the Platen.
 (See "Cleaning Inside the Top Cover.") →P.833

The paper type as specified on the
printer does not match the type
specified in the printer driver.

Make sure the same paper type is specified on the printer as in the printer driver.
 (See "Selecting the Paper Type (Roll).") →P.642
 (See "Selecting the Paper Type (Sheet).") →P.663

Make sure the same paper type is specified in the printer driver as on the printer.

1. Hold down the Stop button for a second or more to cancel printing.

2. Change the paper type in the printer driver and try printing again.

The paper is wrinkled or warped. Straighten out the wrinkles or curls and reload the paper. Do not use paper that
has been printed on previously.
 (See "Loading Rolls in the Printer.") →P.634
 (See "Loading Sheets in the Printer.") →P.664

A cut line is printed because the
function to reduce cutting dust has
been activated.

If this function is not needed, deactivate CutDustReduct. through the printer
menu.
 (See "Main Menu Settings.") →P.730

The Printhead is set too low. In Head Height, choose Automatic.
 (See "Troubleshooting Paper Abrasion and Blurry Images (Head Height).")
→P.683

You are printing on heavyweight
paper or paper that curls or wrin-
kles easily after absorbing ink.

When printing on Heavyweight Coated Paper or other paper-based media, choose
a VacuumStrngth setting of Strong or Strongest. If paper still rubs against the
printhead, try raising the Printhead by setting Head Height to Highest.
 (See "Adjusting the Vacuum Strength (VacuumStrngth).") →P.691
 (See "Troubleshooting Paper Abrasion and Blurry Images (Head Height).")
→P.683

When printing on CAD Tracing Paper or film-based media, choose a Vac-
uumStrngth setting of Standard, Strong, or Strongest. If paper still rubs
against the printhead, try raising the Printhead by setting Head Height to High-
est.
 (See "Adjusting the Vacuum Strength (VacuumStrngth).") →P.691
 (See "Troubleshooting Paper Abrasion and Blurry Images (Head Height).")
→P.683

The Ejection Guide is soiled. Clean the Ejection Guide.
 (See "Cleaning the Printer Exterior.") →P.833

The surface of the paper is dirty

Cause Corrective Action

The Paper Retainer is soiled. Clean the Paper Retainer.
 (See "Cleaning Inside the Top Cover.") →P.833

You are using a paper that
does not dry easily.

In the Control Panel menu, set Roll DryingTime to at least 1 min.
 (See "Main Menu Settings.") →P.730

When paper that does not dry easily is used for printing, it may curl during printing
and touch the Output Tray.
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Cause Corrective Action
You are using a paper that
does not dry easily.

In this case, in the Control Panel menu, complete the settings for Dry time and Area
in Scan Wait Time.
However, note that printing will now take longer.
 (See "Main Menu Settings.") →P.730

The back side of the paper is dirty

Cause Corrective Action

The Platen has become dirty after borderless print-
ing or printing on small paper.

Open the Top Cover and clean the Platen.
 (See "Cleaning Inside the Top Cover.") →P.833

Set CarriageScanWdth to Fixed.

The Platen has become soiled due to printing on the
Platen because width detection is deactivated.

Activate width detection, and open the Top Cover and clean the
Platen.
 (See "Cleaning Inside the Top Cover.") →P.833

Open the Top Cover and clean the Platen. After this, manually
advance the roll onto the Platen before printing.
 (See "Cleaning Inside the Top Cover.") →P.833
 (See "Feeding Roll Paper Manually.") →P.650

The Paper Retainer is soiled. Clean the Paper Retainer.
 (See "Cleaning Inside the Top Cover.") →P.833

Printed colors are inaccurate

Cause Corrective Action

Color adjustment has not been activated in the Ad-
vanced Settings of the printer driver.

In the Advanced Settings of the printer driver, access Color Set-
tings in Color Mode to adjust colors.

Colors have not been adjusted on the computer or
monitor.

Refer to the computer and monitor documentation to adjust the
colors.

Adjust the settings of the color management software, referring to
the software documentation as needed.

The Printhead nozzles are clogged. Print a test pattern to check the nozzles and see if they are clog-
ged.
 (See "Checking for Nozzle Clogging.") →P.813

In the Windows printer driver, Application Color
Matching Priority is not selected.

Click Special Settings on the Layout sheet of the printer driver
and select Application Color Matching Priority in the dialog
box.

Printhead characteristics gradually change through
repeated use, and colors may change.

Adjust the Printhead alignment.
 (See "Automatic Straightening of Lines and Colors (Auto
Head Adj.).") →P.676
 (See "Manual Straightening of Lines and Colors (Manual
Head Adj).") →P.678
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Cause Corrective Action

Color may change slightly even on the same mod-
el of printer if you use a different version of the
firmware or printer driver, or when you print un-
der different settings or in a different printing en-
vironment.

Follow these steps to prepare the printing environment.

1. Use the same version of firmware or printer driver.

2. Specify the same value for all settings items.

Banding in different colors occurs

Cause Corrective Action

The paper feed amount is out of ad-
justment.

Adjust the feed amount.
 (See "Adjusting the Feed Amount.") →P.684

Printing does not proceed smoothly
because print jobs are interrupted
during transmission.

Exit other applications and cancel other print jobs.

In the printer menu, Print Length is
specified in Feed Priority.

Selecting Band Joint may improve printing results.
Adjust the feed amount in the printer menu by specifying Band Joint in Feed
Priority and try printing again.
 (See "Adjusting the Feed Amount.") →P.684

The Printhead is out of alignment. Adjust the Printhead alignment.
 (See "Automatic Straightening of Lines and Colors (Auto Head Adj.).")
→P.676

The Printhead nozzles are clogged. Print a test pattern to check the nozzles and see if they are clogged.
 (See "Checking for Nozzle Clogging.") →P.813

Streaks may occur if you set the
Print Quality too low.

Choose a higher level of Print Quality in the Advanced Settings of the printer
driver and try printing again.
Printing in Draft or Standard mode is faster and consumes less ink than in
Highest or High modes, but the printing quality is lower.
 (See "Giving Priority to Particular Graphic Elements and Colors for Print-
ing.") →P.56

The type of paper specified in the
printer driver does not match the
type loaded in the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.634
 (See "Loading Sheets in the Printer.") →P.664

Make sure the same type of paper is specified in the printer driver as you have
loaded in the printer.

1. Hold down the Stop button for a second or more to cancel printing.

2. Change the type of paper in the printer driver and try printing again.

Colors in printed images are uneven

Cause Corrective Action

Line Drawing/Text is selected
when printing images in many solid
colors.

Specify Image in the printer driver.
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Cause Corrective Action

You are printing on paper that curls
easily.

Printed colors may appear uneven on the leading edge of paper that is suscepti-
ble to curling. Increase the level of vacuum holding the paper against the Platen
or specify a margin of 20 mm (0.79 in.) or more for the leading edge.
 (See "Adjusting the Vacuum Strength (VacuumStrngth).") →P.691

Printed colors may be uneven if you
set the Print Quality too low.

Choose a higher level of Print Quality in the Advanced Settings of the printer
driver.
Printing in Draft or Standard mode is faster and consumes less ink than in
Highest or High modes, but the printing quality is lower.
 (See "Giving Priority to Particular Graphic Elements and Colors for Print-
ing.") →P.56

Color may be uneven between dark
and light image areas.

Select Unidirectional Printing in the Advanced Settings of the printer driver.

When borderless printing is used,
the edge of the paper is cut during
printing. Thus, ink density may be
uneven at the edges.

Specify No in Auto Cut in the printer driver before printing. In this case, the
paper can be printed without borders on the left and right sides only. Cut the
printed document ejected from the printer, then use scissors to cut away the
edges on the top and bottom.

Choose a higher level of Print Quality in the Advanced Settings of the printer
driver.
 (See "Giving Priority to Particular Graphic Elements and Colors for Print-
ing.") →P.56

The Printhead is out of alignment. Adjust the Printhead alignment.
 (See "Automatic Straightening of Lines and Colors (Auto Head Adj.).")
→P.676

Drying documents stacked on each
other may cause uneven colors.

To avoid uneven colors, we recommend drying each sheet separately.

Color density may be uneven if you
use Glossy Paper, art paper, or Coat-
ed Paper.

In Advanced Settings of the printer driver, choose Highest or High in Print
Quality.

The type of paper specified in the
printer driver does not match the
type loaded in the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.634
 (See "Loading Sheets in the Printer.") →P.664

Make sure the same type of paper is specified in the printer driver as you have
loaded in the printer.

1. Hold down the Stop button for a second or more to cancel printing.

2. Change the type of paper in the printer driver and try printing again.

Scan Wait Time > Area in the
Control Panel menu is set to Lead-
ing edge.

When Scan Wait Time > Area is set to Leading edge, colors may be uneven
110–160 mm from the leading edge. (The position varies depending on the
Print Quality setting.)
In this case, select Scan Wait Time > Area > Entire area.
However, note that printing will now take longer.
 (See "Main Menu Settings.") →P.730

Image Edges are Blurred or White Banding Occurs

Cause Corrective Action

The Platen suction is too strong. Set VacuumStrngth to Weakest.
 (See "Adjusting the Vacuum Strength (VacuumStrngth).") →P.691
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Cause Corrective Action
The Platen suction is too strong. Close the blue Switch on the platen so that it matches the paper size.

 (See "Setting the Blue Switch on the Platen.") →P.867

The Printhead is set too high. Lower the Printhead.
 (See "Troubleshooting Paper Abrasion and Blurry Images (Head Height).")
→P.683

The type of paper specified in the
printer driver does not match the
type loaded in the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.634
 (See "Loading Sheets in the Printer.") →P.664

Make sure the same type of paper is specified in the printer driver as you have
loaded in the printer.

1. Hold down the Stop button for a second or more to cancel printing.

2. Change the type of paper in the printer driver and try printing again.

Setting the Blue Switch on the Platen
If printed documents exhibit the following symptoms, adjust the setting of the blue Switch on the Platen.

• Image edges are blurred
• Image edges are affected by white banding

Important
• Always set the blue Switch on the Platen to the ● side for borderless printing. Printing quality may be affec-

ted if the Switch is incorrectly set.

1. Remove any loaded paper that will not be used.

• Rolls  (See "Removing the Roll from the Printer.") →P.644

• Sheet  (See "Removing Sheets.") →P.669

2. Open the Top Cover.
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3. Remove the Cleaning Brush.

4. Using the back of the Cleaning Brush, move the first Switch to the side opposite ●.
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5. Refer to the following table to confirm the number on the Platen that corresponds to the size of paper for printing.

Number Paper Size Dimensions

2 10"x12" / 8"x10" 254 mm (10 in.)

3 14"x17" 355 mm (14 in.)

4 17-in. Roll (431.8mm) / ANSI C 432 mm (17 in.)

5 JIS B2 / JIS B3 515 mm (20 in.)

6 ISO A1 / ISO A2 / 20"x24" 594 mm (23 in.) / 610 mm (24 in.)

7 ISO A0 / ISO A1 841 mm (33 in.)

8 36"x48" (ARCH E) / 24"x36" (ARCH D) 914 mm (36 in.)

9 JIS B0 / JIS B1 1030 mm (40.5 in.)

10 Poster 42"x60" 1,067 mm (42 in.)

6. Using the back of the Cleaning Brush, move the Switch to the side opposite ●, corresponding to the size of the paper
for printing.
In this case, note that you will move the switch in the opposite direction from the direction in step 4.

7. Close the Top Cover.
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The contrast becomes uneven during printing

Cause Corrective Action

The paper feed amount is out of adjust-
ment.

Adjust the feed amount.
 (See "Adjusting the Feed Amount.") →P.684

The type of paper specified in the printer
driver does not match the type loaded in
the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.634
 (See "Loading Sheets in the Printer.") →P.664

Make sure the same type of paper is specified in the printer driver as you
have loaded in the printer.

1. Hold down the Stop button for a second or more to cancel printing.

2. Change the type of paper in the printer driver and try printing again.

The length of printed images is inaccurate

Cause Corrective Action

In the printer menu, Band Joint is
specified in Feed Priority.

To ensure the feed amount matches the paper size, select Print Length in Feed
Priority in the printer menu and enter the amount for adjustment in Adjust
Length.
 (See "Adjusting the Feed Amount.") →P.684
You can adjust the feed amount in 0.02% increments.
 (See "Main Menu Settings.") →P.730

The type of paper specified in the
printer driver does not match the
type loaded in the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.634
 (See "Loading Sheets in the Printer.") →P.664

Make sure the same type of paper is specified in the printer driver as you have
loaded in the printer.

1. Hold down the Stop button for a second or more to cancel printing.

2. Change the type of paper in the printer driver and try printing again.

Documents are printed crooked

Cause Corrective Action

Skew Skew Check Lv. has been set to Loose or Off. Choose Standard in Skew Check Lv..

Width Detection has been set to Off. Choose On in Width Detection.

Documents are printed in monochrome

Cause Corrective Action

In the Advanced Settings of the printer driver,
Monochrome, Monochrome (BK ink), or
Monochrome Bitmap is specified in Color
Mode.

In the Advanced Settings of the printer driver, specify Color in
Color Mode and try printing again.
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Cause Corrective Action

The Printhead nozzles are clogged. Print a test pattern to check the color ink nozzles and see if they are
clogged.
 (See "Checking for Nozzle Clogging.") →P.813

Line thickness is not uniform

Cause Corrective Action

In the Special Settings dialog box
of the Windows printer driver,
Fast Graphic Process is selected.

Open the printer driver's Properties dialog box from Print in the application soft-
ware's File menu, and try printing following the steps below.

1. Clear the option Open Preview When Print Job Starts on the Main sheet.

2. Clear the option Page Layout on the Layout sheet.

3. Click the Special Settings button on the Layout sheet to display the Special
Settings dialog box. Clear the option Fast Graphic Process.

The blue Switch on the platen is
set incorrectly.

Move the Switch numbered corresponding to the size of paper for printing oppo-
site to the ● position.  (See "Setting the Blue Switch on the Platen.") →P.867

The type of paper specified in the
printer driver does not match the
type loaded in the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.634
 (See "Loading Sheets in the Printer.") →P.664

Make sure the same type of paper is specified in the printer driver as you have
loaded in the printer.

1. Hold down the Stop button for a second or more to cancel printing.

2. Change the type of paper in the printer driver and try printing again.

Lines are misaligned

Cause Corrective Action

The Printhead alignment is not ad-
justed.

Adjust the Printhead alignment.
 (See "Automatic Straightening of Lines and Colors (Auto Head Adj.).")
→P.676

 (See "Manual Straightening of Lines and Colors (Manual Head Adj).")
→P.678

 (See "Adjusting Line Misalignment (Head Inc. Adj.).") →P.680

The type of paper specified in the
printer driver does not match the
type loaded in the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.634
 (See "Loading Sheets in the Printer.") →P.664

Make sure the same type of paper is specified in the printer driver as you have
loaded in the printer.

1. Hold down the Stop button for a second or more to cancel printing.

2. Change the type of paper in the printer driver and try printing again.
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Problems with the printing quality caused by the type of paper
For paper-specific troubleshooting tips to improve the printing quality, refer to the Paper Reference Guide.  (See "Types of
Paper.") →P.623
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Cannot print over a network
Cannot connect the printer to the network ...................................................................................................... 873

 

Cannot print over a TCP/IP network ................................................................................................................ 873
Cannot print over a NetWare network ............................................................................................................. 874
Cannot print over AppleTalk or Bonjour networks ........................................................................................... 874

Cannot connect the printer to the network

Cause Corrective Action

The Ethernet cable
is not connected
correctly to the
printer's Ethernet
port.

1. Make sure the printer is connected to the network with the correct Ethernet cable, and then
turn the printer on. For instructions on connecting the cable, refer to the Setup Guide.

2. Make sure the Link indicator is lit.
The Link indicator is green if the printer is connected via 100 Base-TX and orange if connec-
ted via 10Base-T.
If the Link indicator is not lit, check the following points.

• Make sure the hub is on.

• Make sure the end of the Ethernet cable is connected correctly.
Insert the Ethernet cable until it clicks and locks in place.

• Make sure there is no problem with the Ethernet cable.
If there is any problem, replace the Ethernet cable.

• Check the communication mode with the hub.
Although the printer normally detects the hub communication mode and transmission rate
automatically (in auto negotiation mode), sometimes the hub settings cannot be detected.
In this case, configure the connection method manually, specifying the communication
mode in use.
 (See "Configuring the Communication Mode Manually.") →P.776

Cannot print over a TCP/IP network

Cause Corrective Action

The printer's IP address is not
configured correctly.

Make sure the printer's IP address is configured correctly.
 (See "Configuring the IP Address Using imagePROGRAF Device Setup Utili-
ty.") →P.410
 (See "Configuring the IP Address Using the Printer Control Panel.") →P.770

The printer's TCP/IP network set-
tings are not configured correctly.

Make sure the printer's TCP/IP network settings are configured correctly.
 (See "Configuring the Printer's TCP/IP Network Settings.") →P.773

The computer you are trying to
print from is not configured cor-
rectly.

Make sure the computer's TCP/IP network settings are configured correctly.
 (See "Configuring the Printer Driver Destination .") →P.779
 (See "Configuring the Destination for TCP/IP Network .") →P.793
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Cannot print over a NetWare network

Cause Corrective Action

The printer's NetWare set-
tings are not configured
correctly.

Make sure the printer's NetWare settings are configured correctly. In particular, make
sure a valid frame type is selected.
 (See "Configuring the Printer's NetWare Network Settings.") →P.780

The computer you are try-
ing to print from is not con-
figured correctly.

Make sure the computer's NetWare settings are configured correctly.
 (See "Configuring NetWare Network Settings.") →P.787

The NetWare server and
services are not configured
correctly.

Check the following points.

1. Make sure the NetWare file server is running.

2. Make sure there is enough free disk space on the NetWare file server. Insufficient
disk space may prevent you from processing large print jobs.

3. Start NWADMIN or PCONSOLE and confirm that the print service is configured
correctly and the print queue is available.

4. If data transmission to a printer on another subnet fails, deactivate NCP burst mode in
that printer's network protocol settings.

5. If the printer is used in queue server mode, specify Other/Unknown as the printer
type.

Cannot print over AppleTalk or Bonjour networks

Cause Corrective Action

The AppleTalk protocol is not
enabled on the printer.

Activate AppleTalk on the printer.
 (See "Configuring the Printer's AppleTalk Network Settings.") →P.789

The computer you are trying to
print from is not configured cor-
rectly.

Make sure the computer's AppleTalk settings are configured correctly.
 (See "Configuring the Destination for AppleTalk Networks .") →P.790
 (See "Configuring the Destination for Bonjour Network .") →P.796

The computer and printer are not
on the same network.

Due to the nature of Bonjour, you cannot print if the printer is on another network
behind a router. Make sure the computer and printer are on the same network. For
information about network settings, ask your network administrator.
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Installation problems
Removing Installed Printer Drivers .................................................................................................................. 875

Removing Installed Printer Drivers
Follow these steps to remove installed printer drivers and utilities.

Removing printer drivers (Windows)
Remove the printer driver as follows.

Note
• In Windows 2000/Windows XP/Windows Server 2003/Windows Vista/Windows Server 2008, you must log

on with administrative rights, such as those of the Administrator account.

1. From the Windows start menu, select Programs > Canon Printer Uninstaller > imagePROGRAF Printer Driv-
er Uninstaller to display the Delete Printer window.

2. Select the printer in the list and click Delete.

3. Click Yes after the Warning message is displayed.

4. Make sure that the printer has been removed from the list, and then click Exit.

Removing printer drivers and imagePROGRAF Printmonitor (Macintosh)
Remove the printer driver or imagePROGRAF Printmonitor as follows.

1. Insert the User Software CD-ROM provided with the printer in the CD-ROM drive.

2. Start the printer driver installer included in the User Software CD-ROM.
Open the OS X folder and double-click iPF Driver Installer X.

3. In the upper left menu, choose Uninstall, and then click Uninstall.

4. Follow the instructions on the screen to remove the printer driver or imagePROGRAF Printmonitor.

Removing imagePROGRAF Status Monitor (Windows)
Remove imagePROGRAF Status Monitor as follows.

Note
• The following instructions are for Windows XP. The method of removing printer drivers varies depending on

the version of Windows.

1. Select Control Panel from the start menu.

2. Select Add or Remove Programs.
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3. Select imagePROGRAF Status Monitor, and then click the Change/Remove button.

Removing imagePROGRAF Device Setup Utility (Windows)
Remove imagePROGRAF Device Setup Utility as follows.

1. From the Windows start menu, select Programs > imagePROGRAF Device Setup Utility > Uninstaller (image-
PROGRAF Device Setup Utility) to start the wizard.

2. In the wizard window, click Delete, and then click Next.

3. Follow the instructions on the screen to remove imagePROGRAF Device Setup Utility.
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HP-GL/2 problems
Lines or images are missing in the HP-GL/2 data that was printed. ............................................................... 877
Lines Are Printed Too Thick or Thin During HP-GL/2 Printing ........................................................................ 877
HP-GL/2 jobs are printed in monochrome (or color). ...................................................................................... 877
Printed Colors in Line Drawings are Inaccurate During HP-GL/2 Printing ...................................................... 877
HP-GL/2 jobs are printed 6 mm larger than specified ..................................................................................... 878
HP-GL/2 jobs are printed at maximum size, even if a standard size is specified ............................................ 878

 

HP-GL/2 printing takes a long time. ................................................................................................................ 878
The printer stops when printing a HP-GL/2 job (the carriage stops moving) ................................................... 878

Lines or images are missing in the HP-GL/2 data that was printed.

Cause Corrective Action

The memory is full. Check the size of the data in the print job.

An HP-GL/2 command not supported by this printer was re-
ceived.

Check the print job and settings.

The printer has received print data that includes HP RTL
commands when Auto Rotate is On.

Set Auto Rotate to Off before attempting to print again.
 (See "Main Menu Settings.") →P.730

Lines Are Printed Too Thick or Thin During HP-GL/2 Printing

Cause Corrective Action

The Line Width setting in
the main menu is incorrect.

Confirm the selection in Line Width. If fine lines are printed faint, setting ThickenFi-
neLines to On in the main menu will print the lines more distinctly.
 (See "Main Menu Settings.") →P.730

HP-GL/2 jobs are printed in monochrome (or color).

Cause Corrective Action

The Color Mode is
incorrect.

On the printer Control Panel, check the Color Mode setting.
 (See "Main Menu Settings.") →P.730
However, for optimal Printhead performance, the printer consumes trace amounts of color ink
even when Monochrome is selected as Color Mode.

Printed Colors in Line Drawings are Inaccurate During HP-GL/2 Printing

Cause Corrective Action

AdjustFaintLines in the main menu
is set to On.

Selecting Off may help produce the expected results. However, lines in some
colors may appear broken.

Troubleshooting > HP-GL/2 problems >
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HP-GL/2 jobs are printed 6 mm larger than specified

Cause Corrective Action

The page size of the HP-GL/2 print job, as created in the source ap-
plication, is incorrect.

In MAIN MENU, set PageSizeProcess1 to On.
 (See "Main Menu Settings.") →P.730

HP-GL/2 jobs are printed at maximum size, even if a standard size is specified

Cause Corrective Action

The page size of the HP-GL/2 print job, as cre-
ated in the source application, is incorrect.

In MAIN MENU, set PageSizeProcess2 or Conserve Paper to On.
The layout will be changed to the optimal layout.
 (See "Main Menu Settings.") →P.730

HP-GL/2 printing takes a long time.

Cause Corrective Action

Large print jobs with a lot of data take longer to print. On the printer Control Panel, set Input Resolution to 300dpi.
 (See "Main Menu Settings.") →P.730

The printer stops when printing a HP-GL/2 job (the carriage stops moving)

Cause Corrective Action

The printer is analyzing the
print job.

Either wait a while for printing to resume, or on the printer Control Panel, set Input
Resolution to 300dpi.
 (See "Main Menu Settings.") →P.730

Troubleshooting > HP-GL/2 problems >
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Other problems
The printer does not go on .............................................................................................................................. 879

 

If the Printer Makes a Strange Sound ............................................................................................................. 880
 

Messages advising to check the maintenance cartridge are not cleared ........................................................ 880
 

The printer consumes a lot of ink .................................................................................................................... 881
Ink level detection ............................................................................................................................................ 881

The printer does not go on

Cause Corrective Action

The printer is unplugged. Plug the power cord into the outlet, and then turn on the printer.

The specified voltage is not supplied. Check the voltage of the outlet and breaker.
 (See "Specifications.") →P.761

Troubleshooting > Other problems >
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If the Printer Makes a Strange Sound

Cause Corrective Action

The printer
makes a
sound during
operation.

The following sounds do not indicate a problem with the printer.

• There is a sound of vacuum from the Platen
To prevent paper from rising, paper is held against the Platen by suction from Vacuum holes under
it.

• There is a sound when a different size of paper is used and when the Carriage goes from side to side
This may happen especially when using B0 or 44-inch paper.
When paper of a different size is used, a valve is automatically activated to switch the area for pa-
per suction, which may make a sound. This mechanism prevents vacuum from Vacuum holes
where there is no paper.
In addition, ink is ejected in sync with the movement of the Carriage back and forth to ensure opti-
mal ink flow. At this time, the valve automatically switches the area for paper suction, which may
make a sound.

• Roll paper makes a fluttering sound during printing
There may be a fluttering sound when large paper is advanced.

• You suddenly hear the tone for cleaning operations
At regular intervals, for printer maintenance, cleaning operations will begin automatically, even if
the printer is in Sleep mode.

• You suddenly hear the tone for ink agitation
At regular intervals, to ensure optimal printing quality, the ink is agitated automatically, even if the
printer is in Sleep mode. Ink agitation takes about a minute and a half.
The ink is also agitated automatically under the following conditions. Note that other operations are
not possible while "Agitating" is displayed on the control panel.

• After the printer is turned on. (The time for agitation varies depending on how long the printer
has been turned off—between about a minute and a half to twenty minutes. During agitation,
you can print or do other operations after the printer goes Online.)

• After data transmission. (After about a minute and a half, the printer goes Online, and printing
operations begin. However, printing may start later after data reception, depending on the size of
print data.)

• After ink tank replacement. (Ink agitation takes about three and a half minutes. During agitation,
you can print or do other operations after the printer goes Online.)

In other cases, contact your Canon dealer.

Messages advising to check the maintenance cartridge are not cleared

Cause Corrective Action

The printer has not detected the new Maintenance Cartridge that was
used to replace the old one.

Remove the new Maintenance Cartridge you
have just installed and insert it again firmly.

Restart the printer.

Troubleshooting > Other problems >
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The printer consumes a lot of ink

Cause Corrective Action

Many full-page color im-
ages are printed.

In print jobs such as photos, images are filled with color. This consumes a lot of ink.
This does not indicate a problem with the printer.

Head Cleaning B is used
often.

Head Cleaning B consumes a lot of ink. This does not indicate a problem with the
printer. Unless the printer has been moved or stored for a long period or you are trou-
bleshooting Printhead problems, we recommend not performing Head Cleaning B, to
the extent possible.

You have just finished ini-
tial installation, when more
ink is consumed to fill the
system.

After initial installation or at the first-time use after transfer, ink flows into the system
between the Ink Tank and Printhead, which may cause the ink level indicators to drop to
80%. This does not indicate a problem with the printer.

The printhead nozzles are
clogged.

Check for nozzle clogging.
 (See "Checking for Nozzle Clogging.") →P.813

Ink level detection
Ink level detection will be deactivated if you load ink tanks once emptied.

Ink level detection
Ink tanks specified for this printer feature an ink level detection function to prevent the ink from running out during print-
ing, which prevents printer damage.  (See "Ink Tanks.") →P.799
This function will not work correctly if you use refill ink tanks. As a result, printing stops. Thus, before using refill ink
tanks, you must cancel the ink level detection.
Printing with the ink level detection canceled may lead to printer damage and printing problems. Canon Inc. is not liable for
any damage that may occur as a result of refilling ink.

Caution
• After ink level detection has been disabled, this function cannot be reactivated for the currently loaded Ink

Tank. To use ink level detection again, replace the Ink Tank with a new ink tank specified for use with the
printer.

• Repeatedly removing and inserting an Ink Tank may damage the connection between the Ink Tank and the
printer, which may cause ink leakage from the Ink Tank and damage the printer.

Disabling ink level detection

1. On the Display Screen, a message indicates that the ink level cannot be detected. After checking the message, press
the ▶ button.

Troubleshooting > Other problems >
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2. Press ▲ or ▼ to select Information, and then press the OK button.

3. A confirmation message is shown on the Display Screen about disabling ink level detection. After checking the mes-
sage, press the ▶ button.

4. After checking the message, press the ▶ button.

5. Press ▲ or ▼ to select Yes, and then press the OK button.

Troubleshooting > Other problems >
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6. Check the message and press the ▶ button.

7. Check the message and press the ▶ button.

8. Press ▲ or ▼ to select Yes, and then press the OK button.

9. A confirmation message about updating ink information is shown on the Display Screen. After checking the mes-
sage, press the ▶ button.

Troubleshooting > Other problems >

iPF825 Ink level detection

12

883



10. Press ▲ or ▼ to select Yes, and then press the OK button.

Ink level detection is now disabled, and the printer goes online.

Troubleshooting > Other problems >
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Error Message

Error Messages 886

Messages regarding paper 888

Messages regarding ink 900

Messages regarding printing or adjustment 903

Messages regarding printheads 905

Messages regarding the maintenance cartridge 908

Messages regarding the hard disk 910

Messages regarding HP-GL/2 912

Other Messages 913

Error Message >
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Error Messages
Before borderless printing, move the blue platen switch. ................................................................................ 904
Blue platen switch is dirty. ............................................................................................................................... 904
Borderless printng not possible. ...................................................................................................................... 898
Borderless printng not possible. Paper stretched or shrank. ........................................................................... 903

 

Cannot adjust band. ........................................................................................................................................ 905
Cannot adjust printhead. ................................................................................................................................. 905
Cannot print as selected. Another roll is in use. .............................................................................................. 892
Cannot print as specified. ................................................................................................................................ 903
Close Ink Tank Cover ...................................................................................................................................... 901

 

End of paper feed. ........................................................................................................................................... 898
ERROR Exxx-xxxx (x represents a letter or number) ...................................................................................... 913
Execute printhead cleaning. ............................................................................................................................ 907

 

File read error. ................................................................................................................................................. 910
 

GARO Wxxxx (x represents a number) ........................................................................................................... 913
GL2: W0502 The parameter is out of range. ................................................................................................... 912
GL2: W0504 This command is not supported. ................................................................................................ 912
GL2: Wxxxx The memory is full. (xxxx is 0501, 0903, or 0904) ...................................................................... 912

 

Hard disk error. ................................................................................................................................................ 910
Hardware error. xxxxxxxx-xxxx (x represents a letter or number) ................................................................... 913

 

Ink insufficient. ................................................................................................................................................. 900
Ink tank is empty. ............................................................................................................................................ 901
Insert the maintenance cartridge. .................................................................................................................... 908
Insufficient paper for job .................................................................................................................................. 891

 

Mail box full. Now printing without saving data. ............................................................................................... 910
Mail box nearly full. .......................................................................................................................................... 911
Maintenance cartridge full. .............................................................................................................................. 908
Maintenance cartridge problem. ...................................................................................................................... 909
Maximum jobs stored. ..................................................................................................................................... 911
Multi-sensor error ............................................................................................................................................ 915

 

No ink left. ....................................................................................................................................................... 900
No ink tank loaded. .......................................................................................................................................... 902
No Maintenance Cartridge capacity. ............................................................................................................... 908
No printhead .................................................................................................................................................... 906
No Roll Unit. .................................................................................................................................................... 894
Not much ink is left. ......................................................................................................................................... 901

 

Paper cutting failed. ......................................................................................................................................... 897
Paper jam. ....................................................................................................................................................... 895
Paper loaded askew. ....................................................................................................................................... 896
Paper size not detected. ................................................................................................................................. 890
Papr Type Mismatch ....................................................................................................................................... 888
PaprTypeMismatch ......................................................................................................................................... 888
Parts replacement time has passed. ............................................................................................................... 914
PHead needs cleaning. ................................................................................................................................... 906
Prepare for maint cart replacement. ................................................................................................................ 908
Prepare for parts replacement. ........................................................................................................................ 914
Printhead error ................................................................................................................................................ 906
Problem with Printhead ................................................................................................................................... 906
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Regular printing is selected, but a roll is loaded. ............................................................................................ 895
Rel lever is in wrong position. .......................................................................................................................... 898
Remaining level of the ink cannot be correctly detected. ................................................................................ 900
Roll feed unit error. .......................................................................................................................................... 899
Roll printing is selected, but sheets are loaded. ............................................................................................. 892
Roll printing is selected. ................................................................................................................................. 892
Roll x is empty. (x is 1 (Upper) or 2 (Lower)) ................................................................................................... 893
Roll x is selected. (x is 1 (Upper) or 2 (Lower)) ............................................................................................... 893
Roll x jam (x is 1 (Upper) or 2 (Lower)) ........................................................................................................... 896
RollWdthMismatch .......................................................................................................................................... 890

 

Sheet printing is selected. ............................................................................................................................... 895
Sheet removed. ............................................................................................................................................... 894

 

The mail box is full. .......................................................................................................................................... 910
The paper is too small. .................................................................................................................................... 889
The roll feed unit is loose. ............................................................................................................................... 899
This paper cannot be used. ............................................................................................................................. 892
This type of paper is not compatible with HP-GL/2. ........................................................................................ 912
Too many jobs for mail box. ............................................................................................................................ 911
Top cover is open. ........................................................................................................................................... 914

 

Unknown file. ................................................................................................................................................... 914
Use another paper. .......................................................................................................................................... 903

 

Wrong ink tank. ............................................................................................................................................... 902
Wrong maintenance cartridge. ........................................................................................................................ 908
Wrong printhead. ............................................................................................................................................. 906

Error Message > Error Messages >
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Messages regarding paper
Papr Type Mismatch ....................................................................................................................................... 888
PaprTypeMismatch ......................................................................................................................................... 888
The paper is too small. .................................................................................................................................... 889
RollWdthMismatch .......................................................................................................................................... 890
Paper size not detected. ................................................................................................................................. 890
Insufficient paper for job .................................................................................................................................. 891
This paper cannot be used. ............................................................................................................................. 892
Cannot print as selected. Another roll is in use. .............................................................................................. 892

 

Roll printing is selected. ................................................................................................................................. 892
Roll printing is selected, but sheets are loaded. ............................................................................................. 892
Roll x is selected. (x is 1 (Upper) or 2 (Lower)) ............................................................................................... 893
Roll x is empty. (x is 1 (Upper) or 2 (Lower)) ................................................................................................... 893
No Roll Unit. .................................................................................................................................................... 894

 

Sheet removed. ............................................................................................................................................... 894
Sheet printing is selected. ............................................................................................................................... 895
Regular printing is selected, but a roll is loaded. ............................................................................................ 895

 

Paper jam. ....................................................................................................................................................... 895
Roll x jam (x is 1 (Upper) or 2 (Lower)) ........................................................................................................... 896
Paper loaded askew. ....................................................................................................................................... 896
Paper cutting failed. ......................................................................................................................................... 897
End of paper feed. ........................................................................................................................................... 898
Rel lever is in wrong position. .......................................................................................................................... 898

 

Borderless printng not possible. ...................................................................................................................... 898
 

Roll feed unit error. .......................................................................................................................................... 899
 

The roll feed unit is loose. ............................................................................................................................... 899

Papr Type Mismatch

Cause Corrective Action

You tried to print a test pattern for printer adjustment
on several sheets, but sheets of different types of paper
were used.

Hold down the Stop button for a second or more to cancel
printing.

When printing a test pattern, use sheets of the same type of
paper.
Lift the Release Lever and load a sheet of the same type of
paper.
 (See "Loading and Printing on Sheets.") →P.8

PaprTypeMismatch

Cause Corrective Action

When the Detect Mismatch menu is
set to Pause, the type of paper loaded
does not match the type specified in
the printer driver.

Follow these steps to ensure the paper type matches on the printer and in the
printer driver.

1. Hold down the Stop button for a second or more to cancel printing.

Error Message > Messages regarding paper >
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Cause Corrective Action
When the Detect Mismatch menu is
set to Pause, the type of paper loaded
does not match the type specified in
the printer driver.

2. Either change the type of paper specified in the printer driver settings or
replace the loaded paper and change the paper type setting on the printer.
 (See "Loading and Printing on Rolls.") →P.3
 (See "Loading and Printing on Sheets.") →P.8

You tried to print a test pattern for
printer adjustment on several sheets,
but sheets of different types of paper
were used.

Follow these steps to ensure the paper type matches on the printer and in the
printer driver.

1. Hold down the Stop button for a second or more to cancel printing.

2. Either change the type of paper specified in the printer driver settings or
replace the loaded paper and change the paper type setting on the printer.
 (See "Loading and Printing on Rolls.") →P.3
 (See "Loading and Printing on Sheets.") →P.8

Press the Online button to resume printing.
However, note that this error may cause paper jams and affect the printing
quality.

When the Detect Mismatch menu is
set to Warning, the type of paper loa-
ded does not match the type specified
in the printer driver.

You can continue to print, but note that this error may cause problems in the
printing results.

The paper is too small.

Cause Corrective Action

When the Detect Mismatch menu is set to
Pause, the paper loaded in the printer is small-
er than the size specified in the printer driver.

Press the Online button to resume printing.
However, note that this error may cause paper jams and affect the
printing quality.

Adjust the paper size setting in the printer driver to match the size
loaded in the printer as follows.

1. Hold down the Stop button for a second or more to cancel print-
ing.

2. Change the paper size setting in the printer driver to the size loa-
ded in the printer and try printing again.

Replace the loaded paper with paper of a size that matches the size
setting in the printer driver as follows.

1. Hold down the Stop button for a second or more to cancel print-
ing.

2. Replace the loaded paper to match the paper size setting in the
printer driver and try printing again.

When the Detect Mismatch menu is set to
Warning, the paper loaded in the printer is
smaller than the size specified in the printer
driver.

You can continue to print, but note that this error may cause prob-
lems in the printing results.

Error Message > Messages regarding paper >
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RollWdthMismatch

Cause Corrective Action

The roll width set in Fit Roll Paper Width in the
printer driver does not match the width of the roll loa-
ded in the printer.

Press the Online button to resume printing.
However, note that this error may cause paper jams and af-
fect the printing quality.

Hold down the Stop button for a second or more to cancel
printing.

Make sure the roll width selected in the dialog box displayed
when you select Fit Roll Paper Width in the printer driver
matches the width of the roll loaded in the printer, and then
try printing again.

Paper size not detected.

Cause Corrective Action

Paper has been loaded askew, or warped paper has been loaded. Follow these steps to reload the roll.

1. Lift the Release Lever.

2. Open the Top Cover.

3. Adjust the right edge of the roll to make it
parallel to the right Paper Alignment Line.

4. Lower the Release Lever.

5. Close the Top Cover.

6. If "Not finished printing. Finish printing
remaining jobs?" is shown on the Display
Screen, press the OK button.
Printing will resume, starting from the page
on which the error occurred.

 (See "Loading Rolls in the Printer.") →P.634

If this error recurs after you reload the roll, re-
move the Roll Holder from the printer, push the
roll firmly in until it touches the Roll Holder
flange, and reload the Roll Holder in the printer.
 (See "Attaching the Roll Holder to Rolls.")
→P.629

Follow these step to reload a sheet.

1. Lift the Release Lever.

2. Open the Top Cover.

3. Adjust the right edge of the sheet to make it
parallel to the right Paper Alignment Line and
the trailing edge of the sheet to make it paral-
lel to the paper alignment line under the Paper
Retainer.

4. Lower the Release Lever.

5. Close the Top Cover.

Error Message > Messages regarding paper >
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Cause Corrective Action
Paper has been loaded askew, or warped paper has been loaded. 6. If "Not finished printing. Finish printing

remaining jobs?" is shown on the Display
Screen, press the OK button.
Printing will resume, starting from the page
on which the error occurred.

 (See "Loading Sheets in the Printer.")
→P.664

Because the Platen is soiled with ink or other substances, the size
of the clear film cannot be detected.

Open the Top Cover and clean the entire Platen.
 (See "Cleaning Inside the Top Cover.")
→P.833

Insufficient paper for job

Cause Corrective Action

The printer has received a print job longer than the amount of roll paper left when
ManageRemainRoll in the printer menu is On and one of the following settings is
selected.

• An option other than Roll Paper (Auto) is selected in Paper Source in the printer
driver.

• During HP-GL/2 printing, GL2 Settings >Paper Source in the printer menu is set
to an option other than Automatic.

Press the Online button to re-
sume printing.
However, the roll paper may
run out during the print job
and you may not be able to
print all of the document.

Hold down the Stop button
for a second or more to cancel
printing.
Either change the printer driv-
er Paper Source setting or
the GL2 Settings >Paper
Source setting in the printer
menu or replace the roll with
a roll that has enough paper
for the print job, and then try
printing again.
 (See "Removing the Roll
from the Printer.") →P.644
 (See "Loading Rolls in the
Printer.") →P.634

Error Message > Messages regarding paper >
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This paper cannot be used.

Cause Corrective Action

Paper that is too large for the printer has been
loaded.

Lift the Release Lever and load paper of the correct size.
 (See "Paper Sizes.") →P.626

Paper that is too small for the printer has been
loaded.

Lift the Release Lever and load paper of the correct size.
 (See "Paper Sizes.") →P.626

Paper has been loaded that is too small to print
the test pattern for printhead adjustment or noz-
zle checking.

Lift the Release Lever and load unused paper A4 or larger. More
than one sheet may be required depending on the adjustment.

Cannot print as selected. Another roll is in use.

Cause Corrective Action

A printed document remains in the Out-
put Tray without being cut and a print job
was received that specifies the other roll.

Follow these steps to load the other roll after cutting the printed document.

1. Hold down the Stop button for a second or more to cancel printing.

2. Cut the printed document.
 (See "Specifying the Cutting Method for Rolls.") →P.654

3. Load the other roll and resend the print job.
 (See "Loading and Printing on Rolls.") →P.3

Roll printing is selected.

Cause Corrective Action

You have attempted to print a test print sheet or other printer
status information on a roll, but no roll is loaded.

Load a roll and try printing again.

To print on a sheet instead, hold down the Stop button
for more than a second to cancel printing, load a sheet,
and then print.
 (See "Loading and Printing on Sheets.") →P.8

Roll printing is selected, but sheets are loaded.

Cause Corrective Action

A print job for rolls was received when a sheet is
loaded.

Follow these steps to load and print on a roll.

1. Press the OK button and remove the sheet.
 (See "Removing Sheets.") →P.669

2. Load a new roll.
 (See "Loading Rolls in the Printer.") →P.634
The printer now starts printing the print job.

Hold down the Stop button for a second or more to cancel printing.

Error Message > Messages regarding paper >
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Roll x is selected. (x is 1 (Upper) or 2 (Lower))

Cause Corrective Action

The indicated roll is specified for a print job sent from a
computer, but that roll is not loaded.

Load the indicated roll and try printing again.

To print on a sheet instead, hold down the Stop button for
more than a second to cancel printing, load a sheet, and then
print.
 (See "Loading and Printing on Sheets.") →P.8

Roll x is empty. (x is 1 (Upper) or 2 (Lower))

"Lift the release lever and replace the roll."

Cause Corrective Action

The roll is empty. Follow these steps to replace the used roll with a new roll
of the same type and size.

1. Lift the Release Lever and remove the roll.
 (See "Removing the Roll from the Printer.")
→P.644

 (See "Removing the Roll Holder from Rolls.")
→P.649

2. Load the new roll.
 (See "Attaching the Roll Holder to Rolls.") →P.629
 (See "Loading Rolls in the Printer.") →P.634

3. If no barcode was printed on the roll, specify the type
of paper.
 (See "Selecting the Paper Type (Roll).") →P.642

4. If no barcode was printed on the roll, specify the paper
length.
 (See "Specifying the Paper Length (Roll).")
→P.643

5. If "Not finished printing. Finish printing remaining
jobs?" is shown on the Display Screen, press the OK
button.
Printing will resume, starting from the page on which
the error occurred.

There is remaining roll paper, but because it could not be
advanced, it could not be detected.

Choose a higher level of Print Quality in the Advanced
Settings of the printer driver and try printing again.
 (See "Giving Priority to Particular Graphic Elements
and Colors for Printing.") →P.56

Error Message > Messages regarding paper >
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"Press OK."

Cause Corrective Action

The roll is empty. Follow these steps to replace the used roll with a new roll of the
same type and size.

1. Press the OK button and remove the roll.
 (See "Removing the Roll from the Printer.") →P.644
 (See "Removing the Roll Holder from Rolls.") →P.649

2. Load the new roll.
 (See "Attaching the Roll Holder to Rolls.") →P.629
 (See "Loading Rolls in the Printer.") →P.634

3. If no barcode was printed on the roll, specify the type of paper.
 (See "Selecting the Paper Type (Roll).") →P.642

4. If no barcode was printed on the roll, specify the paper length.
 (See "Specifying the Paper Length (Roll).") →P.643

5. If "Not finished printing. Finish printing remaining jobs?" is
shown on the Display Screen, press the OK button.
Printing will resume, starting from the page on which the error
occurred.

No Roll Unit.

Cause Corrective Action

The printer has received a print job that specifies Roll 2
(Lower), but the Roll Unit is not installed.

Hold down the Stop button for a second or more to cancel
printing.

1. Turn the printer off and install the Roll Unit.
Connect the Roll Unit Cable firmly and completely.

2. Turn the printer on and resend the print job.

Sheet removed.

Cause Corrective Action

A sheet has come out of the printer during printing. 1. Lift the Release Lever and remove the paper.

2. If "Not finished printing. Finish printing remaining jobs?"
is shown on the Display Screen, press the OK button.
Printing will resume, starting from the page on which the error
occurred.

Error Message > Messages regarding paper >
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Sheet printing is selected.

Cause Corrective Action

You have attempted to print a test print sheet or other printer
status information on a sheet, but no sheet is loaded.

Load a sheet and try printing again.

To print on a roll instead, hold down the Stop button
for more than a second to cancel printing, load a roll,
and then print.
 (See "Loading and Printing on Rolls.") →P.3

Regular printing is selected, but a roll is loaded.

Cause Corrective Action

A print job for printing on
sheets was sent when a
roll is loaded.

Hold down the Stop button for a second or more to cancel printing.
Remove the roll and load a sheet of the type and size of paper you have specified in the
printer driver.
 (See "Removing the Roll from the Printer.") →P.644
 (See "Loading and Printing on Sheets.") →P.8

Paper jam.

"Lift the release lever."

Cause Corrective Action

A paper jam occurred
in the printer during
printing.

1. Lift the Release Lever and remove the jammed paper.
 (See "Clearing Jammed Roll Paper.") →P.847
 (See "Clearing a Jammed Sheet.") →P.851

2. If "Not finished printing. Finish printing remaining jobs?" is shown on the Display
Screen, press the OK button.
Printing will resume, starting from the page on which the error occurred.

"Manually rewind the roll all the way and press OK."

Cause Corrective Action

A paper jam occurred
when advancing the pa-
per.

1. Rewind paper on the Roll Holder manually, all the way, and then press the OK button.

2. If "Not finished printing. Finish printing remaining jobs?" is shown on the Display
Screen, press the OK button.
Printing will resume, starting from the page on which the error occurred.

Error Message > Messages regarding paper >
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Roll x jam (x is 1 (Upper) or 2 (Lower))

"Lift the release lever."

Cause Corrective Action

A paper jam occurred
in the printer during
printing.

1. Lift the Release Lever and remove the jammed paper.
 (See "Clearing Jammed Roll Paper.") →P.847
 (See "Clearing a Jammed Sheet.") →P.851

2. If "Not finished printing. Finish printing remaining jobs?" is shown on the Display
Screen, press the OK button.
Printing will resume, starting from the page on which the error occurred.

"Manually rewind the roll all the way and press OK."

Cause Corrective Action

A paper jam occurred
when advancing the pa-
per.

1. Rewind paper on the Roll Holder manually, all the way, and then press the OK button.

2. If "Not finished printing. Finish printing remaining jobs?" is shown on the Display
Screen, press the OK button.
Printing will resume, starting from the page on which the error occurred.

Paper loaded askew.

Cause Corrective Action

Paper is loaded askew. Follow these steps to reload the roll.

1. Lift the Release Lever.

2. Open the Top Cover.

3. Adjust the right edge of the roll to make it parallel to the
right Paper Alignment Line.

4. Lower the Release Lever.

5. Close the Top Cover.

 (See "Loading Rolls in the Printer.") →P.634

If this error recurs after you reload the roll, remove the Roll
Holder from the printer, push the roll firmly in until it touches
the Roll Holder flange, and reload the Roll Holder in the print-
er.
 (See "Attaching the Roll Holder to Rolls.") →P.629

Follow these step to reload a sheet.

1. Lift the Release Lever.

2. Open the Top Cover.

3. Adjust the right edge of the sheet to make it parallel to the
right Paper Alignment Line and the trailing edge of the
sheet to make it parallel to the paper alignment line under
the Paper Retainer.

4. Lower the Release Lever.

Error Message > Messages regarding paper >
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Cause Corrective Action
Paper is loaded askew. 5. Close the Top Cover.

 (See "Loading Sheets in the Printer.") →P.664

Note
• To disable this message (if it is displayed repeatedly despite reloading paper, for example), choose Off or

Loose in the Skew Check Lv. setting of the printer menu. However, this may cause jams because paper may
be askew when it is printed. Also, the Platen may become soiled, which may soil the back of the next docu-
ment when it is printed.

Paper cutting failed.

Cause Corrective Action

There are sheets left on the
Ejection Guide.

1. Lift the Release Lever and remove the paper.

2. If "Not finished printing. Finish printing remaining jobs?" is shown on the Dis-
play Screen, press the OK button.
Printing will resume, starting from the page on which the error occurred.

There is a foreign object by
the Output Tray, obstruct-
ing the Cutter Unit.

1. Lift the Top Cover and remove the foreign object.

2. If "Not finished printing. Finish printing remaining jobs?" is shown on the Dis-
play Screen, press the OK button.
Printing will resume, starting from the page on which the error occurred.

You are not using the print-
er under the recommended
environmental conditions
for the paper.

Use the printer only where the recommended environmental conditions for the paper are
met. Note that various environmental conditions are recommended for various types of
paper. For details on the recommended environmental conditions for paper, see the Paper
Reference Guide.
 (See "Types of Paper.") →P.623

You are using paper that is
not compatible with auto-
matic cutting.

Specify Manual as the cutting method and cut the roll manually.
 (See "Specifying the Cutting Method for Rolls.") →P.654
For information about paper that is compatible with automatic cutting, see the Paper Ref-
erence Guide.
 (See "Types of Paper.") →P.623

The Cutter Unit stops in
the middle of cutting.

If the Carriage is out, move the Carriage out of the way, away from the paper.
If the Cutter is out, move the Cutter to the right side (away from the paper) and remove
the jammed paper.
 (See "Clearing Jammed Roll Paper.") →P.847
If the paper cannot be cut using the Cutter Unit, specify Manual as the roll cutting meth-
od and cut the roll manually.

Error Message > Messages regarding paper >
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Cause Corrective Action
The Cutter Unit stops in
the middle of cutting.

 (See "Specifying the Cutting Method for Rolls.") →P.654

In other cases, the Cutter
Unit may be damaged.

Contact your Canon dealer for assistance.

End of paper feed.

Cause Corrective Action

You are pressing the ▲ button on the Control Panel and trying to rewind the roll to the edge. Release the ▲ button.

Rel lever is in wrong position.

Cause Corrective Action

The Release Lever is up. Lower the Release Lever.

If the error occurs again, turn off the printer and wait a while before restoring power.

Borderless printng not possible.

"Lift release lever and reload the paper."

Cause Corrective Action

Because paper expands or con-
tracts depending on the environ-
ment of use, it may become nar-
rower or wider than the suppor-
ted width for borderless printing.

Hold down the Stop button for a second or more to cancel printing.
Use each type of paper only where the recommended environmental conditions are
met. For details on environmental conditions for various paper, see the Paper Ref-
erence Guide.
 (See "Types of Paper.") →P.623

The paper is loaded askew. Lift the Release Lever and straighten the paper so that the edge of the paper is in
the width of the ink groove for borderless printing.
Insert the roll firmly until it touches the flange of the Roll Holder.
 (See "Attaching the Roll Holder to Rolls.") →P.629

If you press the Online button and continue printing, the document will be printed
with a border.

"Check supported paper."

Cause Corrective Action

The print job received specifies a type
or width of paper that is not compatible
with borderless printing.

Follow these steps to change the settings of the print job to enable border-
less printing.

1. Hold down the Stop button for a second or more to cancel printing.

2. Make sure the correct printer driver for the printer is selected and try
printing again.
For information on types of paper compatible with borderless printing,
refer to the Paper Reference Guide.

Error Message > Messages regarding paper >
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Cause Corrective Action
The print job received specifies a type
or width of paper that is not compatible
with borderless printing.

 (See "Types of Paper.") →P.623

If you press the Online button and continue printing, the document will be
printed with a border.

The loaded paper is not compatible with
borderless printing.

Hold down the Stop button for a second or more to cancel printing.

If you press the Online button and continue printing, the document will be
printed with a border.

Roll feed unit error.

Cause Corrective Action

There is a problem with
the Roll Unit.

Turn off the printer and wait at least three seconds before restoring the power. If the mes-
sage is displayed again, contact your Canon dealer for assistance.

The roll feed unit is loose.

Cause Corrective Action

The Roll Unit is detached from the printer. Push the Roll Unit firmly all the way in.

Error Message > Messages regarding paper >
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Messages regarding ink
Ink insufficient. ................................................................................................................................................. 900
No ink left. ....................................................................................................................................................... 900
Remaining level of the ink cannot be correctly detected. ................................................................................ 900

 

Close Ink Tank Cover ...................................................................................................................................... 901
Ink tank is empty. ............................................................................................................................................ 901
Not much ink is left. ......................................................................................................................................... 901
No ink tank loaded. .......................................................................................................................................... 902
Wrong ink tank. ............................................................................................................................................... 902

Ink insufficient.

Cause Corrective Action

The ink level is low, so you cannot print, clean the Printhead, or do other opera-
tions that require ink.

Replace the Ink Tank that is low
with a new Ink Tank.
 (See "Replacing Ink Tanks.")
→P.799

No ink left.

Cause Corrective Action

There is no ink left. Open the Ink Tank Cover and replace the Ink Tank for which the Ink Lamp is flashing.
 (See "Replacing Ink Tanks.") →P.799

Remaining level of the ink cannot be correctly detected.

Cause Corrective Action

Ink level detection cannot work cor-
rectly if you use refill ink tanks.

The refill ink tank can no longer be used. See the section Ink level detection
and take the appropriate action.  (See "Ink level detection.") →P.881

Error Message > Messages regarding ink >
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Close Ink Tank Cover

Cause Corrective Action

The Ink Tank Cover is open. Close the Ink Tank Cover.

Ink tank is empty.

Cause Corrective Action

There is no ink left in an ink tank. Open the Ink Tank Cover and replace the Ink Tank for which the Ink Lamp
is flashing.
 (See "Replacing Ink Tanks.") →P.799

Not much ink is left.

Cause Corrective Action

Not much ink is left. Prepare a new Ink Tank.
We recommend replacing the Ink Tank with a new Ink Tank at this point if
you plan to print large-format or high-quantity jobs.

Error Message > Messages regarding ink >
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No ink tank loaded.

Cause Corrective Action

There is no Ink Tank of the indicated color in the printer. Load or reload the Ink Tank.
 (See "Replacing Ink Tanks.") →P.799

There is a problem with the Ink Tank. Replace it with a new Ink Tank.
 (See "Replacing Ink Tanks.") →P.799

Wrong ink tank.

Cause Corrective Action

The Ink Tank in the printer is incompatible. Load an Ink Tank specified for use with the printer.
 (See "Replacing Ink Tanks.") →P.799

Error Message > Messages regarding ink >
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Messages regarding printing or adjustment
Use another paper. .......................................................................................................................................... 903
Cannot print as specified. ................................................................................................................................ 903

 
 

Borderless printng not possible. Paper stretched or shrank. ........................................................................... 903
Before borderless printing, move the blue platen switch. ................................................................................ 904

 

Blue platen switch is dirty. ............................................................................................................................... 904

Use another paper.

Cause Corrective Action

The Printhead and feed amount cannot
be adjusted when highly transparent
film is loaded.

Press the Online button to clear the error.
We recommend using a type of paper that you often use, other than film, for
Printhead adjustment.
 (See "Automatic Straightening of Lines and Colors (Auto Head Adj.).")
→P.676

Press the Online button to clear the error, and then adjust the feed amount
manually.
 (See "Manual Band Adjustment (Manual Band Adj).") →P.686

Cannot print as specified.

"Lift the release lever and replace paper with A4/LTR (vertical) or larger."

Cause Corrective Action

The loaded paper is too small. Switch to paper A4/Letter (vertical) or larger.

"Lift the release lever and replace roll with 10 in. wide or larger roll."

Cause Corrective Action

The loaded paper is too small. Load a roll 10 inches wide or larger.

Borderless printng not possible. Paper stretched or shrank.

Cause Corrective Action

The loaded roll has expanded or contracted due to environ-
mental conditions, making it wider or narrower than the sup-
ported width for borderless printing.

Hold down the Stop button for a second or more to can-
cel printing.

Use each type of paper only where the recommended
environmental conditions are met. For details on envi-
ronmental conditions for various paper, see the Paper
Reference Guide.
 (See "Types of Paper.") →P.623

Error Message > Messages regarding printing or adjustment >
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Before borderless printing, move the blue platen switch.

Cause Corrective Action

The blue Switch on the platen was set to the side
opposite ● when a borderless print job was re-
ceived.

Before borderless printing, set the blue Switch on the platen to
the ● side.
 (See "Setting the Blue Switch on the Platen.") →P.867

Blue platen switch is dirty.

Cause Corrective Action

The blue Switch on the platen is dirty. Open the Top Cover and clean the blue Switch on the platen.
 (See "Cleaning Inside the Top Cover.") →P.833

Error Message > Messages regarding printing or adjustment >
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Messages regarding printheads
Cannot adjust printhead. ................................................................................................................................. 905
Cannot adjust band. ........................................................................................................................................ 905

 

PHead needs cleaning. ................................................................................................................................... 906
Wrong printhead. ............................................................................................................................................. 906
Problem with Printhead ................................................................................................................................... 906
Printhead error ................................................................................................................................................ 906
No printhead .................................................................................................................................................... 906
Execute printhead cleaning. ............................................................................................................................ 907

Cannot adjust printhead.

Cause Corrective Action

The Printhead noz-
zles are clogged.

Execute Auto Head Adj. again, as follows.

1. Press the Online button to clear the error.

2. Print a test pattern to check the nozzles.
 (See "Checking for Nozzle Clogging.") →P.813

3. Clean the Printhead if the nozzles are clogged.
 (See "Cleaning the Printhead.") →P.815

4. Execute Auto Head Adj. again.
 (See "Automatic Straightening of Lines and Colors (Auto Head Adj.).") →P.676

The Printhead can-
not be aligned; high-
ly transparent film is
loaded.

Press the Online button to clear the error.
We recommend using a type of paper that you often use, other than film, for Printhead adjust-
ment.
 (See "Automatic Straightening of Lines and Colors (Auto Head Adj.).") →P.676

The Printhead is in-
stalled crooked.

Straighten the Printhead as follows, and then execute Auto Head Adj. again.

1. Press the Online button to clear the error.

2. Use Head Inc. Adj. to adjust the angle of inclination of the Printhead.
 (See "Adjusting Line Misalignment (Head Inc. Adj.).") →P.680

3. Execute Auto Head Adj. again.
 (See "Automatic Straightening of Lines and Colors (Auto Head Adj.).") →P.676

Cannot adjust band.

Cause Corrective Action

The Printhead nozzles are clog-
ged.

Execute Auto Band Adj. again, as follows.

1. Press the Online button to clear the error.

2. Print a test pattern to check the nozzles.
 (See "Checking for Nozzle Clogging.") →P.813

3. Clean the Printhead if the nozzles are clogged.
 (See "Cleaning the Printhead.") →P.815

4. Execute Auto Band Adj. again.
 (See "Auto Band Adjustment (Auto Band Adj.).") →P.685

Error Message > Messages regarding printheads >
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Cause Corrective Action

Highly transparent film is loa-
ded that cannot be used for au-
tomatic feed amount adjust-
ment.

Press the Online button to clear the error, and then adjust the feed amount manually.
 (See "Manual Band Adjustment (Manual Band Adj).") →P.686

PHead needs cleaning.

Cause Corrective Action

The Printhead nozzles
are clogged.

Press the Online button to resume printing.

Follow these steps to clean the Printhead.

1. Hold down the Stop button for a second or more to cancel printing.

2. Printhead cleaning options.
 (See "Cleaning the Printhead.") →P.815

If the message is still displayed after you execute Head Cleaning B once or twice, contact
your Canon dealer for assistance.

Wrong printhead.

Cause Corrective Action

An incompatible Printhead has been installed. Open the Top Cover and replace the Printhead with a new one.
 (See "Replacing the Printhead.") →P.816

Problem with Printhead

Cause Corrective Action

The Printhead nozzles are becoming clogged. If printing is faint, clean the Printhead.
 (See "Cleaning the Printhead.") →P.815

Printhead error

Cause Corrective Action

There is a problem with the Printhead. Open the Top Cover and replace the Printhead with a new one.
 (See "Replacing the Printhead.") →P.816

No printhead

Cause Corrective Action

No Printhead is installed. Install the Printhead.
 (See "Replacing the Printhead.") →P.816

Error Message > Messages regarding printheads >
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Execute printhead cleaning.

Cause Corrective Action

The Printhead nozzles are clogged. Follow these steps to clean the Printhead.

1. Hold down the Stop button for a second or more to cancel printing.

2. Printhead cleaning options.
 (See "Cleaning the Printhead.") →P.815

If this message is still displayed, replace the Printhead.
 (See "Replacing the Printhead.") →P.816

Error Message > Messages regarding printheads >
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Messages regarding the maintenance cartridge
Insert the maintenance cartridge. .................................................................................................................... 908
Wrong maintenance cartridge. ........................................................................................................................ 908

 

Prepare for maint cart replacement. ................................................................................................................ 908
No Maintenance Cartridge capacity. ............................................................................................................... 908
Maintenance cartridge full. .............................................................................................................................. 908
Maintenance cartridge problem. ...................................................................................................................... 909

Insert the maintenance cartridge.

Cause Corrective Action

The Maintenance Cartridge is not installed. Install the Maintenance Cartridge.
 (See "Replacing the Maintenance Cartridge.") →P.823

Wrong maintenance cartridge.

Cause Corrective Action

A Maintenance Cartridge for a different model of printer
is installed.

Replace it with the Maintenance Cartridge for your partic-
ular model.

Prepare for maint cart replacement.

Cause Corrective Action

The Maintenance Cartridge is
almost full.

You can continue to print, but prepare a new Maintenance Cartridge to use when the
message for replacement is displayed.

No Maintenance Cartridge capacity.

Cause Corrective Action

The Maintenance Cartridge cannot absorb
enough ink for Printhead cleaning or other
operation.

After confirming that the printer has stopped operating, replace the
Maintenance Cartridge.
 (See "Replacing the Maintenance Cartridge.") →P.823

Maintenance cartridge full.

Cause Corrective Action

The Maintenance Car-
tridge is full.

After confirming that the printer has stopped operating, replace the Maintenance Cartridge.
 (See "Replacing the Maintenance Cartridge.") →P.823

Error Message > Messages regarding the maintenance cartridge >
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Maintenance cartridge problem.

Cause Corrective Action

An incompatible or used Maintenance
Cartridge has been installed.

Install an unused Maintenance Cartridge specified for use with the printer.
 (See "Replacing the Maintenance Cartridge.") →P.823

Error Message > Messages regarding the maintenance cartridge >
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Messages regarding the hard disk
Hard disk error. ................................................................................................................................................ 910
File read error. ................................................................................................................................................. 910

 

The mail box is full. .......................................................................................................................................... 910
Mail box full. Now printing without saving data. ............................................................................................... 910
Mail box nearly full. .......................................................................................................................................... 911

 

Maximum jobs stored. ..................................................................................................................................... 911
Too many jobs for mail box. ............................................................................................................................ 911

Hard disk error.

Cause Corrective Action

The format of the printer's
hard disk is invalid.

Press the OK button to start reformatting the hard disk. When formatting is finished,
the printer automatically restarts. (Formatting will erase all data on the hard disk.)

File read error.

Cause Corrective Action

Files on the printer's hard disk have be-
come corrupted.

Restart the printer. Only the corrupted files will be deleted, and the printer
will restart.

The mail box is full.

Cause Corrective Action

There is no more space on the printer's
hard disk.

Press the Stop button to cancel the print job.

Delete print jobs from the queue.
 (See "Managing Queued Jobs (Deleting or Preempting Other Jobs).")
→P.574

Delete unneeded jobs stored in personal boxes (box numbers in the range
01–29).
 (See "Deleting Saved Jobs.") →P.583

Mail box full. Now printing without saving data.

Cause Corrective Action

No more space is available on the printer's hard disk, so jobs are now printed
without saving them. (Print jobs can no longer be saved on the hard disk.)

After printing, this message is
cleared.

Error Message > Messages regarding the hard disk >

Hard disk error. iPF825
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Mail box nearly full.

Cause Corrective Action

The free hard disk space left for personal boxes in the printer's hard
disk does not have 1 GB, combined.

Delete unneeded jobs stored in personal boxes.
 (See "Deleting Saved Jobs.") →P.583

Maximum jobs stored.

Cause Corrective Action

100 jobs are stored in the personal box. Delete unneeded jobs stored in personal boxes.
 (See "Deleting Saved Jobs.") →P.583

Too many jobs for mail box.

Cause Corrective Action

Saved jobs exceed the personal box capaci-
ty.

Press the Stop button to cancel the print job.

Delete print jobs from the queue.
 (See "Managing Queued Jobs (Deleting or Preempting Other
Jobs).") →P.574

Delete unneeded jobs stored in personal boxes (box numbers in the
range 01–29).
 (See "Deleting Saved Jobs.") →P.583

Error Message > Messages regarding the hard disk >
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Messages regarding HP-GL/2
This type of paper is not compatible with HP-GL/2. ........................................................................................ 912

 

GL2: Wxxxx The memory is full. (xxxx is 0501, 0903, or 0904) ...................................................................... 912
GL2: W0502 The parameter is out of range. ................................................................................................... 912
GL2: W0504 This command is not supported. ................................................................................................ 912

This type of paper is not compatible with HP-GL/2.

Cause Corrective Action

The printer has received a HP-GL/2
print job that cannot be printed on the
paper that has been advanced.

Follow these steps to replace the type of paper in the printer.

1. Hold down the Stop button for a second or more to cancel printing.

2. Replace the paper with a type compatible with HP-GL/2. For details on
paper compatible with HP-GL/2, refer to the Paper Reference Guide.
 (See "Types of Paper.") →P.623

Press the Online button to resume printing. However, note that this error
may cause paper jams and affect the printing quality.

GL2: Wxxxx The memory is full. (xxxx is 0501, 0903, or 0904)

Cause Corrective Action

The printer memory became full while processing the job received. Check the print job and the printing results.

GL2: W0502 The parameter is out of range.

Cause Corrective Action

A parameter specified in a HP-GL/2 command is out of the supported range. Check the print job.

GL2: W0504 This command is not supported.

Cause Corrective Action

The printer has received an unsupported HP-GL/2 command. Check the print job.

Error Message > Messages regarding HP-GL/2 >
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Other Messages
GARO Wxxxx (x represents a number) ........................................................................................................... 913
ERROR Exxx-xxxx (x represents a letter or number) ...................................................................................... 913
Hardware error. xxxxxxxx-xxxx (x represents a letter or number) ................................................................... 913

 

Top cover is open. ........................................................................................................................................... 914
 

Prepare for parts replacement. ........................................................................................................................ 914
Parts replacement time has passed. ............................................................................................................... 914

 

Unknown file. ................................................................................................................................................... 914
Multi-sensor error ............................................................................................................................................ 915

 

GARO Wxxxx (x represents a number)

Cause Corrective Action

There is a problem with the print job. Try printing again, using the correct printer driver.

It is also possible to continue printing in this state.
However, you may not be able to obtain the desired printing results.

ERROR Exxx-xxxx (x represents a letter or number)

Cause Corrective Action

An error requiring service may have occurred. Write down the error code and message, turn off the printer, and con-
tact your Canon dealer for assistance.

Hardware error. xxxxxxxx-xxxx (x represents a letter or number)

Cause Corrective Action

The last portion of roll paper was used during a print job. The
paper was not advanced because the trailing edge is taped to
the roll.

Turn off the printer and remove the roll from the print-
er before restoring power.

Fastening tape or the Belt Stopper has not been removed in-
side the Top Cover.

Turn off the printer, open the Top Cover and remove
the tape or the Belt Stopper before restoring power.

An error requiring service may have occurred. Turn off the printer and wait at least three seconds be-
fore restoring the power.

Error Message > Other Messages >
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Cause Corrective Action
If the message is displayed again, write down the error
code and message, turn off the printer, and contact
your Canon dealer for assistance.

Top cover is open.

Cause Corrective Action

The printer has detected that the Top Cover
is open.

Open the Top Cover fully, remove any foreign objects, and close the Top
Cover again.

If the error occurs again, close the Top Cover, turn off the printer, and
wait a while before restoring power.

Prepare for parts replacement.

Cause Corrective Action

It is almost time to replace consuma-
bles for which service is required.

You can continue to use the printer for some time until "Parts replacement
time has passed." will be displayed.
Contact your Canon dealer for assistance.

Parts replacement time has passed.

Cause Corrective Action

It is past the recommended time to replace consumables for which service
is required.

Contact your Canon dealer for assistance.

Unknown file.

Cause Corrective Action

Data sent to keep the printer up to date (such as
paper information) is in the wrong format.

Check the data. Turn off the printer and wait a while before restor-
ing power, and then resend the data.

You have uploaded firmware for a different
model.

Check the firmware version. Turn off the printer and wait a while
before restoring power, and then resend the firmware.

If the message is displayed again, contact your Canon dealer for as-
sistance.

Error Message > Other Messages >

Top cover is open. iPF825
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Multi-sensor error

Cause Corrective Action

Direct sunlight or strong lighting may be shin-
ing on the printer and causing the sensor to
malfunction.

Take steps to ensure the printer is not used when exposed to direct
sunlight or strong lighting.

The performance of a sensor inside the printer
may be impaired.

Turn off the printer and wait at least three seconds before restoring
the power.
If the message is displayed again, contact your Canon dealer for as-
sistance.

Error Message > Other Messages >
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How to use this manual
About This User Manual .................................................................................................................................. 917
Searching Topics ............................................................................................................................................. 918
HTML Version of the Manual for Printing ........................................................................................................ 920

About This User Manual

• Symbols
The following symbols are used in this User Manual to indicate safety information and explanations on restrictions or
precautions in use.

Impor-
tant

Indicates important information that must be followed when using the printer. Be sure to read
this information to prevent printer damage or operating errors.

Caution Indicates caution items for which operating error poses a risk of injury or damage to equipment
or property. To ensure safe use, always follow these precautions.

Note Indicates helpful reference information and supplemental information on particular topics.

• Button names and user interface elements
Key and button names on the control panel and user interface elements in software (such as menus and buttons) are
indicated as follows in this User Manual.

Control panel buttons Example: Press the OK button.

Control panel messages Example: Head Cleaning is displayed.

Software interface items
(Menus and Buttons)

Example: Click OK.

Keyboard keys Example: Press the Tab key.

• Part names
Names of printer parts are indicated as follows in this User Manual.

Printer part names Example: Open the Top Cover.

• Cross-reference
Other pages or manuals that provide related information are indicated as follows in this User Manual.

Cross-reference in the same User Manual Example: see "Turning the Printer On and Off." →P.702
Click the link to jump to the corresponding page.

Cross-reference in related manuals Example: See the Paper Reference Guide .

Other cross-reference Example: See the printer driver help.

• Figures and software screens

• Figures in this User Manual may be different from the actual appearance of the printer in some cases.
• Screens depicted in this User Manual for the printer driver or other software may be different from the actual

screens because of subsequent updates.
• Windows XP screens are used in explanations of Windows operations in this User Manual.

Appendix > How to use this manual >
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• Trademarks

• Canon, the Canon logo, and imagePROGRAF are trademarks or registered trademarks of Canon Inc.
• Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and other coun-

tries.
• Macintosh is a registered trademark of Apple Inc. in the United States and other countries.
• Other company and product names are trademarks or registered trademarks of their respective owners.

• Copyright
©  2008 Canon Inc.

• Unauthorized reproduction of this User Manual in whole or part is prohibited.

• May we request
Thank you for understanding the following points.

• The information in this User Manual is subject to change without notice.
• We strive to ensure accuracy of information in this User Manual, but if you notice errors or omissions, please

contact us.

Searching Topics
You can find information in topics of this User Manual by searching for relevant terms.

1. Enter a term and click the Search button.

Note
• To search for multiple terms at once, enter a space between each term.

Search results are listed at left.

Appendix > How to use this manual >
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2. Click a topic you want to read.
The terms you searched for will be highlighted in the topic.

To review multiple topics at once, select the check box of desired topics and click the Apply button.
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HTML Version of the Manual for Printing
You can select a group of topics in the table of contents or individual topics in this manual for printing.
The following procedure describes how to do this, using the information in Basic Printing Workflow as an example.

Printing a group of topics in the manual
When you access printable HTML versions of the content from section titles in the table of contents, you can specify a
group of topics to print.

1. Click a section title in the table of contents. Here, Basic Printing Workflow is used as an example.

2. Click Access to the HTML for printing in the title area.
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The topics in Basic Printing Workflow are displayed together in HTML format, ready for printing.

3. Clear the sections you will not print and click the Apply button.
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Printing a group of individual topics in the manual
When you access printable HTML versions from subtitles in the table of contents, you can specify a group of topics to print.

1. Click a section title in the table of contents. Here, Basic Printing Workflow is used as an example.

2. Under Basic Printing Workflow, click Printing Procedure.
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3. Click Access to the HTML for printing in the title area.

The topics in Printing Procedure are displayed together in HTML format, ready for printing.
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4. Clear the topics you will not print and click the Apply button.

Printing selected topics
Print selected topics as follows.

1. Access the printing dialog box as follows, depending on your computer's operating system.

• Windows
In Windows, right-click anywhere in the explanation area except on a figure or a link.In the shortcut menu,
click Print to display the Print dialog box.
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• Macintosh
On a Macintosh computer, click anywhere in the explanation area except on a figure or a link while holding the
Ctrl key. In the shortcut menu, click Print Frame to display the Print dialog box.

2. Specify conditions as needed, and then click Print (Windows) or Print (Macintosh).

• Windows
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• Macintosh

Note
• To print only individual topics that are displayed, use this method.
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Disposal of the product
WEEE Directive ............................................................................................................................................... 928
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